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PC*MILER® Product Line 

END-USER LICENSE AGREEMENT 
 

1.  Grant of License:  Subject to the terms, conditions, use limitations and payment of fees as set 
forth herein, ALK Technologies, Inc. ("ALK") grants the end-user ("you") a non-assignable, 
non-transferable, non-exclusive license to install and use the PC*MILER solution(s) 
(including traffic data and fuel subscriptions) you have purchased ("PC*MILER") on a single 
personal computer.  The PC*MILER software, data and documentation are provided for your 
personal, internal use only and not for resale.  They are protected by copyright held by ALK 
and its licensors and are subject to the following terms and conditions which are agreed to by 
you, on the one hand, and ALK and its licensors (including their licensors and suppliers) on 
the other hand. 

 
2.  Title:  You acknowledge that the PC*MILER computer programs, data, concepts, graphics, 

documentation, manuals and other material owned by, developed by or licensed to ALK, 
including but not limited to program output (together, “program materials”), are the exclusive 
property of ALK or its licensors.  You do not secure title to any PC*MILER program 
materials by virtue of this license. 

 
3.  Copies:  You may make one (1) copy of the PC*MILER program materials, provided you 

retain such copy in your possession and use it solely for backup purposes.  You agree to 
reproduce the copyright and other proprietary rights notices of ALK and its licensors on such 
a copy.  Otherwise, you agree not to copy, reverse engineer, interrogate, or decode any 
PC*MILER program materials or attempt to defeat protection provided by ALK for 
preventing unauthorized copying or use of PC*MILER or to derive any source code or 
algorithms therefrom.  You acknowledge that unauthorized use or reproduction of copies of 
any program materials or unauthorized transfer of any copy of the program materials is a 
serious crime and is grounds for suit for damages, injunctive relief and attorneys' fees. 

 
4.  Limitations on Transfer:  This license is granted to you by ALK.  You may not directly or 

indirectly lease, sublicense, sell, disseminate, or otherwise transfer PC*MILER or any 
PC*MILER program materials to third parties, or offer information services to third parties 
utilizing the PC*MILER program materials without ALK's prior written consent.  To comply 
with this limitation, you must uninstall and deactivate PC*MILER from your computer prior 
to selling or transferring that computer to a third party. 

 
5.  Limitations on Network Access:  You may not allow end-users or software applications on 

other computers or devices to directly or indirectly access this copy of PC*MILER via any 
type of computer or communications network (including but not limited to local area 
networks, wide area networks, intranets, extranets, the internet, virtual private networks, Wi-
Fi, Bluetooth, and cellular and satellite communications systems), using middleware 
(including but not limited to Citrix MetaFrame and Microsoft Terminal Server) or otherwise 
(including but not limited to access through PC*MILER interface products), or install or use 
PC*MILER on a network file server, without first notifying ALK, executing a written 
supplemental license agreement, and paying the license fee that corresponds to the number 
and types of uses to which access is to be allowed. 
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6.  Limitations on Data Extraction:  You may manually extract data (including but not limited to 
program output such as distances, maps, and driving directions) from PC*MILER and use it 
in other applications on the same computer on which PC*MILER is legally licensed and 
installed, as permitted below.  You may not transfer data extracted from PC*MILER onto any 
other computer or device unless you have licensed PC*MILER for that computer or device.  
You agree that you will not, nor will you permit your trade partners or anyone else to, use 
content derived from PC*MILER, including route line data, nor display such data or integrate 
such data into another provider’s service, including, but not limited to, Google or Bing.  You 
agree not to pre-fetch, retrieve, cache, index, or store any data, content, or other portion of the 
product output at any time, provided, however, that you may temporarily store (for less than 
thirty (30) days) limited amounts of such content for the sole and exclusive purpose of 
enhancing the performance of your implementation due to network latency, and only if you do 
so securely and in a manner that: (a) does not permit use of the content outside of the scope of 
this Agreement; (b) does not manipulate or aggregate any content or portion thereof; (c) does 
not prevent ALK from accurately tracking usage; and (d) does not modify attribution of the 
product in any way. 

 
7. Limitations on Mobile Communications:  Without limiting the generality of the foregoing, 

you may not transmit PC*MILER street-level driving directions through mobile 
communications systems such as satellite, or cellular services or to mobile devices such as 
computers, telematics systems, on board or mobile computers or Smartphones, handhelds, 
pagers, electronic recording devices or telephones without first executing a written 
supplemental license agreement with ALK and paying the license fee that corresponds to the 
number and types of devices and systems to and through which transmission is to be 
permitted. 

 
8.  Limitations on Disclosure:  You may disclose PC*MILER distances to trading partners, in the 

course of their providing services to you, for specific origin-destination moves for which you 
provide transportation services and use PC*MILER distances as a basis for payment.  You 
may not make any other disclosure of PC*MILER programs and materials, including, but not 
limited to, program output, to anyone outside the legal entity that paid for and holds this 
license, without prior written permission of ALK.  You acknowledge that the PC*MILER 
programs and materials, developed by or licensed to ALK are very valuable to ALK and its 
licensors, and their use or disclosure to third parties, except as permitted by this license or by 
a written supplemental license agreement with ALK, is strictly prohibited. 

 
9.  Security:  You agree to take reasonable and prudent steps to safeguard the security of the 

PC*MILER program materials and to notify ALK immediately if you become aware of the 
theft or unauthorized possession, use, transfer or sale of the PC*MILER program materials 
licensed to you by ALK. 

 
10. Acceptance:  You are deemed to have accepted the PC*MILER program materials upon 

receipt.  
 
11. Warranties:  ALK represents and warrants that: 
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a) For ninety (90) days from date of purchase, PC*MILER, when delivered and properly 
installed, will function substantially according to its specifications on a computer purchased 
independently by you. 
 
b) For ninety (90) days from date of purchase, the software media on which ALK provides 
PC*MILER to you will function substantially free of errors and defects.  ALK will replace 
defective media during the warranty period at no charge to you unless the defect is the result 
of accident, abuse, or misapplication of the product.  
 
c) THE FOREGOING WARRANTIES ARE IN LIEU OF ALL OTHER WARRANTIES 
EXPRESS OR IMPLIED, INCLUDING WITHOUT LIMITING THE GENERALITY OF 
THE FOREGOING ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A 
PARTICULAR USE.  THE PC*MILER PROGRAM, DATA AND DOCUMENTATION IS 
SOLD "AS IS". IN NO EVENT SHALL ALK OR ITS LICENSORS BE LIABLE FOR 
ANY INDIRECT, SPECIAL OR CONSEQUENTIAL DAMAGES SUCH AS, BUT NOT 
LIMITED TO, LOSS IN CONNECTION WITH OR ARISING OUT OF THE EXISTENCE 
OF THE FURNISHING, FUNCTIONING OR USE OF ANY ITEM OF SOFTWARE, 
DATA OR SERVICES PROVIDED FOR IN THIS AGREEMENT.  IN NO EVENT 
SHALL DAMAGES TO WHICH ALK MAY BE SUBJECT UNDER THIS AGREEMENT 
EXCEED THE CONTRACT PRICE.  THIS WARRANTY SHALL NOT ACCRUE TO 
THE BENEFIT OF THIRD PARTIES OR ASSIGNEES. 

 
12. Disclaimer:  The data may contain inaccurate, incomplete or untimely information due to the 

passage of time, changing circumstances, sources used and the nature of collecting 
comprehensive geographic data, any of which may lead to incorrect results.  PC*MILER’s 
suggested routings, fuel and traffic data are provided without a warranty of any kind.  The 
user assumes full responsibility for any delay, expense, loss or damage that may occur as a 
result of their use.  The user shall have no recourse against Canada, whether by way of any 
suit or action, for any loss, liability, damage or cost that may occur at any time, by reason of 
possession or use of Natural Resources Canada data. 

 
13. Termination:  This Agreement will terminate immediately upon any of the following events: 
 

a) If you seek an order for relief under the bankruptcy laws of the United States or similar 
laws of any other jurisdiction, or a composition with or assignment for the benefit of 
creditors, or dissolution or liquidation, or if proceedings under any bankruptcy or insolvency 
law are commenced against you and are not discharged within thirty (30) calendar days. 
 
b) If you materially breach any terms, conditions, use limitations, payment obligations, or 
any other terms of this Agreement. 
 
c) Upon expiration of any written supplemental license agreement between you and ALK of 
which this license is a part. 

 
14. Obligations on Termination:  Termination or expiration of this Agreement shall not be 

construed to release you from any obligations that existed prior to the date of such 
termination or expiration. 
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15. Hold Harmless and Indemnity:  To the maximum extent permitted by applicable law, you 
agree to hold harmless and indemnify ALK and its parent company, subsidiaries, affiliates, 
officers, agents, licensors, owners, co-branders,  other partners, and employees from and 
against any third party claim (other than a third party claim for Intellectual Property Rights) 
arising from or in any way related to your use of PC*MILER, including any liability or 
expense arising from all claims, losses, damages (actual and/or consequential), suits, 
judgments, litigation costs and attorneys' fees, of every kind and nature. ALK shall use good 
faith efforts to provide you with written notice of such claim, suit or action. 

 
16. Disclosure for Products Containing Certain Data:  
 

a) Historical or Real-time Traffic data:  traffic data, including historical traffic data, is 
licensed as an optional subscription service which must be renewed annually for continued 
use.  ALK and its licensor(s) will use commercially reasonable efforts to make traffic data 
available at least 99.5% of the time each calendar month, excluding minor performance or 
technical issues as well as downtime attributable to necessary maintenance, and Force 
Majeure. 
 
b) Fuel data:  fuel data is licensed as an optional a subscription service which must be 
renewed annually for continued use.  
 
This data is provided to you “as is,” and you agree to use it at your own risk.  ALK and its 
licensors (and their licensors and suppliers) make no guarantees, representations or 
warranties of any kind, express or implied, arising by law or otherwise, including but not 
limited to, content, quality, accuracy, completeness, effectiveness, reliability, fitness for a 
particular purpose, usefulness, use or results to be obtained from this Data, or that the Data or 
server will be uninterrupted or error-free. 

 
17. Limitations on Export:  You hereby expressly agree not to export PC*MILER, in whole or in 

part, or any data derived therefrom, in violation of any export or other laws or regulations of 
the United States. 

 
18. Aggregated Data:  ALK may, from time to time, share information about You with parent 

and sister or affiliated companies for business purposes and when necessary for it to perform 
work under this Agreement.  In addition, ALK may, and is hereby authorized to, use, share 
and provide certain aggregated, non-identifiable information derived from Your use of 
PC*MILER to third parties. 

 
19. ALK Cloud Feature:  ALK Cloud feature will store in anonymized way Your data in a cloud 

account in order to allow You to securely synchronize Your data with other users in Your 
organization.  End-user data is deemed the confidential information of end-user. For more 
information you may refer to ALK’s Privacy Policy. 

 
20. Additional Use Terms, Conditions, Restrictions and Obligations:  This agreement and your 

use of PC*MILER is expressly subject to the ALK Privacy Policy and the Navteq (HERE) 
and ALK End User License Agreement Terms and Conditions respectively  (“Navteq 
EULA”) and (“ALK EULA”) set forth below.  YOU ACKNOWLEDGE AND AGREE 
THAT YOU MAY NOT USE PC*MILER IF YOU DO NOT ACCEPT THE TERMS AND 

 
 PC*MILER User’s Guide x 



 
 

CONDITIONS OF BOTH THE NAVTEQ AND ALK EULA AND THAT YOU 
ACKNOWLEGE THAT YOU HAVE REVIEWED AND ACCEPT THE TERMS AND 
CONDITIONS OF BOTH THE NAVTEQ AND ALK EULA BY INSTALLING OR 
ACTUALLY USING PC*MILER. 

 
21. Miscellaneous:  This agreement shall be construed and applied in accordance with the laws 

of the State of New Jersey.  The Courts of the State of New Jersey shall be the exclusive 
forum for all actions or interpretation pertaining to this agreement.  Any amendments or 
addenda to this agreement shall be in writing executed by all parties hereto.  This is the entire 
agreement between the parties and supersedes any prior or contemporaneous agreements or 
understandings.  Should any provision of this agreement be found to be illegal or 
unenforceable, then only so much of this agreement as shall be illegal or unenforceable shall 
be stricken and the balance of this agreement shall remain in full force and effect. 

 
22. Date:  This EULA was last updated on June 4, 2015. Visit www.pcmiler.com for regular 

updates. 
 
 
END USER LICENSE AGREEMENT FOR NAVTEQ (HERE) DATA 
 
This licence applies to NAVTEQ data included in your Software, if any, as well as to NAVTEQ 
data you obtain separately that is formatted for use with your Software. 
 
The data (“Data”) is provided for your personal, internal use only and not for resale.  It is 
protected by copyright, and is subject to the following terms and conditions which are agreed to 
by you, on the one hand, and ALK Technologies Inc. (“ALK”) and its licensors (including their 
licensors and suppliers) on the other hand. 
 
© 2015 NAVTEQ.  All rights reserved. 
 
Personal Use Only.  You agree to use this Data together with PC*MILER for the solely personal, 
non-commercial purposes for which you were licensed, and not for service bureau, time-sharing 
or other similar purposes.  Accordingly, but subject to the restrictions set forth in the following 
paragraphs, you may copy this Data only as necessary for your personal use to (i) view it, and (ii) 
save it, provided that you do not remove any copyright notices that appear and do not modify the 
Data in any way.  You agree not to otherwise reproduce, copy, modify, decompile, disassemble or 
reverse engineer any portion of this Data, and may not transfer or distribute it in any form, for any 
purpose, except to the extent permitted by mandatory laws. Multi-disc sets may only be 
transferred or sold as a complete set as provided by ALK and not as a subset thereof. 
 
Restrictions.  Except where you have been specifically licensed to do so by ALK, and without 
limiting the preceding paragraph, you may not (a) use this Data with any products, systems, or 
applications installed or otherwise connected to or in communication with vehicles, capable of 
vehicle navigation, positioning, dispatch, real time route guidance, fleet management or similar 
applications; or (b) with or in communication with any positioning devices or any mobile or 
wireless-connected electronic or computer devices, including without limitation cellular phones, 
palmtop and handheld computers, pagers, and personal digital assistants or PDAs. 
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Warning. The Data may contain inaccurate or incomplete information due to the passage of time, 
changing circumstances, sources used and the nature of collecting comprehensive geographic 
data, any of which may lead to incorrect results. 
 
No Warranty.  This Data is provided to you “as is,” and you agree to use it at your own risk.  
ALK and its licensors (and their licensors and suppliers) make no guarantees, representations or 
warranties of any kind, express or implied, arising by law or otherwise, including but not limited 
to, content, quality, accuracy, completeness, effectiveness, reliability, fitness for a particular 
purpose, usefulness, use or results to be obtained from this Data, or that the Data or server will be 
uninterrupted or error-free. 
 
Disclaimer of Warranty. ALK AND ITS LICENSORS (INCLUDING THEIR LICENSORS AND 
SUPPLIERS) DISCLAIM ANY WARRANTIES, EXPRESS OR IMPLIED, OF QUALITY, 
PERFORMANCE, MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE OR 
NON-INFRINGEMENT.  Some States, Territories and Countries do not allow certain warranty 
exclusions, so to that extent the above exclusion may not apply to you. 
 
Disclaimer of Liability.  ALK AND ITS LICENSORS (INCLUDING THEIR LICENSORS AND 
SUPPLIERS) SHALL NOT BE LIABLE TO YOU: IN RESPECT OF ANY CLAIM, DEMAND 
OR ACTION, IRRESPECTIVE OF THE NATURE OF THE CAUSE OF THE CLAIM, 
DEMAND OR ACTION ALLEGING ANY LOSS, INJURY OR DAMAGES, DIRECT OR 
INDIRECT, WHICH MAY RESULT FROM THE USE OR POSSESSION OF THE 
INFORMATION; OR FOR ANY LOSS OF PROFIT, REVENUE, CONTRACTS OR 
SAVINGS, OR ANY OTHER DIRECT, INDIRECT, INCIDENTAL, SPECIAL OR 
CONSEQUENTIAL DAMAGES ARISING OUT OF YOUR USE OF OR INABILITY TO USE 
THIS INFORMATION, ANY DEFECT IN THE INFORMATION, OR THE BREACH OF 
THESE TERMS OR CONDITIONS, WHETHER IN AN ACTION IN CONTRACT OR TORT 
OR BASED ON A WARRANTY, EVEN IF ALK OR ITS LICENSORS HAVE BEEN 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.  Some States, Territories and 
Countries do not allow certain liability exclusions or damages limitations, so to that extent the 
above may not apply to you. 
 
Export Control.  You agree not to export from anywhere any part of the Data provided to you or 
any direct product thereof except in compliance with, and with all licenses and approvals required 
under, applicable export laws, rules and regulations. 
 
Entire Agreement.  These terms and conditions constitute the entire agreement between ALK (and 
its licensors, including their licensors and suppliers) and you pertaining to the subject matter 
hereof, and supersedes in their entirety any and all written or oral agreements previously existing 
between us with respect to such subject matter. 
 
Governing Law.  The above terms and conditions shall be governed by the laws of Illinois, 
without giving effect to (i) its conflict of laws provisions, or (ii) the United Nations Convention 
for Contracts for the International Sale of Goods, which is explicitly excluded.  You agree to 
submit to the jurisdiction of the Illinois for any and all disputes, claims and actions arising from 
or in connection with the Data provided to you hereunder. 
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Government End Users: If the Data is being acquired by or on behalf of the United States 
Government or any other entity seeking or applying rights similar to those customarily claimed by 
the United States government, the Data is a “commercial item” as that term is defined at 48 C.F.R 
(“FAR”) 2.101, is licensed in accordance with End-User Terms and each copy of Data delivered 
or otherwise furnished shall be marked and embedded as appropriate with the following “Notice 
of Use” and shall be treated in accordance with such Notice. 
 
Notice of Use 
Contractor (Manufacturer/Supplier) Name: NAVTEQ 
Contractor (Manufacturer/Supplier) Address: 425 W. Randolph Street, Chicago, Illinois 60606 
This Data is a commercial item as defined in FAR 2.101 and is subject to these End User Terms 
under which this Data was provided 
©2015 NAVTEQ- All rights reserved 
 
If the Contracting Officer, federal government agency, or any federal official refuses to use the 
legend provided herein, the Contracting Officer, federal government agency, or any federal 
official must notify NAVTEQ prior to seeking additional or alternative rights in the Data. 
 
 
END USER LICENSE AGREEMENT FOR ALK DATA  
 
This license applies to ALK Data included in PC*MILER if any, as well as to ALK data you 
obtain separately that is formatted for use with your Software. 
 
The data (“Data”) is provided for your personal, internal use only and not for resale.  It is 
protected by copyright, and is subject to the following terms and conditions which are agreed to 
by you, on the one hand, and ALK Technologies, Inc. (“ALK”) and its licensors (including their 
licensors and suppliers) on the other hand. 
 
© 2015 ALK.  All rights reserved. 
 
1. Personal Use Only:  “You” means you as an End-user or as a “Company” on behalf of its 

End-Users which are subject to either a Non-Disclosure Agreement as employees or a 
License Agreement that contains the same restrictions as herein as a Value Added Reseller.  
Also as used in this EULA “personal use” can also be understood in more general terms as 
for a Company’s use. You agree to use this Data together with PC*MILER for the solely 
personal, non-commercial purposes for which you were licensed, and not for service bureau, 
time-sharing or other similar purposes.  Accordingly, but subject to the restrictions set forth 
in the following paragraphs, you may copy this Data only as necessary for your personal use 
to (i) view it, and (ii) save it, provided that you do not remove any copyright notices that 
appear and do not modify the Data in any way.  You agree not to otherwise reproduce copy, 
modify, decompile, disassemble or reverse engineer any portion of this Data, and may not 
transfer or distribute it in any form, for any purpose, except to the extent permitted by 
mandatory laws. 

 
2. Restrictions:  Except where you have been specifically licensed to do so by ALK in the case 

of an integrated solution bundled or intended for use with specific smartphones, similar 
mobile communication device(s) or personal navigation device(s), and without limiting the 
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preceding paragraph, you may not use this Data (a) with any products, systems, or 
applications installed or otherwise connected to or in communication with vehicles, capable 
of vehicle navigation, positioning, dispatch, real time route guidance, fleet management or 
similar applications; or (b) with or in communication with any positioning devices or any 
mobile or wireless-connected electronic or computer devices, including without limitation 
cellular phones, smartphones, palmtop and handheld computers, pagers, and personal digital 
assistants or PDAs. 

 
3. Warning:  The Data may contain inaccurate, untimely or incomplete information due to the 

passage of time, changing circumstances, sources used and the nature of collecting 
comprehensive geographic data, any of which may lead to incorrect results.  The Data is 
based on official highway maps, the Code of Federal Regulations, and information provided 
by state governments and other licensors.  It is provided without a warranty of any kind.  The 
user assumes full responsibility for any delay, expense, loss or damage that may occur as a 
result of use of the Data.  

 
4. No Warranty:  This Data is provided to you “as is,” and you agree to use it at your own risk.  

ALK and its licensors (and their licensors and suppliers) make no guarantees, representations 
or warranties of any kind, express or implied, arising by law or otherwise, including but not 
limited to, content, quality, accuracy, completeness, effectiveness, reliability, fitness for a 
particular purpose, usefulness, use or results to be obtained from this Data, or that the Data or 
server will be uninterrupted or error-free. 

 
5. Disclaimer of Warranty:  ALK AND ITS LICENSORS (INCLUDING THEIR 

LICENSORS AND SUPPLIERS) DISCLAIM ANY WARRANTIES, EXPRESS OR 
IMPLIED, OF QUALITY, PERFORMANCE, MERCHANTABILITY, FITNESS FOR 
A PARTICULAR PURPOSE OR NON-INFRINGEMENT.  Some States, Territories and 
Countries do not allow certain warranty exclusions, so to that extent the above exclusion may 
not apply to you. 

 
6. Disclaimer of Liability:  ALK AND ITS LICENSORS (INCLUDING THEIR 

LICENSORS AND SUPPLIERS) SHALL NOT BE LIABLE TO YOU: IN RESPECT 
OF ANY CLAIM, DEMAND OR ACTION, IRRESPECTIVE OF THE NATURE OF 
THE CAUSE OF THE CLAIM, DEMAND OR ACTION ALLEGING ANY LOSS, 
INJURY OR DAMAGES, DIRECT OR INDIRECT, WHICH MAY RESULT FROM 
THE USE OR POSSESSION OF THE INFORMATION; OR FOR ANY LOSS OF 
PROFIT, REVENUE, CONTRACTS OR SAVINGS, OR ANY OTHER DIRECT, 
INDIRECT, INCIDENTAL, SPECIAL OR CONSEQUENTIAL DAMAGES ARISING 
OUT OF YOUR USE OF OR INABILITY TO USE THIS INFORMATION, ANY 
DEFECT IN THE INFORMATION, OR THE BREACH OF THESE TERMS OR 
CONDITIONS, WHETHER IN AN ACTION IN CONTRACT OR TORT OR BASED 
ON A WARRANTY, EVEN IF ALK OR ITS LICENSORS HAVE BEEN ADVISED 
OF THE POSSIBILITY OF SUCH DAMAGES.  Some States, Territories and Countries 
do not allow certain liability exclusions or damages limitations, so to that extent the above 
may not apply to you. 
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7. Export Control:  You agree not to export from anywhere any part of the Data provided to you 
or any direct product thereof except in compliance with and with all licenses and approvals 
required under, applicable export laws, rules and regulations. 

 
8. Entire Agreement:  These terms and conditions constitute the entire agreement between ALK 

(and its licensors, including their licensors and suppliers) and you pertaining to the subject 
matter hereof, and supersedes in their entirety any and all written or oral agreements 
previously existing between us with respect to such subject matter. 

 
9. Governing Law:  The above terms and conditions shall be governed by the laws of the State 

of New Jersey.  The courts of the State of New Jersey shall have exclusive jurisdiction to 
settle any and all disputes, claims and actions arising from or in connection with the Data 
provided to you hereunder.  You agree to submit to such jurisdiction. 

 
10. Canada:  DISCLOSURE FOR PRODUCTS CONTAINING CANADIAN POSTAL CODE 

AND/OR CANADIAN STREET-LEVEL DATA:  Based on Computer File(s) licensed from 
Statistics Canada. © Copyright, HER MAJESTY THE QUEEN IN RIGHT OF CANADA, 
as represented by the Minister of Industry, Statistics Canada 2003-2015. ALK Technologies, 
Inc. is an Authorized User of selected Statistics Canada Computer File(s) and Distributor of 
derived Information Products under Licensing Agreement 6147.  No confidential information 
about an individual, family, household, organisation or business has been obtained from 
Statistics Canada. You agree to indemnify Canada and its officers, employees, agents and 
contractors from all claims alleging loss, costs, expenses, damages or injuries (including 
injuries resulting in death) arising out of possession or use by Company of Natural Resources 
Canada data. 

 
========================================= 
ALK TECHNOLOGIES, INC. | www.alk.com 
================================================= 
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                 Introduction 
 

 
Welcome to ALK Technologies’ PC*MILER!  By purchasing a PC*MILER 
product, you have made a cost-effective investment in the transportation and 
logistics industry’s leading routing, mileage, and mapping software solution.  
Accuracy, reliability, and stability have positioned PC*MILER as the technology 
used by 98% of the top motor carriers and 92% of the top freight transportation 
firms in North America. The U.S. Department of Defense (DoD), the General 
Services Administration (GSA) and the Federal Motor Carrier Safety 
Administration (FMCSA) also rely on PC*MILER as their worldwide distance 
standard. If you're seeking to maximize revenues and minimize costs while 
utilizing the safest, most cost-effective routing for your vehicles and shipments, 
PC*MILER is the answer. 

 
PC*MILER is both easy to learn and easy to use.  You simply enter an origin, a 
destination, and any stops in between, and PC*MILER goes to work to calculate 
truck-specific routing that is displayed on a map.  Distances are returned along 
with time and cost estimates based on adjustable speed, time, and cost parameters.  
Detailed driving directions and a state mileage summary can quickly be generated 
with a click of the mouse.  Multiple routing options and additional features 
provide the tools you need to work effectively and productively.  
 
PC*MILER can be used for rate determination and quotes, trip cost and time 
estimates, dispatch, driver pay calculation, fuel tax reporting, driver log auditing, 
load planning, carrier selection, freight bill auditing, and logistics analysis.  
 
Before you go any further please read the License Agreement that starts on page i.  
It details the terms under which ALK Technologies, Inc. grants you a license, 
ALK's copyrights, and your rights as a licensee.   
 
THE SOFTWARE LICENSE CONTAINED IN THIS MANUAL LIMITS THE 
NUMBER AND TYPE OF COMPUTER ON WHICH YOU CAN LEGALLY 
USE PC*MILER.  BY INSTALLING PC*MILER, YOU HAVE ACCEPTED 
THE TERMS AND CONDITIONS OF THE LICENSE AGREEMENT.  ALK 
TECHNOLOGIES, INC. WILL TAKE PROPER LEGAL ACTION AGAINST 
ANY ILLEGAL USE OF THE PC*MILER SOFTWARE.  
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1.1  What is PC*MILER? 
PC*MILER generates point-to-point mileage, routes, and driving instructions 
over the complete highway system in North America, including Greenland, Puerto 
Rico, St. Pierre and Miquelon, and the U.S. Virgin Islands. It can be 
supplemented with the PC*MILER|Worldwide global highway network as a 
separate purchase.* 
* All instructions for PC*MILER|Worldwide included in this User’s Guide pertain only when 
PC*MILER|Worldwide or DTOD data has been purchased and installed with PC*MILER.    
PC*MILER|Worldwide data is updated and released yearly after the release of the North America 
version of PC*MILER. 
 
PC*MILER will calculate an unlimited number of routes and mileage on a single 
personal computer or a network installation. 
 
PC*MILER calculates point-to-point mileage for an origin-destination pair of 
locations with intermediate stop-off points.  It provides leg and cumulative 
mileage, time and cost estimates, state/country distance summaries, driving 
directions, and  much more.  PC*MILER provides Practical, Shortest, Fastest, and 
Least Cost routing, as well as additional options in North America for National 
Network, Toll Discouraged, 53'/102'' Trailer and Twins, and Hazardous Material 
routing and (optionally in the U.S. and Canada) local street networks. 
 
PC*MILER Version 29 includes the following major features: 
 
• Multiple Route Types and Options – PC*MILER includes a number of 

route types and route options to cover a wide range of routing and planning 
needs. 

• Time-based Routing – Gives users the ability to define a departure or arrival 
time for more precise calculation of ETA/ETD. 

• POI & Fuel Stop Search Along a Route – Provides a POI search tool that 
enables you to search for POI, including fuel stops and prices, along a route or 
within a specified radius from within a route window. 

• Optional U.S. DOT Hours of Service (HOS) management, with HOS rest 
stops inserted along the route. 

• PC*MILER|Traffic – Provides an optional traffic data feed for more realistic 
transit times and real-time, historical or typical traffic displayed on the map (North 
America only, PC*MILER|Traffic required) 

• Least Cost Routing – Least Cost routing generates several alternative routes 
based on multiple user-specified trip cost values.  (PC*MILER|Tolls required for toll 
cost calculation) 

• Fastest Routing – In addition to standard PC*MILER Practical and Shortest 
route types, Fastest routing calculates the quickest feasible way to get to a 
destination.  (North America only, PC*MILER|Traffic required) 

• Toll Calculation with the purchase of the PC*MILER|Tolls add-on. (U.S. and 
Canada only) 
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• ALK’s RouteSync® provides a direct link between PC*MILER in the back 
office and ALK’s CoPilot Truck GPS navigation software in the cab.  
(RouteSync license purchase required)  

• The PC*MILER Map, an "electronic road atlas" for map quality graphics. 
• Reports and maps that can be exported via clipboard for use with 

spreadsheet, word processing and database software – including detailed route 
reports and driving instructions. 

• Route Optimization to resequence stops in the most efficient order on a route. 
• Point of Interest (POI) database with customizable categories. 
• Location Radius – For rate determination and operations planning, this tool 

lets you search for all cities, ZIP/postal codes and towns within a specified 
mileage radius around any location. 

• Elevation Discouraged routing lets users set a customized limit on the 
elevation of the roads a route will use. 

• User-specified vehicle dimensions for routing and toll calculation (includes 
an automobile routing option for vehicles classed less than 9,000 lbs./ 4,082 
kgs. and custom vehicle profiles). (PC*MILER|Tolls required for toll cost calculation) 

• Custom Routing Preferences to avoid, favor, or override specific roads, and 
create and manage multiple sets of routing preferences. 

• Via Points creation and management for customized routing. 
• Custom Route and Vehicle Profiles for custom routes and vehicle dimensions 

you use often. 
• Greenhouse Gas Estimator – For estimating greenhouse gas emissions by route. 
• Ability to customize place names to conform to the name of your facilities 

and customer locations. 
• Import Custom Place feature, allowing seamless importing of custom address 

and pickup/delivery information to eliminate manual trip entry. 
• A Drag Route map feature for instant route customization and visualization. 
• Geofence Tools – Create geofenced areas on the map and have PC*MILER 

avoid these areas or send a warning if routes travel in or out of them. 
• Unlimited number of stop-off locations.  
• Multiple route generation with on-screen comparison reports to determine 

the best route. 
• County name designations for all U.S. locations.  
• Comprehensive height and weight restrictions, including 53'/102'' Trailer 

or Twins. 
• Ability to point and click on the map to select origin, stop-offs and destination, 

plus mouse-driven map customization. 
• Custom cost estimates for empty/loaded miles. 
• Custom average road speed estimates. 
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• Hub mode that determines routing, total mileage and state mileage summaries 
from one origin point to unlimited destinations.  

• State/Country mileage summaries including ferry miles. 
• Latitude/Longitude routing that generates point to point routes and mileage 

between lat/long coordinates. 
• Speed limits by state/province/estado. 
• Online User’s Guide that is easily accessed from within the application. 
• U.S. Department of Defense compliance. 
• The complete North American highway network that includes the United 

States, Canada, and Mexico plus Greenland, Puerto Rico, St. Pierre and 
Miquelon, and the U.S. Virgin Islands. 

• ALK Technologies’ complete Worldwide Highway Network, updated yearly 
to include the most current data available. (PC*MILER|Worldwide or DTOD data 
required for global routing) 

• Optional add-on data modules for street-level addresses and map detail in 
the United States and Canada, Europe, India, and available countries in 
Africa, the Middle East, Oceania and South America. (PC*MILER|Worldwide 
required for address data outside North America) 

• Optional add-on data module for hazardous material routing. (U.S. and 
Canada only; PC*MILER|HazMat add-on module required) 

• Optional add-on data module that provides an integrated energy-focused 
map data set for the oil and gas industry.  (North America only; PC*MILER|Energy 
add-on module required) 

 

1.2  What can PC*MILER be used for? 
You can use PC*MILER for:  

 

• Truck-specific routing and mileage calculations for Shortest, Practical, Fastest 
and Least Cost routes, with additional options for Toll Discouraged, National 
Network, and 53'/102'' Trailer routing in North America 

• A direct link between PC*MILER in the back office and CoPilot Truck in the 
cab (ALK’s RouteSync license required) 

• Hazardous material routing for safety and compliance (with the 
PC*MILER|HazMat add-on module, U.S. and Canada only) 

• Toll cost calculation (with the PC*MILER|Tolls add-on module, U.S. and Canada only) 
• Least Cost routing 
• Dispatch, including Hours of Service (HOS) management 
• Driver pay  
• Rate determination 
• Instant customer quotes  
• Fuel tax reporting 
• Trip time and/or cost estimation 
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• Driver log audits 
• Load planning 
• Stop optimization 
• Carrier selection 
• Logistics analysis 
• Freight bill auditing 
• IFTA and IRP auditing, FHWA safety auditing 
 

1.3  What’s New in PC*MILER Version 29? 

NOTE for PC*MILER|Worldwide and DTOD Data Customers:  Beginning 
with Version 28, the .1 versions of PC*MILER have been discontinued.  
PC*MILER|Worldwide and DTOD Data users who historically purchased a .1 
version of PC*MILER can now install the base version of PC*MILER and then 
install PC*MILER|Worldwide or DTOD data as a separate add-on – see section 
2.5.5 for installation instructions.  This is the same seamless data installation as in 
the past, only the additional .1 version number has been dropped. 
 
NOTE:  Beginning in Version 27, the PC*MILER interface was redesigned and 
now looks very different from previous versions.  For users of Version 26 and 
earlier who are updating, a Feature Reference Guide provides the new locations 
for features that you are already familiar with.  To access it, select the Windows® 
Start menu > All Programs (or the equivalent in your version of Windows) > 
PCMILER 29 > User Guides > Feature Reference Guide.  

 
NOTE Also:  PC*MILER includes an easy way to check for updates from within 
the application.  Keeping current on updates is important to maintain the 
usability of your copy of PC*MILER.  See section 16.3, PC*MILER Updates. 
 
Version 29 includes the following new features and enhancements: 
 
• NEW!... HOS Manager.  The HOS Manager provides users with the option 

to incorporate the requirements of the Federal Hours of Service (HOS) 
regulations into route calculations. Stop times can also be entered in this new 
dialog, to be used in conjunction with HOS route calculations or 
independently. See section 3.11.  (PC*MILER|Streets must be licensed and installed) 

• NEW!... Search For POIs Along a Route.  Users can now search for POIs 
from within a route window, either within a specified radius around a location 
or corridor along a route.  Optionally, the search can target specific POI 
categories and can include a key word to look for.  See section 3.9.  
(PC*MILER|Streets must be licensed and installed) 

• NEW!...  Search For Fuel Stops and Fuel Prices.  PC*MILER’s new POI 
search along route feature includes the ability to search for fuel stops and 
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current fuel prices at major providers. See section 3.10.  (PC*MILER|Streets must 
be licensed and installed) 

• NEW!... Elevation Discouraged Routing.  This new route option enables 
users to set a customized limit on the elevation of the roads a route will use.  
See section 9.3.2.   

• NEW!... Ferry Discouraged Routing.  In addition to the Use Ferry Distances 
route option, users can now choose to generate routes that will avoid ferries 
altogether.  See section 9.3.2. 

• NEW!... Energy Land Survey Addresses.  Version 29 gives 
PC*MILER|Energy users access to land survey addresses from the Public 
Land Survey System (PLSS) and the Dominion Land Survey (DLS) including 
Land Survey Grids (LSDs).  Users can now add land survey addresses as stops 
on a route, save them as custom places, and display them on the map.  See 
Chapter 13.  (PC*MILER|Energy and PC*MILER|Streets must be licensed and installed) 

• NEW!...ALK on the Cloud.  ALK Cloud Services now offers the ability to 
share and automatically back up customized data between users within their 
company.  It also enables RouteSync users to dispatch routes and trip options 
to drivers equipped with ALK’s CoPilot Truck navigation software on mobile 
devices.   See Chapters 14 and 15.  (An active internet connection is required) 

• NEW!... Global Road Speed Setting for Energy Roads.  A new category – 
Energy Roads – is included in the Road Speeds tab of the Route Options and 
Default Route Options dialog. Users can now set a global road speed for all 
Energy Roads.  See section 9.6 and 9.7.  (PC*MILER|Energy and PC*MILER|Streets 
must be licensed and installed) 

• NEW!... Addition of Two More Zoom Levels to the PC*MILER Map.  
Zoom levels 19 and 20 have been added to the map for close-up viewing. 

• NEW!... Map Display of Temporary Road Closures.  Road segments that 
have a temporary road closure are now marked with a dashed red bar on the 
map.  See section 10.6. 

• NEW!... Installation of PC*MILER on Windows 10 systems.   PC*MILER 
can now be installed on Windows 10 systems – see section 2.1 for system 
requirements. 

• NEW!... Addition of the U.S. Virgin Islands to the NA Database.  The U.S. 
Virgin Islands were added to the North American database (includes St. 
Croix, St. John and St. Thomas). 

• ENHANCED!... (PLEASE TAKE NOTE) Default “Streets” Mode.  In 
previous versions of PC*MILER, every new route defaulted to Highway Only 
mode (Use Highway Only option enabled in the Route Options dialog).  In 
Version 29, new routes now default to “Streets” mode if PC*MILER|Energy, 
PC*MILER|Streets or RouteSync is installed, based on the assumption that 
local street routing will be used.  Default options can be changed in the 
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Default Route Options dialog (Routes tab > General group > Defaults).  See 
section 9.3.2 and 9.7. 

• ENHANCED!... Revamped Via Points Manager.  The Via Point Set 
Manager has been redesigned to make it easier to enter and edit via points on 
a route.  See section 11.4. 

• ENHANCED!... Revamped Geofence Manager.  The new Geofence 
Manager includes a map, enabling users to create and edit geofences from 
within the Manager.  See section 11.6. 

• ENHANCED!... Implementation of New NHMRR Routes.  ALK’s 
hazardous material routing database has been updated with designations and 
restrictions published on July 14, 2014 by the National Hazardous Material 
Route Registry (NHMRR). (PC*MILER|HazMat must be licensed and installed) 

• ENHANCED!...  “General” Hazmat Route Type Changed to “Other”.  
For those who use PC*MILER for hazardous material routing, the General 
route type has been renamed “Other”.  The new name more accurately reflects 
the variety of hazardous materials that are suitable for this route type, 
especially for our customers in Europe.  (PC*MILER|HazMat data must be licensed 
and installed) 

• ENHANCED!... Improved Organization of Information in the 
Application Settings Dialog.  The options in the Application Settings dialog 
have been reorganized into a more intuitive layout.  See section 3.5. 

• ENHANCED!... PC*MILER|Tolls Discount Program Update.  Three toll 
discount programs have been removed in Version 29.  No new discount 
programs were added.  See Chapter 7 for details.  (PC*MILER|Tolls must be 
licensed and installed)   

• ENHANCED!... Yearly Database Enhancements and Routing 
Improvements in North America and Worldwide. Routing improvements 
are a major part of each PC*MILER release and each annual version release 
confirms our commitment to enhancing the quality of PC*MILER’s truck-
specific routing database.  We have added many routing enhancements to 
improve PC*MILER’s truck-specific database, mileage calculations and 
driving directions. 

North America Region Updates 
Version 29 integrates the following improvements to ALK’s North American 
highway and local streets database: 

• Addition of newly constructed roads and interchanges 
• Addition of US Virgin Islands to the North American database (includes 

St. Croix, St. John and St. Thomas) 
• Realignment of the existing road network to GPS standards 
• Update and addition of exit interchanges and alignment of ramp 

structures 
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• Reclassification of roads where necessary (e.g. changing a road from 
secondary to primary) 

• Addition and confirmation of one way designations on roads to provide 
safer navigation and guidance 

• Update of street-level address changes 
• Improvement of city and ZIP/Postal Code placement and alignment 
• Specifically for commercial vehicles, additional updates include but are 

not limited to: 
o Applied urban coding to appropriate city-centers to aid in generating 

better routes through congested areas 
o Improved highway-level coverage and truck specific  through-travel 

routing within city limits  (e.g. keeping drivers on roads designated 
by local and state authorities as preferred/designated for truck travel) 

o Updated vertical clearance data to accurately model posted limits at 
railroad crossings and overpasses 

o Verified truck restrictions and allowances (classifications include truck 
designated roads, truck discouraged roads, height/weight restrictions 
and allowances, commercial prohibited road classifications, hazardous 
materials restrictions/ allowances, and others 

o Updated address and road access to intermodal facilities 
 
Worldwide Data Updates 
 

Region Changes and Updates: 
• The following countries have been moved from Asia to Europe: Armenia, 

Azerbaijan, Georgia, Kazakhstan, Kyrgyzstan, Tajikistan, Turkmenistan 
and Uzbekistan. 

• Afghanistan has been moved from Asia to Middle East. 
• The following have been moved from Oceania to Asia: Palau, Solomon 

Islands, Guam and Northern Mariana Islands. 
• Bermuda and Guantanamo Bay were moved from North America to South 

America. 
 

Additional Worldwide Updates: 
• New coverage: U.S. Virgin Islands, British Indian Ocean Territory. 
• Data provider for many countries has changed from ALK to HERE 

(formerly Navteq). 
 

Improved Coverage Highlights: 
Coverage in the following countries has been significantly improved: 

• Europe: Kazakhstan 
• Africa: Botswana, Egypt, Kenya, Morocco, Western Sahara, 

Mozambique, Tunisia, Reunion and Zimbabwe 
• South America: Argentina, Bahamas, Cayman Islands, Chile, 

Colombia, Costa Rica, French Guiana, Guadeloupe, Martinique, 
Panama, Paraguay, Peru, Saint Barthelemy, Uruguay, Venezuela 
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• Asia: Hong Kong, Macau, Vietnam 
• North America: U.S. Virgin Islands, Mexico highway level 

 

• ENHANCED!... Annual Updates of Defaults for US$/CAD$ Conversion 
Rate and Trip Costs.  In Version 29, the default US dollar/Canadian dollar 
conversion rate as applied to toll rates (if PC*MILER|Tolls is installed) and 
default fuel/trip costs are as shown below (in U.S. dollars).  See Chapter 7 on 
toll costs, and section 9.4 on fuel and trip costs. 

 
Cost/Time Parameter Version 29 Version 28 
US$/Canadian$ Conversion Rate (note 1) $1.00/$1.277 $1.00/$1.051 
Fuel Cost Per Gallon (note 2) $2.78 $3.95 
Fuel Cost Per Liter  $.73 $1.04 
Fuel Cost Per Mile (Loaded or Empty) $.43 $.61 
Fuel Cost Per Kilometer (Loaded or Empty) $.43 $.61 
Other Cost Per Mile (Loaded or Empty) $.19 $.18 
Other Cost Per Kilometer (Loaded or Empty) $.12 $.11 
Labor Cost Per Hour (Loaded or Empty) $32.89 $31.64 
Greenhouse Gas Estimates (note 3) 22.2 22.2 
MPG – Loaded and Empty (note 4) 6.48 6.48 
Reference Notes: 
(1) As of 3.31.2015, from: 

http://www.fiscal.treasury.gov/fsreports/rpt/treasRptRateExch/treasRptRateExch_home.htm  
(2) Transport Topics 4.13.2015, p. 30 
(3) Emission Facts, U.S. Environmental Protection Agency publication EPA420-F-05-003, February 

2005, p. 2 
(4) James Langley, TMW VP of Business Analytics, 2013, from a survey of 62 North American truck 

carriers with > 200 mile average haul, totaling 21,000 trucks. 
American Transportation Research Institute (ATRI) Reference: 
2014 updated study – http://atri-online.org/2014/09/24/an-analysis-of-the-operational-costs-of-trucking-

2014-update-report-request/ 
 
 

1.4  The PC*MILER Highway Database 
All PC*MILER products are based on ALK Technologies' proprietary computer 
representation of the North American and Worldwide highway systems.  The 
distances contained in PC*MILER are derived from official highway maps 
obtained from state, provincial, and national governments, state DOT maps, county 
maps, local maps, and information received from thousands of industry contacts.  
All U.S. Interstate, Federal and truck-specific State highways are included.   
 
PC*MILER Version 29 data features thousands of new and updated North 
American road miles and locations including: bridges and tunnels, border 
crossings, highway exits, truck stops, state weigh stations, CAT Scale weigh 
stations, all year-2015 five-digit U.S. ZIP codes, all U.S. Department of 
Defense military installations, commercial truck restrictions in the United 
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States, Canada, and Mexico, plus all highway junctions and hundreds of 
thousands of cities, towns, and points of interest.  
  
With the purchase of separate add-on data modules, updated databases of 
Canadian Postal Codes, SPLC, and comprehensive U.S. federal, state, and 
local Hazardous Material restrictions and designations are available as well.   
 
In addition, ALK offers several other regularly updated add-on data modules for 
use with the base PC*MILER product: PC*MILER|Streets for address-to-
address routing (see below); PC*MILER|Energy for oil and gas specific data 
and facilities; PC*MILER|Worldwide for global point-to-point routing; 
PC*MILER|Tolls for toll calculation. 
 
 

1.4.1  PC*MILER Local Street and International Data 
 

In North America, users have the ability to add street-level detail to generate 
door-to-door routes and mileage.  PC*MILER's local street-level databases, 
included with the purchase of the PC*MILER|Streets data module, cover the 
United States and Canada* and include a comprehensive address database, along 
with related routing options and map detail.   
 

* Note that with the purchase of PC*MILER|Streets, street-level detail in the U.S. comes standard 
and a separate purchase of the Canadian Street-Level Add-On is necessary to access related data 
in Canada. 
 
Also available for purchase is the PC*MILER|Worldwide data add-on to generate 
point-to-point truck-specific mileage, driving directions and maps over the entire 
international highway network.  PC*MILER|Worldwide includes access to 
highway data in Africa, Asia, Europe, Middle East, North America, Oceania, and 
South America.  Worldwide data is updated yearly after the base release is 
completed.  Optional street-level data in many countries and regions can be 
purchased along with a PC*MILER|Worldwide installation. 
   

1.5  Distance Calculation 

NOTE for PC*MILER|Streets Users:  By default, routes in North America are 
calculated with the “Use Highway Only” option turned on in the Route Options 
dialog.  This option can affect distance calculation, and may be turned off – see 
section 9.3.2 for a description of distance calculations for highway-only and 
street-level routing. 

 
Distances and routing directions are calculated by first determining which roads a 
vehicle will travel to get between two points and then adding up the distances 
over each section of road to arrive at a total mileage, similar to the manual task 
that one might follow if using an atlas. 
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Routing to all stops will “clean up” to the nearest truck-usable road on the 
highway or local street network.  This local distance equals the short air distance 
between where the point is plotted on the map and the closest truck-usable road.  
In the Detailed Route report, which lists every route segment and interchange on a 
route, this distance may appear as “Local”. 
 

1.6  PC*MILER Route Types 
PC*MILER offers three basic route types: Practical, Shortest and Fastest. For 
routing in North America, any of these may be combined with one or more of the 
three other PC*MILER route types (Toll Discouraged and National Network or 
53'/102'' Trailer or Twins Routing).   
 
Light Vehicle routing for vans, automobiles, pickup trucks, SUVs, etc. is also 
available (North America only), and Least Cost routing may be generated for the 
Practical, Shortest or Fastest route type.  See sections 1.6.1 – 1.6.8 below for 
detailed descriptions of each route type.  See Chapter 9 for route options. 
 
 

1.6.1  PC*MILER Practical Routes 
 

PC*MILER Practical Routes represent distances and driving routes that a driver 
would normally take to minimize time and cost. Practical Routes model the trade-
off between taking the most direct path and staying on major, high quality 
highways.  Interstate highways are given a higher priority than toll roads, which,  
in turn, are given a higher priority than secondary highways, and so on.  Routing 
instructions and mileage can be used when actual travel distances and directions 
are needed. 
 
PC*MILER Practical routings consider distance, road quality, terrain, urban/rural 
classifications, truck-restricted roads, and designated principal and secondary 
through routes. 
In the United States, PC*MILER Practical Route mileage and state-by-state 
mileage breakdowns can be used to supplement your regular fuel tax reporting 
documents for many states.  Many state audit departments have purchased 
licenses to incorporate PC*MILER into their audit procedures. 
 
NOTE:  A PC*MILER user may still be assessed additional taxes even by 
those states using PC*MILER in their audit procedures.  However, your 
chances of being assessed additional taxes greatly diminishes by utilizing a 
computerized mileage system in conjunction with your driver logs, trip sheets, 
invoices, and bills of lading. 
 
In order to minimize the possibility of significant tax assessments, you must 
verify that the PC*MILER generated route is the same as that reported on your 
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driver logs and/or trip sheets.  In addition, you must add the appropriate vicinity 
miles to the PC*MILER generated mileage so that the following equation is true: 
 
TOTAL ODOMETER MILES = PC*MILER Miles + Vicinity Miles 
 
NOTE:  PC*MILER accounts for some vicinity miles if non-Keypoints 
(generally postal code locations and/or place names not associated with the 
downtown metropolitan area) are used as stop-off locations. 
 
ALK Technologies continues to work closely with the member states of the 
International Fuel Tax Agreement (IFTA) and the International Registration Plan 
(IRP).  Currently many IFTA/IRP states are using PC*MILER as an auditing tool 
in their fuel and mileage tax audit procedures. 
 
 

1.6.2  PC*MILER Shortest Routes 
 

PC*MILER Shortest Routes represent distances and driving routes that a vehicle 
would take to minimize total distance traveled while still following a reasonable 
route.  For instance, Shortest Route mileage and routes will also avoid truck-
restricted roads and, in some cases, may favor a beltway rather than traveling 
directly through a city. 
 
ALK believes, however, that carriers and shippers alike would all be better served 
by using a mileage tariff based on actual miles traveled (i.e. similar to those 
generated using the PC*MILER Practical Route option), which would more 
accurately reflect true transportation costs. 
 
 

1.6.3  PC*MILER Fastest Routing (North America only) 
 
(PC*MILER|Traffic must be installed and activated.)  In addition to the standard 
Practical and Shortest routing types, PC*MILER now provides a Fastest routing 
type.  Fastest routing uses any day of the week or time of day information that has 
been set for a route (these are optional settings for Fastest routing) in conjunction 
with Inrix® real-time and/or historic traffic data to calculate the quickest route to 
the trip’s destination(s).  Users who ship time-sensitive freight can select a Fastest 
route that may be longer in distance but save time over the standard Practical 
route. 
 
Additionally, Least Cost routing (see section 1.6.8) now considers Fastest and 
Fastest with Toll Avoidance route types, increasing the number of routes 
considered to six.  Users can opt to utilize Least Cost routing to select the route 
that arrives on time but costs the least, using default or user-specified costs. 
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1.6.4  PC*MILER National Network Routes (U.S. only) 
 

The National Network is a U.S. government-designated system of highways 
originally established by the Surface Transportation Assistance Act of 1982 
(STAA).  This routing option is based on the federally-designated National 
Network system updated in the April, 1992 Code of Federal Regulations, Part 
658, Appendix A.  The National Network includes the Interstate System (several 
minor segments are not included), and many selected U.S. and state highways.  
Highways continue to be added to the National Network by federal and state 
governments. 
 
PC*MILER National Network routing represents distances and driving routes 
which are most reasonable and legal for the larger trucks authorized by the 
Surface Transportation Assistance Act of 1982. 
 
National Network routing stays on the National Network to the maximum extent 
possible.  Given that many areas are not directly served by the National Network, 
the origin and stop-offs of your route may not be on the National Network.  In 
these cases PC*MILER will take the shortest reasonable path from the origin and 
stop-offs to the Network.  Detailed Route Reports (driving directions) for 
PC*MILER National Network routes provide a warning wherever the route is 
forced to use a non-conforming link.  These road segments should be checked 
before traveling. 
 
National Network mileage tends to be higher than Shortest or Practical mileage. 
 
These designated highways permit, at a minimum, 102" wide, single 48 ft. trailers 
and 28 ft. double trailers.  The Interstate system and most, but not all, remaining 
designated routes are open to 80,000 pound vehicles.  Certain states, notably 
Arkansas and Mississippi, have designated certain National Network segments 
with less than an 80,000 pound capacity. 
 
In addition to the National Network highways, access routes and access policies 
are components of routing STAA dimensioned trucks.  The Federal government 
has mandated that no state may prohibit travel from the National Network for a 
minimum of one road mile unless safety restrictions apply.  Also, no state may 
deny reasonable access to terminals and facilities for food, fuel, repairs and rest. 
 
Several states maintain more generous access policies and lists of specifically 
designated access routes to terminals and facilities.  Should you need to travel 
beyond the National Network and the access roads, you must acquire the proper 
permit.  See Appendix A for access rules by state. For detailed information about 
pre-approved access routes, contact the individual states. 

 
NOTES: PC*MILER’s suggested National Network routings are based on 
official highway maps, the Code of Federal Regulations, and information 
provided by state governments.  It is provided without a warranty of any kind.  
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The user assumes full responsibility for any delay, expense, loss, or damage 
which may occur as a result of its use. 
 
See Appendix A, Access Policies From National Network Routes, for the current 
status of National Network access policies.  For detailed information about pre-
approved access routes, contact the individual states. 

 
 

1.6.5  PC*MILER 53' Trailer or Twins Routing (U.S. only) 
 
Because every mile equals money, PC*MILER offers enhanced routing 
specifically for 53'/102'' trailers or 28' tandem trailers (“twins”).  The calculations 
for these routes are based on National Network routing, with the addition of roads 
that permit 53'/102'' trailers or twins.   
 
The regulations that govern the routing of trucks in North America are a function 
of weight, height, number of axles, distance between axles, number of trailers, and 
commodity.  These regulations take two principal forms: restrictions and 
designations.  In the case of designations, trucks may deviate from the designated 
road network, on any road that is not otherwise restricted, to access points of 
loading, unloading and services.   
 
Under the 1982 U.S. federal law known as the STAA, the most important 
distinction in truck designations is between 96'' wide, 48' long trailers on the one 
hand and 102'' wide, 53' long trailers (and twin 28' long trailers) on the other hand.  
When the 53' Trailer and Twins routing option is used in PC*MILER, or when a 
width of greater than 96'' or a length greater than 48' is entered into PC*MILER as 
the vehicle size, PC*MILER’s routing algorithm switches to favoring roads 
designated by the states for “oversize” trucks (over 96'' wide or 48' long).   
In PC*MILER, the routing designations for the following equipment types are 
included in the 53' Trailer or Twins (formerly named “53' Trailer”) routing 
category: 

• double trailers no more than 28' long and 102'' wide; 
• semi-trailers longer than 48' or wider than 96'', but no longer than 53' and no 

wider than 102''. 
 
Detailed Route and Driver’s reports for PC*MILER 53' Trailer and Twins routes 
warn that a road is “Not Designated” if that road is necessary to reach an origin, 
destination or stop-off outside of the maximum access distance for that state.  In 
this case the circle that represents the stop on that link in the route window will 
turn solid red. If the cursor hovers over it a tooltip will tell you what type of 
warning it is.   
 
See Appendix A for state-by-state access policies and an explanation of the criteria 
that will trigger a “Not Designated 53 Foot” warning. 
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“Not Designated” Warning in a Route Window and Detailed Route Report 
 

 
If such a warning appears, then a legal route for 53' equipment is either not 
possible under current state designations or would be so circuitous that you should 
either consider assigning smaller equipment or petitioning the state to designate a 
more direct access route.  Users should check the legal requirements on these 
roads because they vary; for example, delivery may be legal, but stopping for 
food or services may not be. 
 
If the Designated Truck Routes layer in the Map Features dialog is turned on 
(see section 10.7), the PC*MILER map will display the 53-foot designated 
network with a blue underlay when the map scale is approximately 1'' equals 8 
miles or less. This underlay is hidden by default.  (Note: If you have the 
PC*MILER|HazMat module installed and the Hazardous Material layer is 
turned on, you may want to turn it off for a better view of designated truck 
routes.) 
 
 

1.6.6  PC*MILER Toll Discouraged Routes 
 

For those who desire to avoid long stretches of toll roads, ALK provides a Toll 
Discouraged routing option.  Toll Discouraged routing will avoid long stretches of 
toll roads but will not take long, impractical detours to avoid toll bridges and 
tunnels.  For example, a route from Boston, MA to Albany, NY will avoid the 
Massachusetts Turnpike, but a route from Camden, NJ to Philadelphia, PA will 
include a toll bridge. 
 

 
 Chapter 1:  Introduction  15 



 
  

If a Toll Discouraged route needs to travel on a toll road, toll miles will be shown 
in the Detailed Route and State/Country reports.  If PC*MILER|Tolls is installed,   
toll costs will also be shown, even if toll calculation is disabled for the route.  
 
NOTE:  PC*MILER chooses routes by minimizing a cost equation that combines 
distance, certain factors times distance, and certain fixed factors.  When Toll 
Discouraged is selected for a route, the factor that is multiplied times distance for 
toll roads is higher than when Toll Discouraged is not chosen.  This causes the 
route chosen to go a somewhat longer distance (all other factors being equal), but 
not an extremely longer distance, in order to avoid paying a toll. 
 
To see whether the Toll Discouraged option is cost-effective for you or your fleet, 
you may want to consider using ALK’s PC*MILER|Tolls add-on module and  
PC*MILER|Spreadsheets to analyze how much toll cost you will save versus how 
much additional mileage and time cost you will incur, for the particular  origin-
destination pairs that you run frequently.  See Chapter 7, Getting Toll Costs for 
more details about PC*MILER|Tolls.   
 
 

1.6.7  Routing For Different Sizes of Vehicles, and Restriction Overrides 
 

By default, PC*MILER generates routes and mileages for large, heavy trucks of a 
particular size and weight (in North America, 5-axle tractor-semitrailer 
combination, 96” wide, 48’ long trailer, 13’6” high, 80,000 lbs GVW; routing for 
102” wide 53’ long trailers and 28’ twin trailers is available by checking “53’ 
Trailer or Twins” in the Route Options dialog).   You can route other sizes and 
weights of trucks by setting vehicle dimensions, choosing among pre-defined 
vehicle profiles, or creating a user-defined vehicle profile.  See Chapter 9, Using 
Route Options, specifically sections 9.2, 9.3 and 9.5. 
 
PC*MILER also includes a routing option specifically for automobiles and other 
light vehicles (vans, pickup trucks, SUVs, etc.) that relaxes all truck and 
commercial vehicle regulations (see section 9.5.4). 
Additionally, the “Override Restrictions” setting in the Route Options dialog is 
available.  This option relaxes truck restrictions for particular sizes and weights, 
but still avoids roads that are prohibited to or discouraged for all trucks.  If a 
resulting route uses any roads that have restrictions for particular sizes and 
weights, the Detailed Route Report will list them.  This allows you to determine 
the largest or heaviest vehicle you can assign to drive that route.   
 
By default Override Restrictions is off, in which case PC*MILER routing will 
avoid both truck-prohibited and truck-discouraged roads, as well as truck-
restricted roads that pertain to the size and weight set in the current vehicle 
dimensions or profile.  In addition, nationwide 13' 6" height restrictions will be 
taken into account.  
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1.6.8  Least Cost Routing 
 

In response to the needs of our customers, ALK developed the “Least Cost” 
routing feature that considers user-specified values for miles per gallon, cost per 
gallon, fuel cost per mile, maintenance cost per mile, labor cost per hour, and stop 
cost – and includes a parameter for a greenhouse gas emission estimate. If 
PC*MILER|Tolls is installed, toll costs are factored in as well.  See Chapter 4 for 
a full description of this routing type. 
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             Getting Started 
 

 
Before installing PC*MILER, please make sure that you have the required 
hardware and software configuration.  All PC*MILER software, databases and 
auxiliary files are provided with the PC*MILER installation. 
 

2.1  System Requirements 

 

NOTE:  Please check for updates regularly to maintain the usability of your 
current copy of PC*MILER – select the Help tab > Check for Updates. 
 
 

2.1.1  Platforms 
 

• Windows 7, 8 and 10* running in 32-bit compatibility mode as well as support 
for 64-bit native applications on Windows 7 and 8 – please see section 2.4 if 
installing connectivity products on a 64-bit machine 
* IMPORTANT: See the note for Windows 10 in section 2.4. 

• AS/400 
• CICS/MVS 
• UNIX (AIX, HP-UX, Sun-Solaris) and Linux™ 
• Citrix Metaframe and TCP/IP functionality for use with other platforms 
• Windows Server (Windows  Server 2012, Terminal Servers, and Server 2008 

including Server 2008 R2 running in 32-bit compatibility mode for the 
PC*MILER user interface and on 64-bit processors for PC*MILER Connect, 
Mapping, BatchPro, and Spreadsheets) 

NOTE:  Platforms not supported include: Windows Vista, XP, Server 2000, and 
Server 2003. 
 
 

2.1.2  Windows Requirements 
 
Environment: 
• Stand-alone PC with a 1.5-2 GHz processor or networked personal computers 

(LANs and Server/Thin Client Networks)  
• 512 MB RAM minimum, 1 GB strongly recommended for standard desktop 

users.  For Citrix and Terminal Server, 200 MB RAM for each user running 
PC*MILER|Connect and PC*MILER|Spreadsheets. 
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Other Requirements: 
• Minimum screen resolution 800X600 
• Color quality settings supported: 16-bit and 32-bit (8-bit & 24-bit not supported) 
• Internet connection for license activation (recommended) and access to select 

features such as Satellite imagery, real-time Traffic data, and updated fuel 
prices. 

• Email address for license activation 
 

NOTE:  The hard disk requirements listed below are approximate.   
 
PC*MILER: 
• PC*MILER – 2.6 GB hard disk space for full install (including all Add-Ons 

listed below except PC*MILER|Energy, and all Connectivity products) 
o PC*MILER|Tolls – 50 MB hard disk space 
o PC*MILER|Hazmat – 50 MB hard disk space 
o PC*MILER|Streets (U.S. Data) – 1.3 GB hard disk space 
o PC*MILER|Streets (Canadian Data) – 60 MB hard disk space 
o Canadian Postal Codes – 50 MB hard disk space 
o Standard Point Location Codes (SPLC) – 2 MB hard disk space 
o PC*MILER|Energy – Additional 2.6 GB hard disk space 

  
Connectivity Products: 
• PC*MILER|Connect – 8 MB hard disk space 
• PC*MILER|Mapping – 5 MB hard disk space 
• PC*MILER|Spreadsheets – 3 MB hard disk space 
• PC*MILER|BatchPro – 4 MB hard disk space 
• PC*MILER|TCP/IP – 3 MB hard disk space 
 

NOTE:  PC*MILER|Connect and PC*MILER|Spreadsheets support x86-64 
architecture.  Our software was not ported to IA-64 architecture although it 
will still be supported through a hardware compatibility mode. 

 
PC*MILER|Worldwide: 
• Worldwide Highway Network Only – 5.3 GB hard disk space 
• PC*MILER|Streets Data hard disk space requirements: 

• United States – 1.3 GB 
• Canada – 60 MB 
• Africa – 263 MB 
• Europe – 3.38 GB 
• Asia – 616 MB 
• Middle East – 179 MB 
• Oceania – 189 MB 
• South America – 339 MB 
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RouteSync™ Requirements: 
• CoPilot Truck running on one or more mobile devices and registered with 

CoPilot Live Messaging 
• CoPilot Truck Version 9 supported platforms are: Windows® 7, Windows 

Mobile, Windows CE, iPhone, iPad, and Android 
• RouteSync license key code and street-level data in the US and/or Canada 
• TMS solution to dispatch the route to the device 
• PC*MILER 27.3 or higher 
• PC*MILER|Streets or other confirmed 6-digit precision lat/longs 
• Active remote connection on the device (no airplane mode) 
 
These additional components will also be installed: 
• Microsoft Visual C++ 2005 Redistributable Package (x86) – 6 MB disk space 
• WindowsInstaller-KB884016-v2-x86.exe (x86) – 2 MB disk space 
• .NET dotnetfx.exe (x86) – 280 MB disk space 
 

 
2.1.3  AS/400 Requirements 

 
PC to AS/400 Connectivity Options (Not Provided by ALK): 
• PC with a 2+ GHz processor 
• Client Access Express V4R4MO or higher, also known as iSeries Access 

(recommended) 
• Supports OS/400, i5/OS and IBMi operating systems; Version 4.2 (V4R2) and 

higher on IBM AS/400, System i and Power Systems™ hardware. 
 
 

2.1.4  CICS Requirements 
 
Because PC*MILER-CICS employs a distributed processing solution, the 
following additional hardware is required to run the software: 
• A dedicated PC with a high-end Pentium processor (1.5-2 GHz or greater) 
• 512 MB RAM (minimum), 1 GB recommended 
• Communication software from Quotium Technologies (formerly ICOM 

Informatics) called Winsurf+ can be found at www.Quotium.com. 
 
 

2.1.5  UNIX and LINUX Requirements 
 
Contact PC*MILER Technical Support for more information. 
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2.2  General Licensing Information 

Single-User License 
A single-user license can be installed to only one PC or workstation locally. 
 
Multi-User License 
A multi-user license can be installed to a server environment, on the computer 
that will be sharing the licenses to other computers.  It allows “x” number of 
concurrent workstation connections to PC*MILER at a time.  For example, a  
5-User License allows one installation on a central server or PC with as many 
workstation PCs as you want having access, but only 5 users can access 
PC*MILER at the same time. 

 
Enterprise License 
An Enterprise License allows users to install PC*MILER on any combination of 
end-user PCs or workstations without license limitations.  It’s a cost-effective 
installation and licensing solution for larger companies with several users.  It does 
not require license activation but requires signing an enterprise license 
supplemental agreement directly with ALK. 

 
Additional Copy License 
Users can install PC*MILER locally onto additional PCs by purchasing additional 
copy licenses.  If you purchase 5-copy licenses, you can install PC*MILER 
locally onto five additional PCs or workstations.  If you’re installing onto a 
desktop PC and a laptop, two licenses are needed. 

 

2.3  Installation Types 

Non-Network (Local) Installations 
A non-network installation allows you to install PC*MILER to a PC or 
workstation locally, not to be shared with other computers. 

 
Network Installations 
A networked installation allows you to install PC*MILER on network file servers 
where each end-user can save their own option settings or can share option 
settings that are stored on the server. 
 
NOTE:  PC*MILER 29 supports silent installations. 
 
Citrix/Terminal Services Installations 
PC*MILER can be installed onto a Citrix Server or Terminal Services 
environment, if you have purchased a license to do so.  Each end-user must have a 
license to gain access to PC*MILER. 
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Trial Installation 
A trial installation is a 15-day license to access PC*MILER’s features and data.  It 
includes an installation of PC*MILER that provides highway-level routing, 
mileage and mapping, with options for a trial installation of street-level routing, 
truck-specific toll costs, hazardous materials routing, and/or worldwide routing 
(access to worldwide routing is only available with PC*MILER|Worldwide).  A 
trial installation cannot be upgraded, it must be uninstalled and reinstalled to add 
another product or feature.  
 

2.4  Important Installation Notes 

Windows 10 Users:  Because of an unresolved issue with folder permissions in 
Windows 10, if you are installing from a network, you’ll need to copy the 
downloaded PC*MILER installation folder to the desktop or C drive and then run 
the setup.exe from there in order to properly install some of the necessary files. 
 
COM DLL’s on a 64-Bit Computer: If you install PC*MILER|Connect or 
PC*MILER|Mapping Version 29 on a 64-bit computer, you are given the option 
of using either the 32-bit versions or the 64-bit versions of the COM dll’s. To 
switch between the versions, you can run “Modify” in the setup to make the 
decision again or run “UseCom32.bat” to switch to 32-bits or “UseCom64.bat” to 
switch to 64-bits. These .bat files are found in both your 
PCMILER29/Mapping/com and your PCMILER29/Connect/com folders. 
 
PC*MILER Interfaces:  For those who interface any PC*MILER component to 
a transportation management, logistics management or other third party software 
system, please contact the vendor directly to make sure that the interface to this 
new version of PC*MILER is updated and complete before you install. 
 
Access to Updates and Patches: Check the PC*MILER Updater frequently for 
posted updates and patches applicable to your license type and components.  In 
PC*MILER, go the Help tab > Check for Updates.  
 
Microsoft® Windows® 7, 8, 10 and Windows Server 2012 Users: Your license 
must be installed and activated using an Administrator Account.  Once installed, 
you do not have to Run as Administrator provided you install to the recommended 
default directory or to another directory that doesn’t require users to Run as 
Administrator.  Additionally, the administrator should grant write permissions to 
the PC*MILER default directory since some of the newer operating systems 
require an administrator to grant these write permissions. 
 
 
 
 
 
 

 
 PC*MILER User’s Guide 22 



 
 

2.5  Installing PC*MILER  

2.5.1  Single User Local (Non-Network) Installation 
 
NOTE:  Have your Product Key Code on hand before beginning the installation 
process.  It will be emailed to you from alkservices@alk.com in an email titled 
“PC*MILER Software Order…” (Enterprise License customers excluded, see 
note in Step 5 below.)  You should see “Single” in this product key email. 
 
CONVERTING SAVED FILES:  To import saved custom settings and files 
from your previous version of PC*MILER, see section 2.8 before installing 
Version 29. 
   
NOTE for PC*MILER|Traffic Installation: If PC*MILER|Traffic was 
purchased, a separate email will be sent with a second Product Key Code and you 
will need to upgrade the PC*MILER license with this code at the end of the 
installation.  Instructions for installing RouteSync and/or PC*MILER|Traffic 
are included as options in the installation instructions below. 
 
NOTE:  If you have a Multi-User Product Key Code and need to perform a 
Single User install, you will need to contact PC*MILER Technical Support for 
assistance, as a new Product Key Code is needed.  If you cannot get in touch with 
Technical Support at the time of installation, you can install a Single User License 
by typing “FREE” in the Product Key field.  After installing, please contact 
Technical Support to update your license status. 
 
UNINSTALLING an OLDER VERSION: If you need to uninstall a previous 
version of PC*MILER on the computer that you are now installing to, you must 
do it before installing PC*MILER 29.  If you do not need to uninstall, you can 
have both versions of the desktop program installed on the same system.  Please 
note that PC*MILER|Connect, PC*MILER|Mapping and PC*MILER| 
Spreadsheets will be updated to the new version. 
 
 
BEFORE INSTALLING, please double-check that the emailed Product Key 
Code(s) lists all purchased components.  For example, the code shown below 
unlocks the following components: PC*MILER|BatchPro, RouteSync, 
PC*MILER|Tolls, PC*MILER|Streets (U.S. and Canada), and Worldwide 
highway data. 
 

Order #: SO-000000001 
Product Order #: PC*MILER 29 
Date: 7/1/2015 10:33 AM 
Product Key Code: 3QYKJ-V2KJ7-KJ2F5-82KJ2-KJ2F2 
== PC*MILER 29 (Single) BatchPro, Canadian Streets, RouteSync, Tolls, US 

Streets, Worldwide Data 

 
 Chapter 2:  Getting Started  23 

mailto:alkservices@alk.com


 
  

To install your single-user version of PC*MILER 29, follow these steps: 
 

1. If you are downloading the installation, click the provided link in the email 
that was sent to you from ALK Technologies and follow the instructions in 
the email. 

 
NOTE for Windows 10 Users:  Windows 10 users installing from a network, 
please see the note in section 2.4.    
 

If you are installing using a DVD, place the PC*MILER Install DVD in the 
DVD or CD/DVD drive and the installation will start automatically.  If it does 
not start automatically, click the Windows Start menu. Then, depending on 
your operating system, either 1) type “d:\setup.exe” and click the search 
button (if the DVD drive is not the D drive, substitute the letter that designates 
the DVD drive); or 2) select Computer > [DVD drive letter] > setup.exe.  
See the note for Windows users in section 2.4 if applicable to your version. 
  

2. The InstallShield Wizard Welcome screen will open.  Click Next to review 
the End-User License Agreement.  NOTE:  Depending on the current status 
of your Windows operating system, some Windows updates may install 
automatically before the PC*MILER installation begins.  

3. In the next screen, review the license agreement then choose “I accept…”  If 
this option isn’t selected, the setup won’t continue.  After selecting it, click 
Next to continue. 

 
4. When prompted, enter a User Name and Company Name and click Next. 

5. Enter the Product Key Code*,  or “FREE”** for a trial installation.  The 25-
character product key code will have been emailed from alkservices@alk.com 
with the subject line “PC*MILER Software Order…”.  It can be copied from 
the email and pasted in.  If entering the code manually, dashes are not required 
– dashes, spaces, or no spaces are all acceptable.  Click Next when finished.   
* NOTE: As a convenience to Enterprise License customers, the Product Key Code is hard-
coded into the installation and is valid for each install under the contracted terms. 
** NOTE: A trial installation cannot be upgraded, you must uninstall and reinstall to add 
another product or feature. 

6. In the next screen you will see a list of the Licensed Features that will be 
installed.  Check to make sure all the purchased features are in the list, then 
click Next to continue. 

 
NOTE for Enterprise Users:  If you need to disable product components that 
came packaged with your installation, see section 2.5.2 below. 

 
7. Now you will see the Destination Location where all components will be 

installed.  To install to the default directory* (recommended), do not make 
any changes and click Next.  By default, PC*MILER 29 installs directly to 
C:\ALK Technologies\PCMILER29. 
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To install to a location other than the default, click Change to select a 
directory.  “PCMILER29” is required at the end of any custom path; for 
example, “C:\PCMILER\Version29\PCMILER29”.  If this folder is not 
detected, PC*MILER will add it automatically – see NOTE below.  Click OK 
then Next to continue. 
 
IMPORTANT NOTE:  DO NOT attempt to rename your PCMILER29 
folder after installation.  The “PCMILER29” name is required and renaming it 
may cause product failure or unpredictable results. 
 

8. In the next screen, click Next to Start Copying Files.  To change any 
settings, select Back.   
 
If you have a previous version of PC*MILER|Connect or PC*MILER| 
Mapping installed, this alert will appear: “The install found a previous version 
of Connect (Mapping).  These files will be renamed with a .bak extension”.  If 
both products were previously installed, you will receive two alerts.  Click 
OK in the dialog(s) to continue. 

9. Follow through with the rest of the installation.  This may take some time 
depending on the speed of the computer you are installing to.  Do not exit or 
reboot the computer during the installation.  If any error messages appear, 
please contact PC*MILER Technical Support – see Chapter 14, Technical 
Support and Contact Options.   

10. When the installation is complete, you will be prompted to view the 
ReadMe.txt and to activate your license.  If you need to use a Proxy Server 
to access the Internet, skip to section 2.5.3, Activation Using a Proxy Server.  
Otherwise, leave these boxes checked and click Finish to proceed to the 
automatic activation (Step 11 below).  (NOTE: It may take 5-15 seconds for 
the Product Activation window to open.)  When the ReadMe opens, review 
the information in it and then close the window. 

 
IMPORTANT NOTE:  ALK provides a 15-day temporary license prior to 
completing the activation process.  If you make a second attempt to install you 
will lose this license.  If you experience an activation error and need access to 
PC*MILER before Technical Support is available, please do not attempt a 
second installation without assistance – you’ll be able to use PC*MILER for 
15 days without completing the activation. 
 
 

 
AUTOMATIC LICENSE ACTIVATION 

 
11. The PC*MILER Product Activation window should be open.  (If it is not 

open, select Start menu > Programs (or All Programs) > PCMILER 29 > 
License Status to open the License Tool window, then click Activate.)  
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If you are an Enterprise License Customer: You can bypass the following 
license activation steps of the install because you are already activated and 
registered with ALK.  To continue, close the Product Activation window then 
proceed to Step 15 to open PC*MILER and start using the application. 
 
If you are not an Enterprise License Customer: If the computer you are 
installing to has an Internet connection and you have a valid email address, the 
license activation can be processed automatically.  Enter your Email Address 
then click Activate.  “Manual Activation” should be left unchecked. 
 

NOTE:  Internet license activation is available 24 hours a day.  If you don’t 
have an active Internet connection or email address, please contact 
PC*MILER Technical Support during business hours for assistance. 

 
12. When the activation process is complete, you will receive a message in the 

Product Activation window saying, “License Activation Complete!”.  Close 
the window to continue.  If the activation failed, skip to Step 16 below for 
manual activation.   
 

13. To verify that PC*MILER is now licensed, go to the Windows Start menu > 
Programs (or All Programs) > License Status.  In the PC*MILER License 
Tool window, verify that “Licensed” appears under Status.  PC*MILER is 
now activated.  If “Licensed” is NOT in the Status field, skip to Step 16 below 
for manual activation. 
 

If PC*MILER|Traffic was purchased, you can install it now or it can be 
installed at a later time.  See section 2.5.4 below for instructions on how to 
add the license to your base PC*MILER application. 
 

14. If the automatic activation was completed, close the License Tool window.  
An email titled “PC*MILER 29 Activation Code for Product XXXXX…” 
from alkservices@alk.com will be sent to the email you entered in Step 11.  
You only need to keep this email for your records.  

  
15. To start PC*MILER once the installation is complete, click the PC*MILER 

icon on the desktop, or click the Windows Start menu > All Programs > 
PCMILER 29 > PCMILER 29. 

 
MANUAL ACTIVATION 

 
16. (You only need to follow these steps if the automatic license activation 

process failed.)  If the automatic activation (Steps 11-12 above) fails for any 
reason, try manually activating.  In the Product Activation window, enter your 
Email Address (and RouteSync password if applicable) then check “Manual 
Activation”.  

 
17. Next, click the provided URL for the ALK activation site. 
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18. You will be taken to the ALK Technical Support “Activate Product” web 
page, and your PC*MILER product key will automatically populate the 
Product Key fields.  Click Next to continue. 

 
19. In the next screen, enter your Email address and click Finish. 
 
20. An email titled “PC*MILER 29 Activation Code for Product XXXXX…” 

from alkservices@alk.com will immediately be sent to the email you entered. 
 
21. Copy the activation code directly from the Activation web page or from the 

email sent to you, and paste it into the Activation Code field in the Product 
Activation window. 

 
22. Click Activate in the Product Activation window to complete the activation. 
 
23. You will see the message “License Activation Complete!”.  Close the Product 

Activation window.  PC*MILER is now activated. 

24. Start PC*MILER once the installation is complete: click the PC*MILER icon 
on the desktop, or click the Windows Start menu > Programs (or All 
Programs) > PCMILER 29 > PCMILER 29. 

 
 

2.5.2  Disabling Licensed Features (Enterprise Users Only) 
 

If you are an Enterprise User and need to disable one or more features that came 
packaged with your installation, follow the steps below. 
 
1. Open a command prompt window (for Windows 7, click the Windows Start 

menu, type “cmd” and then press Enter). 
 

2. In the command prompt window, navigate to the folder containing 
PC*MILER’s setup.exe by typing cd “C:\your_install_location”. 
Example:  cd “C:\alk technologies\pcmiler29” 

 

3. To launch the install while turning a specific feature off, type the following: 
setup.exe “FeatureName1 off” “FeatureName2 off” “FeatureName3 off” 

 

 For example, to turn off the Connect and Mapping features: 
setup.exe <space>“Connect<space>off”<space>“Mapping<space>off” 

 
Features that can be disabled this way are the following (not case sensitive): 
 

• CanPost • Mapping • TCPIP 
• MVSConnect • TripMatrix • Tolls 
• AS400 • Spreadsheets • Traffic 
• AS400 Tolls • CanadaStreets* • RouteSync 
• BatchPro • Streets* • SPLC 
• Connect   
 

* To turn off North American Streets (includes U.S. and Canadian Streets), use 
the command:  setup.exe “CanadaStreets off” “Streets off”. 

 
 Chapter 2:  Getting Started  27 

mailto:alkservices@alk.com


 
  

2.5.3  Activation Using a Proxy Server 
 

To activate PC*MILER using a Proxy Server, follow these steps: 
 
1. When the installation is complete (Steps 1-9 in section 2.5.1 above), uncheck 

the Activate check box and then click Finish. 
 
2. Next, start PC*MILER:  either click the PC*MILER icon on the desktop, or 

click the Windows Start menu and then select Programs (or All Programs) 
> PCMILER 29 > PCMILER 29. 

 
3. Select the Help tab > Windows group > Proxy Setup. 
 
4. In the Proxy Setup dialog, check Use Proxy Server then enter a Host and Port. 
5. If needed, check Proxy Authentication then enter a Username and Password. 
 
6. Click OK to save your settings and close the dialog.  PC*MILER is now set up 

to use the indicated proxy server when connecting to the Internet. 
 
7. Close PC*MILER. 
 
8. In the Windows Start menu, select Programs (or All Programs) > PCMILER 

29 > License Status to open the PC*MILER License Tool window, then click 
Activate. 

 
9. Follow the steps in section 2.5.1 for automatic activation, beginning at Step 11. 
 
 

2.5.4  Adding PC*MILER|Traffic to the Installation  
 

NOTE:  A trial installation cannot be upgraded, you must uninstall and reinstall 
to add another product or feature.   
 
If a PC*MILER|Traffic subscription was purchased, a separate upgrade product 
key was sent in an email along with the base PC*MILER product key. Follow the 
steps below to install the PC*MILER|Traffic upgrade after PC*MILER has been 
installed and activated.   
1.  If the PC*MILER License Tool window is not already open, select Windows 

Start menu > Programs > PCMILER 29 > License Status. 

2. Click Add License. 

3.  In the PC*MILER Product Activation window, enter the PC*MILER|Traffic 
Upgrade product key that was emailed to you and click Add License. 

 
 PC*MILER User’s Guide 28 



 
 

4. When prompted, enter your Email Address then click Activate.  If 
RouteSync was installed, you will also be asked to enter the same password as 
in Step 11 above under Automatic License Activation. 

5. When the activation process is complete, you will see the message “License 
Activated Successfully.”  The upgrade is now complete. 

6. You will immediately receive an email from ALK Technologies that contains 
the new activation code for this upgrade.  Keep this email for your records. 

7. To start PC*MILER, double-click the PC*MILER icon on the desktop, or 
select Windows Start menu > Programs > PCMILER 29 > PCMILER 29. 

 
2.5.5  Adding PC*MILER Worldwide, Energy or DTOD Data  

 
NOTE:  A trial installation cannot be upgraded, you must uninstall and reinstall 
to add another product or feature.   
 
To install additional PC*MILER|Worldwide*, PC*MILER|Energy or DTOD 
Data to the base installation of PC*MILER, follow the steps below.  The steps 
assume that, after purchasing the data add-on(s), you either 1) received an email 
from ALK Technologies that provides one or more URL link(s) to the setup.exe 
required for the data install; or 2) received an installation DVD which includes the 
data you are adding (or two DVDs if you purchased Worldwide data). 
*  including PC*MILER|Worldwide Streets data sets. 

IMPORTANT NOTE:  Please check that you have the latest updates before 
installing additional components. Open PC*MILER and select the Help tab > 
Check for Updates.   
 

1. If you are using a DVD, insert the DVD and skip to Step 7 below. 

If you are using the email sent to you by ALK, click the download link at the 
bottom of the email.  The email’s subject line will say “PC*MILER 29 Software 
Order #...”.  You may see more than one link, depending on what was purchased 
– begin by clicking the topmost link and follow the instructions in the email.   

2. A web page will open and you will be prompted to open or save the PC*MILER 
zip file.  Click Save and select a folder where you want to save the zip file. 

3. The download will begin.  A very small progress bar in the upper right corner of 
the web page will track the progress of the download.  The progress bar will 
disappear when the download is finished. 

4. Navigate to the folder where you saved the zip file, and double-click the file to 
open it. 
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5. Click Extract at the top of the window that opens to extract the contents of the 
zip file to a separate folder in the same location.  The progress of the extraction 
will be tracked at the bottom of the window. 

6. When the extraction is complete, open the extracted folder and run the 
setup.exe as follows:  For Windows 7 users, right click the setup.exe and 
select "Run as administrator".  For other operating systems, just double-
click the setup.exe. 

7. The PC*MILER Data Installer – InstallShield Wizard will open.  Click Next to 
continue. 

NOTE: If an update to PC*MILER is available, you will be prompted to 
install it before continuing with the upgrade.  Click OK at the prompt. 
 

8. Select “I accept the terms of the license agreement” then click Next. 

9. A prompt will tell you to select “Add License” in the next screen – click OK. 

10. After a few seconds the PC*MILER License Tool window will open – click 
Add License. 

11. In the PC*MILER Product Activation window, enter the Product Key for the 
purchased data add-on, then click Add License.  The product key can be 
copied and pasted from the email that was sent to you at the time of purchase. 

12. Enter your Email Address in the next screen, then click Activate. 

13. When the activation is finished you will see a “License Activation 
Complete!” message.  Close the Product Activation  and License Tool 
windows by clicking on the “X” in the upper right corner of each window. 

14. (AUP Customers Only)  At this point, you may see a prompt asking if you 
want to delete the data from the previous quarter.  Select Yes or No. 

15. Back in the InstallShield Wizard, you will see a list of all the PC*MILER 
Licensed Features that will now be installed.  Click Next. 

16. Now you will see the Destination Location where the new data will be 
installed.  To install to the default directory (recommended), do not make any 
changes and click Next; or click Change to change the destination folder.  
The default destination folder is C:\ALK Technologies\PCMILER29. 

17. In the next screen, click Next to Start Copying Files. 

18. At the end of the copying process, a prompt will appear that says “Setup will 
now create a backup copy of your user.cfg file…”.  Click OK. 

19. Click Finish in the next screen.  Your data add-on is now ready to use. 
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The title bar of the PC*MILER application window will include the installed data 
add-ons, and you will see the new data set in the Map tab > Utilities group > 
Change Data Set menu.  All installed data sets are listed in this menu, and the 
data set you just installed will be activated by default.  See section 3.6.7 on 
changing the map data set. 
 

2.5.6  Multi-User Network Installation 
 
NOTE:  PC*MILER 29 supports silent installations. 

 
NOTE:  Have your Product Key Code on hand before beginning the installation 
process.  It will have been emailed from alkservices@alk.com in an email titled 
“PC*MILER Software Order…” (Enterprise License customers excluded)  You 
should see “X-User” in the Product Key email, indicating that you have purchased 
a multi-user license.  If not, please contact an Enterprise Solutions account 
executive to purchase the correct license. 

 
UNINSTALLING AN OLDER VERSION:  If you need to uninstall a previous 
version of PC*MILER on the computer that you are now installing to, you must 
do it before installing PC*MILER 29.  If you do not need to uninstall, you can 
have both versions of the desktop program installed on the same system.  Please 
note that PC*MILER|Connect, PC*MILER|Mapping and PC*MILER| 
Spreadsheets will be updated to the new version. 
 

 
CONVERTING SAVED FILES:  To import saved custom settings and files 
from your previous version of PC*MILER, see section 2.8. 
  
NOTE FOR INSTALLING TO A MAPPED DRIVE:  For customers who 
install to a mapped drive (this is rare), do not enter the location by its mapped 
name.  For example, if you mapped C:\Apps to F:\, just use C:\Apps as the install 
directory when InstallShield asks you for the location.  Beginning in Version 28, 
the Windows program that PC*MILER uses to automate folder sharing cannot 
share mapped drives by using their mapped name (i.e. F:\ in the example above). 
  
BEFORE INSTALLING, please double-check that the emailed Product Key Code(s) 
lists all purchased components.  For example, the code shown below unlocks the 
following components: PC*MILER|Connect, PC*MILER|Tolls, RouteSync,  
PC*MILER| Streets (U.S. and Canada), and Worldwide highway data. 
 
Order #: SO-000000001 
Product Order #: PC*MILER 29 
Date: 7/1/2015 10:33 AM 
Product Key Code: 3QYKJ-V2KJ7-KJ2F5-82KJ2-KJ2F2 
== PC*MILER 29 (XX-User), Canadian Streets, Connect, Tolls, 
RouteSync, US Streets, Worldwide Data 
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To install PC*MILER 29 on a network, follow these steps: 

1. Begin by installing PC*MILER to the server: follow steps 1-9 for a Single 
User Local Installation (section 2.5.1 above). 

 
2. When the installation is done, you will see the screen shown below.  Click OK. 

 
 

3. You will be prompted to view the ReadMe.txt and to activate your license.  
If you need to use a Proxy Server to access the Internet, skip to section 2.5.3, 
Activation Using a Proxy Server.  Otherwise, leave these boxes checked and 
click Finish to continue.  Review the ReadMe and then close the window. 

 
IMPORTANT NOTE:  ALK provides a 15-day temporary license prior to 
completing the activation process.  If you make a second attempt to install you 
will lose this license.  If you experience an activation error and need access to 
PC*MILER before Technical Support is available, please do not attempt a 
second installation without assistance – you’ll be able to use PC*MILER for 
15 days without completing the activation. 

 
4. After you click Finish, the PC*MILER Product Activation window will open.     

 
If you are an Enterprise License Customer: You can bypass the following 
license activation steps of the install because you are already activated and 
registered with ALK.  To continue, close the Product Activation window. 
PC*MILER is installed on the server and can be opened by double-clicking 
the PC*MILER icon on the desktop, or clicking the Windows Start menu and 
selecting Programs > PCMILER 29 > PCMILER 29. 
 
If you are not an Enterprise License Customer: If the computer you are 
installing to has an Internet connection and you have a valid email address, the 
license activation can be processed automatically.  Enter your Email Address 
then click Activate.  “Manual Activation” should be left unchecked. 
 
NOTE:  Internet license activation is available 24 hours a day.  If you don’t 
have an active Internet connection or email address, please contact Technical 
Support during business hours for assistance – see section 16.1. 

5. If the activation is successful, you will see a “License Activation Complete” 
message that directs you to open an email from ALK Technologies for further 
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instructions.  If the activation was NOT successful, try activating manually 
(Steps 16-23 in section 2.5.1) before calling Technical Support.  To contact 
Technical Support, see section 16.1 in this User’s Guide. 

6. After activation, open the email you received, then follow the instructions for 
copying the “net.lic” file included with the email to the “App” folder in your 
PC*MILER installation.  Net.lic holds the license or user count for your 
installation.  Until you save this file to the designated folder, you will only 
have a single-user installation.  The PC*MILER application is now accessible 
on the server (see Step 2 below for access options). 

INSTALLING ON A WORKSTATION 

To install PC*MILER on each workstation, follow these steps: 
 
1. On the workstation, click the Windows Start menu and enter the network path 

to where the workstation setup program resides.  This path should match the 
network path sent to your email address as a result of running the server 
installation.  The only difference is that you will replace “App” with 
“Network”.  For example, if this path was sent via the email as "\\PRI-QA-
2K332-02\PCMILER29\App\" for the network license file, you will run the 
workstation installation program from \\PRI-QA-2K332-
02\PCMILER29\Network\setup.exe then press Enter. 

 
If you have lost the email that included the network path, you can determine 
the path as follows: navigate to the server’s “PCMILER29” folder, right-click 
the folder, and go to Properties > Sharing.  The network path can be copied 
and pasted from there. 

2. Next, you will be asked to choose your workstation setup options.  Two 
screens will prompt you to select the type of settings you would like to use.   

The setup options in the first screen (Settings Location) are: 

• Use local setting – Allows the user at each workstation to customize 
default options and manage settings, including custom roads and places. 

• Share network settings – Provides each workstation the same default 
options and settings within the application. 

 
The setup options in the second screen (Settings Data) are: 

• Use local data – Installs data to the local workstation.  This option can 
decrease the time it takes PC*MILER to open and begin processing, and 
reduces network traffic.  In general, the performance is better.  However, 
there must be enough hard disk space to accommodate the data.  

• Share data on your network, default – This is the default choice.  
PC*MILER uses the shared data that was installed on the server.  
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NOTE on Fuel Prices:  The feed that keeps fuel prices updated (section 3.10) 
will be turned off by default because the server will be getting the prices 
automatically.  Ensure that the PC*MILER user interface is running on the 
server so that fuel prices are regularly updated.  For PC*MILER|Connect use, 
ensure that the PC*MILER user interface is running on the 
PC*MILER|Connect server. 
 
NOTE for RouteSync Users:  Currently only one RouteSync account is 
allowed per installation.  To access RouteSync functionality from multiple 
workstations, one master RouteSync account must be shared. 

3.  To start PC*MILER on a workstation once the installation is complete, 
double-click the desktop PC*MILER icon, or click the Windows Start menu 
and select Programs (or All Programs) > PCMILER 29 > PCMILER 29. 

 
 

 2.5.7  Citrix and Terminal Services Installations 
 

NOTE: Have your Product Key Code(s) on hand before beginning the 
installation process.  They will be emailed to you from alkservices@alk.com in an 
email with the subject line “PC*MILER Software Order…” (Enterprise License 
customers excluded).  “(Citrix/Terminal Services)” will be included in the Product 
Key email signifying that you have purchased a Citrix or Terminal Services 
license.  If this is not listed, please contact an Enterprise Solutions account 
executive to purchase the correct license and request one Product Key Code for 
each individual server you are installing to.  
 
UNINSTALLING AN OLDER VERSION: If you need to uninstall a previous 
version of PC*MILER on the computer that you are now installing to, you must 
do it before installing PC*MILER 29.  If you do not need to uninstall, you can 
have both versions of the desktop program installed on the same system.  Please 
note that PC*MILER|Connect, PC*MILER|Mapping and PC*MILER| 
Spreadsheets will be updated to the new version. 
 

Custom places, custom road preferences, and geofence files that were saved in an 
older version of PC*MILER can be transferred and converted to Version 29.  For 
custom place conversion, see section 3.16.7.  For custom road conversion, see 
section 11.1.7.  For geofence conversion, see section 11.6.6. 

 
BEFORE USING PC*MILER:  Citrix supports 16 bit and 24 bit color, while 
PC*MILER supports 16 bit and 32 bit color.  A Citrix end user must set the color 
resolution on their workstation to 16 bit before they log into a Citrix server to run 
PC*MILER.  If an end user has their color resolution set to 32 bit and logs in to 
Citrix, the Citrix software will adjust it downward to 24 bit prior to loading 
PC*MILER, and PC*MILER will fail to load. 
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BEFORE INSTALLING, please double-check that the emailed Product Key Code 
lists all purchased components.  For example, the code shown below unlocks the 
following components: PC*MILER|BatchPro, PC*MILER|Tolls, RouteSync,  
PC*MILER|Streets (U.S. and Canada), and Worldwide highway data. 
   

Order #: SO-000000001 
Product Order #: PC*MILER 29 
Date: 7/1/2015 10:33 AM 
Product Key Code: 3QYKJ-V2KJ7-KJ2F5-82KJ2-KJ2F2 
== PC*MILER 29 (Citrix/Term Serv), BatchPro, Canadian Streets, Tolls, 
RouteSync, US Streets, Worldwide Data 

 
If you were using an existing version of PC*MILER with PC*MILER|Connect 
and/or PC*MILER|Mapping in your Citrix environment, there may be existing 
files that require deletion.  Citrix and Terminal Servers can have multiple copies 
underneath C:\Users\<username>\Windows,  C:\Documents and Settings\ 
<username>\Windows or in %homedir%\windows like H:\Windows.  Copies of 
the following files should be deleted from any location outside of C:\WINDOWS: 
 

•  Pcmserve.ini •  Pmwssrv.ini 
•  Pcmserve.ctx •  Pmwssrv.ctx 

 
Only a qualified Citrix administrator should be installing PC*MILER on a 
Citrix system.  With Citrix in Install Mode, follow the steps in section 2.5.1, 
Single User Local (Non-Network) Installation. 
 
 

2.5.8  AS/400 and CICS Installations 
 

Installation instructions can be downloaded from ALK’s website Support Center 
at:  http://www.alk.com/support. 
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2.6  Starting and Closing PC*MILER 
To start the PC*MILER application, double-click the PC*MILER icon on the 
desktop, or click the Windows Start menu > Programs (or the equivalent on your 
computer) > PCMILER 29 > PCMILER 29. 
 
To close PC*MILER, choose Exit from the red File application menu, press 
Alt+F4, or simply close the application window.  
 

2.7  Proxy Setup For Internet Access 
The following PC*MILER features require a connection to the Internet: 
 

• License activation 
• Software update and patch downloads via the Updater tool 
• Real-time traffic data 
• Satellite imagery on the PC*MILER map 
• RouteSync 

 
For those who need to bypass current security settings to access the Internet while 
using PC*MILER, the steps to complete the proxy setup are below.  The setup 
can be implemented after PC*MILER has been activated or before activation 
during the temporary grace period after installation. 
 
1. Open PC*MILER and select the Help tab > Windows group > Proxy Setup. 

2. In the Proxy Setup dialog, check Use Proxy Server then enter a Host and Port. 

3. If needed, check Proxy Authentication then enter a Username and Password. 

4. Click OK to save your settings and close the dialog.  PC*MILER is now set up 
to use the indicated proxy server when connecting to the Internet. 

 

2.8  Importing Saved Files and Settings From a Previous Version 
Saved route files, custom road preferences, custom places, and geofence files can 
all be transferred from the previous version of PC*MILER (Version 28) to the 
newly-installed version.  Saved route files will be automatically updated when 
they are opened in PC*MILER 29.  For custom place conversion, see section 
3.16.7.  For custom road conversion, see section 11.1.7.  For geofence conversion, 
see section 11.6.6. 
 
Additionally, a Settings Importer utility is provided that lets you import 
customized route options, custom road speeds, map feature settings, custom 
vehicle profiles, custom routing profiles, and general application settings from the 
previous version.   
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Here are a few things to note about this utility: 
 

• It will only import from the previous year’s release – i.e. from Version 28 
to Version 29. 

• Settings that change annually, such as currency conversion rate and fuel 
cost, are not imported. 

• The current default values in PC*MILER will be overwritten.  For trip 
options and road speeds, only those values that have been customized in 
the previous version will be imported. 

• The import utility includes a license check and won’t run on workstations 
using shared data.  An error message will appear if an import request 
cannot be processed. 

 

To use the Settings Importer, follow these steps: 
 

1. Select the Windows Start menu > All Programs (or the equivalent for 
your operating system) > PCMILER 29 > Settings Importer. 

2. In this dialog, uncheck any settings you do NOT want to import. 

3. Choose a version from the Import Settings from Version drop-down. 

4. Click Import to proceed with the import (click Close if you decide not to 
proceed).  Close the Settings Importer window when the process is 
complete. 

  
 

 
PC*MILER Settings Importer 
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2.9  Adding New PC*MILER Products 

NOTE:  A multi-user license cannot be changed to a single-user installation of 
PC*MILER by simply adding the license – you must fully uninstall, deactivate 
your multi-user license, then reinstall using the new Product Key Code.   
 
NOTE:  To install a PC*MILER|Traffic subscription, see section 2.5.4.  To 
install PC*MILER|Worldwide, PC*MILER|Energy or DTOD data, see section 
2.5.5.   
 
You may find that you want to purchase an additional PC*MILER component 
sometime after the initial installation of PC*MILER.   

 
First, call PC*MILER SALES at 1-800-377-6453 ext. 1 (or 1.609.683.0220 ext. 
1 outside of the U.S.) 9:00am-5:00pm EST, Monday-Friday to purchase the 
product(s) and obtain a new Product Key Code to license and install the new 
product(s).   
 
Once you receive the new product key code, follow the instructions below for a 
single user or multi-user workstation. 

 
SINGLE USER AND MULTI-USER SERVER INSTALLATION 

1. Go to the Windows Start menu > Programs (or All Programs) > 
PCMILER 29 > License Status. 

2. In the PC*MILER License Tool window, click Add License. 

3. In the PC*MILER Product Activation window, enter the product key for the 
purchased component(s) and click Add License. 

4. When prompted, enter your Email Address.  If you are installing RouteSync, 
you will also need to enter a Password and confirm it. 

5. Click Activate.  

6. When the activation process is complete, you will see the message “License 
Activation Complete!”.  Close the Product Activation window. 

7. Back in the License Tool window, make sure all new and existing PC*MILER 
components are listed under Licensed Components.  

8. Some components include data that needs to be installed after the license has 
been activated.  These components will appear on the Licensed Components 
list with an asterisk (for example, “Canadian Postal Codes*”).  In this case, 
follow Steps 9-14 below.   
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If there are no components that need to be installed, you can close the License 
Tool window and begin using the newly-added PC*MILER products.  
Components that do NOT have additional data that needs to be installed 
include: PC*MILER|Traffic, PC*MILER|HazMat, PC*MILER|RouteMatrix, 
and RouteSync.   

9. To install newly added components, go to the Windows Start menu > 
Control Panel > Programs and Features (or the equivalent on your system). 

10. In the list of installed programs, right click PC*MILER 29 and choose Change. 

11. In the InstallShield Wizard, choose Modify and click Next. 

12. In the next screen, you will see the list of Licensed Features (all activated 
features will be listed – check that the component you are installing is 
included in the list). Click Next to continue. 

13. In the next screen you’ll see the Destination Folder for the installation.  Click 
Next to start copying files. 

14. When the installation is complete, click Finish. 
 
 

MULTI-USER INSTALLATION, FROM A WORKSTATION 

1. Go to the workstation. 

2. Browse to the shared …\PCMILER29\network folder on the server. 

3. Run the setup.exe and choose “Modify”. 

4. Follow through with the rest of the installation. 
 

2.10  Deactivating and Uninstalling a License 
You must fully deactivate the product’s license and uninstall all PC*MILER 
components, including local, network, enterprise, or server installations if you are: 

 

• Moving any PC*MILER installation to a new computer. 
• Reformatting a computer that PC*MILER is currently installed to. 
• Returning the product. 
• Reinstalling on the same PC. 

 
Here are the steps for deactivating and uninstalling: 

 
1. Go to Start > Programs (or All Programs) > PCMILER 29 > License 

Status and in the PC*MILER License Tool window click Deactivate. 

2. In the PC*MILER Product Deactivation window, click Deactivate. 
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3. When the deactivation is complete, you will see a “Deactivation Complete” 
message, with the deactivated product keys listed below.   

4. Close the Product Deactivation and License Tool windows. 

5. To uninstall after deactivating, go to the Start menu > Settings > Control 
Panel > Programs and Features (or the equivalent on your system). 

6. Highlight PC*MILER 29, right-mouse click and select Uninstall. 

7. Click Yes at the prompt to completely remove the application. 

8. Click Finish when the installation process is complete. 

NOTE:  If any messages appear during the uninstall process that say that a 
certain file cannot be removed, click OK to continue.   

 
9. !! IMPORTANT STEP !!  Once the uninstall process is finished, you will 

need to delete the …ALK Technologies\PCMILER29 folder manually to 
completely remove the PC*MILER application from your system.  The 
default location for this folder is C:\ALK Technologies\PCMILER29. 

 
NOTE:  If you deactivated/uninstalled an installation that included 
PC*MILER components that were licensed and added after the initial 
installation, you will need to add those components separately again when you 
reinstall. 

 

2.11  Installation: Frequently Asked Questions 
For FAQs related to problems you may have with the installation of your 
PC*MILER products, please go to www.alk.com/support.   

 

2.12  User Guides, Online Help, and Technical Support 

NOTE: You must have Adobe Acrobat Reader on your computer to properly 
view a PC*MILER product’s user guide.  If you do not have this program 
installed already, a free copy can be downloaded from www.adobe.com.   
 
To make Adobe Reader your default reader, from within the application select the 
Edit menu > Preferences > General and click Select Default PDF Handler.  
Select Adobe Reader from the drop-down, and click Apply then OK to close the 
Preferences dialog. 
 
The PC*MILER User’s Guide can be accessed from within PC*MILER by 
selecting the Help tab > Help Index, by pressing the F1 key, or by clicking a Help 
button in any dialog.   

 
 PC*MILER User’s Guide 40 



 
 

To view the user guide for any PC*MILER product without first opening an 
application, click the Windows Start button > All Programs (or the equivalent 
on your system) > PCMILER 29 > User Guides and select one of the .pdf files 
from the sub-menu. 
 
To search for a keyword or phrase in a user guide, use Adobe Reader’s Find 
option in the Edit menu or on the tool bar.   
 
All user guides can also be accessed at www.pcmiler.com/support. 
 
 

TECHNICAL SUPPORT 
 

ALK Technologies offers one year of free unlimited technical support to all 
registered users of PC*MILER.  See Chapter 15 for contact options. 

 
 
README FILE 

 

Consult the ReadMe file for last-minute product information, updates to the 
PC*MILER documentation, and additional feature information.  To see this file 
after PC*MILER has been installed, click the Windows Start menu > All 
Programs (or the equivalent option) > PCMILER 29 > ReadMe. 
 

2.13  PC*MILER Feature Reference Guide 
Beginning with Version 27, the PC*MILER user interface was updated with a 
new look and feel while retaining the same functionality as in previous versions.  
The new interface features a ribbon style design, a more organized layout for 
smoother navigation, and windows that can be floated outside the PC*MILER 
application to better accommodate your workspace needs.  Users of recent 
versions of  Microsoft® Office 2007 and higher will already be familiar with the 
Ribbon format.  
   
For users of Version 26 and previous versions of PC*MILER who are updating, a 
reference table in PDF format is provided so you can quickly look up the new 
way to access features and options that you are already familiar with.  
  
To access the Feature Reference Guide, click the Windows® Start menu and 
select All Programs (or the equivalent option for your version of Windows) > 
PCMILER 29 > User Guides > Feature Reference Guide.  
 
PDF documents can be searched for a key word – type the word into the Find box 
on the toolbar.  If this box is not visible, select the View menu > Toolbars > Find.  
The drop-down menu off the Find box can be used to refine your search. 
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          Basic Routing 
 
 

3.1  The PC*MILER Application Window 
When you first open PC*MILER, you’ll see an active route window on the left, 
the PC*MILER map window on the right, and a Ribbon toolbar at the top.  The 
Ribbon contains layered toolbars organized in tabs like a set of file folders. When 
you click a tab, the attached toolbar becomes visible.  Users of recent versions of 
Microsoft® Office® and Windows® will already be familiar with the Ribbon 
format.  
 
The options in each toolbar on the Ribbon pertain to tasks that are related to each 
other.  For example, all tools in the Map tab perform tasks related to the map 
window.  In the screenshot below, the Routes toolbar is visible.  

 
 

 

PC*MILER Application Window 
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1 - The File Application Menu.  Click the red File drop-down to open the 
PC*MILER application menu.  This menu can be used to print and save 
maps and reports, change application settings, close all open routes or 
reports, and to exit PC*MILER. 

 
2 - The Ribbon, with the Routes tab selected.  As mentioned above, the 

Ribbon at the top of the application window contains layered toolbars 
organized in tabs like a set of file folders.  The Routes toolbar provides tools 
for entering and editing stops on a route, setting route options, and 
generating routes and reports.  

 
There are six tabs on the PC*MILER Ribbon: Routes, Map, Tools, 
Window, RouteSync, and Help.  The Ribbon can be minimized if needed: 
right-click on it and select Minimize the Ribbon. 
 

 
 
3 - The Routes Window.  This is a floatable pane that houses all the individual 

route windows that you create.  Up to eight routes can be open 
simultaneously inside the Routes window.  Click New Route in the Routes 
tab > General group to open a new route window in which you can enter 
stops and then generate costs, miles and time estimates.  When there’s not 
enough room to display all open routes, a scroll bar appears on the right 
edge of the Routes window that allows access to the hidden routes.    

 
4 - The PC*MILER Map Window.   The PC*MILER map window is a 

versatile, floatable window that provides a graphical representation of 
ALK’s proprietary highway and local street* network.  Each route you run 
is automatically drawn on the map in the indicated color. (This color is 
shown on the left edge of each route window, in the Route legend on the 
map, and on the Ribbon.)  Use this window to compare routes, zoom into 
stops and specific locations, pick stops directly from the map, drag a 
generated route onto new roads, create avoid/favor preferences, and more. 
* Local streets are only available if PC*MILER|Streets is installed.   
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3.2  Using the Quick Access Toolbar 
 
A Quick Access Toolbar is available in the PC*MILER application window.  This 
is a customizable toolbar that allows you to quickly access some of the features on 
the Ribbon that you use frequently, without clicking a tab first.  The toolbar is 
only displayed when at least one button has been added to it. 
 
To place a button on the toolbar, right-click the button and select Add to Quick 
Access Toolbar.  The toolbar will appear in its default location below the Ribbon.   
 
 

 
 
 
To remove a button, right-click it on the Quick Access Toolbar and select Remove 
from Quick Access Toolbar. 
 
 

 
 
 
To put the toolbar above the Ribbon, right-click it and select Show Quick Access 
Toolbar above the Ribbon.  The Quick Access menu also gives you the option to 
minimize the Ribbon to increase the workspace in the application window. 
 

Not all buttons can be placed on the Quick Access Toolbar, only buttons that 
perform an action (e.g. New Route or Options).  Drop-downs (e.g. Save) and 
toggle buttons (e.g. Avoid Roads or Drag Route) can’t be added, but items in a 
drop-down that have an icon can be.  If the Quick Access Toolbar is not available, 
the option will be disabled in the right mouse menu: 
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3.3  Window and Layout Options 
The three panes in the PC*MILER application window – Routes, Map and 
Reports – can be arranged in several different layouts.  Select the Window tab > 
Windows group > Layouts and choose your preferred layout from the options in 
the drop-down menu. Use the Report Location menu to choose a position for the 
Reports window.  The Routes Window and Map Window buttons can be used to 
recover these windows when they have been hidden. 
  
 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Default Layout 

Routes on the Left, Floating Reports Routes on the Right, Bottom Reports 

Routes and Reports, Hidden Map 
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Additionally, these panes can each be manually resized, floated as a separate 
window, or hidden.  Click the down arrow in the window controls and select an 
option.   
 
 

Float Detaches the pane from the main PC*MILER application 
window, so that it can be moved around your screen and 
placed in a convenient position or resized. 

Dock Reverses the “Float” command – the pane will return to its 
previous position inside the PC*MILER application 
window. 

Hide Hides the pane.  Another way to do this is to simply click 
the “X” next to the drop-down arrow.  To reopen, use the 
Window tab > Windows group options. 

 
 

3.4  PC*MILER Shortcut Keys 
 
For those who prefer using a keystroke rather than making a selection with the 
mouse, PC*MILER provides shortcut keys for commonly-used options.  These 
alternate keystrokes are listed below. 
 
KEY(S) FUNCTION  
F1 or F3 Open the PC*MILER User’s Guide for help with a feature. 

F2 Invoke the Custom Place Manager. 

Alt+F2 Invoke the Avoid/Favor Manager. 

Alt+F3 Invoke the Route Options dialog for the active route. 

F4 Generate a Comparison Report. 

F5 Display the Detailed Route Report for the active window. 

F6 Display the State/Country Report. 

F7 Insert a stop above the one highlighted on the stop list. 

F8 Delete the stop that is highlighted on the stop list. 

Alt+F8 Delete all stops in the route window. 

F10 Generate routes and distances (“Run” in the route window). 

Alt+F10 Optimize the stop order for an optimal route. 

Alt+Bkspace Undo typing in any entry field. 

Ctrl+S Save the active route with the existing filename. 
Ctrl+Shift+S Save the active route with a new filename. 
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Ctrl+C Copy the open report to the clipboard for use with another 
 program. 

Ctrl+N Open a new route. 

Shift+↑ Move the highlighted stop up one line on the stop list. 

Shift+↓ Move the highlighted stop down one line on the stop list. 

  
 
3.5  Application Settings    

 
There are several application settings that affect PC*MILER route calculations 
and the information that is displayed.  To open the Application Settings dialog, 
click the red File menu > Application Settings. 
 
 

 
Application Settings Dialog 

 
 
Options in the Application Settings dialog are: 
 
Distances:   
Choose how precise mileage reporting will be.  Options are Tenths, Hundredths, 
or Thousandths.  This option affects all reports that include mileage as well as 
the calculations in route windows. 

Geocoding: 
Provide Pick List – This option is checked by default.  When you enter a stop, it 
provides a pick list of postal codes when there is more than one instance of the 
entered location in the database.  The order in which locations are listed in the 
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pick list is based on such factors as population and geographic centrality, putting 
the most densely populated cities at the top. When this option is not checked, 
PC*MILER will select the first match that is found in the database.   

Postal Code Preference – Use the drop-down to select how PC*MILER handles 
Mexican and U.S. locations that have the same postal code:   

• Use Default US Zip Codes:  The default U.S. ZIP code will be returned. 
Mexican codes cannot be entered. 

• Use Default Mexican Zip Codes:  The default Mexican postal code will be 
returned.  U.S. codes cannot be entered. 

• Use Default US and Mexican Zip Codes:  The default U.S. ZIP code will be 
returned.  However, Mexican codes can be entered with “EM” as the state 
abbreviation; for example, “50510, EM”. 

 
NL Abbreviation – Choose whether to use the state/province abbreviation “NL” 
for Nuevo Leon in Mexico or Newfoundland and Labrador in Canada. 

Country Abbreviation Format – (With PC*MILER|Worldwide or DTOD data 
only)   Select a country code format to use when entering stops in regions outside 
North America. 

Map: 
Show Custom Road Comment Box – Enables the Comment dialog that opens 
each time an avoid/favor road preference is created.  The dialog prompts the user 
to enter an optional comment.  Uncheck this option to disable it  (comments can 
still be entered in the Avoid/Favor Manager). 

Report: 
Show Toll Discount Info – (PC*MILER|Tolls must be installed to generate toll 
costs)  Check to have a breakdown of toll discount programs shown in the 
state/country summary section of the State/Country report.   

Time: 
Time Format – Choose whether times of day should be displayed in AM/PM or 
24 Hours (“military”) format; e.g. 3:20 PM or 15:20. 

Time Zone – Use the drop-down to select how times/dates are reported (local, 
system, or a specific time zone).  This option does not affect how dates/times are 
calculated.  See section 5.1, Route Generation With ETA/ETD. 
 
Fuel Prices: 
Enable Real-Time Fuel Prices – Enables a real-time fuel price feed that pulls in 
current prices at the time interval entered below.  Fuel prices are shown in the 
pick list of matches when the user searches for Fuel Stop POIs in a route window 
– see section 3.10. 
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3.6  Building a Route    
 
To create a new route, you should be in the Routes tab of the Ribbon.  If a blank 
route window is not visible, open a new route window by selecting the Routes tab 
> General group > New Route or Ctrl+N on your keyboard. The elements in a 
new route window are shown below. 
 
 

 
New Route Window 

 
 
1 - Route Name.  By default, each new route is named “Route 1”, “Route 2”, 

etc.  A custom route name can be assigned in the Route Options dialog (see 
section 9.1).  The route name appears in all reports and in the Route legend 
on the PC*MILER map. 

 
2 - Current Route Options.  Current route options are displayed here, under the 

route name. The drop-downs below can be used to change the route type, set 
an arrival or departure time, and enable/disable traffic features.  Additional 
general route options – including the region for PC*MILER|Worldwide or 
DTOD users – can be changed using the Route Options dialog (see section 
9.3). 

 
3 - Color Bar.  Each route displays in a different color on the PC*MILER map.  

A route’s color is shown in this color bar, on the Ribbon, and in the Route 
legend on the map.   

 
4 - Gear Button.  Click the gear button to generate reports, access the Route 

Options dialog, access RouteSync (if installed), and to float, dock or close 
the route window.     

 
5 - More/Less Button.  Use this button to toggle between a fully expanded and 

a minimal view of the route window. 
 

1 

2 
4 5 

6 

7 

3 

8 

5 

 
 Chapter 3:  Basic Routing 49 



 
  

6 -  “Run” Button.  When at least two valid stops are entered for a route, this 
button turns green.  Click it to generate distances, costs, and time estimates. 

 
7 - Stop Entry.  Stops are entered here in the City field.  If PC*MILER|Streets 

is installed, an address can also be entered in the Address field.  Click Add 
Stop or press Enter on your keyboard to validate the stop and add it to the 
stop list for this route. 

 
8 - Stop Type Drop-down.  The stop type defines the type of input that will be 

accepted in the City field.   
   
 

3.6.1  Stop Entry 
 

VERY IMPORTANT For PC*MILER|Worldwide and DTOD Users:  You 
must have the proper region selected in the Route Options dialog when you enter 
stops on a route. See section 3.6.5 on region selection.  Also see section 3.6.7 on 
changing the data set if you are entering local street addresses, and section 10.2 to 
frame the correct region on the map. 
 
To generate distances and driving instructions for a route, you need to specify at 
least two stops – an origin and destination.  An unlimited number of stops may be 
entered.  PC*MILER will always treat the stop at the top of the stop list as the 
origin of the route and the last stop on the list as the destination, unless you are 
generating hub distances (see section 9.3.3).  As you add stops, each one will be 
placed below the previous stop on the list, creating the stop order from origin to 
destination. 
 
To enter a stop, follow these steps: 
 
1. Select the Routes tab > General group > New Route or the Ctrl+N keys. 
 
2. Make a selection in the stop type drop-down. 
 
3. In the City field of the new route window, type a location using any valid 

format (see the list of formats below); a street address can be included in the 
Address field if PC*MILER|Streets is installed. 

 
4. Click Add Stop or press the Enter key on your keyboard. 
 
5. If a pick list of locations appears, highlight your choice and click OK.   
 
6. If the location you entered is valid, the stop will appear above the City field in 

a stop list.  For a stop to be valid, there must be a match in the PC*MILER 
database.  If an error is returned, see section 3.6.25.  To enter an arrival or 
departure time, see Chapter 5.  To set options for a route, see Chapter 9.   
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You can input a city, town or location in any of the formats that are listed below: 
 
• City name, followed by a comma or space and the state abbreviation  

(see section 3.6.2 below).  A street address may be included if PC*MILER|Streets 
data is installed (see section 3.6.4).  Spelling help is available (section 3.6.9). 

• 5-digit ZIP or postal code (section 3.6.10-11).  Postal code help is available. 
• 6-digit Canadian postal code (if the separate add-on data module is installed – 

see section 3.6.12).  Postal code help is available. 
• (North America only)  SPLC (if the separate add-on data module is installed – see 

section 3.6.13 –14).  SPLC help is available. 
• Point on the PC*MILER map – point and click with the mouse (section 3.6.24) 
• Latitude/longitude point (sections 3.6.17-18 and 3.6.24) 
• Custom places, and for U.S./North American locations, border crossings, 

highway junctions, highway exits, truck stops, CAT scale or state weigh 
stations (sections 3.6.15-3.6.22 and 3.16). 

• (North America only)  Point of Interest (POI) – search for POIs from within 
the route window, with a general search or targeting specific types of POI 
such as Fuel Stops or HOS Stops (see sections 3.9-10 ). 

 
TIP on DATA MATCHING:  To confirm that your location data matches the 
PC*MILER database, please see section 3.16.5, Importing Custom Places. 
 
 

3.6.2  City Name and State/Country Abbreviation 
 

To enter a city or town using the city/state format, “Postal Code” should be the 
stop type.  Type the city name and two-letter state/province/country abbreviation 
in the City field, then click Add Stop or press the Enter key on your keyboard.    
The city name can be any length.  The city and state/country do not need to be 
capitalized, but do need to be separated by either a comma or a space.   
 
Examples:   chicago, il     chicago il     paris,fr (PC*MILER|Worldwide or DTOD users only) 
 
 

 

Entering Trenton, NJ as a Stop  
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If the city name contains two or three words, each portion of the city name must 
be separated by spaces. For example: 

 
los angeles, ca 
salt lake city ut 
belle croix,fr (PC*MILER|Worldwide or DTOD users only) 

 
After you click Add Stop, PC*MILER will search through the database for a 
location that matches the city name you entered.  If multiple listings are found in 
the database for the same location, a scrollable pick list will open.  Highlight your 
choice and click OK. 
 
If your entry was valid, a stop list will open above the City field and the stop you 
entered will be displayed along with a time zone:  
 
 

 
Stop List Populated With a Stop  

 
 
If you want to have PC*MILER pick a default match rather than open a pick list 
of multiple postal codes, select the File application menu > Application Settings,  
then uncheck Provide Pick List and click Save.  By default “Provide Pick List” 
is checked and if there is more than one location for a city name, the most densely 
populated city will appear at the top of the pick list, with an alphabetical listing of 
other cities below.   
 
If you are unsure of the correct spelling for a city name, spelling help is available 
– see section 3.6.9.  To look up state/province/country abbreviations, see 
Appendix C in this user’s guide.  
 
If PC*MILER|Worldwide or DTOD data is installed, country abbreviations 
outside North America may be entered using FIPS 2-character, ISO 2-character, 
ISO 3-character, GENC 2-character or GENC 3-character codes.  FIPS codes are 
accepted by default.  To use another format for stop entry, select the File 
application menu > Application Settings.  Choose an option from the Country 
Abbreviation Format drop-down list.  
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3.6.3  Entering Mexican and Canadian Locations 
 

Mexican place names can be entered using a postal code, or a city name plus a 
two-letter abbreviation.  (See Appendix C in this user’s guide for a complete list 
of Mexican estado abbreviations.)  Examples of Mexican locations: 

 
puerto vallarta, ja 
99250 

 
Some Mexican and U.S. locations have the same postal code assigned to them.  
The way PC*MILER handles Mexican versus U.S. postal codes in these cases is 
determined by the setting in the Applications dialog.  (Select the File application 
menu > Application Settings, and use the Postal Code Preference drop-down.)  
Possible options are described below, but note that if Provide Pick List is 
checked below the drop-down, a pick list of Mexican and U.S. locations will 
always open if both are in the database.   
 

• Use Default US Zip Codes:  The default U.S. ZIP code will be returned. 
Mexican codes cannot be entered. 

• Use Default Mexican Zip Codes:  The default Mexican postal code will be 
returned.  U.S. codes cannot be entered. 

• Use Default US and Mexican Zip Codes:  The default U.S. ZIP code will be 
returned.  However, Mexican codes can be entered with “EM” as the state 
abbreviation; for example, “50510, EM”. 

 
Canadian postal codes can be entered only if the separate PC*MILER Canadian 
Postal Codes add-on data module is installed.  With this module installed, a pick 
list of Canadian postal codes will be invoked when a Canadian place name is 
entered that has multiple postal codes assigned to it – provided that Provide Pick 
List is checked in the Application Settings dialog (File application menu > 
Application Settings).  See section 3.6.12 on entering Canadian postal codes.  
 
If the postal code data module is not installed, Canadian place names can only be 
entered using the city name and province abbreviation, for example: 
 

montreal, qc   
 
See Appendix C in this user’s guide for a complete list of Canadian province 
abbreviations.   
 
NOTE:  “NL” is recognized as Newfoundland and Labrador unless this setting 
has been changed to mean Nuevo Leon using the Application Settings dialog (File 
application menu > Application Settings). 
 
NOTE Also:  To enter a location name that includes one or more accented letters 
(for example, Felipe Ángeles, CI), either 1) use the postal code, or 2) use the 
Insert > Symbol option in Microsoft® Word or Excel® to type the location name 
and then copy and paste into the route window in PC*MILER. 
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3.6.4  Address Entry (PC*MILER|Streets only) 
 

(Applies only in countries for which Streets data has been purchased, and the 
correct map data set must be selected – see section 3.6.4)  If PC*MILER|Streets 
address data is purchased and installed with PC*MILER, you can – optionally – 
specify a street-level address in the Address field.  PC*MILER will route to each 
address, and addresses will be labeled on the map when you run your route. 
Addresses can be added to a city/state or postal code entry.  An address can also 
be combined with a latitude/longitude point for more precise geocoding – see 
section 3.6.18.   
 
If, when entering a stop, you enter an address when the “Use Highway Only” 
route option is enabled in the Route Options dialog, a warning that says 
“Highway Only route option enabled” will appear above the stop list.  This 
warning reminds you that a route won’t use local streets unless the highway-only 
option is turned off.  To delete the warning, click the “X” on the far right.  To use 
local streets in routing, select the gear button     > Options, uncheck Use Highway 
Only, then close the Route Options dialog.   

 
 

 
“Highway Only” Warning in a Route Window 

 
To look up synonyms for street type abbreviations that PC*MILER will accept 
(for example, “Blvd” for “Boulevard”), see Appendix D or the synonym.typ file 
located in the PC*MILER installation folder (usually in C:\ALK 
Technologies\PCMILER29\ Data\Info). 
 
In North America, address data is available for the US and Canada. With 
PC*MILER|Worldwide installed, address data is also available in Europe, India, 
and available countries in Africa, the Middle East, Oceania and South America.  
The appropriate data set must be selected – see sections 3.6.6-8 below.   
 
For PC*MILER|Worldwide Users:   In addition to having the correct region and 
data set selected, you may need to frame a different map region – see section 10.2. 
 
NOTE:   The pick list setting in the Application Settings dialog determines how 
PC*MILER handles incomplete or inaccurate street names that are entered in the 
route window.  Select the red Application Menu > Application Settings to see this 
setting.  If Provide Pick List is unchecked, the first approximate match that is 
found in the database (if there is one) will be returned.  When Provide Pick List is 
checked (this is the default setting), a pick list will open and you can choose an 
address from it.  
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TIP:  If you enter a ZIP/postal code and PC*MILER can’t find an address that 
you specify within that code, try expanding your search by entering the city name.  
In general it is recommended that, when entering or importing addresses, you use 
the corresponding city/state instead of the location’s postal code.  (For example, 
enter “457 North Harrison Street, Princeton, NJ” rather than “457 North Harrison 
Street, 08540”.)  Using the city and state/province will increase the geocoding “hit 
rate” and provide a more accurate representation of the address when routing. 
 
 

3.6.5  Changing the Region (PC*MILER|Worldwide and DTOD only) 
 
If the PC*MILER|Worldwide or DTOD data add-on module is installed, the 
correct world region must be selected in the Route Options or Default Route 
Options dialog when entering stops.  In each route entry window, the currently 
selected region is displayed under the route name. To change the region for the 
active trip, select the Routes tab > Route group > Options or click the gear button 
in the route entry window and select Options, then choose a region from the 
Region drop-down in the General tab of the Route Options dialog. 
 
To change the default region for all trips, select the Routes tab > General group > 
Defaults and choose a region as described above.  Now every route entry window 
you open will be set to the region you selected. 
 
If the wrong region is selected (i.e. it does not match the stop you are attempting 
to enter), normally either an error message will appear or your input will be 
matched with a city by the same name in the selected region; for example, if you 
enter “Paris, FR” when your region is North America, “Paris, AR” will be 
returned as a stop.  The currently selected region is always displayed above the 
route name in the route entry window.   
 
However, with PC*MILER’s trans-regional routing, in certain cases the above 
rule does not apply.  Because routing between Europe, Asia, Africa, and the 
Middle East is possible, locations may be entered that do not match the selected 
region when any of these regions are selected.  For example, entering “Paris, FR” 
will return the correct stop if Asia or Africa is the selected region. 
 
You may also need to change the map window to the desired region if you 
wish to see graphic displays of the routes you run.  Select the Map tab > View 
group > Frame > Regions > and choose a region from the sub-menu. 
 
NOTE:  Options are set for each region separately.  PC*MILER remembers 
the options you last used for each region.  When you change regions, all options 
that were previously used for the new region will become active.  To create your 
own custom default settings for each region, select the Routes tab > General 
group > Defaults. 
 

 
 Chapter 3:  Basic Routing 55 



 
  

3.6.6  Changing the Country Format (PC*MILER|Worldwide and DTOD only) 
 
Worldwide country abbreviations may be entered using either FIPS 2-character, 
ISO 2-character, ISO 3-character, GENC 2-character or GENC 3-character codes.   
FIPS codes are accepted by default.  To use another format for stop entry, click 
the File application menu and select Application Settings, then choose an option 
from the Country Abbreviation Format drop-down list.  For a complete list of 
worldwide country abbreviations, see Appendix C. 
 
 

3.6.7  Changing the Data Set 
 
 

 
Change Data Set Menu (with PC*MILER|Worldwide installed) 

 
 
Select the Map tab > Utilities group > Change Data Set > to change the version 
of the map data that PC*MILER uses to calculate routes.  The currently loaded 
data set will be displayed in the title bar of the map window, shown at the bottom 
of each page in any generated reports in Print View, and selected with a 
checkmark in the Change Data Set menu. 
 
For ALK’s Annual Update Program (AUP) Licensed Users:  For PC*MILER 
(North America only), the options in the drop-down will include the base version 
data set plus any mid-year versions that have been released since the base version, 
including PC*MILER|Streets U.S. and Canadian street-level data if installed. 
 
For PC*MILER|Worldwide Users: PC*MILER|Streets data modules are 
available for local street addresses in Canada, the United States, Europe, and 
some countries in Africa, Asia, Middle East, Oceania and South America.  Each 
module may be purchased separately or in combination with other data sets. The 
correct data set must be activated before you enter an address.  When you activate 
a data set, the correct region will automatically select in the Route Options dialog.   
 
Note that Streets data sets in world regions outside North America may not 
include coverage for every country in the region.  Therefore, when such a 
data set is selected, routes can’t be run within or across countries not 
included in the Streets data set.  The Worldwide Highway data set must be used to run 
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routes to/from countries that are not covered in the Streets data set.  For more on worldwide 
data coverage, see Appendix I.   
 
For PC*MILER|Energy Users:  You will see the NA – Streets Canada Energy 
data set in the Change Data Set menu. 
 
 

3.6.8  Pick List Option 
 
By default, when you enter a stop that has multiple listings in the database, a pick 
list of matching locations will open.  The order in which locations are listed in the 
pick list is based on such factors as population and geographic centrality. The 
most densely populated cities that match your entry will be at the top of the pick 
list.   
 
If you want to have PC*MILER pick a default postal code or address rather than 
open a pick list, select the File application menu > Application Settings.  In the 
Application Settings dialog, uncheck Provide Pick List, then click Save.   
 
When “Provide Pick List” is turned off, if a city name has multiple postal codes or 
other database entries, the PC*MILER default match will be the first exact match 
that is found in the database. 
 
 

3.6.9  Spelling Help 
 
If you're not sure how to spell a city name, or if you received an error message 
when entering a city and state abbreviation, try getting spelling help as follows: 
  
 1. In the City field of a route window, type the first letter or first few letters of 

the city name followed by a comma or space and the two-letter state/ 
province/estado abbreviation.  Note that typing more letters of the city name 
(i.e. two or three rather than just one) will decrease the processing time 
needed to create a list of matches. 

 
Examples: chi,il       los ang, ca       pa fr       los a,ca 
 

2. Click Add Stop or press Enter.   
 
3. A pick list of possible matches will open unless this option is turned off in the 

Application Settings dialog (File application menu > Application Settings).  
Scroll the list if necessary and highlight the city or ZIP/Postal code that you 
wish to select, then click OK. 
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Pick List of Matches for Spelling Help 
 
 

3.6.10  Entering ZIP/Postal Codes 
 

IMPORTANT NOTES for PC*MILER|Worldwide and DTOD USERS:  
When you are entering postal codes outside of North America, you need to enter a 
country abbreviation to avoid being routed to the wrong country in cases where the 
same postal code exists in more than one country. 
   
Enter the postal code, a comma, and the correct two-letter country abbreviation; e.g. 
“46001, sp” for Valencia, Spain.  Remember that the correct region must be 
selected in the Route Options dialog (see section 9.3.1).  Not all countries have 
postal codes in the database.  Users can import absent postal codes as custom places 
if needed.  For the format of postal codes in PC*MILER|Worldwide regions and 
various countries in those regions, see Appendix H. 

 
Entering any valid postal code creates a search for the corresponding city. The 
city name will be entered as a stop, along with the state abbreviation and postal 
code.  If you enter 08540 (NA region), PC*MILER will return:  08540 Princeton, 
NJ, Mercer. 
 
NOTE:  If the +4 ZIP code designation is entered, PC*MILER will ignore it. 

 
 

3.6.11  ZIP/Postal Code Help 
 

If you’re unsure of a particular postal code or if you receive an error message 
when entering a postal code, do the following:  
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1. In the City field of a route window, type at least the first two digits of the 
postal code.  For postal codes outside North America, enter a country code as 
well.  Examples: 60 or 606 fr. 

 
2. Click Add Stop or press Enter.   

3. A pick list of all matching codes will be returned unless this option is turned 
off in the Application Settings dialog (File application menu > Application 
Settings > Provide Pick List).  Scroll the list if necessary and highlight the city 
or ZIP/postal code that you wish to select, then click OK. 

 
 

 
 

Pick List of Matches for “606 fr” Entry 
(with PC*MILER|Worldwide licensed and installed) 

 
 

3.6.12  Canadian Postal Codes 
 

If the Canadian Postal Code add-on data module is installed, six-digit Canadian 
postal codes can be entered as stops.  The codes are always alphanumeric in the 
format “ANA NAN” where “A” represents an alphabetic character and “N” 
represents a numeric character.   
 
Entering any valid Canadian postal code will invoke a search for the 
corresponding city and province name, and these will be entered as a stop along 
with the postal code.  
 
If you enter: K7L 4E7     PC*MILER will return: K7L 4E7 Kingston, ON 
 
For help with Canadian postal codes, you need to enter at least 3 digits. 
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Canadian Postal Code Help 

 
 

3.6.13  SPLC Entry (North America only) 
 

If the SPLC add-on data module is installed, a SPLC can be entered as a stop for 
any location in North America that has a SPLC assigned to it.  SPLCs may be six or 
nine digits in length.  SPLC data used in PC*MILER products is owned, 
maintained and copyrighted by the National Motor Freight Traffic Association, Inc. 
To enter a SPLC, do the following: 
 
1.  Select “SPLC” from the drop-down list to the left of the City field. 
 
2. Type your entry and click Add Stop or press Enter.   
 
NOTE:  If you enter a SPLC when “SPLC” has not been selected in the drop-
down list, you’ll get an error message.  When “SPLC” is selected, you won’t be 
able to enter other types of locations. 
 
 

3.6.14  SPLC Help 
 

If you need help finding the correct SPLC for a particular location, a pick list of 
SPLC can be invoked.  First make sure that “SPLC” is selected in the drop-
down to the left of the City field, then type at least the first two digits of the SPLC 
and click Add Stop.   
 
A pick list will be generated unless this option is turned off in the Application 
Settings dialog (File application menu > Application Settings).   
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SPLC Help 

 
3.6.15  Border Crossings (U.S. only) 

 
You can enter a U.S. state border crossing as a stop on a route using the 
PC*MILER border crossing naming convention.  To quickly locate all possible 
border crossings between two states, use the [*] wildcard character.  For example, 
for a pick list of all Pennsylvania/New Jersey border crossings, enter: 

!njpa*, nj 
 
 

 
 

Pick List of NJ/PA Border Crossings 
 
 

NOTE:  A pick list will only be generated if Provide Pick List is checked in the 
Application Settings dialog (File application menu > Application Settings).  By 
default, this setting is turned on. 
 
Border crossings have the following syntax: 
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!XXYY  Name,  XX 
 
where XX is the two-letter abbreviation of the state that is first in alphabetical 
order, YY is the abbreviation of the state that is second in alphabetical order, and 
Name is the route name of the route that crosses the border. 

 
In cases where the road name is different on either side of the border, the road 
name used is the one that lies within the state first in alphabetical order. 

 
 

3.6.16  Highway Junctions (North America only) 
 
PC*MILER allows you to access highway junctions between major road types in 
the United States, Canada, and Mexico.  (Note, however, that there are some 
highway junctions which are truck-inaccessible.  These junctions will not be 
recognized as stops.)  The best way to enter a highway junction is to invoke a pick 
list of matches. Type “+” (a plus sign) followed by a comma and the state 
abbreviation.  For example, enter 
 

+, in 
 

to generate an alphabetical list of all highway junctions in Indiana.  Scroll the pick 
list, highlight your choice, and click OK. 

 
 

 
 

Pick List of Highway Junctions in Indiana 
 

 
NOTE:  A pick list will only be generated if Provide Pick List is checked in the 
Application Settings dialog (File application menu > Application Settings).  By 
default, this setting is turned on. 
 
The format for junction names is as follows: the first route name is the lower 
numbered one, the second route name is the higher numbered one, and the route 
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names are followed by the abbreviation of the state in which the junction is 
located.  An example of this is: 

+I 469  IN 37, IN 
 

In cases where two junctions by the same highway pair occur within the same 
state, the junctions are designated by a location direction (N,S,E,W) relative to the 
location of the other junction.  For example: 
 
+US231 IN 66W, IN  is located one mile west of  +US231 IN 66E, IN 

 
 

3.6.17  Latitude/Longitude Points 
 
There are several ways to enter latitude/longitude points as stops on a route in 
PC*MILER.  Stops that are lat/longs are labeled in the map window just like 
other stops. 
   
Lat/longs can easily be entered using the map.  When you pass your cursor over 
the map without pressing the mouse button, its latitude/longitude position is 
automatically tracked and appears in the status bar in the lower left corner of the 
map window.  With the lat/long you want to enter displayed in the status bar, right 
click the map and choose Copy Latitude/Longitude from the menu, then click in a 
route window’s city field and paste (Ctrl-V or Paste in the right mouse menu).  
Note that it’s easier to copy lat/longs accurately at higher zoom levels.  
 
 
 
 
 
 
 
 
 
 
 
 

 
 

                                                         Lat/Long Point as a Destination on the Map 
                                                   

 
 
Lat/longs can also be entered from the map using Pick Stops mode.  To turn this 
mode on, select the Routes tab > Route group > Pick Stop on Map button or right 
click the map and select Pick Stops, then click on the point you want to enter.    
 
Additionally, latitude/longitude points can be entered manually or imported (see 
section 3.16.5 on importing) in degrees minutes seconds direction format (e.g. 

Right Mouse Menu  
Off the PC*MILER Map 
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0401750N,0742131W) or decimal degrees (e.g. 40.123N,100.333W) – see the 
instructions at the end of this section on formatting.   
 
Degrees-minutes-seconds format: 
In degrees-minutes-seconds format the latitude and longitude are each 8-character 
strings in the following format: 

 

Characters 1-3  specify the degrees (be sure to include  leading zero if required) 
Characters 4-5  specify the minutes 
Characters 6-7 specify the seconds 
Character   8   N, n, W, or w, with N’s for latitude and W’s for longitude  

Latitude and longitude must be separated by a comma WITHOUT A SPACE.  In 
general the format for a point is:   dddmmssN,dddmmssW. 
 
Decimal degrees format: 
In decimal degrees format, latitude and longitude are strings of up to 8 characters 
representing a decimal number with up to 3 decimal places. No leading zeros are 
required. The decimal point counts as one of the characters. Latitude and longitude 
must be separated by a comma WITHOUT A SPACE. In general the format for a 
point is:   dddd.dddN,dddd.dddW. 
 
Converting between formats: 
To convert from degrees-minutes-seconds to decimal degrees use the following 
formula:   dddmmssN → ddd + mm/60 + ss/3600. 
 
Decimal degrees format: 
In decimal degrees format, latitude and longitude are strings of up to 8 characters 
representing a decimal number with up to 3 decimal places. No leading zeros are 
required. The decimal point counts as one of the characters. Latitude and longitude 
must be separated by a comma WITHOUT A SPACE.  In general the format for a 
point is:   dddd.dddN,dddd.dddW. 
 
 

3.6.18  Latitude/Longitude With Street Address 
 
For more precise geocoding and directions, latitude/longitude points can be 
combined with street addresses as in the example shown below. This functionality 
geocodes the lat/long to the nearest point on the particular street in the address, 
rather than to the nearest street in the direction of travel, as would be the case for 
a lat/long by itself.  If the lat/long is more than .5 miles from the street in the 
address, an error message will be returned.  
The minimum input when using this combination should include the lat/long plus 
a street name.  Including a street address will provide more precise geocoding. 
 
NOTE:  “Use Highway Only” must be turned off in the Route Options dialog in 
order to geocode to a street that only exists in the street-level network.   
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Stop Entry Using a Latitude/Longitude With an Address 

 
 

 
 

 
 

 
 

3.6.19  Truck Stop Locations (U.S. and Canada only)  
 
Truck stops can be entered as stops on a route like other places in the PC*MILER 
database.  The syntax for a truck stop starts with an "at" symbol [@], then the 
truck stop name, and the state or province in which the truck stop is located.   

 
You can search for truck stops within a radius or along a route using the POI 
search tool in a route window – see section 3.9.   
 
To generate a pick list of truck stops in a particular state, use the [@] symbol, a 
comma, and the state/province abbreviation.  For example, for truck stops in 
Georgia you would enter: 
 

@, ga 
Or to speed up a search for a known truck stop, use the first letter of the truck 
stop's name.  For example, to generate a pick list of all truck stops in Georgia 
beginning with the letter "C" that are in the PC*MILER database, enter: 
 

@c*, ga 
 

Kuser Road Lat/Long and Address on the Map –  
Routes to a Point Off Kuser Road (Route 619) 
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NOTE:  A pick list will only be generated if Provide Pick List is checked in the 
Application Settings dialog (File application menu > Application Settings).  By 
default, this setting is turned on. 
 
Truck stops are represented on the map by gas pump icons.  

 
 

 
 

Pick List of Truck Stops in Georgia 
 
 

3.6.20  Highway Exits (U.S. only)   
 
PC*MILER includes all Interstate-to-Interstate exit numbers.  It also includes all 
Interstate exits leading to non-Interstate highways.  You can search for highway 
exits within a radius or along a route using the POI search tool in a route window 
– see section 3.9.   
 
To generate a pick list of highway exits in a particular state, enter “^” (Shift-6) 
followed by a comma and state abbreviation to bring up a pick list of all highway 
exits in that state.  For example, to create a pick list of all exits in New Jersey, 
enter: 
 

^, nj 
 

You can also enter an exit directly.  For example, you could type “^I 80 E x273, 
pa” to enter Exit 273 off Interstate 80 East in Pennsylvania.  No spaces are 
necessary, but the east/west designation must be included.  For example, valid 
entries would be: 
 
^I-90 w x35, ny  
^I 90w x35, ny 
^I-90wx35, ny 
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NOTE:  A pick list will only be generated if Provide Pick List is checked in the 
Application Settings dialog (File application menu > Application Settings).  By 
default, this setting is turned on. 
 
 

 
 

Pick List of Highway Exits in New Jersey 
 
 
 

3.6.21  CAT Scale Weigh Stations (U.S. and Canada only) 
 
CAT Scale weigh station locations may be entered as stops on a route.  To enter a 
weigh station, you can type its location in the City field preceded by a pound sign 
(#).  An example is: 

 
#Petro Stopping Center, NJ 

 
To bring up a pick list of all CAT weigh stations in a particular state, enter a 
pound sign followed by a comma and the state abbreviation. For example: 
 

#, nj 
 

To find CAT weigh stations within a specified radius of a location or along a 
route, use the POI search tool (see section 3.9).  CAT Scale weigh stations are 
represented on the map by a cat icon.   
 

 

NOTE:  A pick list will only be generated if Provide Pick List is checked in the 
Application Settings dialog (File application menu > Application Settings).  By 
default, this setting is turned on. 
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Pick List of CAT Weigh Stations in New York 

 
 

 
3.6.22  State Weigh Stations (U.S. only) 

 
You can also search for and enter state weigh stations as stops.  You can search 
for state weigh stations within a radius or along a route using the POI search tool 
in a route window – see section 3.9.  To search for all weigh stations in a 
particular state, use a dollar sign ($).   For example: 
 

$, nj 
 
will bring up a pick list of all state weigh stations in New Jersey.   
 
 

 
Pick List of State Weigh Stations in New Jersey 

 
 

NOTE:  A pick list will only be generated if Provide Pick List is checked in the 
Application Settings dialog (File application menu > Application Settings).  By 
default, this setting is turned on. 
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3.6.23  Entering An Arrival or Departure Time 
 
The ability to generate more precise estimated times of arrival/departure is a feature 
added in Version 25 of PC*MILER, and is described in Chapter 5, Time-Based 
Routing.  See section 5.1 for detailed instructions about how to enter a departure or 
arrival time and date or day of the week.  
 
 

3.6.24  Picking Stops From the Map 
 

TIP:  Pass your cursor over the map without pressing the mouse button.  Notice 
that its lat/long position is automatically tracked and appears in the status bar in 
the lower left corner of the map window.  

 
Stops can be entered directly from the PC*MILER map window by pointing and 
clicking with the mouse.  To pick a stop, do the following: 
 
1. Select the Routes tab > Route group > Stops > Pick Stop on Map button; or 

select Pick Stops from the right mouse menu off the map.   

2. In the map window, the cursor will now be in the shape of a hand.  Use the 
mouse to point to the location you wish to enter and click once.  The location 
will be entered as a stop in the currently active route window. 

3. Alternatively, use the right mouse menu in the map window to select Copy 
Latitude/Longitude to copy the lat/long displayed in the status bar of the map 
window, then paste into the city field of a route window as a stop (Ctrl-V or 
right click > Paste). Note that it’s easier to copy a lat/long accurately at higher 
zoom levels.  

 
You can use the mouse to select any point on the map.  If the point is a node on a 
highway, the place name will be returned; otherwise, a latitude/longitude position 
will be returned.  
 
NOTE:  There are some highway junctions which are truck-inaccessible.  These 
junctions won’t be recognized if you try to enter them as stops.  

 
 

3.6.25  Input Errors 
 
One of several error messages might be returned when entering stops.  The most  
common one is “No matching city found”.  If you encounter an error message, 
you should try the following:  

 

• Double-check that you separated the city name and state abbreviation with 
a comma or space. 
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• Double-check for typos and spelling errors. 
• Make sure that the stop type matches your input.  If entering a SPLC, 

make sure that “SPLC” is selected in the drop-down list to the left of the 
City field.  

• Get spelling help (see section 3.6.9). 
• Use the exact postal code or get ZIP/postal code help (see section 3.6.11). 
• See Appendix C for a list of valid state/province/estado abbreviations. 

 
In all cases, the ZIP/postal code takes precedence over the city and 
state/province/estado name.  Certain suburbs or small towns may not have their 
actual names in the database, but rather the name of the larger nearby city.  In 
these cases, the ZIP or postal code for the smaller community will have to be 
entered to achieve correct results.  
 
Also see section 3.6.9 for a description of how a default location is selected when 
duplicate or multiple cities exist in the database. 
 
 

3.6.26  Duplicate City Names and County Designations 
 
In the PC*MILER database, there are several thousand instances of towns in the 
same state, province or estado that share the same name.  For example, in the U.S. 
state of Pennsylvania, there are two towns named Hamlin: one in Wayne County 
and one in Lebanon County.  Another example is the towns of Londonderry in the 
United Kingdom: one is in Londonderry and one is in North Yorkshire.  
 
In certain circumstances, duplicates can be separately identified by means of their 
differing postal codes.  However, some duplicate towns do not have postal codes 
assigned to them.  You can identify your desired stop by the county listing in the 
town name.  In the database, the county name follows the state abbreviation (e.g. 
Hamlin, PA, Wayne).  It appears in the route window after a stop has been 
entered, in small letters after the city name and state abbreviation. 
 
If you are not sure which city is the stop you want, first click the File application 
menu > Application Settings and make sure that Provide Pick List is checked.  
Then enter the city name and state/province/estado abbreviation.  When you click 
Add Stop, a pick list will provide all the possible choices in the database along 
with county names.  The order in which locations are listed in the pick list is 
based on such factors as population and geographic centrality. The most densely 
populated cities that match your entry will be at the top of the pick list.  Select the 
correct city from the pick list and click OK to enter it as a stop. 
 
If you know the county in which the duplicate city is located, you can enter that 
exact city in the stop entry field.  Do so by entering the city and state in a normal 
fashion, followed by a comma and the county name.  Your entry must be in one of 
the following formats: 
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hamlin, pa, wayne hamlin,pa, wayne 
hamlin, pa,wayne hamlin,pa,wayne 
 

TIP:  Another way to see the county name: in the PC*MILER map window, 
place your cursor over a town without clicking – the full name of the town, with 
its county, will appear in a tooltip. 
 
In Canada, duplicate city names are found in the same provinces.  PC*MILER 
identifies the town by assigning a county to it in the same way that the county 
name follows a U.S. city name.  For a list of Canadian counties in the PC*MILER 
database, see Appendix B. 
 
 

3.6.27  Editing the Stop List 
 
All options related to editing the stop list are found in the Routes tab > Route 
group, under Stops.  Alternatively, several editing options are available in a right 
mouse menu off any stop name on the list.  Here are all the editing options in the 
Routes tab, with the right mouse menu option noted where available: 
 
 

Editing Option Button/Shortcut Option Description 

Add Stop at End  

Type a location in the location entry fields 
and click this button to add the stop at the 
end of the stop list. 

Insert Stop Above    F7 

Click to insert a stop above the highlighted 
stop; or right mouse click on the 
highlighted stop and choose Insert Above 
from the menu. 

Edit Stop  

Click to edit the highlighted stop, or right 
mouse click on the highlighted stop name 
and choose Edit from the menu. When done 
editing, click Add Stop to add the edited 
stop back to the same position on the list. 

Delete Stop    F8 

Click to delete the highlighted stop; or right 
mouse click the stop name and choose 
Remove from the menu. 

Delete All Stops    Alt+F8 
Click to delete all stops from the currently 
active route window. 

Frame Stop on Map  

Click to frame the highlighted stop on the 
map; or right mouse click on the stop name 
and choose Zoom to Stop from the menu. 

Pick Stop on Map  
Click to activate this option. Then pick a 
stop from the map: in the map window zoom 
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in to the target location, point the cursor to a 
town, address, intersection, or lat/long on the 
map, then click to add this place as a stop. 

Move Stop Up    Shift+↑ 

Move the highlighted stop up on the list, or 
right mouse click on the stop name and 
choose Move Up. 

Move Stop Down    Shift+↓ 

Move the highlighted stop down on the list, 
or right mouse click on the stop name and 
choose Move Down. 

Reverse Stops  
Click to reverse the order of stops in the 
currently active route window. 

 
 

3.6.28  Dragging and Copying Stops 
 
A geocoded stop can be copied or moved from one route window to another, or 
dragged to a different position in the same window.      
 
To copy a stop to another route window, left click the stop name while holding 
down the Ctrl key and drag it onto the stop list in the target window, letting go 
when the stop is in the desired position on the list.  The geocoded stop will be 
copied but also remains in its original window.   
 
To move a stop either to another position on the list of stops or to a different route 
window, left click the stop name and drag to the desired position.  If placed in 
another window, the stop will be deleted from the original window. 
 

 

 
Moving a Stop to the Route 2 Window 

 
 
To move or copy a stop using the right mouse menu, right click the stop name and 
select either Move to > or Copy to > from the menu.  Select a target window 
from the list of all open windows in the sub-menu.  The stop will be placed at the 
bottom of the stop list in the target window.  
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NOTE:  Waypoints can be copied or moved just like stops.  However, if a 
waypoint is moved to the Origin or Destination position on the stop list, it will 
become a stop rather than a waypoint. 
 
 

3.6.29  Frame a Location On the Map     
 
To zoom directly to a specific location on the PC*MILER map, first enter the 
location as a stop in the route window and make sure it is highlighted on the stop 
list.  Then you can either 1) double-click the stop name; 2) right mouse click on 
the stop name and select Zoom to Stop from the menu; 3) select the Routes tab > 
Route group > Frame button; or 4) select Zoom to Stop from the right mouse 
menu in the map window. 

 
NOTE:  If PC*MILER|Streets data is installed and you're trying to find an 
address, you can place your cursor, without clicking, on any road segment on the 
map to see a tooltip containing the street name and address range of that segment.  

 
TIP:  Pass your cursor over the map without pressing the mouse button.  Notice 
that its latitude/longitude position is automatically tracked and appears in the 
status bar in the lower left corner of the map window. 

 
 

 
 

Zoomed Into a Stop in Indiana 
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3.6.30  Reversing the Order of Stops 
 
To reverse the order of all stops on the stop list, select the Routes tab > Route 
group > Reverse Stops.   
 
This option is especially useful when used with the route optimization feature (see 
section 3.7).  For example, you might need to make multiple pickups and you 
want to start at the farthest one on the route and end up at some other location for 
delivery.  Enter the delivery location first, then enter your pickup points.  Next, 
optimize your route keeping the first and last stops the same.  After optimizing, 
reverse the order of stops.  This will put your farthest pickup point first on the list, 
and your delivery point last, with an efficient route in between. 
 

3.7  Route Optimization 

PC*MILER can optimize the order of stops in the active route window to 
minimize the total time (when using Practical routing), the total distance (when 
using Shortest routing), total toll distance (when using Toll Discouraged routing), 
and distance of the National Network (when using the National Network or 53-
Foot Trailer routing).  Optimizing a route provides the optimal order of stops, 
keeping the origin the same (or optionally, keeping both the origin and destination 
the same).    
 
Optimization cannot be undone.  The original order of stops cannot be 
recovered, so you may want to save the original route before optimizing (see 
section 3.15).  
  
To optimize a route, select the Routes tab > Route group > Optimize > Optimize 
Stops from the drop-down list or press Alt+F10 on your keyboard to bring up the 
Optimize Route dialog: 
 
 

 
 

Optimize Route Dialog 
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This dialog gives you the following options: 
 

• Route Through All: Stops will be optimized in any order, with only the 
origin remaining fixed. 

• Destination Fixed:  Keeps the origin and destination the same. 

• Run route after optimizing stops: Automatically generates the route when 
optimization is finished. 

 
NOTE:  You need at least three stops to optimize with Route Through All and 
four stops using Destination Fixed. 
 

3.8  Location Radius 
PC*MILER includes a Location Radius search tool for easier rate determination 
and trip planning.  This tool enables you to find all cities and/or postal codes 
within a specified radius around any location.  To search for POIs, including 
custom places, see section 3.9 below on searches from the route window.  
 
To use the Location Radius feature, select the Routes tab > Route group > 
Location Radius then follow the steps below. 
 

 
Postal Codes Within 10 Miles of Ames, IA 

 
 

1. Enter a location in the City field.  The location can be a city/state, postal code, 
latitude/longitude, or custom place.  If PC*MILER|Streets is installed, an 
address can also be entered.   
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2. Use the check boxes to select which types of places to include in your search: 
Cities, Postal Codes, or both. 

3. Enter a Radius (a number of miles or kilometers, depending on the unit of 
distance setting in the Route Options dialog, General tab). 

4. Click Find to search.  The list below will be populated with the search results. 

You can select one, several, or all matching places to add as stops to the active 
trip, plot on the map, or save to a text file.  Highlight the one(s) you wish to select 
– hold down the Shift or Ctrl key to pick multiple places. To select all places, 
highlight the first place on the list, then hold down the Shift key and highlight the 
last place, scrolling down if necessary.   
 
To add the selected places as stops in the active route window, click Add Stops.  
To save them to a text file, click Save.  To plot the selected points on the map, 
click Plot Points.  The plotted points will appear as small red squares. 
 
To copy the selected points to the Windows clipboard for pasting into another 
application, highlight your selection and press Ctrl+C on your keyboard. 

  
To clear points from the picklist, click Clear.  Plotted points will remain on the 
map until another set of points is plotted or the Location Radius window is closed. 
 
NOTE:  The maximum number of matching places that can be displayed after 
you execute the search is 15,000.  In some cases you may need to specify a 
smaller radius to get a complete list of matches.   
 

3.9  POI Search Along a Route or Within a Radius (U.S. & Canada only) 
(PC*MILER|Streets must be licensed and installed, and the Streets routing option 
must be enabled to search along a route.)  PC*MILER enables you to execute a 
search for POIs and custom places in the United States and Canada from a route 
window, either within a specified radius around a location or along a corridor on a 
route.  Optionally, the search can target specific POI categories and can include a 
key word to look for.  Categories include truck stops and services, parking and 
rest areas, intermodal ramps, highway exits, airports, schools and facilities, 
hotels/motels, and emergency/medical. 
 

Searching Within a Radius Around a Location 
 
To search for POIs within a radius of a location, follow these steps: 

 
1. In a route window, select Place of Interest from the stop type drop-down. 

You can do this either before or after stops have been entered.   To insert a 
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POI above an existing stop, right-click that stop and choose Insert Stop Above, 
then select Place of Interest from the stop type drop-down.   

 
 
 
 
 
 
 
 
 
 
 

Beginning a POI Search in the Route Window 
 
 

2. In the City field, if no stops have been entered you must specify a location 
around which to search.  If one or more stops have been entered and you don’t 
specify a location, PC*MILER will search around the previous stop.   

3. (Optional)   To narrow the search, enter a word or name to search for in the 
Name field.   For example, you could enter “inn” and all POIs with a name 
that includes “inn” will be found. 

4. In the Search within field, enter a number of Miles to specify a radius.  The 
default here is 5.0 miles. 

5. (Optional)   In the categories drop-down, uncheck the POI categories that you 
don’t want to include in the search.  To clear the list of check marks, you can 
uncheck Show All Categories and then check the ones you want. 
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6. Click Search.  A pick list of POIs will be created and displayed on the map.   

 

 

                   
 
 

 
7. To zoom to any POI on the map, just highlight it on the pick list.  Click OK to 

enter the selected POI as a stop.   
 

 
 
 

8. The POI you select will be entered as a stop.  It can be edited, deleted or 
moved like any other stop on the trip.   

 

 
POI Found and Added to the Stop List 
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Searching for POIs Along a Route 

To search for POIs along a trip leg between two stops, the steps are similar to the 
above but with a few modifications.  A route must be generated before the search. 

 
1. First enter and run a route. 

2. Right-click a stop on the route and choose Insert Stop Above. The stop type 
drop-down will be inserted above the stop. 

3. Select Place of Interest from the stop type drop-down. 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Beginning a POI Search in the Route Window 
 
 

4. Select along the route from the Search drop-down.  The City, Name and 
Search within fields will be disabled when you select this option. 

 
 

5. (Optional)   In the categories drop-down, uncheck the POI categories that you 
don’t want to include in the search.  To clear the list of check marks, 
uncheck Show All Categories and then check the ones you want. 
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6. Click Search to create a pick list of POIs and to see them along the route on 
the map.   

 

 
 
 
 
 
 
 
 
 
 
 

 

 
                  

 
7. To see any POI on the map, just highlight it on the pick list.  To enter a POI 

from the pick list as a stop, select it and click OK or simply double-click it 
(click Cancel to close the list without making a selection).   

 

 
 
 

8. The POI you select as a stop can be edited, deleted or moved within the route 
window like any other stop on the trip.   
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POI Found and Added to the Stop List 

 

3.10  Searching for Fuel Stops and Fuel Prices (U.S. & Canada only) 
(PC*MILER|Streets must be licensed and installed and the Streets routing option 
must be enabled.  An internet connection is required to access updated fuel 
prices.)  PC*MILER enables users to search for fuel stops along a route and real-
time fuel prices where available at major providers in the U.S. and Canada.  If you 
have an active internet connection, you can enable an automatic fuel price feed at 
customized intervals using the Application Settings dialog  (File menu > 
Application Settings) – this setting is enabled with a 60-minute interval by default. 
 
NOTE:  Fuel prices for stops in Canada are priced in Canadian dollars per liter.   

NOTE Also:  A fuel price of $0.00 on the pick list means that current price data 
is not available.  

 

 
Fuel Prices Enabled in the Application Settings Dialog 
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To search for fuel stops and prices, a route must be generated first and you must 
insert a stop above one of the stops on the route.  Follow the steps below:  

 
1. Enter stops and generate a route.   

2. Insert a stop above one of the stops on the route (press the F7 key or right-
click the stop and choose Insert Stop Above).   

3. Select Fuel Stop from the stop type drop-down. 

4. Enter a Distance from the previous stop.  PC*MILER will search along the 
route from this point until the next stop. 

 

5. (Optional)   To narrow the search, in the categories drop-down uncheck any 
categories that you don’t want to include.  To clear the check marks, uncheck 
Show All Fuel Stops and then check the ones you want. 

 
6. Click Search to create a pick list of fuel stops with fuel prices where 

available.   Amenities at each stop are shown in the pick list, along with the 
distance from the origin of the trip segment.  Fuel stops will be plotted on the 
map as well.  To zoom to a stop, highlight it on the pick list.  To apply a 
location on the pick list as a stop, highlight it and click OK. 

 
NOTE:  Fuel prices won’t be displayed if all the values in the results pick list 
are $0.00. 

 
 
 
 
 
 
 
 
 
 
 
 

 
Results of a Fuel Stop Search 
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3.11  Hours of Service (HOS) Management (U.S. only) 

NOTE:  PC*MILER|Streets must be licensed and installed to use the HOS 
Manager.  And though not required, a PC*MILER|Traffic license can 
significantly enhance reported travel times and the timing of applicable driver 
breaks and rest stops. 

 
NOTE Also:  When one or more HOS-enabled routes are open, Drag Route mode 
is not available for any route until the HOS route(s) are closed. 

 
(PC*MILER|Streets must be licensed and installed, and U.S. Streets routing must 
be enabled.)  Beginning in Version 29, PC*MILER’s HOS Manager provides 
users with the option to incorporate the requirements of the U.S. Federal Hours of 
Service (HOS) regulations into route calculations.  Users can enter the driver’s 
available remaining hours of service and, optionally, expected stop times at each 
stop along a route.   
 
When the route is generated, PC*MILER then inserts rest stops along the route at 
time intervals that meet the HOS requirements.  Users also have the option to 
enter stop times without enabling HOS breaks (this functionality replaces the 
Route Options dialog > Stops tab in previous versions). 
 
The rest stop locations that PC*MILER selects can be customized as needed.  
When you choose to edit a rest stop, PC*MILER will search for alternate rest 
stops/fuel stops, backtracking along the route within a time window of about one 
hour.  This logic avoids a possible violation of HOS regulations, due to traffic or 
other unforeseen conditions, if the driver were to continue moving forward on the 
route past the time when a rest stop is due. 
 
 

 
HOS Manager Access From the Routes Tab 
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The table below summarizes the U.S. government’s Hours of Service regulations 
that have been incorporated into PC*MILER’s HOS functionality: 
 

 

Hours of Service Rules (HOS) for 
Property Carrying Drivers in the U.S. – 

PC*MILER 29 

11-Hour Driving 
Limit 

May drive a maximum of 11 hours 
after 10 consecutive hours off-duty. 

14-Hour Limit 

May not drive beyond the 14th 
consecutive hour after coming on 
duty, following 10 consecutive hours 
off-duty.  
 
Off-duty time does not extend the 
14-hour period. 

Rest Breaks 

May drive only if 8 hours or less 
have passed since end of driver’s last 
off-duty or sleeper berth period of at 
least 30 minutes.  
 
Does not apply to drivers using 
either of the short-haul exceptions 
in 395.1(e). 
 
[49 CFR 397.5 mandatory “in 
attendance” time may be included in 
break if no other duties performed] 

 
 
A summary of Federal HOS regulations can be found on the following web page: 
https://cms.fmcsa.dot.gov/regulations/hours-service/summary-hours-service-regulations. 
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To generate a route that includes HOS stops, follow the steps below: 
 
1. First enter and run a route with all the route options set the way you want 

them.  (If a route is run using the HOS Manager, and then the route options 
are changed, you will need to enter all your HOS options again and re-run the 
route.) 

2. Select the Routes tab > Route group > HOS Manager.  
 
 

 
HOS Manager  

 
3. In the HOS Manager, check Insert HOS Driver Breaks. 

4. Enter the driver’s driving hours remaining until he/she needs to take a 30-
minute rest break and 10-hour end-of-work-day break in the boxes under 
Available Driving Hours at Origin. 

5. Enter the driver’s duty hours remaining until he/she needs to take a 10-hour 
end-of-work-day break under Available Duty Hours at Origin. 

6. (Optional)   To enter stop information, check Include Stop Duration and then 
enter one or more of the settings to the right: a number of hours next to the 
stop (Stop Duration) in hh.hh format (e.g. “1.25” would equal 1 hour and 15 
minutes); whether the duration of the stop is on duty time (Status); and the 
stop Type (Pickup, Dropoff, RestStop or FuelStop).  Stop durations affect 
the time estimates used in route calculations.  (This option can be used with or 
without enabling HOS breaks.  Stop durations are reported and counted 
towards the total trip time in the Detailed and Driver’s reports.  In the route 
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window, if an arrival or departure time was entered, the ETA/ETD column 
accounts for stop times but the estimated drive time column does not.)   

7. Click Save to save your entries and begin HOS route calculations. 

8. In the route window after processing is finished, you’ll see the rest stops that 
PC*MILER inserted into the trip.  All stops will be numbered in order, with 
the rest stops numbered in a different color than the stops you entered 
manually. 

 

 
Route with HOS Rest Stops Inserted 

 

9. Now you have the option to either Accept each inserted stop, or Change it to 
an alternate rest stop.  If you click “Accept” next to all the inserted stops, the 
route does not need to be rerun. 

10. Click Change next to any stop to initiate a search for an alternate rest stop.  
You’ll be given the option to narrow down the search.  In the drop-down on 
the left, choose Fuel Stop, HOS Stop, or Places of Interest as the type of 
stop.  The options in the drop-down on the right will reflect the stop type and 
enable you to narrow the search further.   
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11. Click Search to generate a pick list of alternate stops along this route segment.  
The pick list will include columns that show amenities where available, the 
time and distance from the origin of the trip, and a fuel price where price data 
is available.  (Fuel prices require an internet connection.  If a fuel price is listed 
as $0.00, it is because the current price data is not available.)   

 

NOTE:  To delete the HOS stops:  If you open the HOS Manager and uncheck 
Insert HOS Driver Breaks, all HOS stops will be deleted from the trip without 
affecting the original stops. 

 
 

 
Pick List of Alternate Rest Stops 

 
 

12. In addition to the pick list, all the rest stops found along the route segment will 
be visible on the PC*MILER map.  (Note that when rest stops are displayed 
after a search, all other POIs will be temporarily hidden.)   To zoom to any 
rest stop on the map, just highlight it on the pick list.   

 

 
Zoomed View of an Alternate Stop 
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13. To choose an alternate from the list, select it and click OK.  If you click 

Cancel, you will be returned to the route window to perform another search.  
An alternate rest stop must be selected, or you must open the HOS Manager 
and uncheck Insert HOS Driver Breaks. 

14. After editing an HOS stop, the new stop will be accepted and the trip will re-
run automatically. 

 
 
When using the HOS Manager, note the following: 

-   PC*MILER may select and insert rest stops that occur along a route up to one 
hour before the HOS requirement would go into effect, to avoid violations due 
to traffic or another unforeseen event.  For example, if a driver is scheduled 
for a stop at 3:00, PC*MILER would in most cases favor a stop at 2:10 versus 
one estimated to occur at 2:50.   

- Remember, the hours that PC*MILER returns for a trip are estimates that may 
not reflect a variety of factors that can influence driving times.   

- When changing an HOS rest stop, all POIs other than rest stops will be 
temporarily disabled – i.e. they won’t be visible on the map in the areas 
surrounding the route. 

- If all stops on a route are outside the United States, the HOS Manager will be 
disabled. 

- If you delete an HOS stop, PC*MILER will rerun the route and insert the 
original stop recommendations.  To delete all HOS stops, uncheck Insert 
HOS Driver Breaks in the HOS Manager.  

- When a route is saved that includes rest stops inserted by the HOS Manager, 
the rest stops will be saved but any custom settings in the Manager under 
Available Driving Hours and Available Duty Hours won’t be saved along 
with the route.  In other words, when the saved route is open, the HOS stops 
will be there but if you open the HOS Manager you’ll see the default available 
hours (8, 11 and 14 hours). 

- An arrival or departure time can be added to the trip after HOS rest stops have 
been inserted, the route will rerun automatically. 
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3.12  Running a Route 
 

 

Mileage, Time and Cost Calculations for a Generated Route 
 
 
For a route to be generated, there must be a valid origin and at least one valid 
destination entered in the active route window.  To generate a route, you can:  
 

• click Run in the active route window; or 
• press the F10 key; or 
• select the Routes tab > Route group > Run. 

 
Active routing options are listed at the top of the route window, under the route 
name.  The routing options that are active by default are listed below. See Chapter 
9 to change routing options.  
  

• For North America: Practical, Borders Open, Highway Only*, Use Ferry 
Distances, Tolls Discount - US$**  (** Defaults to Streets if PC*MILER|Streets, 
PC*MILER|Energy and/or RouteSync is installed) (** With PC*MILER|Tolls installed) 

• For All Other Regions:  (PC*MILER|Worldwide and DTOD only) 
Practical, Borders Open, Highway Only*, Use Ferry Distances 
* Except if PC*MILER|Streets is installed for the active region 

 
When processing is finished, the route will be drawn and framed on the 
PC*MILER map, and mileage, cost, and time estimates by trip leg will appear to 
the right of each stop on the list.  If an arrival or departure time was entered, the 
ETA at each stop will also be calculated.  From left to right, the columns are: 

 
• Time Zone – Displays the time zone for each stop. See section 5.1 on how 

time zones are reported and setting this option.  
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• Tolls – (Only if PC*MILER|Tolls is installed) At each stop, shows toll 
costs for the trip leg from the previous stop, with the total toll cost for the 
trip at the bottom.   

• Cost – At each stop, shows the estimated cost of the trip leg from the 
previous stop, including tolls if PC*MILER|Tolls is installed.  Trip costs 
are calculated by multiplying PC*MILER’s default cost per mile by the 
number of miles. The cost per mile settings can be customized using the 
Route Options or Default Route Options dialog – see sections 9.4 and 9.7. 

• Time – At each stop, shows the estimated driving time for the trip leg 
from the previous stop.  Cumulative driving time is shown at the bottom. 

• Miles –  At each stop, shows the mileage for the trip leg from the previous 
stop.  Cumulative miles for the trip are shown at the bottom. 

• ETA/ETD – If an arrival or departure time was entered, this column 
shows the departure time at the origin (this time is an estimate if an arrival 
time was entered) and estimated arrival time(s) at each stop. 

 
TIP on Resizing a Route Window:  If the columns you want to see aren’t visible 
after running a route, try adjusting the column order or eliminating columns using 
the Column Chooser (see section 3.12.2); or float the window.  A floating window 
can easily be resized like any other window – click the gear button and select 
Float.  Select Dock to return the window to its default position. 

 
 

 
 
 

3.12.1  Warnings in Route Windows 
 
When PC*MILER generates any type of warning regarding a routing issue, the 
circle that represents the stop related to the warning will be solid red.  Place the 
cursor over the red circle without clicking to see a tool tip that briefly describes 
the reason for the warning.  Generate a Detailed or Driver’s Report to see more 
details. 
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Warning Indicator with Tooltip in the Route Window 

 
 

3.12.2  Editing Columns in a Route Window 
 
The columns in any route window can be hidden and the column order can be 
changed in any route window using the Column Chooser dialog.  To access this 
feature, right click any stop on the stop list in a route window, then select Column 
Chooser… in the right mouse menu that pops up. 
 

 
 
 
 
 
 
 
 
 
 
       
 
 
 
 
 
 
In the Column Chooser dialog, all possible columns are listed.  Columns that are 
displayed are checked. (Note that the ETA/ETD column only displays if an 
arrival or departure time has been entered for a route.)  Uncheck any column to 
hide it.  To change the column order, click on a column name to highlight it and 
then click Move Up or Move Down.  As the column name moves up the list, it 
will be moved to the left in the route window, and vice versa.  Click the Reset 
button to reset to the default column order. 
 
NOTE:  The Column Chooser is also available in reports – right click any column 
header to access it. 

Right Mouse Menu Off a Stop Column Chooser Dialog 
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3.12.3  Route Framing on the Map 
 
• To automatically frame each route after it is run, select the Map tab > View 

group > Frame > Auto Frame Routes (this option is turned on by default). 
 
• To frame one route, select the Routes tab > Route group > Frame or the Map 

tab > View group > Frame One Route > and select a route. 
   
• To frame all generated routes, select the Map tab > View group > Frame > All 

Routes.  
 
 

3.12.4  Copy and Paste the Mileage Report 
 
After a route is generated, the results in the route window can be copied and 
pasted into a text editor such as Microsoft Word.  With your cursor inside the 
route window, press Ctrl + C.  Then open the text editor and press Ctrl + V.  The 
example below is in a WordPad file.  The widths of the data columns have been 
adjusted by changing the position of the tabs in those paragraphs. 
 
 

 
Mileage, Time and Cost Data Pasted Into WordPad 

 

3.13  Working with Multiple Routes and Windows 
For comparison purposes, you may want to route through different locations while 
keeping the routes you already generated open.  Up to eight route windows can be 
kept open simultaneously.   
 
When there are hidden or partially hidden windows open, a scroll bar will appear 
on the right side of the Routes pane.  The active route window will have a 
highlighted title bar at the top.   
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Each open route will be drawn in a different color in the map window.  Routes are 
identified in the Route Legend (if this legend is not visible, select the Map tab > 
Customize group > Legends > Route) and their corresponding route color appears 
on the left side of each individual route window.  
 
Reports can be run for each generated route, with each report appearing in a 
separate window.  See section 3.3 on screen layout options. 
 
To bring a window forward, click the Window tab and select the window you 
want to see from the Windows group.  
 

3.14  Duplicating a Route for Easy Comparison 
To duplicate a route either before or after it is run, select the Routes tab > Route 
group > Duplicate.  A new route window will open that contains all the stops 
from the original route.  This option makes it easy to compare different route 
types (for example, Shortest and Practical) for the same route. 
 

3.15  Saving and Retrieving Trips 
Routes generated in PC*MILER can be saved for later retrieval, either before or 
after they are generated.  This is particularly useful for trips you run frequently.  
To save a route either before or after processing, select the Routes tab > Route 
group > Save > Save Route As to bring up the Save Route dialog. 
 
 

 
 

Save Route Dialog 
 

 
NOTE:  When route files from previous PC*MILER versions are opened as trips, 
they are automatically converted to Version 29 format. 
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This dialog is a standard Windows® dialog.  Choose the folder where you want 
your route file to be placed, assign a file name and type to the file, then click 
Save.  There is no limit to the number of characters a file name can contain.   
 
Select the route type “.r21” from the Save as Type drop-down for trips that will 
be retrieved at a later time from within PC*MILER.   When you save a file with 
the .r21 extension, route options will be saved together with the route, but saved 
route files do not retain mileage, cost and time information. 

 
To save sets of points in text format for batch processing using 
PC*MILER|BatchPro or for use with PC*MILER|FuelTax, select the route type 
“.in”.  Files saved with the extension “.in” do not include any route options. 

 
 

To load a previously saved .r21 route file, select the Routes tab > General group > 
Open.  This will bring up a standard Windows dialog similar to the one you used 
to save your route.  Select your saved file from the File Name drop-down and 
click Open.   
 
As mentioned above, all settings used to create the file will be restored when you 
open it, but you will need to rerun the route to see reports and a map display of 
the route.  
 

3.16  Custom Places 

3.16.1  Adding Custom Place Names to the Database 
 

PC*MILER gives you the capability to assign your own custom names to an 
unlimited number of locations in the PC*MILER database, and optionally to 
assign them to custom categories.  Follow the steps below.   
 
1. Select the Tools tab > Custom Place Manager group > Add Places; or to pick 

a location from the PC*MILER map select the Tools tab > Custom Place 
Manager group > Pick Places on Map then click on the desired location. 

2. (Optional)  In the Add a Place dialog, click New to create a new category of 
custom places. 

3. (Optional)  Enter a unique Name for this category. 

4. (Optional)  From the drop-down Pin list, choose an icon to represent this category 
on the map.  (If none is chosen, the generic gray pushpin will be used.) 
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5. (Optional)  Click Save to save the new category. 

6. (Optional)  In the Add a Place dialog, make a selection in the Category drop-
down.  If a category is not selected, the custom place you are creating will be 
in the generic “Custom” category. 

7. Enter your custom name in the Name field (the same name cannot be used 
more than once).   

8. Enter the PC*MILER location (real name) in the Location and (optionally) 
Address fields.  The location can be in any format that is valid for stop entry.  

9. Click Save to save the new custom place name to the PC*MILER database. 
 
 

 
  Saving a Custom Place 

 
 

Once a custom place is saved, you can enter it as a stop on a route: in the route 
window, type the custom name into the City field.   
 
NOTE:  Custom place names are sensitive to spacing – for example, the name 
“01586,GM” is not the same as “01586, GM”. 

 
To view or edit custom places, press F2 or select the Tools tab > Custom Place 
Manager group > Manage (see below). 
 
To view or edit custom categories, select the Tools tab > Custom Place Manager 
group > Categories. 
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Entering a Custom Place as a Stop 

 
 

3.16.2  Using the Custom Place Manager 
 

To view, edit or delete custom places, select the Tools tab > Custom Place 
Manager group > Manage.  All custom places in the database are listed in the 
Custom Place Manager.  To sort any column, click the column header. 
 

 

 
Custom Place Manager 

(Address data shown above can be entered only if PC*MILER|Streets data is installed) 
 
 
To edit a custom place, click the Edit button for that place in the last column. 
Make the desired changes and click Save to save your edits. 
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Edit a Place Dialog 

 
 

To delete a place, click the Delete button for that place.  To delete all places on 
the list, click Delete All.  A prompt will ask you to confirm if you mean to delete 
all places.  To Export the list of places, see section 3.16.4 below.  Click the “X” 
in the upper right corner to close the Custom Place Manager and save your edits. 

 
IMPORTANT:  It is strongly suggested that you regularly back up important 
PC*MILER files such as custom places.  See section 11.7 for simple instructions.  
 
 

3.16.3  Creating Custom Latitude/Longitude Points  
 
You can assign a name of your choosing to a latitude/longitude point in the 
PC*MILER database by using the Add a Place dialog (section 3.16.1 above).  For 
example, you could type “Home Office” in the Name field, and “40n,100w” in 
the Location field.  After you add this name to the list, you’ll be able to enter 
“Home Office” as a stop on your route. 
 
Note that PC*MILER tracks the latitude and longitude position of your cursor as 
it passes over the PC*MILER map (watch the status bar in the lower left corner of 
the program window). 
 
 

3.16.4  Exporting Custom Places 
 
PC*MILER gives you the ability to export all custom places listed in the Custom 
Place Manager into a .csv (“Comma Separated Value”) file or a tab-delimited text 
file.  This feature can be used to import custom places from an older version of 
PC*MILER, see section 3.16.7.   
 
To export custom places from the Custom Place Manager, follow these steps:  
 
1. Select the Tools tab > Custom Place Manager group > Manage. 
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2. In the Custom Place Manager, click Export.   

3. In the Export window, select a file type in the Save as type drop-down.  For 
a comma-delimited value file choose “.csv”, or choose “.txt” to save as a 
comma-delimited text file.   

4. Assign a file name. 

5. Select a target location where the export file will be saved.   

6. Click Save to create the export file. 
 
 

 
Custom Places Exported to Excel (Column Formatting Adjusted) 

 
 

3.16.5  Importing Custom Places  
 
NOTE:  See section 3.6.17 for the correct way to format latitude/longitude points.  
See section 3.6.1 for all other stop entry formats that are accepted by the Import 
Custom Place Wizard.   
 
TIP:  Did you know that the Import Custom Place Wizard can be used as a batch 
geocoding tool to clean up your data?  If you have a list of customer locations that 
include street addresses and/or other information, you can import those locations 
to confirm that they match locations in the PC*MILER map database.  
(PC*MILER|Streets is required to process address data.)  The original input file 
does not need to include custom place names but does have to be correctly 
formatted – see Step 1 below. 

 
NOTE Also:  Importing a file containing more than 4,000 places may take a very 
long time and is not recommended.  Consider dividing a large input file into 
smaller files for importing. 

 
Using the Import Custom Place Wizard, you can import sets of custom places 
which were created in an environment independent of PC*MILER.  During the 
import process, PC*MILER provides the option to 1) enter the whole set of 
imported places as stops on a route, or 2) save the imported places as custom 
places in the map database for future use.       
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The Import Custom Place Wizard first tries to match each record in the input file 
to a place or address range in the database, converting the records to a format that 
PC*MILER can use.  The input file must be a text file with columns delimited by 
a tab or other character such as a comma.  Here are several lines from a sample 
text file of custom places that are suitable for importing: 
 
 

 
Sample Text File, Tab Delimited 

 
 
The import process includes five basic steps, covered on the following pages: 
 
Step 1. Setting Up a Correctly Formatted Input File 
Step 2. Open the Input File 
Step 3. Select and Preview Input 
Step 4. Confirm Matches 
Step 5: Add Places to a Route Window or the Custom Place Manager 

 

STEP 1:  Set Up a Correctly Formatted Input File 
 

The first step is to ensure that your input file is correctly organized and formatted.  
Making the effort to properly organize the input file can make a big difference in 
how efficiently the locations in the file are processed.   
 
The input file must be a text file with columns delimited by a tab or other 
character such as a comma.  If the original file is a text file, try opening it in 
Excel, formatting as necessary, and then saving it again as a tab-delimited .txt file 
 
To successfully add places to the database, at minimum the input file must include 
a location column.   
 
The required location for each place must be either a latitude/longitude, postal 
code, or city and state/province/country abbreviation.  (PC*MILER|Worldwide or 
DTOD data must be installed for countries outside North America.)  Other 
location information can be included in additional columns.  As you will see in 
Step 3, you can tell PC*MILER to ignore columns in the input file that contain 
data that can’t be imported. 
 
It is recommended to organize the information in each column of the input file 
into like groups, separating the data that PC*MILER will accept from the data 
that won’t be accepted.  For example, from left to right the file might include: 
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• Place Name – A custom place name (required).  If the file does not 

include place names and you are importing places for the purpose of data 
matching, you can insert a column with any appropriate custom name. 

• Address Line 1 – A location address including a street number and street 
name.  PO Box numbers are not accepted by PC*MILER and should be 
removed.  (PC*MILER|Streets is required for address data to be accepted.) 

• Address Line 2 – Secondary address information such as suites, floors, 
apartments, units, building names, etc.  Not accepted by PC*MILER. 

• City – The city name. 

• State/Province – A two-letter state/province/estado abbreviation, the name 
should not be spelled out (e.g. “ON” is correct, “Ontario” won’t be accepted). 

• ZIP/Postal Code –  
o U.S. addresses can be a ZIP or ZIP+4 Code (use a dash with 

ZIP+4, e.g. 12345-1155).  PC*MILER will only read in the first 
five digits and will ignore the last four. 

o Canadian addresses should include spaces, do not use dashes (e.g. 
G1A 1B1, the format is ANA<space>NAN where “A” stands for 
“letter” and “N” stands for “number”). 

• Country – Not usually needed, but should be in its own column. 

• Region – (PC*MILER|Worldwide or DTOD data must be installed)  A region 
is only needed if locations are outside North America.  Region names should 
be spelled out as they appear in the Route Options dialog. 

 
Example File: 

 
 Place Name  Address Line 1  Address Line 2  City  State/Province  ZIP/Postal Code  Country 
 Warehouse1  4 Moore Street  First Floor  Princeton  NJ  08540  US 
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STEP 2:  Open the Input File 
 

1. To begin, open the Import Custom Place Wizard: select the Tools tab > 
Custom Place Manager group > Import . 

 
 

 
Import Custom Place Wizard – Initial View 

 
2. In the Wizard, select Tab Delimited if the input file is tab-delimited text.  

Otherwise, select Other Delimited and enter a delimiter in the box to the 
right.  This setting tells the Wizard where a new column should begin in the 
input file.  Usually the delimiter is either a tab or a comma. 

 
3. Click Browse and navigate to the drive and directory where your data file is 

located.  Be sure to select the correct file type in the drop-down, then select 
the file to be imported and click Open.   

 
 

 
Open Input File Dialog 
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STEP 3:  Select and Preview Input 
 

Now you’ll see the data from the input file, organized in columns.  Initially, all 
column headers are labeled Skip, meaning that PC*MILER cannot interpret what 
type of data is in each column.  Use the drop-down menu at the top of each 
column to assign a new column header; or if the first row of the input file 
included appropriate headers, check First row contains column headers.   
 
 

 
Import Custom Place Wizard – Select and Preview Input 

(Address data shown above can be imported only if PC*MILER|Streets data is installed) 
 

 
To successfully import places, there must be at least one location column.  The 
location must be a LatLong (latitude/longitude), PostCode (postal code), and/or 
City and State (state/province/country abbreviation) with an optional Address.  
Other available headers are: Region (used only with PC*MILER|Worldwide or 
DTOD data), Description and Category. 
 
 
TIP:  The “Category” header can be used to assign a map icon of your choosing 
to a set of custom places.  Simply create a custom category (Tools tab > 
Categories) and make sure the category name in your input file exactly matches 
the custom category name. 
 
 
Each of the headers can be applied to only one column, with the exception of 
Skip.  Label a column Skip if the data in it should not be read (e.g. memos or 
descriptions) or if it is blank. 
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To adjust column widths in the table for better visibility, place your cursor 
between two column headers.  When the cursor changes to an arrow, hold down 
the left mouse button, drag the margin to the desired width, then let go. 
 
The options under Records to Process determine how many and which rows of 
data in the table will become custom places.  Select All to have all the data 
processed, or Selected to process only some of the records.  If you choose 
Selected, enter the range of records to be processed. 
 
With the columns and input selection set, click Next to continue. 

 
TIP:  If you want to import a file that has different types of locations (postal 
code, city and state, and/or latlong) on different rows, and/or different 
combinations of types (such as postal code and state), first use the 
=citytolatlong() function in PC*MILER|Spreadsheets to convert those types 
consistently to LatLong, then import that file specifying a Name column and a 
LatLong column as the only location.  See the PC*MILER|Spreadsheets User’s 
Guide for instructions on how to use the =citytolatlong() function. 
 
ADDITIONAL NOTES:  The more information you include, the more certain it 
is that a unique match will be found.  Import Custom Places will import a file that 
has city and state combined into a single column (label this column "City"), or zip 
code, city and state combined into a single column (label this column "Zipcode"). 
A county name may optionally be included at the end of either one. A space 
should separate the ZIP code from the city, a comma should separate the city from 
the state, and a comma should separate the state from the county. For example, 
any of the following are acceptable: 
 

City 
Princeton 
Princeton, NJ 
Princeton, NJ, Mercer 
 

ZipCode 
08540 
08540, NJ 
08540 Princeton, NJ 
08540 Princeton, NJ, Mercer 
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STEP 4:  Confirm Matches 
 
When all records have finished processing, the Confirm Matches screen will 
display the processed records along with results data and output options. 
 
 

 
Import Custom Place Wizard – Confirm Matches 

 
 
Results: 
 

• Total Processed: The total number of records processed. 

• Total Matches: The total number of records that were successfully 
matched with a location in the PC*MILER database.   

• Seconds/Records:  The average time spent on processing each record. 

• Time Elapsed: The time elapsed since the start of the record matching 
process. 

Confidence Level: 
 

There are four possible levels of confidence in the accuracy of the data 
matching for each record: 
 
1  Exact – An exact match was made.  For street addresses, trust is 95% or 
greater AND if address is outside the range listed in the database, the top 
match is within 100 address units of input address*; OR for any other match 
level if there are multiple matches they are all within .1 air miles of each 
other.  * For example, “100 Main Street” was input and the best match in the database is 
“150-250 Main Street”. 
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2  Fair – Inexact match but unique result (i.e. there is only one match). For 
street addresses, trust is 85% or greater AND if address is outside the range 
listed in the database, the top match is within 500 address units of input 
address*; OR for any other match level if there are multiple matches they are 
all within .5 air miles of each other. 
* For example, “100 Main Street” was input and the best match in the database is “450-550 
Main Street”. 

3  Uncertain – Inexact match and there is more than one match in the 
database.  For street addresses, trust is 50% or greater. 

4  Failed – Match not found. Trust is below 50% for street addresses. 
 
# of Records: 
This column displays the total number of records which fall into each of the above 
categories. 
 
% of Records: 
This column shows the percentage of all records that fall into each category. 

 
In the Accept column, accepted records will be checked to indicate that they were 
successfully matched with a location in the PC*MILER database with either an 
Exact or Fair confidence level.  Locations that were not accepted will have an 
error message in the Error(s) column that briefly describes the reason for the 
error.  Check marks can be manually entered or deleted in the Accept column.   
 
The Conf (Confidence) column shows the confidence level of each record’s 
match (described above).  The Match column displays the record in the database 
that was matched to the input location. 
 
 

STEP 5:  Add Places to a Route Window or the Custom Place Manager 
 
Once the validity of all the Accepted matches have been confirmed, you are ready 
to add the imported places to a route window or the Custom Place Manager.  You 
only need to make a few option selections, described below.   
 

Add Selected Places:  
Choose whether output should be added to the Custom Place Manager (i.e. 
the PC*MILER database) or a Route Entry Window.   Check Accepted to 
only add the accepted names, or All Matched to include all matches except 
those in the “Failed” category.  

Options:  
Here, if you selected to save the imported places to the Custom Place 
Manager, choose whether to automatically overwrite any duplicate custom 
place names or PC*MILER place names that already exist in the database.  If 
Do not override existing place or Prompt for each duplicate is selected, a 
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prompt will pop up when a duplicate is detected and processing won’t proceed 
until there is an interaction.  If you are adding the output to a route window, 
under Add Places to Route Window choose whether to open a new route 
window or add them to the currently active window. 

 
When ready, click Add Selected Places to send the output to the target route 
window and/or the Custom Place Manager.  Click Export Results in the upper 
right corner to create a text file containing the confirmed matches.  
 
   

3.16.6  Editing Custom Place Records 
 
To edit or verify a record, highlight it in the Results window and click Edit 
Selected Custom Place in the upper right corner of the Confirm Matches screen.  
In the Edit Match window, you’ll see all matches that were found in the 
PC*MILER database for that location listed and displayed on a map.  
 
 

 
Edit Match Window 

 
 
The map in this window is set to “Box Zoom” mode.  To zoom to a match on the 
map, hold and drag a box around it with the left mouse button. 
   
Under the map, the fields on the left show the name and data included in the 
highlighted record.  These fields can be edited.  On the right, all matches are listed 
and the Selected Match field shows the complete record in the PC*MILER 
database for the match that is highlighted on the list. 
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To search for a wide range of possible matches, you can enter the first few 
characters of a faulty postal code or city/state name and then click Find All 
Matches.  For example, type “085” in the LatLong, Postal Code, or City, State 
field to get a list of all postal codes that begin with “085”.  (Note that if there is an 
address in the Street Address field, you should delete it before performing the 
search for best results.) 
 
Click OK to exit the window and save your edits, or Cancel to cancel the edits. 
 
 

3.16.7  Converting Custom Place Files from a Previous Version 
 
Custom places that were saved in the previous version of PC*MILER (28) can be 
transferred and converted to PC*MILER Version 29.  First you will need to 
export the custom places into a text (.txt) file using the Custom Place Manager in 
PC*MILER 28.  The .txt file you created can then be imported into Version 29 – 
see section 3.16.5 above. 
 
IMPORTANT NOTE:  Do NOT try to simply copy your old custom places from 
the previous version to the new version.  PC*MILER won’t recognize the older 
custom places unless you go through the process described above. 
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Least Cost Routing 
 
 
Costing has always been an important use of PC*MILER.  Among ALK 
customers there has been a growing interest in using PC*MILER to help with the 
trade-off of toll costs, costs per mile, and costs per hour in determining a “least 
cost” route. 

 
In response to the needs of our customers, ALK began to research the relevant 
costing issues using several cost factors (typical miles per gallon, cost per gallon, 
fuel cost per mile, other cost per mile, and labor cost per hour for an 18-wheeler) 
and found that: 

 
• a slower (less “practical”) route is the least-cost route 58% of the time, 

regardless of diesel price, provided the truck can still make its delivery 
window and its pickup window for its next load; 

• if the least-cost route is chosen, there is the potential to save 0.6/% - 0.9% 
in costs, on average1; 

• when diesel prices are high, the least-cost route is more likely to be a 
“shorter” route compared to when diesel prices are low; and 

• the absolute amount of savings from choosing a least-cost route is 
insensitive to diesel price. 

 
Of the 90 origin/destination pairs used in ALK’s study2, the O/D with the largest 
difference in cost, regardless of diesel price, was Chicago, IL to Washington, DC.  
At a fuel price of $2.71/gallon, the savings if the “least cost” route was chosen 
would be $79, or 7.8% 3: 
 
 

Chicago, IL to Washington, DC 

Route Miles Hours 
Cost 

Total Tolls Fuel Time Maint 
Prac 697.1 11.60 $1,010 $147 $315 $465 $84 
Prac|Toll 776.8 12.90 $961 $0 $351 $517 $93 
Short 689.9 12.10 $994 $115 $312 $485 $83 
Short|Toll 700.1 13.23 $931 $0 $316 $531 $84 
Least-cost difference 3.0 1.63 -$79 -$147 $1 $66 $0 
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Would a customer in the above scenario actually save $79 in cost if they chose the 
“least cost” route?  That would depend on a lot of factors that are external to the 
route: 

• where the driver is in their hours of service cycle 

• the delivery time window for the truck and driver’s current load 

• the pickup time window for the truck and driver’s next load 

• alternative opportunities to match a different truck and driver to the next 
load (for a dispatcher of company drivers) or to choose a different next 
load (for an owner-operator) 

 
On the basis of all the above findings, ALK has developed a new Least Cost 
routing feature that considers user-specified values for miles per gallon, cost per 
gallon, fuel cost per mile, other costs per mile, labor cost per hour, and stop costs 
– and includes a parameter for a greenhouse gas emission estimate.   
 
Least Cost routing generates a series of alternative routes with distance, time and 
cost estimates, and lets the dispatcher or driver (or an external system, such as a 
truck dispatch optimization system) choose an optimal route, considering factors 
such as those cited above that are external to the route.  If PC*MILER|Tolls is 
installed, toll costs are factored in as well. 
 
______________________________ 
Reference Notes: 
1 - These results are for 48' equipment.  It is expected that the potential savings for 53' equipment will be 

lower, due to fewer opportunities for legal alternative routes. 
2 - The O/D pairs used for the study connect the centers of the 10 largest metro areas in the U.S. 
3 - Sources of “average” data used in the study were default values for drivers paid by the hour, along with 

values from a recent American Transportation Research Institute (ATRI) study (An Analysis of the 
Operational Costs of Trucking), the U.S. Energy Administration, and typical miles per gallon for an 18-
wheeler. 
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4.1  Using Least Cost Routing  
To calculate Least Cost routing, follow the steps below: 

 
1. In a new route window, enter an origin and at least one destination, then run 

the route – click Run or press F10.  If there are any time/cost settings that 
need to be specified, they can be entered in the Route Options dialog – see 
section 9.4 – either before or after running the trip. 

 
2. Select the Routes tab > Route group > Optimize > Least Cost Routing.  A 

separate window will open that displays the possible routes on a map and the 
calculated totals for each route below the map.  The most efficient calculated 
totals for distance, costs, hours and tolls will be highlighted in yellow below 
the map. 

 

 

 
Least Cost Options Window 

 
 

To hide a route on the map, uncheck it in the Visible column. 
 
To use one of the generated routes, highlight it and click Save Selected 
Options.  The calculated totals will appear in the route window, replacing the 
original route. 
 
Click Print to print the Least Cost route calculations in a Comparison report. 
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Least Cost Comparison Report 

 
 

NOTE:  Internally, PC*MILER calculates six route types for Least Cost 
routing, but if the total cost is the same for two or more of these routes, not all 
routes will be displayed.  Route types that PC*MILER calculates for every 
route are: Practical, Practical - Toll Discouraged, Shortest, Shortest - Toll 
Discouraged, Fastest, and Fastest - Toll Discouraged. 
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Time-Based Routing 
 
 
In recent years, ALK Technologies has become aware that a number of our 
customers are interested in considering time of day, day of the week, and time 
zones when calculating and reporting routes, distances, travel times, and toll 
costs.  Up to and including Version 29, PC*MILER default routes, distances, 
travel times and toll costs are calculated based on: 
 

• average road speeds by state/province, urban/rural, and class of road; 

• height, length, width, and weight restrictions that apply during the 
majority of the commonly traveled seasons of the year, days of the week, 
and times of day; 

• seasonal roads being open during shipping and receiving seasons, but not 
to through traffic; 

• and peak-period toll costs for the most recently updated quarter of the 
release year. 

 
These fundamental routing criteria work well for the many purposes of our users, 
and will always be foundational to ALK’s industry-leading PC*MILER products. 
 
The time-based feature enhancements described in this chapter were added in 
PC*MILER Version 25 and now offer more precise travel time estimates to those 
users who are interested.  PC*MILER capabilities related to time-based routing 
allow users to: 
 

• specify a departure or arrival date and time for more realistic transit times; 

• calculate truck-specific toll costs based on the time of day (PC*MILER|Tolls 
must be installed); 

• and calculate more accurate transit times based on industry-leading 
historical traffic data. 

 
Time-based routing can be run with or without the use of traffic data to increase 
the precision of travel time calculations.  When time-based routing is used, 
ETA/ETD information appears in the route window, Detailed Route Report, and 
Driver’s Report.   
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5.1  Route Generation With ETA/ETD 

 
 
 
 

 
Time-Based Routing Options in the Route window 

 

 
Optional  time and date settings in the route window can be used to generate time-
based routing that determines estimated times of arrival (ETA) and departure 
(ETD) based on a user-specified departure or arrival day and time.  An ETA is 
calculated for every stop and toll plaza on the route (PC*MILER|Tolls must be installed 
to access toll information).  Follow the steps below to generate time-based routing. 
 
1. Select the red File application menu > Application Settings. 
 
2. In the Application Settings dialog, choose the desired option in the Time 

Zone drop-down (note that this setting affects how dates/times are reported, 
not how they are calculated): 

  
 

• Local: Reported ETA/ETD will conform to the time zone where each stop 
or toll plaza is located (applies in all world regions).  

• System: ETA/ETD at stops and toll plazas will be reported based on the 
time zone setting on the host computer. 

• Specific: Select a time zone by region (options will reflect the world region 
selected in the Route Options dialog).  ETA/ETD at all stops and toll plazas 
will be reported using this time zone (available only for NA and Europe). 

Optional Arrival/Departure  
and Traffic Settings 
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3. In the route window, click the middle drop-down to open time options and 
specify an arrival/departure time and date or day of the week: 

 
 

• Depart by/Arrive by:   
Select Depart by (to set the departure day/time at the trip’s origin) or 
Arrive By (to set the arrival time at the trip’s last stop).  If this setting is 
changed after a route is calculated, the ETD and ETA’s will automatically 
recalculate.   

 
• Specific Date or Day of the Week:   

Select either Specific Date or Day of the Week.  To enter a date, either 
type it in the text box or click the calendar and select a date.  To specify a 
day of the week, click the drop-down list. 

         
 
 
 
 
 
 
 
 
 
 
 
 
 
• Local Time: 

A time of day must also be entered.  Type the targeted local time at the 
arrival/departure location. 
 

 

Picking a Specific Date  
from the Calendar 

Selecting a Day of the Week 
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To change the time format from AM/PM to 24 Hours (“military time”), 
select the File application menu > Application Settings and choose the 
desired option: 

 

 
 
4.  Click OK to close the time options dialog. 
 
5. Now add at least two locations (an origin and destination) to the stop list and 

click Run to generate the route.  Estimated arrival and departure times at all 
stops on a route will be shown in the mileage report in the route window after 
the route has been generated.  If a target Arrival time was entered, the 
necessary ETD from the origin to meet that target is calculated. 

 
ETA/ETD calculations do not include break times or stop times.  To add stop 
times or Hours of Service rest stops to a route, see section 3.11. 

 
 

 
Generated Route With a Target ETA 

 
 

5.2  Using Traffic Data for More Precise Time Estimates  
(U.S. and Canada only) 

NOTE:  A subscription to PC*MILER|Traffic must be purchased to access traffic 
data in PC*MILER, and you must have an Internet connection to use these 
features. 
 
Time-based routing can be generated with or without using traffic data.  
Conversely, traffic data may be used whether or not an arrival or departure 
day/time has been entered.  Using traffic data will increase the precision of time 
estimates. 
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If you choose not to use traffic data, travel times and ETA’s will be calculated in 
the same manner as in all previous versions of PC*MILER, based on average road 
speeds (either PC*MILER default or user-specified) by class of road in each 
state/province.  Road speeds can be customized in the Route Options or Default 
Route Options dialog.  
 
To calculate a route’s ETA/ETD using traffic data, use the drop-down menu in the 
route window to change Traffic Disabled to Traffic Enabled.  This option will 
remain active until it is changed by the user again (to set the default for all route 
windows, see section 5.2.1 below). 
 

 
 
If Traffic is enabled and a departure or arrival time and date are not entered, 
INRIX default travel times that reflect free-flow conditions – think middle of the 
night – are used.  (This is the “Typical” option mentioned below.) 
 
Traffic data is collected by road segment.  With the Use Traffic Data option 
selected and a departure or arrival time and date entered, travel times and ETA’s 
will be calculated based on historical, typical and/or real-time traffic data, 
depending on the arrive/depart and day/time settings.   
 
“Historical” data reflects how average traffic patterns affect road speeds on the 
road segments used by the generated route.  (An “average” pattern is created 
using a historical time slice: 7 days in a week, with each day divided into 15-
minute time slices.)  “Typical” data uses road speeds that would occur if there 
were no traffic on those road segments.  “Real-time” data is just that: current 
traffic patterns that are fed into the system in real-time. 
 
NOTE:  The three types of traffic data mentioned above can be displayed in the 
map window – see Chapter 6. 
 
If Depart by is selected and the day/time is within 15 minutes of the current time, 
real-time traffic data will be used for the first 15 miles and Historical data will be 
used for the remainder of the route.  (This is because after 15 miles of driving, 
conditions will have changed and they are more likely to resemble historical 
conditions than current conditions.)  When Arrive by is selected, Historical data 
is always used.    
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5.2.1  Use Traffic Data By Default 
 
To use traffic data by default in every new route window, select the Routes tab > 
General group > Defaults > Road Speeds tab and make sure that Use Traffic 
Data is checked.  When this option is enabled, custom road speeds cannot be 
entered in the Route Options dialog and, if already entered, are not available.   
 
 

 
Default Route Options Dialog, Road Speeds Tab 

 

5.3  Time-Based Routing  in Reports 
Estimated arrival and departure times at all stops on a route are shown in the 
mileage report in the route window after the route has been generated.  These 
times appear in the ETA/ETD column to the far right.  This column is inactive 
when an arrival or departure day/time has not been entered. 
 
ETA/ETD information also appears in the far right column of the Detailed Route 
Report if a day/time was entered for the route (the report may need to be scrolled 
to the right – see section 8.2 for a detailed description of this report).  This report 
column will show the estimated times of arrival at every stop and toll plaza on the 
route.  If a target arrival time was entered, the estimated departure time from the 
origin will be shown.  If a departure time was entered, that time will be shown at 
the origin. 
 
In the Driver’s Report (see section 8.4), if a route was run using real-time traffic 
data, a Delay column will appear just to the right of the Time column.  The 
“delay” time identifies delays caused by the current traffic conditions on the first 
15 miles of the trip.  (Note that real-time traffic data is used for the first 15 miles 
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of a generated route if “Use Traffic Data” is turned on, unless a time is entered 
and Day of Week is selected rather than a date – in that case, historical traffic data 
is used for the whole route.)  
 

5.4  “Special Restrictions” in Routing and Reports 
Beginning in Version 28,  time-based routing now integrates road restrictions that 
are active only during specific times.  These new restrictions are enabled when 
you open the Arrival/Departure window in a route window and select an arrival 
or departure time.  This action will cause PC*MILER to route around roads that 
have time-based restrictions. 
 
These special restrictions may include roads that are closed in one or more 
directions; have a temporary closure in one or more directions 
(construction/natural disaster); have a restriction on a particular truck 
configuration (weight, hazardous material) in one or both directions; have a 
special speed limit in effect;  or have a particular lane closed or allowed.  
 
For example, the I-82 highway from Aspen, CO to Buena Vista, CO is closed in 
winter;  so if an arrival or departure time during the winter season is entered, 
PC*MILER will route around I-82. (Note that the roads the alternate route takes 
may vary depending on whether the Highway Only option is turned on in the 
Route Options dialog.  Using local streets in routing generally provides a route 
that is closer to the original one – in this case the spring, summer and fall route.) 
 
Selecting “Override Restrictions” in the Route Options dialog will override these 
time-based restrictions, along with all other restrictions, but warning messages 
will appear in the Detailed and Driver’s reports where a restriction exists. 
 
The information provided in warnings will be formatted as follows: 

Days of the Week:  SMTWTFS.  Any days during which the restrictions don’t 
apply appear as a dash, e.g. S-T-TFS. 

Hours: XX:XX AM – XX:XX PM, or XX:XX – XX:XX (Military Time – The 
format can be changed in the Application Settings dialog.) 

Months: Includes the three-letter abbreviation of all valid months. 
Days:  Date range in every month from X-Y, e.g. 7-10. 
Weeks:  Week range in every month from X-Y, e.g. 1-2. 
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5.5  Time-Based Toll Cost Reporting 
(Installation of PC*MILER|Tolls required) Prior to Version 25, PC*MILER 
calculated toll costs based exclusively on peak hour rates while factoring in 
vehicle dimension settings that affect those rates.  Beginning in Version 25, when 
an arrival or departure time is entered in the route window, truck-specific toll 
costs can be calculated even more precisely because time-of-day variations are 
factored into toll rates when and where they occur, including peak and non-peak 
tolls.   
 
See Chapter 7, Getting Toll Costs, for more on generating routes with toll costs.  
 
NOTE:  Toll costs are always calculated in the local time as the planned route 
crosses the toll booth.  By default, the date/time of the toll collection is also 
reported in that local time.  To change this setting, select the File application 
menu > Application Settings and use the Time Zone option to choose either 
System (your computer’s time) or a specific time zone.  The date/time of the toll 
collection will then be reported in the time zone you specified.  Note that time 
zones displayed for each stop in the route windows will also be affected by this 
setting change. 
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        Traffic Display 
 
 
PC*MILER gives users the option to purchase access to traffic data for roads 
throughout the U.S. and Canada that can be used for more precise time-based 
routing, as described in Chapter 5.  This data can also be used to display 
historical, typical or real-time traffic patterns in the PC*MILER map window.  
(Note that an internet connection is needed for real-time data and for subsequent 
updates to the historical and typical traffic data.)  For general instructions on 
using the map window, see Chapter 10. 
 
 

 
Traffic Display Showing Level of Congestion – Lincoln Tunnel, New York, NY 

 
 
PC*MILER’s new traffic display feature lets users instantly visualize traffic data 
on the map in any location throughout the continental United States to help with 
route planning, analysis, and diagnostics. 
 
NOTE:  An internet connection is required for the display of real-time traffic 
patterns.  If you are not connected to the Internet and request traffic data to be 
displayed, you won’t see any traffic flows on the map, and the Traffic legend will 
show the default text: “Actual: Last Update: 12:00 AM”. 
 
NOTE Also:  The traffic display options described in this chapter do not affect 
how traffic data is used in time-based routing.   
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6.1  Traffic Display Options 
To access the traffic display and set options for it, select Traffic in the right mouse 
menu off the map window.  The Traffic Display window can be left open and 
moved around anywhere on the screen as you work in PC*MILER.  
 
 

 
Traffic Display Window 

 
 
When traffic display is turned on and your computer is connected to the internet, 
you will see traffic data displayed on the map at zoom level 5 and higher within 
the area you are zoomed into.  (The current zoom level is shown in the title bar of 
the map window.)   
 
To turn on the display, select either Congestion or Speed at the top of the Traffic 
Display window.  When you change an option in this window, the map will 
immediately redraw to reflect the new data.   
 
Options in the Traffic Display window are the following: 
 

• Show: 
Select Congestion to show the amount of congestion (relative to Typical – 
see the Time options description below), or Speed to show absolute traffic 
speeds.  Select Off if you don’t wish to see traffic displayed on the map. 

 
• Time: 

Select Now to see real-time data displayed (internet connection required). 
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Select Historical to see past traffic patterns.  The Historical option displays 
average traffic based on patterns created using a historical time slice: 7 
days in a week, with each day divided into 15-minute time slices.  The 
Historical display depends on the day and time selected (see below). 
 

The Typical option pertains only to road speeds (not congestion) and 
represents road speeds that are typical when there is no traffic congestion. 

 
• Historical Day and Time: 

Using the radio buttons and slider bar or arrows, indicate a day and time of 
day for which historical data will be displayed.   

 
If you close the Traffic Display window, the selected options will remain in effect 
(unless you turn the traffic display on or off using the Map Features dialog). 
 

6.2  Traffic Display on the Map 
 

 
Real-Time Traffic Display – Holland and Lincoln Tunnels, New York, NY 

 
 
The traffic display can be seen on the map at a zoom level of 5 or higher (the 
zoom level is shown in the title bar of the map window). 
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To turn the Traffic legend on or off, select the Map tab > Customize group > 
Legends > Traffic.  As with the other legends in the map window, you can click 
on this legend and drag it to where you want it.   
 
The settings in the Traffic Display window determine which Traffic legend – 
Traffic Congestion or Road Speeds – appears on the map.  In the example above, 
congestion is displayed and the Traffic Congestion legend shows the colors used 
to draw traffic patterns.   
 
Both legends shown below include update times, indicating the display of real-
time data.  
 

                         
Traffic Legends – Real-time Display  

 
 
The legends below pertain to a Historic traffic display, and show the day of the 
week and time that are set in the Traffic Display window. 

 

          
Traffic Legends – Historic Display 

 
 

In the Road Speeds legend, distances are in miles by default.  This setting can be 
changed in the Route Options or Default Route Options dialog (see 8.10 and 
8.11). 
 
NOTE:  If you are working with a real-time display, it may take anywhere from a 
few seconds to a minute or so for the display to update, depending on the speed of 
your Internet connection and when updated traffic information becomes available. 
 
 

 
 Chapter 6:  Traffic Display 123 



 

 
 

Getting Toll Costs 
 
 

If ALK’s PC*MILER|Tolls add-on module was purchased with PC*MILER, you 
can generate accurate, up-to-date toll costs for U.S. and Canadian lanes with these 
costs integrated directly into the routing database and reported turn-by-turn per 
trip.  Columns for toll costs appear in the Detailed Route Report, State/Country 
Summary Report, and Comparison Report, and tolls can be reported in the 
currency of choice – either U.S. or Canadian dollars – using the current 
conversion rate. 
 
Accurate toll cost calculations can optimize productivity in multiple departments 
of your organization by assisting in the routing, rating, and reconciliation 
processes. Now you can determine whether it’s more cost-effective to take a toll 
route, or a non-toll route with a few additional miles, before routing a vehicle.  
 
PC*MILER|Tolls generates up-to-date, truck-specific toll costs for toll roads, 
bridges, tunnels, and border crossings for U.S. and Canadian toll authorities.  The 
data that PC*MILER|Tolls provides includes: 
 
• Both cash and discount toll program transactions.    
• Range (ticket) and barrier (coin drop) data in addition to two-way tolls, one-

way tolls, and tolls that vary by direction.  
• Quarterly toll data updates to ensure accuracy when calculating toll costs 

throughout the year.  (PC*MILER|Tolls users receive notification by email 
when quarterly updates are available, or may use Check for Updates in the 
Help tab to ensure they have the most current data.) 

• Time-of-day variations factored into truck-specific toll rates when and where 
they occur, including peak and non-peak tolls, if time-based routing is active 
in the route window.  (See Chapter 5 for a detailed description of how to use 
time-based routing.) 

• Toll rates for smaller 2-axle vehicles when automobile routing is generated. 
• Future expected changes to toll rates included as available. 
• Thirty-five (35) toll discount programs throughout the U.S. and Canada (states 

in which each program apply are listed below). 
 
GENERAL NOTES on TOLL RATES: Unless vehicle dimension settings are 
customized in the Route Options dialog (see section 9.5), PC*MILER|Tolls 
calculates toll costs for an 80,000 pound, 5-axle vehicle.  Reported toll amounts 
are accurate and up-to-date, but not always exact due to several factors: first, 
several – though not many – toll roads have rates that are based on weight (for 
example, the Detroit-Windsor Tunnel charges a set rate per 100 lbs. gross weight 
in both directions); second, some toll charges (in various states) are time-of-day 
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driven, and in this case, tolls will be calculated using the highest (peak) rate 
unless PC*MILER’s new time-based routing is used; and third, future and 
proposed toll rates are incorporated into the database where appropriate and these 
rate changes may occasionally be cancelled at the last minute. 
 
Also note the following:  if the user does not specify a departure/arrival date, the 
computer’s system date is used as the date of departure to determine the effective 
toll rates for the trip (which include any rate changes that become effective during 
the trip).  However, this is not true for the time of day.  If the user does not 
specify a time of departure/arrival, the base rate for the date (i.e. highest rate) is 
used without reference to the system time. 

 
 
States/Provinces Where Each Discount Program Applies: 

 
 

SPECIAL NOTE:  The “EZPass-WV” or “EZPass-NJ” options apply to those who 
purchased the EZPass service in West Virginia or New Jersey. 
 
 
Discount Program Valid In  Discount Program Valid In 
407 ETR Transponder ON Canada  I-Pass IL 
A25 Transponder QC Canada  K-Tag KS 
A30 EXPRESS 
Transponder QC Canada  Laredo Trade Tag TX 

BreezeBy OR  LeeWay FL 
Cruise Card GA  MACPASS NS Canada 
Downbeach Express 
Pass NJ  NC Quick Pass NC 

E-Pass TX  NEXPRESS TOLL MI 
ON Canada 

E-Pass Canada NS Canada  Palmetto Pass 
(PAL PASS) SC 

ExpressPass NY, ON Canada  Peach Pass GA 
EXpressToll CO  PikePass OK 
EZ Tag TX  Quickpass BC Canada 

EZPass 
DE, IL, IN, ME, MD, 
MA, NH, NJ, NY, NC, 
OH, PA, RI, VA, WV 

 
StraitPASS PEI Canada 

EZPass-NJ NJ  SunPass FL 
EZPass-WV WV  TollTag LA, TX 
FasTrak CA  TReO BC Canada 
GeauxPass LA  TxTag TX 
Good To Go WA  Wabash Pass IN 
GO-PASS CO    
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The following discount programs have been discontinued in the database: 
 
Discontinued 
Program 

State Versions 
Available 

Version 
Discontinued 

Reason 

C-Pass FL 24-28 29 Adopted SunPass 
FAST LANE MA  

and all 
EZPass 
facilities 

21-28 29 Only EZPass is used now 

Smart Tag VA 21-28 29 Only EZPass is used now 
NEXUS NY, ON 27 28 Discontinued 
I-Zoom IN 21-26 27 Replaced by EZPass 
B-Pass NB 17-25 26 Toll discontinued 
M-Tag MD 17-23 24 Replaced by EZPass 
NH Tokens NH 17, 18 19 Replaced by EZPass 
O-Pass FL 21-23 24 Absorbed into SunPass 
Ready Toll OH 17, 18 19 There is no discount 

associated with this 
program, it’s simply a 
“debit card” used to pay 
tolls 

Transpass ME 17- 23 24 Replaced by EZPass 
 
 
NOTE:  Toll costs on the New York State Thruway for “5-axle 48’ Trailer” and 
“5-axle 53’ Trailer” vehicles are now accurately reported.  The N.Y. Thruway 
lists separate toll rates for these vehicle types and now PC*MILER|Tolls has been 
calibrated to report the correct rate depending on the routing option selected.  If 
the Vehicle Dimension length is set to 53’ in the Route Options dialog, the 
corresponding 5-axle 53’ Trailer toll cost will be reported. 
 
NOTE Also:  Some toll exits in the U.S. and Canada have recently become 
“electronic only”; for example, starting December 1st, 2008, the 183A toll road in 
Texas has become cashless. The way to pay for this toll road is either by TXTag 
(their electronic toll payment method) or Pay By Mail.  Pay By Mail is for those 
who don’t have the electronic discount program – their license plates get 
photographed and a bill is mailed to the owner.  Commonly referred to as “video 
tolling” or “video billing”, the rates for this payment method are higher to cover 
processing costs. 
 
See Appendix G for a list of all electronic-only toll roads. 
 
All Pay By Mail and video toll rates are considered as “Cash” in PC*MILER toll 
rate calculations. 
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7.1  Turning On Toll Cost Calculation (U.S. and Canada only)  
(PC*MILER|Tolls must be purchased and licensed)  Toll costs can be calculated 
along with mileage, cost and time estimates when you generate any PC*MILER 
route with at least an origin and a destination using any available route type or 
option, including Hub routing.   
 
To turn on toll calculations for an individual route, select the Routes tab > Route 
group > Options > Tolls tab and make sure Tolls Enabled is checked.  This 
option is turned on by default when PC*MILER|Tolls is installed. 
 
Toll costs can be calculated with or without discount programs applied.  By 
default, Use Discount Programs is checked on in the Route Options dialog and 
all discount programs are selected.  You can customize these settings by 
unchecking the Use Discount Programs option or any of the listed discount 
programs.   
 
 

 
 

Route Options Dialog, Tolls Tab 
 
   
To switch to Canadian dollars as the currency for toll calculations, use the 
Currency drop-down list to choose Canadian Dollars.  The PC*MILER default 
Conversion Rate is displayed to the right and can be customized by simply 
typing in a new rate.  Whenever toll calculations are turned on, the currency in 
use is shown in each route window along with the discount program status. 
 
NOTE:  Settings in the Tolls tab not only affect PC*MILER, but also determine 
which discount programs will be in effect whenever you use PC*MILER|Connect, 
PC*MILER|Spreadsheets, or PC*MILER|BatchPro to calculate tolls.  
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When toll calculations are turned on, you’ll see a Tolls column in the route 
window.  Toll fees for each leg (not cumulative) will be listed in addition to 
mileage and cost/time estimates.  For total cumulative toll costs, run a State 
Summary Report or Comparison Report (see sections 8.3 and 8.6). 
 
 
 
 

 
Toll Calculation by Trip Leg in the Route Window 

 
 
The default Tolls settings are: 
 

• Tolls Enabled is checked 
• Use Discount Programs is checked 
• All discount programs are selected 
• Currency is US$ 
• Version 29 Default Conversion Rate is USD/CAD = $1.00/$1.277 
 

7.2  Customizing Toll Costs By Weight and Axle  
Jurisdictions in the U.S. and Canada that have toll roads class their toll rates either 
by vehicle weight or by a vehicle’s number of axles. Beginning in PC*MILER 
Version 22, setting the vehicle’s dimensions in the Vehicle Dimensions tab of the 
Route Options dialog enables toll cost reporting based on vehicle weight and 
number of axles.   
 
The available toll rates by axle are from 2 (two axle dual rear wheel vehicles 
only) up to 14 axles, including multi-trailer rates and automobile routing.  For toll 
rates categorized by weight, each toll road authority publishes its own definition 
of weight classes, and PC*MILER categorizes and reports these toll rates based 
on the published weight category and range provided. 
 

Discount Status & Currency Tolls Column 
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For those who are new to the arena of toll cost reporting, the jurisdictions that 
charge toll costs by weight and those that charge by axle are identified below.    
This information is important to know if you intend to use PC*MILER to 
generate toll costs that are customized by weight and axle. 

• Jurisdictions Charging Tolls by Vehicle Weight:  MI, NJ, ON, PA 

• Jurisdictions Charging Tolls by Axle: AK, AL, BC, CA, CO, DE, 
FL, GA, IL, IN, KS, LA, MA, MD, ME, MI, MN, MO, NB, NC, NE, 
NH, NJ, NS, NY, OH, OK, OR, PA, PEI, QC, RI, SC, TX, UT,  VA, 
VT, WA, and WV 

 
To enter the weight and/or number of axles for a vehicle either before or after 
stops have been entered for a route, select the Routes tab > Route group > Options 
> Vehicle Dimensions tab.   
 
 

 
Route Options Dialog, Vehicle Dimensions Tab 

 
 
In the Vehicle Dimensions tab, only the weight, axle number and multiple trailer 
settings affect toll cost reporting.  Enter these parameters as follows: 

 
Weight:  Weight may be entered in pounds or kilograms (select English or 

Metric at the top of the dialog).  Weights up to 132,000 lbs. or 59,874 
kg. may be entered.  Weights less than 9,000 lbs./4,082 kgs. will 
generate routing appropriate for automobiles and small vans.  See 
section 9.5 for more on how PC*MILER handles vehicle weight, and 
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section 11.2 on custom vehicle profiles.  Vehicle weight is 80,000 lbs. 
by default. 

 
Axles:  Select a number from the drop-down.  The default is 5 axles.  Note that 

2 axle includes two axle dual rear wheel vehicles only. 
 
Multiple Trailer (MT):  Check this option if the vehicle is a long combination 

vehicle with multiple trailers. (See Important Note below.) 
 

IMPORTANT NOTE:  Twin trailers with 7 or more axles are not allowed on the 
Massachusetts Turnpike east of Exit 14. If you enter 7 or more axles and check 
“Multiple Trailer (MT)”, PC*MILER will return a $0 toll rate for that section 
without a warning. 
 
When done, click Save to close the Route Options dialog, then generate your 
route.  PC*MILER will calculate the appropriate route and report the 
corresponding toll costs according to the vehicle dimensions you set.    
 
If custom information is not entered in the Vehicle Dimensions tab, the default 
values will be used.  The default values are based on a typical Class 8 vehicle 
with a weight of 80,000 lbs./36,287 kg. and 5 axles. 
 
NOTE:  Users have the option to set up profiles for individual vehicles or for 
specific vehicle types that include vehicle dimensions and time/cost settings (the 
same ones that are found in the Route Options dialog).  See section 11.2 for a full 
description of this option. 
 

 
7.3  Tolls and Plaza Names in the Detailed Route Report 

Toll costs are calculated by trip leg in the Detailed Route Report.  To generate this 
report, select the Routes tab > Route group > Reports > Detailed Report or press 
F5 on your keyboard.  For more on this report, see section 8.2. 

 
To assist users in toll cost reconciliation, toll plaza names have been added to the 
database.  Some plazas listed in this report have multiple sub-plazas at the same 
location, but PC*MILER assigns one name to all of them.  For a list of toll 
authorities and names where sub-plazas exist, see Appendix F.   
 
Abbreviated plaza names appear in the Detailed Route Report in a new column 
titled “Toll Plaza”.  If the Toll Plaza column is blank, either the agency does not 
have a transponder program or the agency has a transponder program but the toll 
plaza abbreviations used on that agency’s invoices could not be determined at this 
time. 
The format of the plaza names is as follows: the agency abbreviation, the entry 
plaza abbreviation, and the exit abbreviation.  In cases where the entry and exit 
plazas are the same (barrier toll), the plaza abbreviation will be shown only once. 
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NOTE:  If a Toll Discouraged route is run with toll calculation disabled in the 
Route Options dialog, and the route needs to use a toll road, the Detailed Route 
Report will report toll miles and the associated cost for that leg of the trip. 
 

 
 

 
 

          
 

Detailed Route Report 
 

7.4  Getting Toll Totals in the Comparison Report  
The PC*MILER Comparison Report calculates total toll amounts, along with 
mileage and estimated time and cost, for two or more trips.  To generate this 
report, click the Comparison button on the toolbar or press F4 on your keyboard.    
 
The two routes shown below in a sample report are identical except that the Toll 
Discouraged routing option was turned on for Route 2. 
 
 
 
 
 

 

 
 

Comparison Report Showing Toll Discouraged Routing Option 

Toll Costs by Trip Leg 
and Toll Plaza 

Toll Total 
For Each Trip 

 
 Chapter 7:  Getting Toll Costs 131 



 
  

7.5  Toll Information in the State/Country Report 
The PC*MILER State/Country Report automatically calculates toll totals at each 
stop, by state, and by trip if tolls were calculated.    
 
A breakdown of toll costs by the type of discount program applied is also 
available.   To obtain this breakdown, select the File application menu > 
Application Settings and check Show Toll Discount Info in the Application 
Setttings dialog then click Save.  This can be done before or after the 
State/Country Report is generated. Discount program information will appear in 
the state/country summary section at the bottom of the report, in the Tolls column 
(see the example below). 
 
To generate this report, first run the trip in the route window, then press F6 on 
your keyboard or click the State button on the toolbar.  See section 8.3 for 
additional information about this report.  The location of toll cost data in the 
report is shown below. 
 
 

 
 

State/Country Report – 
Display of Toll Costs and Discount Program Information 

 
 
 
 
 
 
 
 
 
 
 
 

State/Country Report with Toll Discount Information (Print Preview) 
 
 

NOTE:  If a Toll Discouraged route is run with toll calculation disabled in the 
Route Options dialog, and the route needs to use a toll road, the State/Country 
Report will report toll miles and the associated cost for that leg of the trip. 

Toll Amounts  
by State/Country 

Toll Total 
For the Trip 

Discount Information – 
“Show Toll Discount Info” 
must be turned on in the 

Application Settings dialog. 

Leg Tolls & 
Toll Total at 
Each Stop 
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Generating Reports 
 

In addition to the mileage, time and cost information that is returned when a route 
is run, there are six different PC*MILER reports that can be generated:  Mileage, 
Detailed Route, State/Country, Driver’s, Road Type, and Comparison.   
 
When a report is generated, it opens in a separate pane.  You can control the 
location of this pane within the PC*MILER application window using the Report 
Location and Layouts buttons in the Window tab.  Any subsequent reports will 
open in the same pane. 
 
 
 
 

To float an individual report in its own window, right-click the report title in the 
tab at the top of the report, then select “Float”.  To dock it, right-click the report 
title again and select “Dock”. 

 

 
Display Options for an Individual Report Window 

 

8.1  Mileage Report 

When a route is run, mileage, time and cost information is returned in the route 
entry window.  A Mileage Report can be printed that summarizes this information 
and also includes cumulative miles by trip leg and greenhouse gas estimates.  
Select the File application menu > Print Report > Mileage.   
 
Note that this report does not appear on-screen, printing it is the only way to 
generate it.   
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Printed Preview of Mileage Report 

 

8.2  Detailed Route Report 

After running a route, select the Routes tab > Route group > Reports > Detailed 
or press the F5 key to display a Detailed Route Report for the active route.   
 
 

 
 

Detailed Route Report 
 
 
This report includes direction of travel, roads, interchanges, times and distances, 
stops, and toll costs (if PC*MILER|Tolls is installed and toll calculation is turned 
on).  The report displays additional information depending on the options selected 
when the route was run.     

TIP:  You can double-click a line in this report to zoom into that route segment 
on the map. 
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The columns from left to right in the Detailed Route Report give you the 
following information for each route segment: state/country, toll or free road, 
direction of travel, route (with exit number where available), distance, driving 
time, interchange point, cumulative distance and time for the trip leg, and 
cumulative distance and time for the whole trip.  For each stop on the route, the 
on-duty status and duration is shown. (The default for these values is on-duty and 
0 hours.  Stop times and on-duty status can be set in the HOS Manager, see 
section 3.11.) 
  
If PC*MILER|Tolls is installed and toll calculations are enabled, leg toll costs and 
the corresponding toll plazas will be shown in two columns on the far right.   
 
If ETA/ETD information was entered for the route, there will be an additional 
Stop Time column to the far right.  This column will show the estimated time of 
arrival at every stop and toll plaza on the route.  If a target arrival time was 
entered, the estimated departure time from the origin will be shown.  If a 
departure time was entered, that time will be shown at the origin.  The column 
header for the Stop Time column will reflect the Time Zone Display setting (File 
application menu > Application Settings).    
 
A dollar sign ( $ ) to the left of the directional column marks segments that are 
toll roads.  Alerts such as height, weight, 53-Foot restrictions, and geofence 
warnings are noted where they exist, appearing before the pertinent road segment 
in the report.  (See section 1.6.5 for more on 53-Foot restrictions in reports.)   
 
NOTE:  Due to the way PC*MILER identifies locations and calculates routes and 
distances, occasionally a toll barrier won’t be reported in the Detailed Route 
Report.  When this happens anywhere on a route, an alert will appear at the very 
bottom of the report stating that this has occurred.  You can then check all route 
segments marked with a dollar sign to find the omission. 
 
At the point where a route begins to use a road segment that travels through a 
geofenced area, a warning like this will appear that includes the name of the road, 
the name of the geofence set, and the name of the individual geofence: 
 
Warning * US-1 * : New Jersey : NewBrunswickNJ  

 
If one of the Hazardous Material route types was used (PC*MILER|HazMat 
installation is required), the Detailed Route Report will include a Restriction 
column on the far right.  Any restricted road segments on the route will be labeled 
with the appropriate hazmat restriction type in this column.  (PC*MILER uses 
these route segments in its calculations only if no other alternative is possible, or 
the alternative is extremely impractical.)  Routes designated as preferred for 
hazardous materials will not be indicated in the report. 
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Detailed Route Report Showing HazMat Restriction Column 
(PC*MILER|HazMat installation required) 

 

8.3  State/Country Report 
 

 
 

State/Country Report with Toll Information (Print Preview) 
(PC*MILER|Tolls installation required for toll cost calculation) 

 
 
After running a route, you can select the Routes tab > Route group > Reports > 
State/Country or press the F6 key to display a table summarizing mileage by state, 
province, or country traveled.  
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The State/Country Report lists leg and total miles, cost, and time estimates in 
columns from left to right.  Leg and total toll costs will also be shown if 
PC*MILER|Tolls is installed and toll calculation is turned on.  The last two 
columns show leg and cumulative greenhouse gas estimates in pounds or 
kilograms of carbon dioxide equivalent per gallon/liter of fuel.  (Values that affect 
cost, time, toll and greenhouse gas estimates are set in the Route Options dialog.)  
A breakdown of the route by state/country and category is at the bottom of the 
report.   
 
If PC*MILER|Tolls is installed and toll calculation is turned on, a breakdown of 
toll costs by the type of discount program applied is also available.  Select the File 
application menu > Application Settings and check Show Toll Discount Info in the 
Application Settings dialog, then click Save.  This can be done before or after the 
State/Country Report is generated.  You will see the discount breakdown in the 
Toll($) column in the summary section. 
 

 
8.3.1  Order of States in the State/Country Report 

 
In the State/Country Report, states and countries are displayed in alphabetical 
order by default.  To display them in the order they occur along the route, select 
the Routes tab > Route group > Options (or to change the default setting, General 
group > Defaults) and choose Route Order under State/Country Report Order.  
States/countries will now appear on the report as they would in a driver log. 
 

8.4  Driver’s Report (Driving Instructions)    
Select the Routes tab > Route group > Reports > Driver’s to generate easy-to-read 
detailed driving instructions with turn directions and distance between turns, and 
driving times that include the duration of each stop if entered in the HOS 
Manager.  This report includes all alerts that appear in the Detailed Route Report. 
 

 
 

Driver’s Report (Print Preview) 
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If the route was run using real-time traffic data and the departure time for the trip 
is within 15 minutes of the current time, the Delay column just to the right of the 
Time column identifies delays caused by the current traffic conditions on the first 
15 miles of the trip.  
 

8.5  Road Type Report 

Select the Routes tab > Route group > Reports > Road Type to generate a distance 
breakdown by PC*MILER road category for the active trip.  See section 9.6.1, 
Average Road Speeds, for detailed descriptions of these road types. 

 
 

 
 

Road Type Report (Print Preview)  
 

8.6  Comparison Report 

If two or more routes have been generated and are open, a Comparison Report is 
available that lists the total mileage, cost and time estimates for all open routes. 
To create this report, select the Routes tab > Utilities group > Comparison Report 
or press F4 on your keyboard.   
 
Columns from left to right show trip totals for miles, estimated cost, estimated 
hours, toll costs (if PC*MILER|Tolls is installed and toll calculation is turned on), 
estimated fuel cost, estimated cost of labor, estimated miscellaneous costs, and 
estimated greenhouse gas emission (these last four columns are not shown in the 
resized report window below).  Values that affect cost, time, toll and greenhouse 
gas estimates are set in the Route Options dialog. 
 
 

 
Comparison Report, Practical vs. Shortest Routing (Print Preview) 
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NOTE:  The Comparison Report lists only the origin and destination of each 
route.  If there are stop-off points in one route and no stop-offs in another, the 
mileage discrepancy between these routes could be large.  Be sure to check 
intermediate stops in the route window if you see differences in mileage that are 
larger than expected. 

 

8.7  Font Size and Page Layout 
To see a preview of how the report will look when it is printed, check Show Print 
Preview in the upper left corner of the report.  The Print Preview view will be 
displayed along with a toolbar for editing the page layout and font size.  Place 
your cursor over any button on the tool bar to see a tooltip that briefly describes 
what that button is for. 
 
To change the font size in the active report, use the Font Size drop-down on the 
toolbar.  For adjustments to the page layout, there are six buttons that control 
formatting (portrait vs. landscape) and magnification. 
 

 
 
To hide columns or change their position or width, right click on any column 
header in a report and click on “Column Chooser”.  See section 3.12.2 on how to 
use the Column Chooser.   

 

 
Right Clicking a Column Header in a Report 

 

8.8  Printing Reports 

All PC*MILER reports can be printed.  To print a report, first check Show Print 
Preview in the upper left corner.   
 
 
A toolbar for editing will display and you’ll be able to see what the printed copy 
will look like.  To print, do one of the following: 
 
1.  Click the Print button (upper right corner);   

2.  Click the Print icon on the toolbar; or 

3. Press Ctrl+P.   
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To directly print a report without first generating it in its own window, select the 
File application menu > Print Report > and choose a report type.        

 

8.9  Saving and Copying Reports 
 

PC*MILER reports can be saved to disk – choose Save Report to File from the 
File application menu.  In the Save Report dialog, select the folder where the file 
will be saved and enter a file name in the File Name field.  Click OK to save.  
  
In addition, PC*MILER reports can be copied to the clipboard for use with other 
Windows® programs such as Microsoft® Word.  To copy and paste a report: 
 

1. Select the report in the Reports window. 

2. Check Show Print Preview in the upper left corner. 

3. In the toolbar that displays, click the Copy icon.   
 

4. In the application you are copying to, press Ctrl+V to paste. 
 
 
NOTE:  With some reports you may get better results if you save the report as a 
.CSV (comma separated value) file and then import that file into your target 
application.  This may be especially true for the Detailed Route report with its 
many columns.  To save the active report, select the File application menu > Save 
Report to File and select “.csv” as the file type. 
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Using Route Options  
 
 
The Route Options dialog enables you to change the options and parameters used 
to calculate a route.  There are three ways to open the Route Options dialog: 
 

• Select the Routes tab > Route group > Options; 
• Press Alt+F3; or 
• Click the gear button (     ) in a route window and choose Options. 

 
When you edit routing options in this dialog, only the currently active route 
window will use the new parameters.  If you open a new route window, it will use 
the PC*MILER default options.  To edit the defaults, see section 9.7.  Note that if 
you save a route, the options that were active for that route will be saved along 
with it. 
 
PC*MILER chooses routes by minimizing a cost equation that combines distance, 
certain factors times distance, and certain fixed factors.  A PC*MILER user can 
choose between different versions of the equation and numerical values by 
choosing among different routing options.  Options in the General, Vehicle 
Dimensions, and Hazmat* tabs affect which route is chosen.  The Cost/Time, 
Road Speeds, and Tolls* route options affect time/cost and toll data that is 
returned when a route is generated, but do not affect which route is chosen. 
* The Hazmat and Tolls tabs are available only if the related data modules have been purchased.  
 

 

 
Route Options Dialog 
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9.1 Route Name 
The Route Name field at the top of the Route Options dialog can be used to 
assign a name to your route that will appear at the top of the route window, in the 
title bar of report windows, and in the Route legend in the map window.   
 

9.2  Route Profile 
The Route Profile drop-down in the upper right corner of the Route Options 
dialog will list all custom route profiles that have been created in PC*MILER (see 
section 11.3). When you select a profile, the options specified by that profile will 
be in effect for the route.  Using a route profile is optional. 
 

9.3 General Options 
 

 
 

Route Options Dialog, General Tab 
 

 
9.3.1  Region 

 
North America is the only region that is available with PC*MILER.  If 
PC*MILER|Worldwide or DTOD data is installed, other regions can be selected: 
click the down arrow and select a region from the drop-down.  Available 
worldwide regions are: Africa, Asia, Europe, Middle East, Oceania and South 
America.  The active region is displayed at the top of each new route window. 
 
To change the default region from North America to another region, see section 
9.7 on creating default options. 
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9.3.2  Route Type 
 

NOTE:  Changing the route type may affect the time and cost estimates that are 
calculated for any given route.  See the explanation of how route type affects 
routing at the beginning of Chapter 9.     
 
In the drop-down Route Type list you will see the three basic route types that 
PC*MILER can generate: Practical, Shortest, and Fastest.  Fastest routing is 
available only if  PC*MILER|Traffic is installed and activated.  See sections 1.6.1 
– 1.6.3 for full descriptions of these route types.  

In addition to selecting a basic route type, check any of the routing options to the 
right that you wish to apply to route calculations: 

Toll Discouraged:  Avoids long stretches of toll roads without taking long or 
impractical detours to avoid toll bridges and tunnels.  See section 1.6.6 for the full 
description. 

National Network:  (U.S. only)  Based on the National Network, a U.S. 
government-designated system of highways originally established by the Surface 
Transportation Assistance Act of 1982 (STAA).  This option will calculate routes 
that stay on the National Network to the maximum extent possible.  Given that 
many areas are not directly served by the National Network, the origin and stop-
offs on a route may not be on the Network.  See section 1.6.4. 

53' Trailer or Twins:  (U.S. only)  This option is only available if National 
Network is checked.  Its calculations are based on National Network routing, with 
the addition of roads that permit 53’/102” trailers or twins.  See section 1.6.5 for 
the full description. 

Hub Routing:  Check this option to generate mileage from one origin to a 
virtually unlimited number of destinations.  See section 9.3.3. 

Borders Open:  If Borders Open is checked, PC*MILER will ignore international 
boundaries in generating the best route.  If this option is not checked, the number 
of border crossings will be minimized; for example, if all your stops are in the 
“lower 48” United States, the resulting route will stay in the United States even 
though the most practical or shortest route would normally involve some 
Canadian mileage.  “Open” or "Closed" will appear in the title of each route 
window, indicating which option is selected. 

Use Custom Roads: If checked, the route you run will take into account the road, 
state, and override preferences found in the Avoid/Favor and States/Roads 
Managers.  "Custom" will appear in the title of the route window when this 
options is active.  See sections 11.1-11.3.   This box must be checked for user-
designated road preferences to be active when running routes. 

Override Restrictions:  Check “Override Restrictions” to generate routes that 
waive truck restrictions pertaining to specific sizes and weights, but that continue 
to avoid truck-prohibited and truck-discouraged roads.  When this option is 
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active, all height, length, width and weight restrictions will be overridden.  If a 
route uses roads that have any of these types of restrictions, the Detailed Route 
Report will list them.  This allows you to determine the largest or heaviest vehicle 
you can assign to drive that route. 

By default the Override Restrictions option is not checked, in which case 
PC*MILER routing will avoid truck-prohibited and truck-discouraged roads, as 
well as truck-restricted roads that pertain to the size and weight set in the current 
vehicle dimensions or profile. 

Below is a table showing the North American states/provinces that have a 
jurisdiction-wide weight limit, with exceptions listed. 
 

State/ 
Province 

Weight 
Limit* 

Exceptions Ref. 

SK 76,038 lb 
(34,500 kg) 

- 87,058 lbs (39,500 kg) on designated primary highways year-round and other 
designated primary highways for 9 months/year, and a maximum distance of 15 
kilometers on any secondary provincial [not including municipal] highway or 
provincial road 
- 91,466 lbs (41,500 kg) on most roads in winter, i.e. Nov16-Mar14 (except for 
certain restricted exceptions) 
- special restrictions on certain listed highways 

(1) 
(2) 

MB 76,038 lb 
(34,500 kg) 

- 82,650 lbs (37,500 kg) on designated “A1” highways 
- 87,058 lbs (39,500 kg) on designated “RTAC” highways 
- Winter weights higher in some cases 
- “If a delivery needs to be made off of a designated truck route the vehicle is 
allowed to stray from the truck route via the shortest distance to its destination.  
Once the delivery has been completed the vehicle must return to the truck 
route the same way” 

(3) 
(4) 

*  For the PC*MILER default vehicle configuration:  5-axle tractor/48’ long semitrailer 
combination.  Higher limits > 80,000 lbs apply in SK & MB for 6+ axles. 

Ref: 
1. http://www.highways.gov.sk.ca/trucking/ 
2. Saskatchewan Vehicle Weight and Dimension Regulations, 1999, page 17, Sec 12(1)(KK) 
3. http://www.gov.mb.ca/mit/mcd/mcpd/pdf/normalloading.pdf & http://www.gov.mb.ca/mit/mcd/mcpd/twlm.html 
4. Email from Dwight Solon, Director, Motor Carrier Enforcement Programs, Province of Manitoba, 11/03/08 

 
NOTE for PC*MILER|Streets Users: An error message will appear if you 
attempt to enter an address that is on a truck-prohibited road. 

SAFETY NOTE:  For winter roads in Manitoba and North West Territories, 
Canada, road safety information for heavy vehicles using these roads can be 
found at: http://www.gov.mb.ca/ 
 
Use Highway Only:  (PC*MILER|Streets required for street-level routing) This 
option is enabled by default except when PC*MILER|Streets, PC*MILER|Energy 
and/or RouteSync is licensed and installed.  When checked, routes are calculated 
using an air distance from the midpoint of the truck-usable highway segment that 
is nearest to the destination postal code or city/state.  Routes to stops that include 
a street-level address are calculated to the truck-usable highway-level road that is 
closest to the entered address.  This functionality matches the base PC*MILER 
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highway product.  If this option is not checked, PC*MILER calculates the route 
and driving distance using local streets between the nearest truck-usable highway 
segment and the stop. All stops, whether they contain a street-level address or not, 
clean up via the shortest air distance to the nearest road (highway or street level).  
This distance may appear as “Local” in the Detailed Route report.   
 
Ferry Discouraged:  When checked, routes will avoid ferries if possible, i.e. 
unless it would be extremely impractical or impossible to do so.  No warnings are 
issued when a ferry must be used on a Ferry Discouraged route. 

Use Ferry Distance:  Includes ferry distances in mileage and cost calculations.  
When turned off, the ferry portion of a route will not contribute to the mileage and 
cost.  The setting does not affect the actual route on the map and travel time is not 
affected.  Note that the “Total” column of the State/Country report always 
includes ferry distances, even if this option is turned off here.  

Elevation Discouraged:  This option enables users to set a customized limit on 
the elevation of the roads a route will use.  Enter the elevation in feet that should 
cause PC*MILER to calculate an alternate route.  Elevations at or above this 
height will be avoided unless 1) it is extremely impractical to do so; or 2) a stop 
or destination on the route is located at the higher elevation.  No warnings are 
issued when a road that exceeds the elevation limit must be used.  Elevations are 
from the National Elevation Data produced by the U.S. Geological Survey. 

The default route type settings are: 

• For North America:  Practical, Borders Open, Highway Only*, Use Ferry 
Distances, Discount Tolls – USD** 

• For All Other Regions: Practical, Borders Open, Highway Only*, Use Ferry   

* If PC*MILER|Streets, PC*MILER|Energy or RouteSync is installed, street-level routing is 
the default for this option 

** PC*MILER|Tolls must be installed  
 
 

9.3.3  Hub Routing 
 
PC*MILER enables you to generate mileage from one origin defined as the "hub" 
to an unlimited number of destinations in the same route window.  This type of 
route calculation gets its name from the image of a wheel with spokes and a hub 
at the center. 
 
To generate a route in Hub mode, check Hub Routing in the Route Options 
dialog and click Save to save this setting.  All subsequent routes run in the current 
route window will be in Hub mode unless this setting is changed.  The Detailed 
Route Report and State/Country Report are both available for hub routing.  
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Hub Routing with New York, NY 10001 as the Hub 
 

 
9.3.4  Unit of Measure Options 

 
PC*MILER will report distances in either English or Metric units.  The unit of 
measure route options affect trip costs, average road speeds, and the distances 
shown on reports and in route windows when you generate a route.   
 
Under Length and Distance in select English (miles, feet, inches) or Metric 
(kilometers, meters, centimeters).  Under Fuel in select Gallons or Liters. The 
default settings for all world regions are Miles and Gallons. 
 

 
9.3.5  State/Country Report Order 

 
Choose whether State/Country reports will have states/countries listed in 
Alphabetical order by state/country, or in the Route order (as in a driver log).  
The default setting is alphabetical. 
  

  
9.3.6  Report Memo (Customized Reports) 

 
The Report Memo field allows you to create custom report headers.  The text 
you type in this field will appear at the top of all printed reports (check Show 
Print Preview in the Reports window to see how the header looks).  By default 
the Report Memo field is left blank. 
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9.4  Cost/Time Options – Trip Costs 
 

 
 

Route Options Dialog, Cost/Time Tab 
 
 
PC*MILER calculates a total cost for each route generated.  This cost estimate is 
determined by multiplying a dollar amount per mile by the number of miles.  Cost 
parameters can be edited for empty and loaded miles to better reflect your actual 
costs, or you may choose to use the PC*MILER default values.   

 
In the Cost/Time tab of the Route Options dialog, the trip costs that go into the 
dollar amount per mile have been broken out into fuel costs, labor costs, and 
“other” maintenance or miscellaneous costs.  For information purposes only, a 
greenhouse gas emissions value is also included.  You will see these values 
reflected in the columns of the Comparison report.  The greenhouse gas estimate 
also appears in the State Distance Summary report.   
 
 

9.4.1  Fuel Costs 
 
NOTE:  If the measure of distance is set to Metric and/or the unit of measure for 
fuel is set to Liters in the General tab, the units and default values in the 
Cost/Time tab will change accordingly. 
 
Fuel Cost Per Gallon/Liter:  All world regions have the same default value for 
fuel cost, depending on the unit of measure (see note above), as follows: 
 
• Per Gallon = $2.78 • Per Liter = $.73 
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Miles/Kilometers Per Gallon/Liter: Default values for all world regions are:  
 
• Miles/Gallon = 6.48 • Miles/Liter = 1.71 
• Kilometers/Gallon = 10.43 • Kilometers/Liter = 2.75 

 
Fuel Cost Per Mile/Kilometer:  (For reference only) Values in these fields are 
based on the Fuel Cost Per Gallon and MPG, and are used only to calculate the 
fuel cost total that appears in the Comparison Report (this report is automatically 
created when Least Cost routing is generated, or it may be run whenever two or 
more generated routes are active). 
 
NOTE:  For reference information pertaining to default fuel costs, see the notes at 
the end of section 1.3, What’s New in PC*MILER 29?. 
 
 

9.4.2  Labor and Other Costs 
 
Enter your own Other Cost Per Mile and Labor Cost Per Mile values, or use 
the default values.  Labor and Other cost totals for a route appear only in the 
Comparison Report (this report is automatically created when Least Cost routing 
is generated, or may be run whenever two or more routes have been generated).   
 
The default values for these settings in all world regions are: 

 
• Other Cost Per Mile (loaded or empty) = $0.19 
• Other Cost Per Kilometer (loaded or empty) = $.12  
• Labor Cost Per Hour (loaded or empty) = $32.89 

 
NOTE:  For reference information pertaining to default trip costs, see the notes at 
the end of section 1.3, What’s New in PC*MILER 29?. 
 
 

9.4.3  Greenhouse Gases Emission Estimate 
 
Enter the pounds per gallon (or liter) emissions as CO2 equivalent in the 
Greenhouse Gases field, or use the default values.  Leg and total greenhouse gas 
(GHG) emission estimates appear in the State/Country Report, and a total GHG 
estimate appears in the Comparison Report (this report is automatically created 
when Least Cost routing is generated, or may be run whenever two or more routes 
have been generated). 

 
The default Greenhouse Gases settings for all world regions* are as follows: 
 

• If Gallons are selected in the Fuel In field: 22.20 lbs. 
• If Liters are selected in the Fuel In field: 5.86 lbs. 
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*  These default settings are based on values for North America that were provided 
by the U.S. Environmental Protection Agency (EPA).  For more information, see 
http://www.epa.gov/otaq/climate. 

 
 

9.4.4  ETA/ETD 
 
A target arrival or departure date/day of the week and local stop time can be set 
for the trip under Time Costs.  With this setting active, PC*MILER will return an 
estimated time of arrival/departure (ETA/ETD) at each stop on the route.  This 
same setting is found in a drop-down in each route window.  See Chapter 5, Time-
Based Routing, for more information.  This setting can be included in custom 
route profiles – see section 11.3.  Follow the steps below: 

 
1. Select either Depart by or Arrive by.  Depending on your choice, 

PC*MILER will calculate time estimates at each stop based on either a 
departure time at the origin of the trip or an arrival time at the trip’s final 
destination. 

2. Select either a Specific Date or Day of the Week as the target day for 
departure or arrival.  For a specific date, you can either type in a date in the 
format MM/DD/YYYY (zeros are not necessary for single-digit months and 
days), or click the calendar icon to choose a day from the calendar.  For a day 
of the week, select a day from the drop-down list. 

3. Enter the targeted local time at the trip’s origin (if entering a departure time) 
or destination (if entering an arrival time). 

4. Click Save to save your settings. 
 
 

9.4.5  Stop Costs 
 
Beginning in Version 29, stop times and costs can be entered in the HOS 
Manager.  See section 3.11, Hours of Service Management, for details. 
 

9.5  Vehicle Dimensions   
The vehicle dimension options enable you to generate routes based on custom 
vehicle dimensions.  Building on the foundation of PC*MILER’s previously 
existing routing database and routing options, users can generate routing that 
conforms to the requirements of a vehicle’s height, length, width and weight. 
 
If a vehicle weight and/or height is entered, PC*MILER route calculations will 
take into account restrictions on roads and bridges to ensure that the vehicle’s 
weight/height is below the restriction(s).  Vehicle weight, length and width 
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information is checked against the threshold at which a truck becomes 
“oversized” and appropriate routing is generated. 
 
Additionally, PC*MILER supports calculation of routes and toll costs for smaller 
vehicles (vans, pickup trucks, SUVs, automobiles, etc. that are classed less than 
9,000 lbs./4,082 kgs.) with a “Full-size van” profile option or your own custom 
vehicle profile that includes dimensions that meet the required criteria.  
 

 

 
Route Options Dialog, Vehicle Dimensions Tab 

  
 

9.5.1  Vehicle Dimensions, Profiles and Types 
 

Below is a description of how PC*MILER vehicle types, profiles and dimensions 
are related. 
 
The Vehicle Type indicates how PC*MILER will route the vehicle.  You will see 
the vehicle type displayed in the upper right corner of the Vehicle Dimensions 
tab.  The vehicle type is determined by the vehicle dimensions entered, either 
manually or by choosing a Vehicle Profile.  In other words, the vehicle type will 
update automatically when dimensions are changed.  It is informational only and 
cannot be edited by the user.  Possible categories are Auto, Truck (Medium-
Duty), or Truck (Heavy). 

 
A Vehicle Profile (full-size van, 48 ft semitrailer, etc.) is a template containing a 
particular combination of vehicle dimensions that can be conveniently reapplied 
as needed.  A selection of vehicle profiles are shipped with the software and 
appear in the Vehicle Profile drop-down out of the box.  Vehicle profiles can also 
be defined by end users (see section 9.5.5).  Custom vehicle profiles appear in the 
Vehicle Profile drop-down in Route Options after they are created and saved. 
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Vehicle Dimensions (weight, length, height, width, axles, trailers) are specific 
values that will affect the selection or avoidance of road segments that restrict 
vehicles to below those dimensions.  These dimensions can trigger warning 
messages if a restriction is violated because an alternate road segment was either 
unavailable or too impractical.  Additionally, the number of axles is used in 
calculating tolls.  Vehicle dimensions determine the vehicle type (mentioned 
above) as shown in Table 1 below.  
 

Table 1.  PC*MILER Rules for Inferring Vehicle Type from Vehicle Dimensions 

 
Dimension Automobile 

if ALL values 
are less than  
or equal to 

Medium Truck  
if ALL values  
are less than or  
equal to 

Heavy truck 
All other 
values are 
regular 
heavy truck, 
unless… 

In USA, Nat’l 
Network and 
State Oversize 
if ANY values 
are greater 
than 

In Canada* in 
SK and MB, 
State Oversize 
if greater than 
*see note below 

In Canada* in MB, 
National Network if 
greater than 
*see note below 

Weight 8,500 lbs. 26,000 lbs.    76,038 lbs. 
(34,500 kg.) 

82,650 lbs. 
(37,500 kg.) 

Length 20 ft. 26 ft.   48 ft.   
Height 7 ft. 13 ft. 6 in.      
Width 96 in. 96 in.   96 in.   
Axles 2 (4 tires) 2 (6 tires)      
Trailers None None      

 
 
* The rules for Canada in the table above are for truck tractors with a single 5 or 6 
axle semi-trailer.  Customers who run heavy straight trucks (this would be 
unusual) or doubles (more common) in SK or MB are advised to consult the 
Weights and Dimensions Compliance Guides published by those provinces, and 
to select the PC*MILER National Network and/or 53 ̍Foot Trailer or Twins route 
type as appropriate. 
 
NOTE:  An alternative to entering vehicle dimensions manually is, where 
appropriate, to select the PC*MILER National Network and/or 53 Foot Trailer or 
Twins routing type. 
 
NOTE ALSO:  If the user enters a vehicle height over 13 ft. 6 in., PC*MILER 
will avoid jurisdictions with lower overall limits in its calculations wherever 
possible and practical.  You will receive a warning message in the Detailed and 
Driver’s reports if any of these jurisdictions cannot be avoided on a route. 
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9.5.2  Setting Vehicle Dimensions  
 
NOTE:  Oversize permits will allow for “normal” truck routing if you have 
purchased the appropriate permits for your oversize vehicle for routing on 
assumed 80,000 lb./36,287 kg. roadways (see section 9.5.3 below).  Nonetheless, 
if the route includes a road segment for which the truck as configured will require 
a permit, the destination will be represented by a solid red circle in the route 
window (position the cursor over it to see the warning) and a warning will appear 
in the Detailed and Driver’s reports. 
 
Units:  Select English (feet, inches, and pounds) or Metric (meters and 
kilograms) as the unit of measure for the options in this tab.  The default is 
English in all regions 
 
Height:  The maximum vehicle height is 13 feet 6 inches, or 4.11 meters, and this 
is the default setting for all regions except Europe.  For Europe, it is 12 feet 5 
inches, or 3.78 meters.  The minimum height is > 0.  
 
Length:  The maximum trailer length is 53 feet or 16.15 meters, and this 
is the default setting for all regions except Europe.  For Europe, it is 39 
feet 4 inches, or 11.99 meters.  The minimum length is > 0.   
 
NOTE:  If the 53' Trailer or National Network routing option is selected in the 
General tab and a custom vehicle dimension is also entered in the Length field, 
both attributes are weighed in the overall calculation but the routing option takes 
precedence. 

 
Width:  For English units, select 96 or less, 102 or more, or 98.  For Metric units 
select 2.44 or less, 2.59 or more, or 2.48.  Note that entering the larger vehicle 
width category will use National Network routing in the U.S. and Canada except 
where necessary for local deliveries.  The default width setting for all regions is 
96 or less. 
 
Weight:  For all regions except Europe, weights up to 132,000 lbs. or 59,874 kg. 
may be entered, and minimum weight is 1000 lbs. or 454 kg.  In Europe, the range 
is 1500 – 156,748 lbs. or 680.39 – 71099.7 kg.  Weight less than 9000 lbs./4082 
kg. will generate routing appropriate for automobiles and small vans (see section 
9.6.4).  See section 9.5.1 above for more on vehicle weight.  The default weight 
setting for all regions is 80,000 lbs.  
 
Axles:  (For PC*MILER|Tolls users only)  The number of axles entered here is 
used only for the calculation of toll costs using the PC*MILER|Tolls add-on 
module.  If PC*MILER|Tolls is not installed, this option will be disabled.  See 
Chapter 7 for toll cost calculation information.  The default number of axles is 5. 
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9.5.3  Permit and Multiple Trailer Options 
 
Permit: If you try to enter a weight greater than 80,000 lbs/36,387 kg and this 
option is not checked, a warning will display in the Route Options dialog: “Trucks 
weighing over 80,000 lbs (36,287 kgs) require a permit in most U.S. states.”  
Check Permit to continue.  This field does not affect routing, it only serves as a 
reminder that a permit is usually required for the vehicle dimensions entered.  
 
Multiple Trailer (MT):  Check if the vehicle is a long combination vehicle with 
multiple trailers. (See section 7.2 for toll calculation considerations.) 
 
By default, neither of the above options are checked. 
 
 

9.5.4  Vehicle Dimensions for Automobile Routing 
 
To generate a route that ignores all commercial truck restrictions (Truck 
Restricted, Truck Prohibited and Truck Discouraged), you can either 1) use the 
“Full-size van” vehicle profile (select it from the Vehicle Profile drop-down in 
the General tab of the Route Options dialog), or 2) enter your own vehicle 
dimensions that conform to the criteria for automobile routing in PC*MILER.  
Those criteria are as follows (all criteria must be met): 

• 2 axles; 
• less than or equal to 9,000 pounds/4,082 kilograms in weight; 
• less than or equal to 7 feet/2.133 meters in height; 
• less than or equal to 20 feet/6.096 meters in length; 
• less than or equal to 96 inches/2.438 meters in width. 

 
Automobile routing will relax all regulations that pertain to trucks, allowing the 
route to take advantage of parkways and other roads that larger and/or heavier 
and/or commercial vehicles are prohibited from using.  PC*MILER will also use 
toll rates that apply to 4-tire vehicles with 2-axles, which often differ from rates 
that apply to 6-tire 2-axle vehicles.  (PC*MILER|Tolls must be installed to access 
toll costs) 
 
 

9.5.5  Custom Vehicle Profiles 
 
In addition to setting default route options, PC*MILER also lets users create 
custom vehicle profiles to enable quick entry of vehicle or fleet attribute sets that 
you use often when routing.  This time-saving feature enables you to set up and 
save groups of vehicle dimension and cost/time settings for easy access in the 
future.  Using custom vehicle profiles ensures that the defined settings are 
consistent for the particular vehicle type selected for a route.   
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To use custom vehicle profiles, select the Routes tab > Utilities group > Vehicle 
Profile.  In the Vehicle Profiles Manager dialog, you can select a profile to view, 
edit, or delete, or you can create a new custom profile.  For North America, 
sample profiles are provided in the drop-down for full-size van, 26' straight truck, 
28' double trailers, 40' straight truck, 48' semi-trailer, and 53' semi-trailer 
vehicles.  The sample profiles can be edited, but not deleted.   
 
 

 
Vehicle Profiles Manager 

 
 

To create a new custom profile, click New.  A dialog will open that has two tabs – 
Cost/Time and Vehicle Dimensions.  The editable fields in these tabs are the 
same ones found in the Route Options dialog.  Enter a profile name and the 
desired edits in each tab. When finished, click Save.  The new profile will be 
saved as a .DAT file in the Data\Base\Save folder of the PCMILER29 
installation folder. 

 
 

 
 

 
 
 

 
 
 

 
 
 
 
 
 
 
 

Options for Vehicle Profile –  
Cost/Time Tab 

Options for Vehicle Profile –  
Vehicle Dimensions Tab 
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NOTE:  The “Full-size van” profile is intended for use with vans, pickup 
trucks, SUVs, automobiles, etc. that are classed less than 9,000 lbs./4,082 kgs. 
The automobile routing that is generated from this profile ignores all commercial 
truck restrictions, and if toll rates are calculated, will use toll rates that apply to 
small vehicles with 2-axles, which often differ from rates that apply to larger 2-
axle vehicles.  
 
NOTE For PC*MILER|Worldwide or DTOD Users:  When creating, 
accessing, or editing a custom vehicle profile, you must perform the additional 
step of specifying a region.  Each vehicle profile is applicable to only one region. 
 
An unlimited number of custom profiles can be defined.  The profiles you create 
will appear in the drop-down of available profiles in the Route Options and 
Default Route Options dialogs, General tab.  
 
Once a profile is set up, it can be used globally (all new routes will use the 
selected profile in route calculations) or applied to each new route as appropriate:   
 
• To apply a profile to all new routes, choose the Routes tab > General group > 

Defaults.  At the top of the Default Route Options dialog, select the desired 
profile from the drop-down Vehicle Profile drop-down.  Click Save to save 
this profile as the default. 

 
• To apply a profile to a single route, choose the Routes tab > Route group > 

Options.  At the top of the Route Options dialog, select the desired profile 
from the drop-down Vehicle Profile drop-down.  Click Save when you are 
finished editing options for this route.  Repeat for each new route. 

 
By default, custom profiles are not used.  Sample vehicle profiles are provided in 
the Vehicle Profile drop-down (Route Options and Default Route Options 
dialogs). 
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9.6  Road Speeds 
 

 
 

Route Options Dialog, Road Speeds Tab  
 
 

9.6.1  Average Road Speeds (Estimated Travel Time) 
 
NOTE:  Custom road speeds are not available when Use Traffic Data is active.  
You need to uncheck this option to enter road speeds. 

 
PC*MILER calculates time estimates for each generated route.  These estimates 
are computed by summing up the estimated time traveled on each road segment 
on the route, plus an added stop-off time for each stop along the route if this was 
set in the HOS Manager.  
 
Each PC*MILER road class has two average road speed parameters assigned to it, 
one for “urban” and one for “rural”.  Spreading the estimated average speed over 
the various road classes gets a more accurate estimate of the total time traveled 
based on the quality of the road used.  See descriptions of road classes below.   
 
For PC*MILER default road speeds for jurisdictions in all world regions, see 
Appendix E.  
 
To customize road speeds, first select a jurisdiction from the pick list of 
jurisdictions, then enter your new road speed(s) by road class.  Click Save to save 
your changes, or Cancel to exit the Route Options dialog without saving changes.   
 
To apply your changes globally to all jurisdictions, click Update All Road 
Speeds.  These changes will affect time and cost estimates in route calculations. 
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To restore all road speeds to the PC*MILER default settings, click Reset All to 
Default.  For a table of PC*MILER default road speeds, see Appendix E. 
 
To use traffic data in time estimate calculations, check Use Traffic Data, then 
click Save to close the dialog.  This same option is available in a drop-down in 
each route window.  See section 5.2 on using traffic data.   
 
                      

PC*MILER ROAD CLASSIFICATIONS 
 

Interstate Highways • The primary function of these roads is to move high volumes of 
vehicular traffic over medium to long distances at high speeds  

• Can be accessed only via access ramps  

Divided Highways • Major arteries that move heavy volumes of traffic at moderate speeds 
• Can be limited access in some areas but may also offer access from 

local roads 
• Usually have a barrier or median that prevents movement between 

lanes of opposing traffic 
• Medians may have crossovers that are part of the normal traffic 

pattern 
• Left turns are often restricted, both off of the highway and onto the 

highway 
• Usually multi-lane 
• Many but not all U.S. highways are in this class 

Primary Highways  • Move significant volumes of traffic at moderate speeds 
• Most state roads fall into this class 

Secondary Roads • These roads move moderate volumes of traffic over short to moderate 
distances 

• Carry vehicles from local roads to higher class roads 

Ramp • A connecting road leading on or off of a main road or highway 

Local Roads • Function is to provide access to homes and properties 

Ferry • Ferry routes (boarding/exit time not included) 

Energy • Roads that lead in or out of well sites and other facilities (requires a 
PC*MILER|Energy license and installation) 
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9.7  Creating Your Own Default Options 
To change the default values for the settings in the Route Options dialog, select 
the Routes tab > General group > Defaults.  The Default Route Options dialog is 
identical to the Route Options dialog (covered in sections 9.1 - 9.6 above), but 
allows you to set and save defaults rather than changing the settings only for the 
currently active route window.   
 
Enter your edits as you would in the Route Options dialog.  Click Save to save 
your settings.  Every time you open a new route, the defaults that you set will be 
in effect.  Note that default options will not be applied to saved routes when you 
open them. 
 

 
Default Route Options Dialog – General Tab 
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   Using the  
PC*MILER Map Window 

 
 

The PC*MILER map window is like an electronic road atlas.  All routes 
generated by PC*MILER are automatically displayed in the map window.  This 
enables you to examine routes in detail, visually evaluate routing alternatives, and 
perform a variety of "what-if" analyses.   
 
 

 
 

The PC*MILER Map Window 
 

10.1  Routes on the Map 

To see a route on the map, first enter an origin, a destination, and any intermediate 
stop-off points in a route window and then click the Run button in the route 
window or press the F10 key on your keyboard.  PC*MILER will automatically 
create a graphic display of the route you just ran.   
 
Up to eight routes can be displayed simultaneously, with each route drawn in a 
different color to differentiate them.  The Route Legend on the map and a color 

C
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bar in the route window show the color used for each route (see section 10.6 on 
legends). 
 
To maximize the size of the map so that it fills the whole PC*MILER application 
window, close the Routes and Reports panes.  To toggle the map window between 
hide and display, select the Window tab > Windows group > Map Window.  To 
restore the default layout, in the same tab select Layouts > Default Layout. 

 

10.2  Frame Options 
To frame a country or area within the region selected in the Route Options 
dialog, select the Map tab > View group > Frame > Areas > and select an area 
from the sub-menu. 
 
 (PC*MILER|Worldwide only)  To frame a worldwide region on the map, select 
the Map tab > View group > Frame > Regions and choose a region from the sub-
menu.   
 
To frame the active route on the map, do one of the following: 

• select the Routes tab > Route group > Frame; or 

• select the Map tab > View group > Frame > Frame One Route >; or  
> Auto Frame Routes to automatically frame each route that is generated. 

 
To frame all currently open routes, select the Map tab > View group > Frame > 
All Routes. 
 
There are several ways to frame a stop, see section 10.3, Zoom Options, below. 

 
 

 
Framed Routes on the Map 
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10.3  Zoom Options 

The PC*MILER map window features 20 possible zoom levels.  You will see the 
current zoom level in the window’s title bar (e.g. “Zoom Level 14 of 20”).  There 
are several ways to zoom your view of the map in and out, described below.   
 
To zoom into a specific area, select the Map tab > View group > Box Zoom (this 
option is turned on by default).  Then drag a box around the area: press and hold 
the left mouse button down and drag the cursor on the map.  Repeat as necessary.  
 
To zoom directly to a stop you have entered in the route window, highlight it 
on the stop list, then do one of the following:  

• double-click the highlighted stop; 
• right-click the stop name and select Zoom to Stop from the menu; 
• select the Routes tab > Route group > Frame; 
• or choose Zoom to Stop from the right mouse menu off the map. 

Other ways to zoom your view of the map are:  
• simply double-click a point on the map; 
• use your mouse’s scroll wheel: rotate the mouse wheel up to zoom in and 

down to zoom out; 
• choose Zoom In or Zoom Out from the right mouse menu off the map; 
• or use the slider bar and compass in the upper left corner of the map as 

follows: either 1) click, hold and drag the zoom control to move up (zoom 
in) or down (zoom out); or 2) click the plus sign or minus sign to move up 
or down one zoom level.  To pan north, south, east or west as needed, 
click the directional arrows on the compass.   

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Zoom Control 

Compass 

Zoom Out 

Zoom In 
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10.4  Drag Map or Pan To Shift the View 

There are several ways to pan your view of the map in any direction. 
 
Drag the Map: 
Select Drag Map in the right mouse menu off the map or click the Map tab > 
View group > Drag Map.  With your cursor (now in the shape of a hand) in the 
map window, hold the left mouse button down and drag in the desired direction.  
The map will redraw the new view. 
 
To turn this feature off, click Drag Map again. 
 
Pan: 
One way to pan the map is: select Pan in the right mouse menu off the map, then 
select any direction from the sub-menu.  You will see the map view shift in the 
chosen direction.  Other ways to pan are using the scroll bar (see section 10.5 
below) or the compass (see section 10.3). 

 

10.5  Scroll Bars in the Map Window 

The PC*MILER map window includes scroll bars that are hidden from view until 
activated.  To activate, touch any edge of the map window with your cursor and a 
translucent scroll bar will appear.  Click on this scroll bar to move the map 
incrementally in the direction indicated by the arrow, or click and hold to pan 
your view. 
   

 
 
 
 

         
Scroll Bar for Map Panning 

Scroll Bar with 
directional arrow 
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10.6  Legends  
Legends on the map can be hidden or shown – select the Map tab > Customize 
group > Legends.  Legends that are checked in the menu will be displayed.   
 
Any legend can be moved to a different position – simply click on it, hold down 
the left mouse button, and drag it to the desired location.  Available legends are: 
 
• Road Legend: Shows how PC*MILER road 

classes appear on the map.   This legend is 
displayed by default.  Road colors will depend 
on which map style is chosen. 

 
 
 
 
 
 
 
 

Road types included in each classification in the Road Legend are: 
 

Interstate Multi-lane toll free and urban highways 
Divided Divided highways, urban access roads 
Primary Non-divided highways 
Ferry Ferries 
Secondary Non-divided highways, urban access roads, ferries 
Ramp Ramps 
Local Truck-discouraged roads (as defined by PC*MILER) 
Toll Toll roads and urban highways 
Closed Temporary road closure. 
Discouraged* Not compatible for trucks, as determined by PC*MILER 
Restricted* Most kinds of trucks prohibited, as determined by the 

controlling governmental authority.  Appears if “Truck 
Restrictions” is checked in the Map Features dialog.    
* For more on truck-discouraged vs. truck-restricted roads, see 
sections 1.6.7 and 11.1.2. 

Designated Designated 53' road network (these roads have either 
“State Oversized”, “Oversized Access”, or “National 
Network” designations on them).  Appears if 
“Designated Truck Routes” is checked in Map Features. 

Comm 
Prohibited 

Roads that are prohibited for commercial truck traffic.  
Appears if “Commercially Prohibited” is checked in 
Map Features. 
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• Route Legend:  Appears if at least one route window is open; provides a key 
to the color(s) used to draw each generated route on the map.  Routes are 
listed in the order they were generated. 

 
 

• Scale Bar:  A standard component of most maps, providing the scale of 
miles/kilometers.  Appears by default.  To change from miles to kilometers, 
use the Default Route Options dialog – see sections 9.3.4 and 9.7. 

 
 

• HazMat Legend:  If the PC*MILER|HazMat add-on data module was 
installed, a legend showing hazmat restrictions will be available. 

 
 

• Traffic Legend:  For PC*MILER|Traffic subscribers only, this legend shows 
the significance of the colors used for traffic flows on the map, along with 
update times (for real-time data) or day/time information (for historic data). 
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10.7  Hiding, Displaying and Layering Map Features 

You can control what features are displayed and in what order features are drawn 
using the Map Features dialog.  Select the Map tab > Customize group > Map 
Features, or choose Features... from the right mouse menu off the map to bring 
up this dialog. 
 
 

 
 

Map Features Dialog 
 
 
Checked features will be displayed – click any check box to toggle between 
hiding and displaying an individual feature.  Click Show All or Hide All to check 
or uncheck all listed features.  Click on the Reset button to return to the default 
settings. 
 
Additionally, the Up, Down, To Top, and To Bottom buttons can be used to 
manipulate the order in which the features on the left are drawn.  For example, 
putting “Places” on top of all other features will make points of interest (POIs) 
stand out more on the map.  The order of features in the list on the right cannot be 
changed, though they can be shown or hidden.   
 
Click OK to close the Map Features dialog and redraw the map. 
 
TIPS:  Truck Restrictions: Note that by default “Truck Restrictions” is turned 
off in the map display.  If you want to see all truck-restricted roads highlighted on 
the map, check this feature.  Then refer to the Road Legend to see the color of the 
highlight that is used in the active map style for these roads. 
 
Points of Interest: If your map is too cluttered with points of interest, uncheck 
“Places” to hide them. 
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10.8  Map Styles 
The PC*MILER map window can be drawn in one of nine available map styles.  
Each style features a different color scheme and overall appearance.  Available 
styles are Classic, Contemporary, Default, Lightness, Black and White, Night, 
Road Atlas, Satellite, and Smooth.  
 
To change the map style, select the Map tab > Customize group > Map Style > 
and click on one of the style options. 

 

10.9  Satellite Image Layer on the Map (North America only) 
(Requires Internet connectivity)  To display a photographic satellite image 
superimposed onto the PC*MILER map, select the Map tab > Customize group > 
Map Style > Satellite; or turn the “Satellite Imagery” feature on in the Map 
Features dialog (Map tab > Customize group > Map Features). 
 
For best visibility, the map should be zoomed in to at least Zoom Level 10.  (The 
zoom level is displayed in the title bar of the map window – see section 10.3 on 
the many ways to zoom your map view.)   
 
 

 
Satellite Image on the PC*MILER Map (Zoom Level 16) – Chicago, IL  
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10.10  Route Distances and Times on the Map 
Select the Map tab > Customize group > Tooltips > Route Distance to have a 
tooltip appear when you place your cursor over a generated route on the map.  The 
tooltip will show the distance between the selected point and the route’s origin, and 
between the selected point and the route’s final destination. 
 
 

 
Tooltip on Route Near Bowling Green, KY 

 
 

The estimated number of on-duty hours from the origin of a route is automatically 
shown on the map when a route is generated: 
 

 
Hours:Minutes from the Origin of a Route 

 

10.11  Right Mouse Map Menu 

A right mouse menu off the map window is available to give you quicker access 
to frequently-used map options.  To use it, place your cursor in the map window 
and click the right mouse button, then highlight the option you want.   

 

10.12  Stop Labels 
Stops are represented on the map by circle icons with borders of different colors: 
green for the origin of a trip, red for the destination, deep blue for a stop, light 
blue for an HOS rest stop, and gray for a waypoint. 

By default, each stop is labeled with the name, address (if entered) and ZIP code 
of the location, or its latitude/longitude position.  Stop labels can be toggled 
on/off by selecting the Map tab > Customize group > Stop Labels, or by selecting 
Stop Labels in the right mouse menu. 
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10.13  Using the Mouse To Pick Stops   
PC*MILER gives you the ability to enter stops in the route window directly from 
the map window without typing.  You can use the mouse to select any point on a 
highway, labeled city, unlabeled location, intersection, truck stop, or 
latitude/longitude point.  See section 3.6.24 for a description of this feature.   

 
TIP:  Notice that as you pass your cursor over the map without pressing the 
mouse button, its latitude/longitude position is automatically tracked and appears 
in the status bar in the lower left corner of the program window. 
 
Here’s an easy way to enter a latitude longitude point: right mouse click on the 
map and choose Copy Latitude/Longitude, then click in a route window’s city 
field and paste (Ctrl-V or Paste in the right mouse menu).  Note that it’s easier to 
copy lat/longs accurately at higher zoom levels. 
 

10.14  Infogroup Points of Interest on the Map (U.S. only) 

PC*MILER offers as a standard feature the ability to search, display and route to 
millions of points of interest (POIs) from Infogroup’s U.S. business database.  
Truck stops, weigh stations, business locations, rest areas, intermodal ramps, and 
many other landmarks are visible on the map.   
 
Each of the icons below represents a POI category that you might see on the 
PC*MILER map.  You can search POIs in several of these categories using the 
POI search tool in any route window (see section 3.9). 
 
TIP:  If the map is too cluttered with points of interest at a particular location, 
select the Map tab > Customize group > Map Features and uncheck “Places” to 
hide them.  

 
   

  Address   Games   Rest Area   

  Airport   Generic POI   Restaurant 

  ATM   Government/Municipal   Retail 

  Attraction   Grocery Recreation Vehicle 

  Auto Dealership   Home   Safety Camera 

  Auto Rental   Hotel   School 

  Auto Repair   LiveLink Kiosk   Toll Booth 

  Bank   Live Search   Train Station 
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           Blank (white square)   Marina   Truck 

  Border Crossing   Marker (generic)   Truck Stop 

  Bus Stop   Medical   Web Result 

  Cat Scale   Motorcycle Dealer   Weigh Station 

  Commuter Rail   Park   Wikipedia 

  Custom Place (generic)   Parking   Work 

  Entertainment   Place of Worship 

  Favorite   Public Venue 

  Ferry   Recent 

  Fuel Stop   Recreation 
 

 

10.15  Printing or Copying a Map 
The map in the PC*MILER map window can be printed or copied.  
 
To print the map, either select Print Map from the File application menu or select 
the Map tab > Utilities group > Print Map.  A standard Windows® setup dialog 
for printing will open. 

 
To copy a map to the clipboard for pasting into another Windows program, select 
the Map tab > Utilities group > Copy Map. 
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Custom Routing 
 
 
PC*MILER provides a number of ways to customize routing, described in this 
chapter, including via point creation, dragging a route on the map, avoid and favor 
preference designations, truck and hazardous material restriction overrides, and 
geofence options. 
 
IMPORTANT NOTE:  To back up your customized data, see section 11.7 in 
this chapter.  
 
  

11.1  Picking Roads to Avoid or Favor  

IMPORTANT:  The avoid/favor preferences you designate will affect routing 
only when Use Custom Roads is checked in the Route Options or Default Route 
Options dialog.  Select the Routes tab > Route group > Options or Routes tab > 
General group > Defaults, then check “Use Custom Roads” in the General tab.  
This option is turned off by default.  It does not affect via points or routes that 
have been dragged onto another road on the map.  

 
You may wish to indicate road segments that PC*MILER should avoid or favor 
when generating a route.  An avoided road segment is effectively treated as if it 
were closed unless no other road can be used for the route, or if the total trip 
distance would be increased to the point of unacceptable inefficiency.  
Favored road segments will be used unless it is not practical to do so.  
Preferences are saved in a file called “avoidfavor.db” in the Data\Base\Save 
folder of your installation. 
 
Road segments to avoid or favor can be picked from the PC*MILER map 
window.  Alternatively, you can use the map provided in the Avoid/Favor 
Manager dialog – see section 11.1.1. below for a description of this Manager.  
Here are the steps to create a road preference using either map: 
 
1. First select the Tools tab > Avoids/Favors group > Avoid Roads or Favor Roads.   

2. On the map, the cursor will now appear with a minus or plus sign. Click on 
the road segment to be avoided/favored (zoom in for a closer view if 
necessary).   

NOTE:  To deselect Avoid Roads or Favor Roads, click the active tool again. 

IMPORTANT:  The Avoid and Favor tools won’t be available if there is no 
set selected, or if more than one set is selected – see section 11.1.4. 

C
ha

pt
er

 
11 
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3. An Add Comments box will appear on the map.  To add a comment that will 
be saved along with the avoid/favor, type it in then click OK.  (A comment 
can also be added at a later time – see section 11.1.1 below.)  If you do 
nothing, the dialog will close on its own as soon as another action is initiated. 

 
NOTE:  If you don’t want the Add Comments box to keep appearing, check 
“Do not show this dialog again” in the lower left corner.  To activate it 
again, select the red File menu > Application Settings and check Show 
Custom Road Comment Box, then click Save. 

 

 
Add Comments Dialog 

 
 
4. The selected road segment will be marked with red highlighting if it is to be 

avoided or green highlighting if it is to be favored. You may need to click on 
several adjoining segments to cover the entire area you wish to designate.   

 
 

 
Avoid and Favor Designations on the Map – Philadelphia, PA 

 

5. If you want to cancel an existing preference on the map, click on the road 
segment again with the Avoid Roads or Favor Roads tool selected.  

 
NOTE on Favored Roads:  The PC*MILER long-distance “backbone” contains 
the roads that PC*MILER uses for its default Practical and Shortest routes over 
long distances.  If a favored road is not in the PC*MILER long-distance 
backbone, it will not be used for long-distance routes even if it is favored, unless 
an intermediate stop on that road is inserted into the route. 
 

Favor 

Avoid 
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11.1.1  Using the Avoid/Favor Manager 
 
All avoid/favor road preferences are saved in the Avoid/Favor Manager.  To open 
this dialog, select the Tools tab > Avoids/Favors group > Manager or press 
Alt+F2 on your keyboard. 
 
From within this Manager dialog you can create, delete, edit or export existing 
avoid/favor preferences using the tabs, buttons and map provided.   
 
 

 
Avoid/Favor Manager 

 
 

In the Avoid/Favor Manager, you will see a map that includes most but not all of 
the functionality that exists in the PC*MILER map window.  It can be used just 
like the PC*MILER map to designate road preferences – click one of the 
avoid/favor buttons at the top (Avoid Roads, Favor Roads, Toggle Overrides, 
or Adjust for Permits), then click a road segment on the map to add it to the list 
in the corresponding tab.  Clicking again on the designated road segment deletes 
the preference.   
 
See section 11.1.2 below on overriding truck restricted roads, and section 12.3 on 
overriding hazardous material restrictions to accommodate hazmat permits. 
 
The Avoid/Favor map can be navigated like the PC*MILER map using the 
translucent scroll bars at the map’s edges, or the Drag Map and Box Zoom 
functionality via the buttons at the top.  A right mouse menu provides additional 
options.  To zoom your map view to a road segment listed in any tab of the 
Manager, first highlight it in the applicable tab and then double-click. 
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To delete an individual route segment from any tab in the Manager, highlight it 
and click the “X” on the far right.  Click Delete All to delete the entire contents of 
the list in any tab.  
 
To add or edit a comment, highlight a preference, then click it again and type 
directly in the Comments column. 
 
To save your edits and close the Manager, simply click the “X” in the upper right 
corner to close the window. 
 
 

11.1.2  Overriding Truck-Restricted Roads 
   

NOTE:  A road that is flagged as “truck-discouraged” (versus “truck-restricted”) 
in the PC*MILER database cannot be overridden only by using the method 
described below.  In addition to overriding the road, you must designate all the 
road segments on it as favored to make it fully truck-accessible (see section 11.1 
above).  To determine if a road is truck-discouraged, refer to the Road legend on 
the map for the color of the highlighting used to indicate a truck-discouraged 
road. (Truck Restrictions must be checked in the Map Features dialog to see 
truck-discouraged roads on the map.) 
 
A truck-restricted road, as determined by the controlling governmental authority, 
prohibits trucks larger than a certain size and weight.  To see these roads on the 
map, select the Map tab > Customize group > Map Features and turn on Truck 
Restrictions.   In accordance with these regulations, PC*MILER does not use 
truck-restricted roads when routing vehicles larger or heavier than the restricted 
size or weight.  However, you can override these restrictions using the Restriction 
Override feature described in this section, to determine the largest and heaviest 
vehicle that can be assigned to a route. 
 
A truck-discouraged road is one that is open for local deliveries, but unsuitable for 
through trucks, as determined either by the controlling authority or by 
PC*MILER.  The road may be discouraged because it is narrow, winding, not 
well paved, or for a variety of other reasons.  PC*MILER avoids routing over 
truck-discouraged roads whenever possible, with the following exceptions: if the 
destination is located on such a road; if avoiding the truck-discouraged road will 
add a very significant amount of time and distance to a route; or if you have 
marked the road to be favored. 
 
If you have questions about truck restrictions, please contact each jurisdiction 
directly.  
 
NOTE Also:  You can set PC*MILER to override truck restrictions by default in 
the Default Route Options dialog – check Override Restrictions. 

 

 
 Chapter 11:  Custom Routing 173 



  

IMPORTANT:  The road preferences you designate will affect routing only 
when Use Custom Roads is checked in the Route Options or Default Route 
Options dialog, General tab.  Select the Routes tab > Route group > Options or 
General group > Defaults, then check “Use Custom Roads”.  
 
PC*MILER normally routes around all truck-restricted roads.  However, some of 
these restrictions may be overridden, making the roads accessible. (This assumes 
that you have been granted permission to use these roads from the controlling 
authority, or that you are going to be using special equipment.) 
 
To see truck-restricted roads highlighted on the map, turn on the Truck 
Restrictions layer in the Map Features dialog.  A “Restricted” category will 
appear in the Road legend, showing the color of the highlighting on these roads. 
 
Overriding restrictions on a road is similar to designating road segments to be 
avoided or favored – you can pick overrides from thePC*MILER map window or 
from the map in the Restriction Overrides tab of the Avoid/Favor Manager.  
Remember though, that a “truck-discouraged” road must be favored as well; and 
to override a road restriction you must click on each segment of the road until the 
whole road is redrawn.  The color of the new highlighting will depend on which 
map style is selected.  Comments can be added if needed.  Be sure to override all 
segments included on the route; otherwise the entire road will continue to be 
treated as inaccessible. 
 
To undo an override, click on it with the Toggle Overrides tool activated.  The 
road will be restored to its original truck-restricted status.  Alternatively, you can 
delete it from the Restriction Overrides tab of the Avoid/Favor Manager.  
 
 

 
Truck Restriction Override on the Map 

 
 

11.1.3  HazMat Permit Overrides 
 
To change the status of roads that are restricted for hazardous materials, see 
section 12.3.  To transport hazardous materials on these roads, the applicable 
permits must have been obtained. 
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11.1.4  Creating Sets of Custom Road Preferences 
 
The Avoid/Favor Manager enables you to manage multiple sets of custom road 
preferences by allowing you to create and save sets of these preferences.  You 
may find that custom sets are a useful tool for working with special equipment 
you operate, or for seasonal routing requirements.  Sets can include road segment 
avoids/favors, and hazmat and truck restriction overrides.   
 
NOTE:  Many states and provinces in the north central part of the North 
American continent have seasonal weight limits that apply either to all 
commodities or to particular commodities (such as grain) at certain times of year 
(harvest season, winter, spring thaw, etc.). 
 
In these areas, the carrier typically works with the shipper to adjust how much 
material is loaded into the truck in order to max out the limit for the season in 
question, rather than adjust the route traveled.    So (for example) more grain 
would be loaded into the truck during harvest season or winter than during spring 
thaw.   That is the only way to have a legal load when an origin or destination is 
on a road with a seasonal limit.    In addition to legal considerations there are also 
practical physical considerations since many loading and unloading points in that 
part of the country are on unpaved surfaces, and to overload a truck during spring 
thaw risks the truck getting stuck during pickup or delivery. 
 
In PC*MILER, we have coded the weight limit that applies to general 
commodities during most seasons of the year.   For situations where the low-limit 
road is used as a through route rather than for pickup or delivery, the Sets feature 
described below can be used to create avoid/favor/restriction override “sets” for 
each season of the year for each commodity. Custom routing must be turned on in 
the Route Options dialog; then use the set that applies for a specific commodity at 
the appropriate season of the year. 
 
REMEMBER:  The road preferences you designate will affect routing only when 
Use Custom Roads is checked in the Route Options or Default Route Options 
dialog, General tab.  Select the Routes tab > Route group > Options or General 
group > Defaults, then check “Use Custom Roads”.  
 
 
To create a set, do the following: 
 
1. Select the Tools tab > Avoids/Favors group > Manager to open the 

Avoid/Favor Manager. 

2. Click Create Set in the lower left corner. 

3. At the prompt, enter a Name for the new set. 
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4. Click Save. 

5. You will see the new set under Available Sets on the left.  Uncheck the 
DefaultNA set and any other existing sets that are checked in this list. 

NOTE: If more than one set is enabled in the Avoid/Favor Manager, the 
avoid/favor buttons in the Tools tab will be disabled. 
 

6.  Now you can begin to add road segments in any tab of the Manager.  These 
avoid/favors will be specific to this set.  The set you are adding them to must 
be the only set selected in the Available Sets list. 

Note the following guidelines for creating new sets: 
 

• Set names cannot be longer than 50 characters, and must be comprised of 
letters and/or numbers. 

• Spaces are not allowed in the set name, but underscores (“_”) are 
permitted.   

 
To delete an individual set, place the cursor over the set name and click the “X” 
that appears on the right: 
 

 
Deleting a Set 

 
 
To delete all sets, click the Delete All Sets button in the lower left corner.  The 
Default NA set cannot be deleted. 
 
When more than one set is checked, all preferences included in the active sets will 
be visible on the map and listed in the corresponding tabs.  However, only one set 
must be active when you want to add or delete preferences to a set.  When 
multiple sets are active, the Favor Roads, Avoid Roads, Toggle Overrides, and 
Adjust for Permit buttons will be grayed out on the toolbar and in the right 
mouse map menu. 
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11.1.5 Exporting Custom Roads Data To a Report 
 
To create a report in a text file (.txt) or Excel file (.csv) that contains all the 
preferences in the open tab of the Avoid/Favor Manager, click Export All.  In the 
dialog that opens, name the file and choose a file format from the Save as type 
drop-down.  Here are examples of the two types of file formats (the formatting in 
these files has been edited): 
 

 
Exported File of Avoided Roads in .TXT Format 

 
 

 
Exported File of Avoided Roads in .CVS Format 
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11.1.6  Avoiding or Favoring Whole Roads or States/Countries  
 

REMEMBER:  The road preferences you designate will affect routing only when 
Use Custom Roads is checked in the Route Options or Default Route Options 
dialog, General tab.  Select the Routes tab > Route group > Options or General 
group > Defaults, then check “Use Custom Roads”.  
 
In addition to the road preferences described above, whole roads and whole states 
can be selected to be avoided or favored for a route using the States/Roads 
Manager.  If PC*MILER|Worldwide or DTOD data is installed and a region other 
than North America is selected, whole countries can be avoided/favored as well.   
 
 

Avoid/Favor a State or Country: 
 
1. Select the Tools tab > Avoids/Favors group > States/Roads to open the 

States/Roads Manager.  
 
2. VERY IMPORTANT:  Make sure “Enable” is checked in the upper left 

corner of the State Restrictions tab. 
 
3. Select a state (or country) from the States pick list. 
 
4. Click either Avoid or Favor to add to the desired list. 
 
To delete a state (or country) from one of the lists, place the cursor over it and 
click the “X” that appears to the right.  To clear either list, click Clear All at the 
bottom of the list. 
 
 

 
States/Roads Manager, State Restrictions Tab 
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Avoid/Favor a Whole Road: 
 
NOTE for PC*MILER|Streets Users:  You cannot designate a local street by 
name to be avoided or favored in the Roads tab; a local road can only be 
avoided/favored by designating it as such on the map.  

 
1. Click the Roads Restrictions tab. 

2. Select a state (or country) from the State drop-down. 

3. Type the road name* in the Road Name field (e.g. I 95) without a state 
abbreviation. 

4. Click Avoid or Favor under the road name.   
 
To delete a road from one of the lists, place the cursor over it and click the “X” 
that appears to the right.  To clear either list, click Clear All. 
  
*  To see how the name of a particular road appears in the PC*MILER database, 
you can zoom to that road on the map and place your cursor over the road without 
clicking.  Some highway labels may include a common name along with the road 
number; for example, “Pennsylvania Turnpike (I 276)”.  In these cases, use the 
road number from within the parentheses (“I 276” in this example). 
 
 

 
States/Roads Manager, Road Restrictions Tab 

 
 
NOTE:  You won’t see any indication on the map that a whole road or whole 
state/country has been designated to be avoided or favored.  To see the difference 
a designation makes on a route, first run the route with the Enable option 
unchecked, and duplicate that route; then go back and check this option and run 

 
 Chapter 11:  Custom Routing 179 



  

the duplicated route.  You will see the difference between the two routes on the 
map and in reports.  Another way to do this is to check and uncheck the Use 
Custom Roads option in the Route Options or Default Route Options dialog. 
 

 
11.1.7  Converting Custom Road Files from a Previous Version  

 
Saved custom road preferences from the previous version of PC*MILER can be 
imported using PC*MILER’s file conversion utility as in the steps below.  
  
1. Select the Tools tab > Avoids/Favors group > Convert.   

2. Click Import and navigate to your existing custom road file(s) that are located 
in the Data\Q1\Save folder in your PC*MILER 28 installation folder.  In that 
folder select the file avoidfavors.db. 

3. After you select the file(s), click Open to start the import.   

4. Once the import process is complete, check to make sure all the avoid/favors 
were imported successfully.  Due to changes in the highway and street-level 
network database over time, some avoid/favors may not be successfully 
imported.  Double-clicking on any listed road segment in the Conversion 
Utility dialog will zoom to that segment on the map where you can edit your 
preferences further if necessary.   

 
IMPORTANT NOTE:  Because of recent enhancements to the PC*MILER 
database that incorporate express, local, north/south and east/west lanes, etc., 
some of your avoid/favor/override designations from a previous version may need 
to be edited link-by-link to be sure the designated preference will operate in both 
directions.  
 
In the Avoid/Favor Manager, open the Avoid, Favor, Restriction Overrides or 
Haz Permits tab to see a list of your preferences. Then zoom in to the maximum 
level (20) on each listed link on the map (you can double-click each link to do 
this) and make sure that lanes in both directions are marked with the desired 
designation.    
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11.2  Custom Vehicle Profiles 
For those who make use of custom vehicle dimensions, PC*MILER provides the 
ability to create custom vehicle profiles that enable quick entry of vehicle or fleet 
attribute sets that you use often when routing.  This time-saving feature lets you 
set up and save groups of vehicle dimension and cost/time settings for easy access 
in the future.  Using custom vehicle profiles ensures that the defined settings are 
consistent for the particular vehicle type selected for a route.   
 

To use custom vehicle profiles, select the Routes tab > Utilities group > Vehicle 
Profile.  In the Vehicle Profiles Manager dialog that opens, you can select a 
profile to view, edit, or delete, or you can create a new custom profile.  For North 
America, sample profiles are provided in the drop-down for full-size van, 26' 
straight truck, 28' double trailer, 40' straight truck, 48' semi-trailer, and 53' semi-
trailer vehicles.  The sample profiles can be edited, but not deleted.   
 
NOTE:  The “Full-size van” profile is intended for use with vans, pickup 
trucks, SUVs, automobiles, etc. that are classed less than 9,000 lbs./4,082 kgs. 
The automobile routing that is generated from this profile ignores all commercial 
truck restrictions, and if toll rates are calculated, will use toll rates that apply to 
small vehicles with 2-axles, which often differ from rates that apply to larger 2-
axle vehicles.  
 
NOTE For PC*MILER|Worldwide and DTOD Users:  When creating, 
accessing, or editing a custom vehicle profile, you must perform the additional 
step of specifying a region.  Each vehicle profile is applicable to only one region. 

 
 

 
Vehicle Profiles Manager 

 
 

To create a new custom profile, click New.  A dialog will open that has two tabs – 
Cost/Time and Vehicle Dimensions.  The editable fields in these tabs are the 
same ones found in the Route Options dialog.  Enter a profile name and the 
desired edits in each tab and click Save to save your changes. 
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An unlimited number of custom profiles can be defined.  The profiles you create 
will appear in the drop-down of available profiles in the Vehicle Dimensions tab 
of the Route Options and Default Route Options dialogs. 
  
Once a profile is set up, it can be used globally (all new routes will use the 
selected profile in route calculations) or applied to each new route as appropriate:  
  

• To apply a profile to all new routes, choose the Routes tab > General 
group > Defaults.  In the Vehicle Dimensions tab, select the desired 
profile from the Vehicle Profile drop-down.  Click Save to save this 
profile as the default. 

• To apply a profile to a single route, choose the Routes tab > Route group > 
Options.  In the Vehicle Dimensions tab, select the desired profile from 
the Vehicle Profile drop-down.  Click Save when you are finished editing 
options for this route.   

 
 

 
 
 
 

 
 
 

 
 
 
 
 
 
 
 
 
 
 
By default, custom profiles are not used.  Sample vehicle profiles are provided in 
the Vehicle Profile drop-down as follows: 
 

• North America:  Full-size van, 26' straight truck, 28' double trailer, 40' 
straight truck, 48' semitrailer, 53' semitrailer 

• Europe:  12m straight truck, 16.5m articulated, 18.75m road train, Full-
size van 

• All Other Regions:  none 
 
 

 

Options for Vehicle Profile –  
Cost/Time Tab 

Options for Vehicle Profile –  
Vehicle Dimensions Tab 
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11.3  Custom Route Profiles 
In addition to custom vehicle profiles, you can create and save route profiles that 
include custom settings available in the Route Options dialog.  This feature is a 
time-saver if there are combinations of route option settings that you need to use 
frequently but do not want to set as defaults.   
 
To create and use a new route profile, follow these steps: 
 
1. Select the Routes tab > Utilities > Route Profiles.  
 
2. In the Route Profiles Manager, click New. 
 
 

 
Route Profiles Manager 

 
 

3. In the Route Profiles dialog, you will see the same options as in the Route 
Options dialog.  Type a name for the new profile under Route Profile Name. 

4. Set the route options as you want them for this profile. 

5. Click Save to save the profile and close the Route Profiles dialog.  A standard 
Windows Save dialog lets you save the new .DAT file in the Data\Base\Save 
folder in the PCMILER 29 installation.  This location cannot be changed. 

6. Click Close to close the Route Profiles Manager. 

7. Now the new profile is available for every route you run – click the gear 
button (      ) in a route window and choose Options, then select it from the 
Route Profile drop-down at the top of the Route Options dialog. 

8. To edit or delete a profile, open the Route Profiles Manager as in Step 1, 
select a profile from the drop-down and then click Edit or Delete. 

 
NOTE:  If you select and save a Route Profile in the Route Options dialog to be 
applied to the currently open route, and then edit that Route Profile, you will need 
to open a new route window and select the Route Profile again for the edit you 
made to take effect.   
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11.4  Using Via Points For Route Customization 
PC*MILER gives users the ability to enter and save up to 12 via points between 
an origin and destination to guide a route along user-preferred roads.   
 
The via points you create can be designated as stops or waypoints.  The 
“waypoint” designation means that these locations were added only to guide the 
route along desired roads.   Waypoints are treated like stops on the map (routes 
travel through the centroid of a waypoint town or city), but they don’t appear in 
the driving instructions in the Driver’s Report and are marked as a “Via” in the 
Detailed route Report.  Waypoints appear on the stop list as circles with a gray 
border.  When using RouteSync and CoPilot, the navigation system will tell 
drivers to stop at a stop or to drive through a waypoint 
  
Via points are saved in a set and the option to enter them will be offered whenever 
the route segment for which they were created is included on a trip.  For example, 
vias for a trip leg between Baltimore and Chicago can be entered with a click of 
the mouse whenever Baltimore followed by Chicago is entered for a route.   
 
To create a via point set, follow these steps either before or after running a route: 
 
1. In a new route window, enter at least two stops. 

2. Highlight the stop that you wish to designate as the origin.  This need not 
be the origin of the route if multiple stops are entered.  You will be creating via 
points between this highlighted stop and the next destination on the stop list. 

3. Select the Routes tab > Route group > Create Via Point Set to open the Via 
Point Set Manager. 

 

 
Via Point Set Manager 
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4. Under Via Point Location, type a PC*MILER location (city/state, postal 
code, etc.) in the top field and, optionally, a street address underneath. 

5. Under Via Point Type, select whether the point you entered will be a Stop or 
a Waypoint.     

6. Press Enter or click Add Point.  PC*MILER will confirm that the location 
exists in the database – if a pick list appears, make a selection and click OK.  

7. Click Add Point again to add this location to the Via Points in Set list.  

8. Under Via Point Set Application, select whether the new set will be applied 
only when the route travels from Origin to Destination, from Destination to 
Origin, or in Both Directions. 

9. Also under Via Point Set Application, the radius around the origin and/or 
destination can be edited (default is 10 miles).  This is the radius within which 
an origin and a destination point must be located to trigger the via points 
option for this route segment.  The radius is defined from the city center or 
postal code center.  

10. Steps 4-9 can be repeated to add up to 11 additional via points to the set. 

11. When finished adding points, click Save Set to save the new set then click 
Close to close the dialog. 

12. In the route window, you will see a line inserted into the stop list under the 
origin for the via point set.  Click the Add Via Set button on this line to add 
the points to the stop list.  If you decide not to use the via points for this route, 
ignore this button and the via points won’t be used. 

 
 

 
“Add Via Set” Button in the Route Window 

 
 

13. Click Run to run the route.  If you activated the via points in Step 11, the 
route will travel on the preferred roads through the via points.   

  

To Edit a Set: 
To edit a set at any time, select the Routes tab > Utilities group > Manage Via 
Point Sets.  Then select the set you want to edit from the drop-down of sets, make 
your changes, and click Save Set. 
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Editing options include: 

• Rename the set – click Edit Set Name, enter a new name, then click Rename. 
• Delete the set – click Delete Set in the upper right corner of the dialog.  

This action cannot be undone. 
• Change the direction to which the set will be applied. 
• Add more stops or waypoints as described above. 
• Change the via point type – select a point on the list then click Stop or 

Waypoint. 
• Delete one or more via points – select a point on the list and click Delete 

Point. 
• Change the order of points in the set – select a point on the list and click 

Move Up or Move Down. 
 

11.5  Dragging a Route on the Map 
Once a trip has been generated, any point along the generated route on the map 
can be dragged onto another road in order to re-route the trip.  To drag a route, do 
the following: 
 
1. Select the Routes tab > Utilities group > Drag Route.   
 
2. In the PC*MILER map window, click on the route and hold down the cursor, 

then drag to the desired location and let go.   
 
3. This action will create a waypoint at the location to which the route was 

dragged, indicated by a gray circle icon. The trip will be re-routed to 
accommodate the new waypoint.   

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Original Route New Route Created by Dragging 
 

New Via Point 
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11.6  Geofence Options 
PC*MILER now provides tools that enable you to create, modify and manage 
geofences.  A geofence defines a geographic area that will either generate an alert 
when a route enters it, or will be avoided by the route.  Its use has many different 
applications, such as: 

 
• Drawing zones around a warehouse to identify delivery/billing zones 
• Alerting dispatchers when a vehicle enters an area that it wasn’t 

authorized to enter –  for example, leaving the country 
• Avoiding or warning about steep grades, mountain passes susceptible to 

snow closures, tunnels requiring escorts, etc. 
• Avoiding or warning if an asset has crossed into a high crime or high 

accident area 
• Avoiding or warning about areas where bad weather is expected or has 

occurred: heavy snowfalls, floods, hurricane evacuation areas, etc. 
 
The geofence tools in PC*MILER allow users to: 

 

• Create and modify the characteristics of a geofence: 

-  Define its size and shape as a circle, rectangle, or a user-defined polygon 
-  Give the geofence a unique name (with  the exact text that will appear in 

report warnings) 
-  Delete the geofence 

• Identify points and roads that fall within the boundaries of a geofence 
• Group geofences into sets and assign and modify the characteristics of a set: 

-  Create and uniquely name a set with the name that will appear in report 
warnings 

-  Define the border color, border width and fill color of the geofences in 
the set 

-  Define the set properties: off (not active), warning only, or avoid and warn 
-  Delete the set 

 
 
11.6.1  Creating a Geofence 

 
NOTE:  There is no limit to the number of individual geofences that can be 
created and added to a geofence set, or to the number of sets that can be created.   
 
TIP:  A geofence that covers a very large area (for example, a whole state) will 
draw very slowly on the map and will affect other map functions that involve a 
map redraw.  Whole states and whole roads can be avoided or favored using the 
States/Roads Manager – see section 11.1.6. 
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NOTE:  To see geofences on the PC*MILER map or on the map in the Geofence 
Manager, “Geofences” must be checked in the Map Features dialog (Map tab > 
Customize group > Map Features).  This map feature is enabled by default. 
 
Follow the steps below to create an individual geofence:   

1. Select Tools tab > Geofences group > Geofence Options > Manage to open 
the Geofence Manager. 

 

 
GeofenceManager 

 

2. In this window, use the zoom tools and Drag Map button to zoom into the 
target area on the map.  

3. Click the Rectangular, Circular, or Polygonal button at the top of the map.  
Depending on which shape you chose, the cursor will change to one of the 
following: 

 

• When drawing a rectangle:  
• When drawing a circle:  
• When drawing a user-defined polygon:    

If using the circle or rectangle shape, drag the cursor over the desired area.  
If using the polygon tool, click all the points of the desired perimeter and 
finish by clicking on the first point again to close the polygon.  If you are 
not satisfied with the area that is covered, delete the geofence in the 
Available Geofences list to the right and start over. 
 
NOTE:  Note that alternatively you could use the map and geofence tools in 
the PC*MILER application window to initially create a geofence – open the 
Tools tab > Geofences group > Create Geofence and create a geofence on 
the map as in Steps 2-3. 
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NOTE Also:  See sections 11.6.5 on identifying points and roads that are 
included within the boundary of a geofence. 

 
4. In the Available Geofences list, you will see a generic name assigned 

(“Geofence_#”) to the geofence you just created on the map.  (If more than 
one geofence is on the list, they will be listed alphabetically, e.g. 
Geofence_1, Geofence_10, Geofence_2, etc.)  To assign a unique name to 
this geofence (for example, a geographic location): 

a. Click on the default name. 

b. Click Rename below the list. 

c. In the prompt that pops up, type a new name. 
 

 
 
 
 
 

 
d. Click Save. 

 
5. A geofence must belong to a set before a warning status and display 

properties can be assigned to it: 

a. Click Create under Geofence Sets. 

b. Type a name for the new set. 
 
 
 
 
 
 
 

c. Click Create.  The set name will appear as the selected set in the 
Geofence Sets list.   

d. Go back to the Available Geofences list, highlight the geofence(s) you 
want to add and click Add To Set.   

 
6. Click OK to close the Geofence Manager.  The geofence(s) you created will 

be saved in the PC*MILER installation folder. 

 

TIP:  To zoom to an existing geofence or set on the map in the Manager, 
double-click the geofence name under Available Geofences or the set name 
under Geofence Sets. 
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11.6.2  Customizing Geofence Sets 
 
The properties of each geofence set can be customized in the Geofence Manager.  
All geofences in the set will have the same appearance and activity status.  
Individual geofences cannot be customized.  
 
 
Customizing the Appearance of Geofences in a Set: 
 

 
 
1. Under Customization, select a set from the Applied To drop-down. 

2. To edit the Fill Color or Border Color, choose a new color from the drop-down. 

3. Use the Border Weight drop-down to select a new width for the border. 

4. Click Apply Changes to see these atributes appear on the map. 
 
 

Designating the Behavior of Geofences in a Set: 
 
 1. Under Customization, select one of these Behavior options: 

Off:  Geofences are not active. They do not affect the Detailed Route Report 
and are not visible on the map. 

Warning Only:  Geofences are visible on the map, and a warning will appear 
in the Detailed Route Report at the points where the route begins to 
travel on a road segment that is part of a geofenced area.  The warning 
will include the road name, geofence set name, and geofence name, for 
example: 
Warning * US 69 *: Montana Geofences: ButteMT 

Avoid + Warning:  Geofences are visible on the map.  The route will avoid 
road segments within the geofenced area if “Use Custom Routing” is 
checked in the Route Options or Default Route Options dialog. A 
warning will appear in the Detailed Route Report in cases where the 
route has to enter the geofence (for example, if the destination is within 
the geofenced area). 

 
2. Click Apply Changes to save your selection. 
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Detailed Route Report with Geofence Warning 

  

 
 
 
 
Renaming and Deleting Geofences and Sets: 
 
To delete a geofence: 
 

To permanently delete a geofence, highlight it in either the Geofences In This Set 
list or the Available Geofences list and click Delete below the list. 

 

To delete an individual geofence directly from the map: 
 

1. On the map, zoom to the location of the geofence you want to delete. 

2. Click the Delete button at the top of the map.  In Delete mode, your cursor will 
change to look like this:        To exit from delete mode, select Delete again. 

3. Click the geofence(s) you want to delete. 

4. To exit from Delete mode, select Delete again. 
 
To delete a set: 

Under Geofence Sets, select the set you want to delete from the drop-down, then 
click Delete to the right. 
 

To rename a set: 

Under Geofence Sets, select the set you want to rename from the drop-down, 
click Rename to the right, type a new name in the prompt that appears, and click 
Save. 
 

To edit a set: 
 

To remove a geofence from a set and reassign it to the Available Geofences list, 
highlight it in the Geofences In This Set list and click Remove From Set. 
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11.6.3  Generating a Geofence Report 
 
To create a report that shows all road segments included within the perimeter of a 
geofence, do the following: 
 
1. Select the Tools tab > Geofences group > Convert > Export Geofences.   

2. In the Save dialog, select a file type (*.txt or *.csv), enter a file name, and 
select a target location where the report will be saved.    

 
To open the report, navigate to the folder where it was saved.  If the report was 
saved as a *.txt file, it will open in Notepad.  If it was saved as a *.csv file, it will 
open in Excel.   
 
This report includes the following data: the name of the geofence, the set that the 
geofence belongs to, the corresponding road segments included in the geofence, 
and the date the geofence was added.  A sample *.txt report for two geofences is 
shown below.   

 
 

 
Geofence Report in *.txt Format 

Geofence Location, Set 
Name, Date Created, Shape, 
and Defining Lat/Longs  

Each road segment listing 
includes Segment, Length, 
Nearest Town, Date and 
Set Name     

List of road 
segments in both 
geofences begins 
here.  
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11.6.4  Geofence Behavior on the Map 
 
By default, geofences that are created will initially appear on the map with light 
gray fill and a thin red border.  Fill color and border width can be edited as 
described in section 11.6.2. 
 
When a geofence is inactive (not assigned to a set, but still listed under “Availabe 
Geofences”), it will no longer be visible on the map though it is still saved. 
 
There are also two settings in the Map Features dialog that affect the geofence 
display on the map: if Avoids & Favors is unchecked, the blue highlighting that 
designates road segments inside each geofence will be hidden; and if Geofences 
is unchecked, the geofence shapes will be hidden but the blue highlighting on 
affected road segments will still be visible.  All geofences are affected by these 
settings. 
 
 

11.6.5  Identify Points Within a Geofence Boundary 
 
To determine if particular points lie within a geofence boundary, follow the steps 
below. 
 

1. Select the Tools tab > Geofences group > Geofence Options > Identify. 

2. Enter a location in the City field, with or without an Address.  Any 
PC*MILER location is acceptable, including lat/long points and custom place 
names.  If you enter a city name without an address, PC*MILER will use the 
city center of that town. 

 

 
Geofence Identifier 
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3. Under Search Within, select to search All geofence sets for the location, or 
within A specific geofence set.  Choose a set from the drop-down menu if you 
want to search within a specific set. 

4. Click Search.  All geofences that include the location will be listed under 
Matching Geofences.  If the point is not within the boundary of any 
geofence, a “No matches found” message will appear. 

5. Click Reset to clear the search before entering another location. 

 
11.6.6  Using the Geofences Conversion Utility 

 
If you created and saved geofences in the previous version of PC*MILER, you 
can easily import those files into Version 29 using the Geofences Conversion 
Utility.  To do this, follow the steps below.   
 
1. Select the Tools tab > Geofences group > Convert > Import Geofences.  

2. In the window that opens, navigate to the PC*MILER 28 installation folder 
(usually C:\ALK Technologies\PCMILER28).  In that folder, navigate to 
NA\Q1\Save\geofences, then select the geofence files (flattened_gf.dat and 
flattened_af.dat) and click Open. 

3. You will see the saved geofence files being copied into Version 29. 

4. When the process is complete, close the dialog.  The geofences should now be 
accessible in Version 29.  

 

11.7  Backing Up Your Custom Files (Better Safe Than Sorry) 
It’s always strongly suggested to back up important files frequently to a different location 
in case the unexpected occurs.  The following customized data in PC*MILER can be 
backed up: 
 

• Custom places 
• Custom roads 
• Geofences 
• Default routing options 
• Default road speeds 

To  create a backup, copy your files into a separate folder, preferably one that is located 
on a second computer or device.  Your custom data files can be found in a “Save” folder 
in the PC*MILER installation.  The location of the Save folder in different types of 
PC*MILER installations is shown below: 
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• PC*MILER 29 - NA - US/Canada Base 
- C:\ALK Technologies\PCMILER29\Data\Base\save 

 

• PC*MILER 29 - NA - US/Canada Energy 
- C:\ALK Technologies\PCMILER29\Data\NA_Energy\save 

 

• PC*MILER 29 - Highway WorldWide 
- C:\ALK Technologies\PCMILER29\Data\WW\save 

 

• PC*MILER 29 - Streets Africa/Asia/Middle East/Oceania/South America 
- C:\ALK Technologies\PCMILER29\Data\'xx'\save 
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Hazardous Material Routing 
 

If the separate PC*MILER|HazMat data add-on module is installed, routing can 
be generated in North America, Europe and Oceania for various types of 
hazardous materials and dangerous goods using any PC*MILER route type.  To 
use a hazardous materials routing option, click the gear button in a route window  
(   ) and select Options or select the Routes tab > Route group > Options, then 
click the HazMat tab. 

 

 
 

Route Options Dialog, HazMat Tab (North America Region) 
 

 
Hazardous material routing options for North America include:  Other, 
Corrosive, Explosives, Flammable, Inhalants, and Radioactive.  When Europe 
or Oceania is the selected region, the options are: Other, Explosives, 
Flammable, and Harmful to Water (with additional tunnel restrictions 
categories in Europe – see Table 2 below).     
 
Tables 1 and 2 below show how each PC*MILER hazmat route type handles 
each hazmat road category.  Table 3 shows U.S. DOT Hazmat classes and the 
corresponding PC*MILER route type.   
 
NOTE:  The “Other” option should be used for any hazardous material that 
presents a danger during transportation and is not corrosive, explosive, 
flammable, inhalant, or radioactive.  Common examples include: oxidizers (such 
as compressed oxygen tanks), combustible liquids (such as diesel fuel), and 
poisons (such as pesticides). 

12 C
ha

pt
er
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TABLE 1:  PC*MILER Hazardous Material Route Types and Road Categories 

 

favor = routing will prefer these segments 
no change = routing will not be altered in any way 
avoid = routing will go around these segments whenever possible 
discourage = a lesser degree of avoidance, used when a state or road authority allows hazmat only at certain times of day, with 

prior notification, by permit, or in limited quantities, and for tunnels not otherwise classified 
 
 

 
(continued on next page) 
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NOTE: U.S. hazardous material routing restriction/designation information taken from The National Hazardous Materials 
Route Registry provided by the Federal Motor Carrier Safety Administration (FMCSA); and various other state and federal 
sources.  Canadian hazmat/dangerous goods routing data derived from government and municipal sources in each Province and 
Territory, and includes restrictions for major Canadian bridges and tunnels. 
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TABLE 2:  PC*MILER HazMat Route Types and Road Categories – EU Harmful 

to Water and EU Tunnels 
 

(PC*MILER|Worldwide or DTOD data must be installed)  For PC*MILER|Worldwide and 
DTOD users, the hazmat categories below are used in the Europe and Oceania regions. 
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TABLE 3:  U.S. DOT Hazmat Classes and Corresponding PC*MILER Hazmat Route Types 
 
The table below shows how the wording used for PC*MILER hazmat routing options, which is 
derived from industry-standard placarded descriptions of hazardous materials, corresponds to the 
U.S. Department of Transportation Hazmat classifications.  See sections 12.1 and 12.2 below on 
how to use this table. 
 

U.S. DOT Hazmat Classes (corresponding PC*MILER routing options are bolded): 

Class 1: Explosives – Explosive  
Class 2: Compressed Gases 
              2.1: Flammable Gas – Flammable 
              2.2: Non-Flammable Compressed Gas – Other  
              2.3: Poisonous Gas – Inhalant  
Class 3: Flammable and Combustible Liquid – Flammable  
Class 4: Flammable Solids 
              4.1: Flammable Solid – Flammable 
              4.2: Spontaneously Combustible Material – Flammable  
              4.3: Dangerous When Wet Material – Other  
Class 5: Oxidizers – Other  
Class 6: Poisons 
              6.1: (part) Inhalation Hazard – Inhalant  
              6.1: (balance) – Other  
              6.2: Infectious Substance (Etiologic agent) [“Biohazard”] – Other  
Class 7: Radioactive Materials – Radioactive  
Class 8: Corrosive Liquids – Corrosive (“Caustic” in PC*MILER 22 and earlier) 
Class 9: Miscellaneous – Other  
 

12.1  Determining Which Route Type to Use 

NOTE:  Hazmat regulations for a particular tunnel on a route should be checked 
if there is any doubt about which materials are permitted, as regulations may 
change over time and might not be included in the version of the PC*MILER 
database that you are currently using. 
 
The shipper of hazardous materials is legally responsible for determining the U.S. 
DOT Hazmat Class for their shipment and communicating that class to the carrier 
in their shipping papers. 
 
To determine the U.S. DOT Hazmat Class, go to the online 49 CFR 172.101 at 
www.ecfr.gov.  Once the Class is identified for a shipment, use Table 2 above to 
determine which route type should be used when generating a PC*MILER route 
for that shipment. 
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For example, on the government web site, hydrogen is classified as a Flammable 
Gas (DOT class 2.1), while oxygen, nitrogen, carbon dioxide, and argon are Non-
Flammable Compressed Gases (DOT class 2.2). 
 
Using Table 2 above, DOT class 2.1 corresponds to the PC*MILER Hazmat route 
type “Flammable”, while DOT class 2.2 corresponds to the PC*MILER Hazmat 
route type “Other”.  
  

12.2  Routing Multiple Hazmat Classes 
For routing a single shipment containing multiple hazmat classes, the following 
procedures are suggested: 
 
1. First, determine the weight of each commodity and check the U.S. DOT 

(PHMSA) rule to see if that combination is permissible and if so, which 
placard(s) are to be used. 

2. Then, for each placard, look up the PC*MILER|Hazmat routing options in the 
table above. 

 a. If all the placards correspond to one routing option, use that option. 
 b. If the placards correspond to multiple routing options, then run the route 

 for each option, and: 
  i.  If all the routes are the same, that common route is the route to be used. 
  ii. If the routes are different, then there may or may not exist a legal route  

     for that combination of commodities for the specified origin/destination  
     (this will occur only rarely). 

 

12.3  Changing the Status of Hazmat-Prohibited Roads 
Customers who have obtained permits can change the status of hazmat-prohibited 
roads as follows: 
 

1. First make sure “Hazardous Materials” is checked in the Map Features 
dialog (Map tab > Map Features).   

2. Select the Tools tab > Avoids/Favors group > Adjust for Permits. 

3. In the map window click on the prohibited road(s) that you wish to make 
accessible for routing.  The adjusted route segments will change color (the 
color will depend on which map style is currently active).  

 
All user-created road preferences are saved and managed in the Haz Permits tab 
of the Avoid/Favor Manager (Tools tab > Avoids/Favors group > Manage – see 
section 11.1.1).  A comment may be added to each record, either by typing a 
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comment in the Add Comment dialog that appears when a road segment is clicked 
or by entering it directly in the Avoid/Favor Manager.   
 
 

 
HazMat Restriction Override Shown on the PC*MILER Map 

 
 
The custom road settings you create can be removed by clicking again on the 
same roads with the Adjust for Permits tool active, or by using the Avoid/Favor 
Manager. 
 

12.4  Hazardous Material Routing on the PC*MILER Map 
 

 
Map Showing Hazmat Restricted Roads & Restrictions Legend 

Restrictions 
Override near 
Greenville, RI 
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With the PC*MILER|HazMat add-on data module installed, hazmat-prohibited 
and -designated roads will be highlighted in the PC*MILER map window 
provided this feature is checked in the Map Features dialog (see TIP below). The 
Restrictions legend shows the highlight color for various designations (to 
show/hide this legend, select the Map tab > Customize > Legends). 

 
 

TIP:  If you do not want hazmat routing to show up on maps, the highlighting can 
be hidden from view by turning off the Hazardous Material feature in the Map 
Features dialog.  Select the Map tab > Customize group > Map Features and 
uncheck “Hazardous Material”, then click OK to save. 
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Using PC*MILER|Energy 
 
 
Beginning in Version 28, PC*MILER now offers users an integrated energy-
focused map data set for the oil and gas industry.  Through partnership with 
GEOTrac Systems Inc. of Calgary, ALK has created the PC*MILER|Energy data 
set that includes access roads and infrastructure coverage across states and 
provinces in North America where oil and gas wells are actively developed and 
known reserves are found.   
 
PC*MILER|Energy is available as a separate add-on data module for PC*MILER.  
Your PC*MILER installation must also include the PC*MILER|Streets US and 
PC*MILER|Streets Canada data modules.  With these three modules installed, 
PC*MILER|Energy gives users the ability to: 
 

• plot the latitude/longitude of a wellhead, facility or land survey address 
and route directly to it, then view that route on the PC*MILER map; 

• generate turn-by-turn directions on leased or bonded roads in and out of 
well sites and other facilities; 

• assign a custom average road speed to all roads classified as “Energy 
Road” in the PC*MILER|Energy dataset for ETA accuracy; 

• switch between the base PC*MILER map data set, accessible to general 
users of PC*MILER, and the PC*MILER|Energy oil- and gas-specific 
data set; 

• use the PC*MILER Import Custom Place Wizard to customize the 
PC*MILER database with specific wellhead, facility and land survey 
addresses, and group those locations into one or more POI (point of 
interest) category (see section 3.16.5). 

 

 
Satellite View of a PC*MILER|Energy Route To a Wellhead 
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The PC*MILER|Energy road network currently includes approximately 365,674 
miles of access roads that are not included in the base PC*MILER map data set.  
These roads are found in the following states and provinces:  Alberta, British 
Columbia, Manitoba, and Saskatchewan in Canada; and Arkansas, Colorado, 
Louisiana, Mississippi, Montana, New York, North Dakota, Ohio, Oklahoma, 
Pennsylvania, Texas, Utah, West Virginia, and Wyoming. 
 
PC*MILER Version 29 also gives users access to land survey addresses from the 
Public Land Survey System (PLSS) and the Dominion Land Survey (DLS) 
including Land Survey Grids (LSDs)*.  Land survey POIs give users the ability to 
route to locations on roads that were created too recently to be included in the 
most current update of PC*MILER’s energy road database. 
 

*  Oil and Gas field content provided by GeoTrac Systems Inc. ©Copyright 2015.  
All rights reserved. 

 

13.1  Accessing the PC*MILER|Energy Data Set 
With PC*MILER|Energy data purchased and installed, select the Map tab > 
Utilities group > Change Data Set and select NA Energy.  (If PC*MILER|Energy 
data has not been installed yet, see section 2.5.5.)  The currently loaded data set 
will be displayed in the title bar of the PC*MILER map window, shown at the 
bottom of each page in any reports that are generated, and checked in the Change 
Data Set menu.  To switch to another data set, simply select it in the menu. 
 
Before routing with the Energy data set, open the Default Route Options dialog 
(Routes tab > General group > Defaults) and make sure the “Use Highway Only” 
option is turned off and the default region is North America.  Options listed in 
the route entry window should include “Streets”, indicating that local streets will 
be included in routing calculations, and North America as the region. 
 
 

 
 

Change Data Set Menu 
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13.1.1  Searching for Land Survey Addresses 
 
If PC*MILER|Energy and PC*MILER|Streets are licensed and installed, 
PC*MILER|Energy users now have access to land survey addresses from the 
Public Land Survey System (PLSS) and the Dominion Land Survey (DLS) 
including Land Survey Grids (LSDs).  Users can search for a land survey name 
with an exact 12-character match, for example,  “SW NW S27 T010N R020W”.  
These locations can be added as stops on a route, saved as custom places, and 
displayed on the map.   
 

 
 

 
 
 

 
Generated Trip To a Survey Address 
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13.2  PC*MILER|Energy Routing and Mapping 
With the NA Energy data set selected and local street routing activated, you are 
ready to generate PC*MILER routes directly to the latitude/longitude points 
where wellheads or other oil and gas facilities are located, using leased or bonded 
access roads to get there.  For lat/long formats that PC*MILER accepts as stops, 
see section 3.6.18.  Use the 6-digit decimal format for precision and best results. 
Locations can also be picked off the map using the mouse – see section 3.6.24.   
To change the map to a satellite view, select the Map tab > Customize group > 
Map Style.  An internet connection is required to display satellite images. 
    
The two routes shown below illustrate the difference between a route calculated 
using the PC*MILER|Energy data set and one that does not use the Energy data.  
The route run without Energy data uses the air distance between wellheads. 
 

 

 
Routing at a Well Site Near Odessa, TX – Using Energy Data 

 
 

 

 
Routing at a Well Site Near Odessa, TX – Without Energy Data 

(Route Uses Air Distances) 
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ALK on the Cloud 
 
 

Beginning in PC*MILER Version 29, ALK Cloud Services is available for users 
who are interested in sharing data.  (An active internet connection is required to 
use ALK Cloud Services.)   
 
The benefits of using ALK Cloud Services include: 
 

• Allows users to seamlessly and securely create, modify, and share user-
generated data. 

• Provides reliable backup and restoration of user-generated data. 

• Provides a common company account and user login. 
 
Currently, ALK Cloud Services enables sharing of custom place data generated 
by users of the PC*MILER user interface.  It also enables RouteSync users to 
dispatch routes and trip options to drivers equipped with ALK’s CoPilot Truck 
navigation software on mobile devices in the cab.  (See Chapter 15 for a 
description of the RouteSync features available in PC*MILER.)  
 

14.1  Creating an ALK Cloud Account 
1.  Select the ALK Cloud tab > ALK Cloud group > User Login.   
 
2. In the ALK Cloud Login dialog, click the secure link to the right: 
 

 
 

 
3.  On the web page that opens, click Sign Up: 
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4.  In the ALK Cloud Signup screen, enter a unique, valid email and click Continue. 
 

 
 

5.  In the next screen, enter a first and last name, a password (8 characters or 
more), and a name for this new account, then click Submit. 

 

 
 

6.  After a few seconds of processing, you should see a login screen that displays 
the message “You have successfully signed up” and you will receive an 
email confirming that you created an account.  You can Login immediately 
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from this screen or close the web page and login later from the ALK Cloud 
ribbon in PC*MILER. 

 

 
 

14.2  Login, Settings and Options    
To login to your new account from PC*MILER, select the ALK Cloud tab > ALK 
Cloud group > User Login and enter the user name (email) and password that you 
used to create the account.  If there is more than one account associated with the 
email you enter, you will also need to pick an account from the drop-down list 
that appears under your password: 
 

 
 
 
If the login was successful, you’ll see the icon on the ALK Cloud tab turn green: 

   
 
After login, select the ALK Cloud tab > ALK Cloud group > Manage Account to 
bring up the Manage ALK Cloud Account web page.  You’ll be asked to login 
again first.   
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When you set up a new Cloud account, you are automatically given administrator 
status for that account.  As an administrator you can add or disable users on the 
account, permanently cancel the account, and change your own password. 
 
Users on an account may be given administrative rights by the original 
administrator, and one user can join multiple accounts. 
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14.2.1  Adding/Deleting Users 
 
To add a user to the account, click Add User to Account, enter a first and last 
name and email address, then click Add.  The user will be added to the account 
and will receive a Welcome email from ALK Cloud Services that includes a link 
to create a password. 
 
When the new user has been added to the Account Users list, check the Account 
Administrator column if you want to give this user administrative rights.  By 
default, each new user you add will be Enabled.  An administrator can disable a 
user temporarily by unchecking this option, or by clicking the garbage can icon in 
the Remove column. The deleted user’s ID will remain on the list but the user 
will no longer have access to the account.  
 
 

14.2.2  Administrators vs. Non-Admin Users 
 
Users who do not have administrator rights won’t see the Account Users list, the 
Cancel Account button, or the Regenerate button for the account Alias.  They 
can change their password, and view subscription information and the account 
Alias. Here is what the non-admin user’s account management page looks like: 
 

 
 

 
14.2.3  How Is the Account Alias Used? 

 
The Account Alias is a system-generated string of six letters that uniquely 
identifies your account on the cloud.  It is displayed on the ALK Cloud ribbon in 
PC*MILER when a PC*MILER user logs into the account.  The Alias can be 
given to remote users to allow them to join the account and receive RouteSync 
routes on their mobile devices while using CoPilot (see Chapter 15 for more on 
RouteSync).   
 
To disable an Alias and create a new one for the account, an administrator can 
click Regenerate.   
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14.2  Sync Data   

NOTE:  To sync data on the Cloud, you must login to the same ALK Cloud 
account on both the server and the workstation.  Even if you login to the ALK 
Cloud account on your workstation, but you are not logged into the same account 
on the server, syncing won’t work. 
 
Syncing your custom place data makes it available to all other users on the ALK 
Cloud account that you are logged into. The goal is to provide built-in sharing and 
backup of this data so that users need not manage their custom places manually 
and can share files over a network.  Here are a few things to keep in mind 
regarding data syncs: 
 

• Only one user at a time may edit the data set on the ALK Cloud (by 
syncing), simultaneous editing is not currently supported.  

• Data syncs always apply in both directions (to and from the cloud) and 
data from the ALK cloud is synced back to users as a complete set.  Data 
will never be partially synced.  Syncing your data will overwrite any 
local unsynced data sets.   

• All users on the Cloud should sync up immediately after login to avoid 
the possibility of data loss.  As an illustration, consider the following 
scenario: User 1 creates 50 custom places and then syncs her data.  A few 
minutes after User 1’s sync, User 2 creates 50 custom places without 
syncing first, and then syncs his data.  In this scenario, User 1’s data 
would overwrite User 2’s data and User 2 would lose his custom places 
because he did not sync before starting his local edits. 

• Cloud data is not available when the user is not logged in.  Only data 
that was created locally when the user was offline will be available. 

• A user should not choose to use the Cloud sometimes and not other 
times.  Participation in ALK Cloud Services is optional.  Users may 
choose to continue storing data locally.  However, intermittent use of ALK 
Cloud Services would create a non-optimal situation in which the most up-
to-date or desired data might not be available to other Cloud users. 

 
To sync your data, select Sync Data on the ALK Cloud ribbon in the PC*MILER 
application window.  
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Using ALK’s RouteSync® 
 
 
RouteSync by ALK Technologies is an add-on to PC*MILER that provides a 
direct link between two of ALK’s existing industry-standard products: 
PC*MILER routing, mileage and mapping software in the back office and CoPilot 
Truck – ALK’s truck-specific GPS navigation system for mobile devices – in the 
vehicle.  
 
PC*MILER, synced with CoPilot Truck in the cab via RouteSync, now offers the 
transportation and logistics industry a unique tracking and route management 
capability.  PC*MILER route compliance ensures that CoPilot Truck will follow 
user-defined routing (Practical, Hazmat, Toll Discouraged, etc.) that includes 
vehicle dimensions and custom avoid/favor routing preferences. 
 
RouteSync is an ideal fit for motor carriers, private fleets and owner operators 
who need to maintain operational consistency between PC*MILER operations 
and accounting functions in the back office and their vehicles.  It offers a flexible 
approach to minimizing the mileage variance between actual and planned routes. 
 
From the back office, RouteSync can be used in the following ways: 
 
• send routes and trip options* to CoPilot Truck in the cab; 
• send a PC*MILER route’s lat/long sequence to CoPilot Truck;  
• tell CoPilot Truck how strictly its in-cab directions should follow the exact 

route calculated by PC*MILER for a trip; 
• provide Out-of-Route warnings to drivers via CoPilot when they depart from 

the prescribed route, exceeding a specified distance from the route. 
 
* Note that avoid/favor options are the exception, they currently cannot be sent 

via RouteSync. 
 
NOTE:  PC*MILER|Streets and RouteSync must be licensed and installed, and 
you must have an active internet connection to use RouteSync.  For RouteSync 
hardware and software requirements, see section 2.1.2, Requirements. 
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15.2  Getting Started With RouteSync 
To use RouteSync, you must first log in to an ALK Cloud Services account.  To 
set up an account, see section 14.1. 
 
Follow these steps to get started:  
 
1.  Open PC*MILER and select the ALK Cloud tab > ALK Cloud group > User 

Login. 
 
 
 
 

 
 

2. Enter the email address and password that were used to create an ALK Cloud 
Services account, and click Login.   

 
3. If the login attempt was successful, you will see the icon on the ALK Cloud 

tab turn green: 
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15.3  Adding Drivers 
To invite CoPilot-equipped drivers to join your ALK Cloud account: 
 
1. After login, select the ALK Cloud tab > ALK Cloud group > Manage Account 

and enter the required email and password.  If you belong to more than one 
account, you will need to select an account from a drop-down list. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2. When the Manage ALK Cloud Account web page opens, you have two options: 
you can 1) provide drivers with the Account Alias shown on the page, which 
they then use to login and join the account from within CoPilot, or 2) add drivers 
to the account as new users directly from the Manage Account page by entering 
the email address the driver used while activating CoPilot after installation on a 
mobile device. Using the Manage Account page generates a “Welcome to ALK 
Cloud” email that enables the driver to sign up.  For this second option, continue 
with the steps below. 

Option 2:   
Add drivers directly 
from the Manage 
Account page 

Option 1:   
Send the Account 
Alias to drivers 

 
 PC*MILER User’s Guide 216 



   
 

3. To add a driver as a new user, click Add User to Account. 

4. Enter a first and last name and a valid email address at the prompts that appear 
below, then click Add.  The email you enter must match the email that the 
driver used when installing CoPilot. 

 
5. You’ll see the new user added to the list of Account Users, enabled by 

default.  Each user you add will receive an email for signing up.  To 
temporarily disable a user, uncheck the Enabled column, or click the garbage 
can icon (the user will remain on the list but access to the account will be 
denied in both cases). 

 

15.4  Sending Routes and Options from PC*MILER to CoPilot 
The usernames (emails) of all CoPilot-equipped drivers who join your ALK 
Cloud account will appear in the RouteSync Vehicle Manager, along with their 
online/offline status.  Select Vehicle Manager on the ALK Cloud ribbon to open 
the Vehicle Manager and see all users who have joined your account. 
 

 
RouteSync Vehicle Manager 

 
 
PC*MILER routes can be sent to any CoPilot-equipped driver listed in the 
Vehicle Manager.  By sending a route to CoPilot, the sender requires the driver to 
adhere precisely to that route.  To send a route, follow the steps below. 
 
1. Run a PC*MILER Route.  PC*MILER|Streets must be installed. 

 
2. Open the Send Route dialog.  In the route window, click the gear button and 

select RouteSync. 
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3. Select a Vehicle.  In the Send Route dialog, select one or more vehicles from 
the Select Vehicle drop-down.  Click View Vehicle List to view the 
online/offline status of all users on your ALK Cloud account. 

 
4. Select Route Compliance Level. 
 

 
 
Under Route Compliance, select how strictly CoPilot should try to return to 
the original route once the driver is out-of-route: 

Strict:  This is the default compliance level.  CoPilot will try to navigate back 
to the original route at all costs, even if it means the driver needs to turn 
around and drive back to rejoin the prescribed route. 

Moderate:  CoPilot will try to navigate back to the original route but will take 
into account the driver’s current position in relation to the destination; i.e. 
CoPilot will try to rejoin the prescribed route as it navigates towards the 
destination, but along a route that is more reasonable than what the Strict 
compliance level would follow. 

Minimal:  At this level, the original prescribed route is not taken into 
consideration.  The route taken may still rejoin the original route, but its first 
objective is to navigate to the destination from the driver’s current position. 

 

RouteSync Send Route Dialog  
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5. Set a Distance That Triggers an OoR Alert. 
 

 
Whenever the CoPilot-equipped vehicle goes off route, CoPilot generates an 
alert for the driver that is also sent to the PC*MILER-side dispatcher. By 
default, an out-of-route alert is generated when the vehicle reaches a point .2 
miles away from the planned route.  To adjust this distance, type in a new 
distance under Alert. 

 
6. Send the Route. 
 

 
Click the active Send to Copilot button. 
 
The CoPilot user will receive an onscreen alert that a route has been sent and 
may choose to click OK to accept the route, or Details to see driving 
instructions.   
 

15.5  Managing and Tracking Vehicles 
 

 
RouteSync Vehicle Manager 

 
 

To Track Vehicles: 
To see all vehicles that have accepted to join your account, click View Vehicle 
List in the Send Route dialog or Vehicle Manager on the ALK Cloud ribbon.   
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Vehicles in the Vehicle Manager are listed by their associated CoPilot ID under 
TruckName.  For each vehicle, PC*MILER displays an online/offline Status and 
Last Known Position.  For trucks that are offline, the date/time when the truck 
went offline is shown.  The last column in the Vehicle List records the last 
message that the dispatcher received from a truck, including a timestamp and 
message description. 
 
When you select a vehicle on the list, its Last Known Position will be displayed 
if it is available.  If a vehicle is offline, the route that you send will be received 
when CoPilot comes back online in the vehicle.   
 
To Delete Vehicles: 
Use the Manage ALK Cloud Account web page.  See section 14.2.1. 
 
To Update the Vehicle List: 
To refresh the information in the Vehicle Manager, click Update Vehicles.   
   

15.6  Vehicle Display on the Map 
To zoom to a vehicle’s current or last known position on the PC*MILER map, in 
the Send Route dialog (gear menu > RouteSync) click Show Vehicle On Map.   
The vehicle’s position on the map is updated automatically every 60 seconds. 
 

 
 
 

 
 

 

 

 

 

 

 
 

Send Route Dialog 

Two Online Vehicles on the Map 
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Technical Support & 
Contact Options 

 
 

16.1  Technical Support Options 

ALK Technologies offers one year of free unlimited technical support to all 
registered users of PC*MILER.  If  you have unresolved questions about 
PC*MILER or problems with the software, visit us at www.alk.com/support for 
answers to frequently asked questions (FAQ) or contact us in the following ways:  
 
Phone: 1.800.377.6453, ext 2 or 609.683.0220, ext. 2.  When calling, ask for 

PC*MILER Technical Support.  Please be sure to have your PC*MILER 
Product Key Code, version number, Windows® version number, and 
hardware configuration information (manufacturer, speed, and monitor 
type) available before your call.  Please include this information in your 
message if you are contacting us by email. 

Email: pcmsupport@alk.com, or from within PC*MILER select the Help tab > 
Technical Support group > Email Technical Support and follow the 
instructions provided.  If you have any supporting material, click Attach 
File and browse for the file(s) to attach. Attachments of supporting 
documentation can be up to 10 MB.  When ready, click Send.  ALK's 
technical support team will send a confirmation email to the email entered 
in the "Enter your email here" field when it is received. 

Web Site: www.pcmiler.com 
Hours: 9:00am – 5:00pm EST, Mon-Fri 

 
To print additional copies of this User’s Guide, click the Windows Start button, 
then go to All Programs > PCMILER 29 > User Guides and select the .pdf file 
from the sub-menu.   
 

16.2  PC*MILER Sales Contact Information 

Phone: 800.377.6453, ext 1  
  609.683.0220 (outside the U.S.) 
Fax:  609.683.0290 
Email: sales@alk.com 
Web Site: www.alk.com/support 
Address: ALK Technologies, Inc. 
     457 North Harrison Street 
     Princeton, NJ 08540  USA 
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16.3  PC*MILER Updates 
A new, updated release of PC*MILER is offered on an annual basis.  Updated 
releases of PC*MILER|Worldwide and DTOD data are provided annually several 
months following the PC*MILER for North America release.  Updates may 
include revisions to the software, updates to the North American and Worldwide 
highway and road network databases, and updates to the SPLC and ZIP/Postal 
code databases.  To order your annual update contact ALK Technologies, Inc. or 
your PC*MILER dealer.  
 
Between version releases, updates and patches are periodically made available as 
the need arises.  These may include corrections to any reported errors in the 
software or data, or access to new data releases (for applicable products and 
license types*).  Note that these patches and updates are now cumulative, 
meaning they include items from previously released patches/updates of the same 
type.  ALK strongly recommends checking for the most current updates 
regularly.  This is recommended for all users, but particularly important for 
PC*MILER|Tolls users. 
 
* NOTE:  If a PC*MILER product was purchased along with signing up for 
ALK’s Annual Update Program (AUP license purchase), customers are entitled to 
use PC*MILER during the term of their agreement and also to receive data 
updates when and if available.  AUP licensed users will have access to the base 
version data set as well as to any more recently released data sets as they are 
available.  For those who do not sign up for the AUP, PC*MILER is purchased as 
a Perpetual license which entitles the licensed user to any available software 
patches released for the purchased version, and any available toll data updates if 
PC*MILER|Tolls was purchased.   
 
For more information on upgrading a Perpetual license to an AUP license, please 
contact an Enterprise Solutions account executive at 800-377-6453 ext. 1 or email 
sales@alk.com.  
 
 

16.3.1  Using the Updater Tool 
 

Provided you have an internet connection, follow the steps below to install the 
available updates: 

 
1. Close all open instances of PC*MILER and its connectivity products.  If a 

third-party program that accesses any PC*MILER component is running, 
(for example, PC*MILER|Connect or PC*MILER|Mapping) it must be 
closed before updating. 

2. Open PC*MILER and select the Help tab > Windows group > Check for 
Updates.  The PC*MILER Updater dialog will open.  The Updater first 
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checks for valid license information and then begins checking for available 
updates. 

 
PC*MILER Updater 

 
3. When the search for updates is complete you will see all available updates 

listed.  In the Download & Install drop-down menu next to each available 
update, select either Download & Install to download and install right away 
or Download to download now and install at a later time.  

 

 
Download and Install Options 

 
4. Note the version number of the updates you will be downloading so you can 

check if the update installed properly (see Step 7 below).   
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5. Selecting either option will begin the download process.  You will see the 
progress of the download reflected in a progress bar.  If any PC*MILER-
related application is open, you will be prompted to close it.  After closing 
the application(s), click OK to continue with the download. 

 

 
 

6. If you chose Download and Install, the InstallShield Wizard will open when 
the download is finished.  Follow the instructions to complete the installation.  
After installing, you will see the update listed under “Installed Updates” in the 
Updater window. 

 
If you chose Download, when the download is finished the button to the 
right will now say “Install”.  You can complete the installation as described 
above at any time in the future by opening the Updater window and clicking 
Install. 
 
IMPORTANT:  You must close the Updater after processing is finished.  
The next time you open the Updater, the files you downloaded will be shown 
in the “Downloaded Updates” section of the dialog. 
 

7. As a last step, check to make sure the update installed properly.  Select the 
Help tab > About group > About and look for the Software Version number 
under “This Product is Licensed To”.  It should match what you 
downloaded. 

 
 

 
PC*MILER “About” Window 
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16.4  Reporting Data Errors 

ALK Technologies' North American and Worldwide highway and road networks 
– the primary databases used by PC*MILER products – undergo constant 
revision.  Revisions include the addition of new roads, upgrades of improved 
sections of highway, and addition of new Key Cities. 
 
ALK Technologies is dedicated to maintaining a highway and street-level 
network of the highest quality and welcomes user input and comments.  If you 
encounter any problems related to mileage, routing or highway names, from 
within PC*MILER please go to the Help tab > Technical Support group > Email 
Data Correction and follow the on-screen guidelines to submit the issue.  
Supporting documentation can be attached to this email form, just click the 
Attach File button and browse for the file.  Attachments can be up to 10 MB.  
 
When you are finished filling out the form, click Send to send it.  Our digital 
cartography team will make every effort to correctly analyze and incorporate your 
data suggestions.  
 
You can also print a copy of the route, highlighting the problem (such as incorrect 
road name, mileage, city name, postal code) and send it to: 
  

 

PC*MILER Products Division 
ALK TECHNOLOGIES, INC. 

457 North Harrison Street ∙ Princeton, NJ 08540 ∙ USA 
Email: pcmsupport@alk.com 
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        About ALK Technologies 
 
 
 

ALK® Technologies, Inc., a Trimble® company headquartered in Princeton, NJ, 
was founded in 1979 as a transportation industry pioneer. ALK harnesses the 
power of information technology to enhance transportation and mobility, 
supporting competitive advantage and improved quality of life. 
 
Today, ALK is a global leader in GeoLogistics® solutions and navigation 
software, focused on developing innovative solutions for transportation, logistics, 
mobile workforces and consumers. Product lines include award-winning 
CoPilot®, a leading source of GPS navigation software for fleets, mobile 
operators, hardware OEMs, systems integrators, professional drivers and 
consumers. ALK’s PC*MILER® is widely recognized as a transportation industry 
standard for routing, mileage and mapping. ALK® Maps is a development 
platform designed for the transportation industry and provides commercial 
routing, geocoding and mapping visualization for enterprise applications. 
 
See section 17.1 below for an overview of ALK’s Enterprise Solutions.  For 
detailed product information, visit us at www.alk.com or www.pcmiler.com. 
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17.1  Enterprise Solutions from ALK Technologies 
Contact an Enterprise Solutions account executive to find out how the following 
value-add on solutions can boost productivity, reduce out-of-route mileage and 
improve return on investment.  For more detailed information on each product, go 
to www.alk.com or www.pcmiler.com.   
 
• PC*MILER — PC*MILER is truck-specific, point to point routing, mileage 

and mapping software that the transportation and logistics industry depends on 
to succeed. Accuracy and reliability have positioned PC*MILER as the 
software used by 98 of the top 100 motor carrier, 46 of the top 50 freight 
transportation firms and 47 of the top 50 logistics companies in North 
America. The U.S. Department of Defense (DoD), the General Services 
Administration (GSA) and the Federal Motor Carrier Safety Administration 
(FMCSA) also rely on PC*MILER as their worldwide distance standard. 

• PC*MILER|Streets — PC*MILER|Streets is street-level routing, mileage 
and mapping software designed to provide dock-to-dock driving directions 
over truck-specific routes.  It includes all the features and functionality of 
PC*MILER plus an enhanced street-level routing network, map database, and 
street address database. Ensure that your vehicles and loads get to the right 
place using the most precise truck-specific route possible, taking into 
consideration truck-preferred and truck-restricted roads. PC*MILER|Streets 
data is available for the U.S. and Canada and, with PC*MILER|Worldwide, 
for many countries outside North America. 

 
• PC*MILER|Traffic — PC*MILER|Traffic calculates more accurate transit 

times and ETAs with real time, historical and predictive traffic speed data. It 
allows visualization of traffic trends directly on the PC*MILER map. 
PC*MILER|Traffic includes a “Fastest” routing type that optimizes overall 
transit time, taking into account real time traffic congestion and predictive 
traffic speeds, by the hour and by the day. 
 

• PC*MILER|Tolls — PC*MILER|Tolls calculates truck-specific toll costs 
based on a vehicle’s weight, axle count, trailer count, transaction type (cash or 
discount program), and time of day travel in the U.S. and Canada. It is driven 
by the same technology and map data set as ALK's industry-standard 
PC*MILER routing, mileage and mapping software. When generating routes, 
truck-specific toll costs are added into a route’s overall calculation. Determine 
whether it's more cost-effective to take a toll route, or a non-toll route with a 
few additional miles, before routing a vehicle.  

 
• PC*MILER|HazMat — PC*MILER|HazMat generates point to point and 

street-level routes, mileage and driving directions for hauling hazardous 
materials and dangerous goods in the U.S. and Canada. Federal government 
mandates state that shippers and carriers are to implement security plans 
regarding the transport of hazardous materials. A major step in that process is 
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providing drivers with routes and mileage that ensure compliance with these 
federal, state/province and local restrictions and route designations. To ensure 
fleet and driver safety, PC*MILER|HazMat identifies where drivers should 
legally be traveling for the particular type of hazardous commodity they are 
hauling.  
 

• PC*MILER|Worldwide — PC*MILER|Worldwide is point-to-point routing, 
mileage and mapping software that generates routes, distances, maps and 
driving directions over the entire international highway network. Employ the 
functionality of PC*MILER across worldwide data coverage, including 
Africa, Asia, Europe, the Middle East, North America, Oceania, and South 
America.  Additionally, street-level address data modules are available for the 
U.S. and Canada, Europe, and many countries in worldwide regions. 

 
• PC*MILER|BatchPro — PC*MILER|BatchPro is a batch-processing tool 

that permits the simultaneous processing of large volumes of lanes (set as 
origin/destination pairs) entered as city/state combinations, ZIP or Postal 
Codes, or latitude/longitude coordinates rather than entering routes 
individually. It gives you the ability to generate routes, mileage, as well as 
cost and time information per route. 
 

• CoPilot® Truck — CoPilot Truck offers an easy to use, intuitive interface 
with spoken turn-by-turn directions and easy to follow, non-distracting 
guidance displays. Unlike standard car navigation systems, it calculates 
efficient routes based on your vehicle profile information, routing parameters 
and load type, including hazardous materials.  Running conveniently on a 
wide range of smartphones, tablets and laptops, CoPilot Truck uses street-
level ALK Digital Maps™ enhanced with industry standard PC*MILER 
truck-specific attributes featuring 3.52 million commercial truck restrictions 
and allowances. With powerful multi-stop routing it effortlessly provides the 
optimal route for any itinerary, while automatically avoiding commercial 
truck restrictions to increase efficiency, reduce mileage and help avoid costly 
fines and vehicle damage. 

• RouteSync – RouteSync provides the transportation and logistics industry 
with a crucial link between the planned route in the back office and the 
navigated route in the cab.  RouteSync delivers the guidance to drive the miles 
that are being billed.  Using RouteSync, dispatchers can send PC*MILER 
optimized routes directly to drivers running CoPilot Truck on an on-board 
device, smartphone or tablet.  

• ALK® Maps – ALK Maps is a JavaScript API for interactive visualizations 
tailored to the transportation industry.  Powered by the same core technology 
that drives ALK’s portfolio of GeoLogistics® and navigation software 
solutions, ALK Maps provides a high-quality customized alternative to 
consumer mapping services that can be used in web applications, mobile apps, 
or desktop products.  With only a few lines of code, an interactive map can be 
displayed; and a few more lines of code enables route generation and address 
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geocoding.  ALK Maps is designed to get you up and running quickly and 
with less overhead. 

 
• PC*MILER|Web – PC*MILER|Web is an internet-based version of 

PC*MILER, available in monthly, quarterly or annual subscription packages.  
This product is perfect for owner operators, fleets, brokers, or anyone else 
who needs instant, accurate mileage for rate calculation or truck-specific 
driving directions or maps.  And it’s accessible on the web through any 
internet-connected computer, in the office, at home, or on the road. 

 
• PC*MILER|Rail — PC*MILER|Rail is the rail and logistics industry's 

leading point-to-point routing, mileage and mapping software. Widely used in 
fuel surcharge calculation, equipment management, rail car mileage auditing, 
carrier selection, rate determination and negotiation, and ad valorem tax 
reporting, PC*MILER|Rail determines actual operating or fuel surcharge 
routes and mileage using station/state abbreviations or railroad industry codes. 
Through ALK’s close working relationship with all major railroads, 
PC*MILER|Rail features the most accurate digital representation of the North 
American rail network. 

 
 

CONNECTIVITY and INTERFACE PRODUCTS 
   
• PC*MILER|Connect — PC*MILER|Connect seamlessly interfaces 

PC*MILER routes, mileage and reports with third-party and custom systems, 
such as transportation and logistics management software systems. Client 
applications are able to retrieve PC*MILER distances, detailed driving 
directions, drive times, state-by-state mileage summaries, stop optimization 
functionalities and more. 
 

• Multi-Version Switch (MVS) — Multi-Version Switch is a high-end 
function of PC*MILER|Connect that serves as an integration tool designed to 
simultaneously support multiple versions of PC*MILER that are installed on 
one server or on several different servers.  Instead of manually querying data 
from each individual version, the Multi-Version Switch functions as the main 
connection point to programmatically gain access to the version of choice. 
 

• PC*MILER Web Services — PC*MILER Web Services is an integration 
tool designed to efficiently fulfill all PC*MILER routing, mileage and 
mapping transactions in a simple hardware and software-agnostic system 
interface to any computing platform. It offers a standardized way of 
integrating PC*MILER with Web Services, .NET, or Web-based applications 
using XML (Extensible Markup Language) and SOAP (Simple Object Access 
Protocol) over an Internet Protocol Backbone – all developed in Microsoft® 
.NET. 
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• PC*MILER|Mapping — PC*MILER|Mapping seamlessly interfaces 
PC*MILER routes and geographic data on maps for integration with real-time 
dispatch and operations analysis programs. PC*MILER|Mapping allows you 
to include commands in spreadsheets, databases and custom systems to obtain 
a visual overview of your data.  
 

• PC*MILER|Spreadsheets — PC*MILER|Spreadsheets gives you the ability 
to access PC*MILER features and functionality from within your own 
spreadsheet software. Generate point-to-point or street-level mileage and drive 
times within a spreadsheet program, and then use built-in functions to 
summarize and analyze your data. PC*MILER|Spreadsheets provides a 
seamless interface with PC*MILER and Microsoft Excel, allowing you to 
perform customized data analyses. 
 

• PC*MILER|TCP/IP — PC*MILER|TCP/IP is an integration tool that 
provides an interface to PC*MILER|Connect running in a Windows® 
environment to an application residing on another platform. Through a 
TCP/IP network, client applications can access a text-based interface to call 
PC*MILER|Connect's features and functionality. The interface opens cross 
platform communications in a thread-safe manner, giving you the flexibility to 
transmit the output of PC*MILER|Connect to multiple networks within your 
organization. 

• PC*MILER|Rail-Connect – This PC*MILER|Rail connectivity product 
seamlessly interfaces with custom third-party systems such as transportation 
and logistics management, costing and tracking software systems. Custom 
client applications are able to retrieve PC*MILER|Rail routes, maps, 
distances, detailed reports, state-by-state and railroad mileage summaries, and 
much more. Also includes the ability to access the PC*MILER|Rail database 
from within your own spreadsheet software. 

  
• PC*MILER|Rail-BatchPro – PC*MILER|Rail-BatchPro processes large 

volumes of origin-destination pairs formatted as city/state names, SPLC’s, 
FSAC’s, ERPC’s (3-3-3’s) or R260 junction codes.  PC*MILER|Rail users 
can save time using batch processing rather than entering rail routes 
individually. 

• PC*MILER|Rail-TCP/IP – This product is an integration tool that provides 
an interface to PC*MILER|Rail-Connect running in a Windows environment 
to an application residing on another platform.  Through a TCP/IP network, 
client applications can access a text-based interface to call PC*MILER|Rail-
Connect's features and functionality. The interface opens cross-platform 
communications in a thread-safe manner, giving you the flexibility to transmit 
the output of PC*MILER|Rail-Connect to multiple networks within your 
organization. 
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ADDITIONAL DATA MODULES 

• Canadian Postal Codes — Enhance the PC*MILER database with six-digit 
Canadian Postal Codes.  Enables search and display of corresponding 
city/province names to enter them as stops along a route. 
 

• Standard Point Location Codes (SPLC) — Add SPLC to the PC*MILER 
database to generate routes for rating and freight bill auditing.  A SPLC 
provides each point originating freight and each point receiving freight in 
North America with a unique code number that identifies the point by its 
geographic location. 

• PC*MILER|Energy — Provides oil- and gas-specific data and facilities 
including bonded or leased access roads.  Users can now generate precise 
mileage and driving directions that take them directly to facilities in the patch 
including off-road wells, compressor stations, and plants. 

 
 

 
 

1-800-377-MILE 
www.alk.com 

ALK Technologies, Inc. 
457 North Harrison Street 

Princeton, New Jersey 08540 
U.S.A. 
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Appendix A: 
 Access Policies from National Network Routes 

to Terminals & Services 
 
 
 

Reasonable Access Defined 
 
Reasonable access is the deviation allowed between the specified truck network and any 
allowable stops.  A stop is typically defined as a place of loading or unloading, or facilities for 
food, fuel, repairsand rest.  In all cases, local signs and warnings prohibiting truck access or 
providing an applicable restriction take precedence over reasonable access rules.  In some states 
the deviation allowed from the National Network or 53 Foot Designated Truck Network may vary 
depending on the roads used to get to the stop.  If this is the case, we have differentiated between 
reasonable access from the truck route and on a state highway versus local roads. 
 
For detailed information about pre-approved routes, contact the individual states. 
 
 

PC*MILER Designated Road Categories 
 
In the PC*MILER database, roads designated for 102” wide, 53’ long trailers or twin 28’ 
long trailers are coded in three ways: 

 
 National Network – These are the original roads designated by the states and 

approved by FHWA circa 1990, or (rarely) changes submitted by the states to 
FHWA post-1990.  FHWA requires that the states allow at least 1 mile access 
distance to/from these roads, but the states are free to specify a longer access 
distance if they wish.  Many states (especially in the west) have size limits for 
their entire state that equal or exceed this size of equipment in both width and 
length. In PC*MILER, these roads are considered to have “unlimited” access 
distance.  Some states in the east restrict this equipment to designated roads, but 
allow unlimited access “by the shortest and/or most direct route” (or similar 
language), and roads in these states also have “unlimited” access distance. 
 

 State Oversize – This category includes additional roads designated by the states 
since 1990, or which they have not submitted to FHWA for approval since 1990, 
to which the same access distance applies as to the National network in that state. 
 

 Oversize Access – This category includes additional roads designated by the 
states to which a different (shorter, often zero) access distance applies.    Usually 
these are county highways or local streets that lead all the way from the National 
Network and/or State Oversize network to the entrance to an industrial park, truck 
terminal, distribution center, factory, warehouse, etc. 
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Users will receive a “Not Designated” warning in the route window and the Detailed and 
Driver’s reports if National Network and 53’ Trailers or Twins are checked in Route 
Options, and  
 

a. the route uses a road that is not designated National Network, State Oversize, 
or Oversize Access to go between roads that are designated National Network, 
State Oversize, or Oversize Access, OR 

b. the route uses a road that is not designated National Network, State Oversize, 
or Oversize Access to access an origin, destination, or stop further  than the 
distances specified in the regulations. 

 
 

Allowable Distance by Jurisdiction 
 
The table below shows the allowable distance (in miles) on truck access roads in North 
American jurisdictions, by PC*MILER road category as described above.  Columns in 
the table are: 
 
Column 1 - Jurisdiction abbreviation 
Column 2 - Jurisdiction FIPS code 
Column 3 - Access miles from National Network on US and State numbered highways 
Column 4 - Access miles from National Network on all other roads 
Column 5 - Access miles from State Oversize on US and State numbered highways 
Column 6 - Access miles from State Oversize on all other roads 
Column 7 - Access miles from Oversize Access 
 
NOTE:  “Unlimited access” in this table is as defined in the description of PC*MILER 
designated road categories above. 
 

Jurisdiction 
Abbrev. FIPS 

3 - From Nat’l 
Netw on US & 
State Highways 

4 - From Nat’l 
Netw on other 
roads 

5 - From State 
Oversize on 
US & State 
Highways 

6 – From State 
Oversize on 
other roads 

7 – From 
Oversize 
Access 

AL 1 1 1 1 1 0 
AK 2 Unlimited access Unlimited access Unlimited access Unlimited access 0 
AZ 4 1 1 1 1 0 
AR 5 Unlimited access Unlimited access Unlimited access Unlimited access 0 
CA 6 1 1 1 1 0 
CO 8 Unlimited access Unlimited access Unlimited access Unlimited access 0 
CT 9 1 1 1 1 0 
DE 10 1 1 1 1 0 
DC 11 1 1 1 1 0 
FL 12 Unlimited access Unlimited access Unlimited access Unlimited access 0 
GA 13 Unlimited access Unlimited access Unlimited access Unlimited access 0 
HI 15 Unlimited access Unlimited access Unlimited access Unlimited access 0 
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Jurisdiction 
Abbrev. FIPS 

3 - From Nat’l 
Netw on US & 
State Highways 

4 - From Nat’l 
Netw on other 
roads 

5 - From State 
Oversize on 
US & State 
Highways 

6 – From State 
Oversize on 
other roads 

7 – From 
Oversize 
Access 

ID 16 1 1 1 1 0 
IL 17 5 1 5 1 0 
IN 18 Unlimited access Unlimited access Unlimited access Unlimited access 0 
IA 19 Unlimited access Unlimited access Unlimited access Unlimited access 0 
KS 20 Unlimited access Unlimited access Unlimited access Unlimited access 0 
KY 21 5 1 5 1 0 
LA 22 10 10 10 10 0 
ME 23 Unlimited access Unlimited access Unlimited access Unlimited access 0 
MD 24 Unlimited access Unlimited access Unlimited access Unlimited access 0 
MA 25 Unlimited access Unlimited access Unlimited access Unlimited access 0 
MI 26 5 1 5 1 0 
MN 27 1 1 1 1 0 
MS 28 Unlimited access Unlimited access Unlimited access Unlimited access 0 
MO 29 10 10 10 10 0 
MT 30 Unlimited access Unlimited access Unlimited access Unlimited access 0 
NE 31 Unlimited access Unlimited access Unlimited access Unlimited access 0 
NV 32 Unlimited access Unlimited access Unlimited access Unlimited access 0 
NH 33 1 1 1 1 0 
NJ 34 Unlimited access Unlimited access Unlimited access Unlimited access 0 
NM 35 20 20 20 20 0 
NY 36 1 1 1 1 0 
NC 37 3 3 3 3 0 
ND 38 Unlimited access Unlimited access Unlimited access Unlimited access 0 
OH 39 Unlimited access Unlimited access Unlimited access Unlimited access 0 
OK 40 Unlimited access Unlimited access Unlimited access Unlimited access 0 
OR 41 1 1 1 1 0 
PA 42 1 1 1 1 0 
RI 44 1 1 1 1 0 
SC 45 Unlimited access Unlimited access Unlimited access Unlimited access 0 
SD 46 Unlimited access Unlimited access Unlimited access Unlimited access 0 
TN 47 Unlimited access Unlimited access Unlimited access Unlimited access 0 
TX 48 Unlimited access Unlimited access Unlimited access Unlimited access 0 
UT 49 1 1 1 1 0 
VT 50 Unlimited access Unlimited access Unlimited access Unlimited access 0 
VA 51 1 1 1 1 0 
WA 53 Unlimited access Unlimited access Unlimited access Unlimited access 0 
WV 54 Unlimited access Unlimited access Unlimited access Unlimited access 0 
WI 55 15 15 15 15 0 
WY 56 Unlimited access Unlimited access Unlimited access Unlimited access 0 
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Jurisdiction 
Abbrev. FIPS 

3 - From Nat’l 
Netw on US & 
State Highways 

4 - From Nat’l 
Netw on other 
roads 

5 - From State 
Oversize on 
US & State 
Highways 

6 – From State 
Oversize on 
other roads 

7 – From 
Oversize 
Access 

PR 72 Unlimited access Unlimited access Unlimited access Unlimited access 0 
NU 80 Unlimited access Unlimited access Unlimited access Unlimited access 0 
YT 81 Unlimited access Unlimited access Unlimited access Unlimited access 0 
NT 82 Unlimited access Unlimited access Unlimited access Unlimited access 0 
BC 83 Unlimited access Unlimited access Unlimited access Unlimited access 0 
AB 84 Unlimited access Unlimited access Unlimited access Unlimited access 0 
SK 85 Unlimited access Unlimited access Unlimited access Unlimited access 0 
MB 86 Unlimited access Unlimited access Unlimited access Unlimited access 0 
ON 87 Unlimited access Unlimited access Unlimited access Unlimited access 0 
QC 88 Unlimited access Unlimited access Unlimited access Unlimited access 0 
NB 89 Unlimited access Unlimited access Unlimited access Unlimited access 0 
PE 90 Unlimited access Unlimited access Unlimited access Unlimited access 0 
NS 91 Unlimited access Unlimited access Unlimited access Unlimited access 0 
NL 92 Unlimited access Unlimited access Unlimited access Unlimited access 0 
EM 93 Unlimited access Unlimited access Unlimited access Unlimited access 0 
BD 130 Unlimited access Unlimited access Unlimited access Unlimited access 0 
GL 131 Unlimited access Unlimited access Unlimited access Unlimited access 0 
BH 132 Unlimited access Unlimited access Unlimited access Unlimited access 0 
CS 133 Unlimited access Unlimited access Unlimited access Unlimited access 0 
ES 134 Unlimited access Unlimited access Unlimited access Unlimited access 0 
GT 135 Unlimited access Unlimited access Unlimited access Unlimited access 0 
HO 136 Unlimited access Unlimited access Unlimited access Unlimited access 0 
NU 137 Unlimited access Unlimited access Unlimited access Unlimited access 0 
PM 138 Unlimited access Unlimited access Unlimited access Unlimited access 0 
AG 139 Unlimited access Unlimited access Unlimited access Unlimited access 0 
BJ 140 Unlimited access Unlimited access Unlimited access Unlimited access 0 
BS 141 Unlimited access Unlimited access Unlimited access Unlimited access 0 
CP 142 Unlimited access Unlimited access Unlimited access Unlimited access 0 
CH 143 Unlimited access Unlimited access Unlimited access Unlimited access 0 
CI 144 Unlimited access Unlimited access Unlimited access Unlimited access 0 
CU 145 Unlimited access Unlimited access Unlimited access Unlimited access 0 
CL 146 Unlimited access Unlimited access Unlimited access Unlimited access 0 
DF 147 Unlimited access Unlimited access Unlimited access Unlimited access 0 
DG 148 Unlimited access Unlimited access Unlimited access Unlimited access 0 
GR 149 Unlimited access Unlimited access Unlimited access Unlimited access 0 
GJ 150 Unlimited access Unlimited access Unlimited access Unlimited access 0 
HG 151 Unlimited access Unlimited access Unlimited access Unlimited access 0 
JA 152 Unlimited access Unlimited access Unlimited access Unlimited access 0 
MH 154 Unlimited access Unlimited access Unlimited access Unlimited access 0 
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Jurisdiction 
Abbrev. FIPS 

3 - From Nat’l 
Netw on US & 
State Highways 

4 - From Nat’l 
Netw on other 
roads 

5 - From State 
Oversize on 
US & State 
Highways 

6 – From State 
Oversize on 
other roads 

7 – From 
Oversize 
Access 

MR 155 Unlimited access Unlimited access Unlimited access Unlimited access 0 
NA 156 Unlimited access Unlimited access Unlimited access Unlimited access 0 
NX 157 Unlimited access Unlimited access Unlimited access Unlimited access 0 
OA 158 Unlimited access Unlimited access Unlimited access Unlimited access 0 
PU 159 Unlimited access Unlimited access Unlimited access Unlimited access 0 
QA 160 Unlimited access Unlimited access Unlimited access Unlimited access 0 
QR 161 Unlimited access Unlimited access Unlimited access Unlimited access 0 
SI 162 Unlimited access Unlimited access Unlimited access Unlimited access 0 
SL 163 Unlimited access Unlimited access Unlimited access Unlimited access 0 
SO 164 Unlimited access Unlimited access Unlimited access Unlimited access 0 
TA 165 Unlimited access Unlimited access Unlimited access Unlimited access 0 
TM 166 Unlimited access Unlimited access Unlimited access Unlimited access 0 
TL 167 Unlimited access Unlimited access Unlimited access Unlimited access 0 
VZ 168 Unlimited access Unlimited access Unlimited access Unlimited access 0 
YC 169 Unlimited access Unlimited access Unlimited access Unlimited access 0 
ZT 170 Unlimited access Unlimited access Unlimited access Unlimited access 0 
ACT 200 Unlimited access Unlimited access Unlimited access Unlimited access 0 
NSW 201 Unlimited access Unlimited access Unlimited access Unlimited access 0 
NT 202 Unlimited access Unlimited access Unlimited access Unlimited access 0 
QLD 203 Unlimited access Unlimited access Unlimited access Unlimited access 0 
SA 204 Unlimited access Unlimited access Unlimited access Unlimited access 0 
TAS 205 Unlimited access Unlimited access Unlimited access Unlimited access 0 
VIC 206 Unlimited access Unlimited access Unlimited access Unlimited access 0 
WA 207 Unlimited access Unlimited access Unlimited access Unlimited access 0 
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Appendix B:  Canadian Counties 
 
 
 
Canadian Counties that are included in the PC*MILER database are listed below.  
Regional districts and other types of sub-divisions that exist within Canadian 
provinces and territories are not included in the database and therefore not listed. 
 
 

Province Counties 
  
Alberta (No Counties) 
  
British Columbia (Contains a County) 

 CARIBOO 
  
Manitoba (No Counties) 
  
New Brunswick (Contains Counties) 

 ALBERT 
 CARLETON 
 CHARLOTTE 

 GLOUCESTER 
 KENT 
 KINGS 
 MADAWASKA 
 NORTHUMBERLAND 
 QUEENS 
 RESTIGOUCHE 
 ST. JOHN 
 SUNBURY 
 VICTORIA 
 WESTMORLAND 
 YORK 
  

Newfoundland and 
Labrador 

(No Counties) 

 
Northwest 
Territories 

(No Counties) 
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Nova Scotia (Contains Counties) 

 ANNAPOLIS 
 ANTIGONISH 
 CAPE BRETON 
 COLCHESTER 
 CUMBERLAND 
 DIGBY 
 GUYSBOROUGH 
 HALIFAX 
 HANTS 
 INVERNESS 
 KINGS 
 LUNENBURG 
 PICTOU 
 QUEENS 
 RICHMOND 
 SHELBURNE 
 VICTORIA 
 YARMOUTH 
  
Nunavut 
 
Ontario 
 

(No Counties) 
 
(Contains Counties) 
 

 ALGOMA 
 BRANT 
 BRUCE 
 COCHRANE 
 DUFFERIN 
 DURHAM 
 ELGIN 

 ESSEX 
 FRONTENAC 
 GREY 
 HALDIMAND 
 HALIBURTON 
 HASTINGS 
 HURON 
 KENORA 
 KENT 

 LAMBTON 
 LANARK 
 MANITOULIN 
 MIDDLESEX 
 NIPISSING 

NORFOLK 
 NORTHUMBERLAND 
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 OTTAWA - CARLETON 
 OXFORD 
 PARRY SOUND 
 PERTH 
 PETERBOROUGH 
 PRINCE EDWARD 
 RAINY RIVER 
 RENFREW 
 SIMCOE 
 SUDBURY RM 
 THUNDER BAY 
 TIMISKAMING 
 TORONTO 
 VICTORIA 
 WELLINGTON 
  
Prince Edward 
Island 

(Contains Counties) 

 KINGS 
 PRINCE 
 QUEENS 
  

Quebec (Contains Counties) 
 

 ABITIBI-TEMISCAMINGUE 
 BAS-SAINT-LAURENT 
 CENTRE-DU-QUEBEC 
 CHAUDIERE-APPALACHES 

 COMMUNAUTE-URBAINE-DE-MONTREAL 
 COTE-NORD 
 ESTRIE 
 GASPESIE - ILES-DE-LA-MADELEINE 
 LA CÔTE-DE-BEAUPRÉ 
 LANAUDIERE 
 LAURENTIDES 
 LES JARDINS-DE-NAPIERVILLE 
 MAURICIE 
 MONTEREGIE 
 MONTREAL 
 OUTAOUAIS 
 QUEBEC 
 ROUVILLE 
 SAGUENAY - LAC-SAINT-JEAN 

 
Saskatchewan (No Counties) 
 
Yukon (No Counties) 
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Appendix C: 

 State/Province/Country Abbreviations 
 
 
 

States/Provinces in the U.S., Canada, and Mexico 
(For countries and country abbreviations included in the North America region, see “North 
America” below under Country Codes For All Worldwide Regions) 
 
States/Provinces in the United States & Canada 
 
AL Alabama 
AK Alaska 
AB Alberta 
AZ Arizona 
AR Arkansas 
BC British Columbia 
CA California 
CO Colorado 
CT Connecticut 
DE Delaware 
DC Dist. of Columbia 
FL Florida 
GA Georgia 
ID Idaho 
IL Illinois 
IN Indiana  
IA Iowa 
KS Kansas 
KY Kentucky 
LA Louisiana 
ME Maine 
MB Manitoba 
MD Maryland 
MA Massachusetts 
MI Michigan 
MN Minnesota 
MS Mississippi 
MO Missouri 
MT Montana 
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NE Nebraska 
NV Nevada 
NB New Brunswick 
NH New Hampshire 
NJ New Jersey 
NM New Mexico 
NY New York 
NL Newfoundland & Labrador 
NC North Carolina 
ND North Dakota 
NT Northwest Territory 
NS Nova Scotia 
NU* Nunavut 
OH Ohio 
OK Oklahoma 
ON Ontario 
OR Oregon 
PA Pennsylvania 
PE Prince Edward Island 
QC Quebec 
RI Rhode Island  
SK Saskatchewan 
SC South Carolina 
SD South Dakota 
TN Tennessee 
TX Texas 
UT Utah 
VT Vermont 
VA Virginia 
WA Washington 
WV West Virginia 
WI Wisconsin 
WY Wyoming 
YT Yukon Territory 
 
 

* The same FIPS code, NU, is used for Nicaragua and the province of Nunavut, Canada in the 
PC*MILER database. 
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Mexican Estados 
AG Aguascalientes 
BJ Baja California 
BS Baja California Sur 
CP Campeche 
CH Chiapas 
CI Chihuahua 
CU Coahuila de Zaragoza 
CL Colima 
DF Distrito Federal 
DG Durango 
GJ Guanajuato 
GR Guerrero 
HG Hidalgo 
JA Jalisco 
EM Mexico (Estado) 
MH Michoacan de Ocampo 
MR Morelos 
NA Nayarit 
NX * Nuevo Leon 
OA Oaxaca 
PU Puebla 
QA Queretaro Arteaga 
QR Quintana Roo 
SL San Luis Potosi 
SI Sinaloa 
SO Sonora 
TA Tabasco 
TM Tamaulipas 
TL Tlaxcala 
VZ Veracruz 
YC Yucatan 
ZT Zacatecas 

 
*  Please note that by default, “NX” is used for Nuevo Leon because the province of 

Newfoundland and Labrador in Canada already utilizes “NL” in the database.  However, there 
is an option that sets “NL” as the abbreviation for Nuevo Leon: in the File application menu, 
select Application Settings .  In the NL Abbreviation drop-down, select Use for Nuevo Leon 
and click Save. 
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Country Codes For All Worldwide Regions 
 
Africa 

 

COUNTRY NAME FIPS ISO2 ISO3 GENC2 GENC3 
Algeria AG DZ DZA DZ DZA 
Angola AO AO AGO AO AGO 
Benin BN BJ BEN BJ BEN 
Botswana BC BW BWA BW BWA 
Burkina Faso UV BF BFA BF BFA 
Burundi BY BI BDI BI BDI 
Cameroon CM CM CMR CM CMR 
Cape Verde CV CV CPV CV CPV 
Central African Republic CT CF CAF CF CAF 
Chad CD TD TCD TD TCD 
Comoros CN KM COM KM COM 
Congo Democratic Republic (Kinshasa) CG CG COD CD COD 
Congo, Republic of the (Brazzaville) CF CD COG CG COG 
Djibouti DJ DJ DJI DJ DJI 
Egypt EG EG EGY EG EGY 
Equatorial Guinea EK GQ GNQ GQ GNQ 
Eritrea ER ER ERI ER ERI 
Ethiopia ET ET ETH ET ETH 
Gabon GB GA GAB GA GAB 
Gambia GA GM GMB GM GMB 
Ghana GH GH GHA GH GHA 
Guinea GV GN GIN GN GIN 
Guinea-Bissau PU GW GNB GW GNB 
Ivory Coast (Côte d’Ivoire) IV CI CIV CI CIV 
Kenya KE KE KEN KE KEN 
Lesotho LT LS LSO LS LSO 
Liberia LI LR LBR LR LBR 
Libya LY LY LBY LY LBY 
Madagascar MA MG MDG MG MDG 
Malawi MI MW MWI MW MWI 
Mali ML ML MLI ML MLI 
Mauritania MR MR MRT MR MRT 
Mauritius MP MU MUS MU MUS 
Mayotte MF YT MYT YT MYT 
Morocco MO MA MAR MA MAR 
Mozambique MZ MZ MOZ MZ MOZ 
Namibia WA NA NAM NA NAM 
Niger NG NE NER NE NER 
Nigeria NI NG NGA NG NGA 
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COUNTRY NAME FIPS ISO2 ISO3 GENC2 GENC3 
Reunion RE RE REU RE REU 
Rwanda RW RW RWA RW RWA 
Saint Helena SH SH SHN SH SHN 
Sao Tome and Principe TP ST STP ST STP 
Senegal SG SN SEN SN SEN 
Seychelles SE SC SYC SC SYC 
Sierra Leone SL SL SLE SL SLE 
Somalia SO SO SOM SO SOM 
South Africa SF ZA ZAF ZA ZAF 
South Sudan OD SD SDW SS SSD 
Sudan SU SD SDN SD SDN 
Swaziland WZ SZ SWZ SZ SWZ 
Tanzania TZ TZ TZA TZ TZA 
Togo TO TG TGO TG TGO 
Tunisia TS TN TUN TN TUN 
Uganda UG UG UGA UG UGA 
Western Sahara WI EH ESH EH ESH 
Zambia ZA ZM ZMB ZM ZMB 
Zimbabwe ZI ZW ZWE ZW ZWE 
 

 
     Asia 

 

     Bangladesh BG BD BGD BD BGD 
Bhutan BT BT BTN BT BTN 
British Indian Ocean Territory IO -- -- -- -- 
Brunei  BX BN BRN BN BRN 
Burma (Myanmar) BM MM MMR MM MMR 
Cambodia CB KH KHM KH KHM 
China CH CN CHN CN CHN 
Guam GQ GU GUM GU GUM 
Hong Kong HK HK HKG HK HKG 
India IN IN IND IN IND 
Indonesia ID ID IDN ID IDN 
Japan JA JP JPN JP JPN 
Korea, North KN KP PRK KP PRK 
Korea, South KS KR KOR KR KOR 
Laos LA LA LAO LA LAO 
Macao MC MO MAC MO MAC 
Malaysia MY MY MYS MY MYS 
Maldives MV MV MDV MV MDV 
Mongolia MG MN MNG MN MNG 
Nepal NP NP NPL NP NPL 
Northern Mariana Islands CQ MP MNP MP MNP 
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COUNTRY NAME FIPS ISO2 ISO3 GENC2 GENC3 
Pakistan PK PK PAK PK PAK 
Palau PS PW PLW PW PLW 
Papua New Guinea PP PG PNG PG PNG 
Philippines RP PH PHL PH PHL 
Singapore SN SG SGP SG SGP 
Solomon Islands BP SB SLB SB SLB 
Sri Lanka CE LK LKA LK LKA 
Taiwan TW TW TWN TW TWN 
Thailand TH TH THA TH THA 
Timor-Leste TT -- TMP TL TMP 
Vietnam VM VN VNM VN VNM 
 
 

     Europe 
 

     Akrotiri AX -- -- QZ XQZ 
Albania AL AL ALB AL ALB 
Armenia AM AM ARM AM ARM 
Andorra AN AND AND AD AND 
Austria AU A AUT AT AUT 
Azerbaijan AJ AZ AZE AZ AZE 
Belarus BO BY BLR BY BLR 
Belgium BE B BEL BE BEL 
Bosnia and Herzegovina BK BIH BIH BA BIH 
Bulgaria BU BG BGR BG BGR 
Croatia HR HR HRV HR HRV 
Cyprus CY CY CYP CY CYP 
Czech Republic EZ CZ CZE CZ CZE 
Denmark DA DK DNK DK DNK 
Dhekelia DX -- -- XD XXD 
Estonia EN EST EST EE EST 
Faroe Islands FO FO FRO FO FRO 
Finland FI FIN FIN FI FIN 
France FR FR FRA FR FRA 
Georgia GG GE GEO GE GEO 
Germany GM D DEU DE DEU 
Gibraltar GI GI GIB GI GIB 
Greece GR GR GRC GR GRC 
Guernsey GK -- -- GG GGY 
Hungary HU H HUN HU HUN 
Iceland IC IS ISL IS ISL 
Ireland EI IE IRL IE IRL 
Isle of Man IM -- IMN IM IMN 
Italy IT I ITA IT ITA 

 
 PC*MILER User’s Guide          246 



  

COUNTRY NAME FIPS ISO2 ISO3 GENC2 GENC3 
Jersey JE -- -- JE JEY 
Kazakhstan KZ KZ KAZ KZ KAZ 
Kosovo KV -- XKS XK XKS 
Kyrgyzstan KG KGZ KGZ KG KGZ 
Latvia LG LV LVA LV LVA 
Liechtenstein LS FL LIE LI LIE 
Lithuania LH LT LTU LT LTU 
Luxembourg LU L LUX LU LUX 
Macedonia MK MK MKD MK MKD 
Malta MT M MLT MT MLT 
Moldova MD MD MDA MD MDA 
Monaco MN MC MCO MC MCO 
Montenegro MJ MNE MNE ME MNE 
Netherlands NL NL NLD NL NLD 
Norway NO N NOR NO NOR 
Poland PL PL POL PL POL 
Portugal PO P PRT PT PRT 
Romania RO RO ROU RO ROU 
Russia RS RUS RUS RU RUS 
San Marino SM RSM SMR SM SMR 
Serbia RI SRB SRB RS SRB 
Slovakia LO SK SVK SK SVK 
Slovenia SI SLO SVN SI SVN 
Spain SP E ESP ES ESP 
Svalbard and Jan Mayen Islands SV SJ SJM XR XSV 
Sweden SW S SWE SE SWE 
Switzerland SZ CH CHE CH CHE 
Tajikistan TI TJ TJK TJ TJK 
Turkey TU TR TUR TR TUR 
Turkmenistan TX TM TKM TM TKM 
Ukraine UP UA UKR UA UKR 
United Kingdom UK GB GBR GB GBR 
Uzbekistan UZ UZ UZB UZ UZB 
Vatican City VT V VAT VA VAT 

      
      Middle East 
Afghanistan AF AF AFG AF AFG 
Bahrain BA BH BHR BH BHR 
Gaza Strip GZ -- XGZ XG XGZ 
Iran IR IR IRN IR IRN 
Iraq IZ IQ IRQ IQ IRQ 
Israel IS IL ISR IL ISR 
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COUNTRY NAME  FIPS  ISO2  ISO3  GENC2  GENC3 

Jordan  JO  JO  JOR  JO  JOR 

Kuwait  KU  KW  KWT  KW  KWT 

Lebanon  LE  LB  LBN  LB  LBN 

Oman  MU  OM  OMN  OM  OMN 

Palestinian Territory  ‐‐  PS  PSE  PS  PSE 

Qatar  QA  QA  QAT  QA  QAT 

Saudi Arabia  SA  SA  SAU  SA  SAU 

Syria  SY  SY  SYR  SY  SYR 

United Arab Emirates  AE  AE  ARE  AE  ARE 

West Bank  WE  ‐‐  XWB  XW  XWB 

Yemen  YM  YE  YEM  YE  YEM 

    

North America 
 

Canada  CA  CA  CAN  CA  CAN 

Greenland  GL  GL  GRL  GL  GRL 

Mexico  MX  MX  MEX  MX  MEX 

Puerto Rico*  PR*  PR  PRI  PR  PRI 

Saint Pierre and Miquelon  SB  PM  SPM  PM  SPM 

United States  US  US  USA  US  USA 

Virgin Islands, U.S.  VI  VI  VIR  VI  VIR 

* Note: “PR” for Puerto Rico is a USPS code, not a FIPS code. 
 

 

Oceania 
 

American Samoa  AQ  AS  ASM  AS  ASM 

Australia  AS  AU  AUS  AU  AUS 

Cook Islands  CW  CK  COK  CK  COK 

Fiji  FJ  FJ  FJI  FJ  FJI 

French Polynesia  FP  PF  PYF  PJ  PYF 

French Southern and Antarctic Islands  FS  TF  ATF  TF  ATF 

Kiribati  KR  KI  KIR  KI  KIR 

Marshall Islands  RM  MH  MHL  MH  MHL 

Micronesia, Federated States of  FM  FM  FSM  FM  FSM 

Midway Island  MQ  UM  ‐‐  QM  XMW 

Nauru  NR  NR  NRU  NR  NRU 

New Caledonia  NC  NC  NCL  NC  NCL 

New Zealand  NZ  NZ  NZL  NZ  NZL 

Niue  NE  NU  NIU  NU  NIU 

Norfolk Island  NF  NF  NFK  NF  NFK 

Pitcairn Islands  PC  PN  PCN  PN  PCN 

Samoa (Western Samoa)  WS  WS  WSM  WS  WSM 
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COUNTRY NAME  FIPS  ISO2  ISO3  GENC2  GENC3 

Tokelau  TL  TK  TKL  TK  TKL 

Tonga  TN  TO  TON  TO  TON 

Tuvalu  TV  TV  TUV  TV  TUV 

Vanuatu  NH  VU  VUT  VU  VUT 

Wake Island  WQ  WQ  XWK  QW  XWK 

Wallis and Futuna  WF  WF  WLF  WF  WLF 

    

South America 
 

Anguilla  AV  AI  AIA  AI  AIA 

Antigua and Barbuda  AC  AG  ATG  AG  ATG 

Argentina  AR  AR  ARG  AR  ARG 

Aruba  AA  AW  ABW  AW  ABW 

Bahamas  BF  BS  BHS  BS  BHS 

Barbados  BB  BB  BRB  BB  BRB 

Belize  BH  BZ  BLZ  BZ  BLZ 

Bermuda  BD  BM  BMU  BM  BMU 

Bolivia  BL  BO  BOL  BO  BOL 

Bonaire, Sint Eustatius, Saba  ‐‐  ‐‐  ‐‐  BQ  BES 

Brazil  BR  BR  BRA  BR  BRA 

Caribbean Netherlands  NT  AN  BES  BQ  BES 

Cayman Islands  CJ  KY  CYM  KY  CYM 

Chile  CI  CL  CHL  CL  CHL 

Colombia  CO  CO  COL  CO  COL 

Costa Rica  CS  CR  CRI  CR  CRI 

Cuba  CU  CU  CUB  CU  CUB 

Curacao  UC  ‐‐  ‐‐  CUW  CUW 

Dominica  DO  DM  DMA  DM  DMA 

Dominican Republic  DR  DO  DOM  DO  DOM 

Ecuador  EC  EC  ECU  EC  ECU 

El Salvador  ES  SV  SLV  SV  SLV 

Falkland Islands (Islas Malvinas)  FK  FK  FLK  FK  FLK 

French Guiana  FG  GF  GUF  GF  GUF 

Grenada  GJ  GD  GRD  GD  GRD 

Guadeloupe  GP  GP  GLP  GP  GLP 

Guantanamo Bay  ‐‐  ‐‐  ‐‐  A2  AX2 

Guatemala  GT  GT  GTM  GT  GTM 

Guyana  GY  GY  GUY  GY  GUY 

Haiti  HA  HT  HTI  HT  HTI 

Honduras  HO  HN  HND  HN  HND 

Jamaica  JM  JM  JAM  JM  JAM 

Martinique  MB  MQ  MTQ  MQ  MTQ 

Montserrat  MH  MS  MSR  MS  MSR 
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COUNTRY NAME  FIPS  ISO2  ISO3  GENC2  GENC3 

Nicaragua*  NU*  NI  NIC  NI  NIC 

Panama  PM  PA  PAN  PA  PAN 

Paraguay  PA  PY  PRY  PY  PRY 

Peru  PE  PE  PER  PE  PER 

Saint Barthalemy  TB  ‐‐  BLM  BL  BLM 

Saint Kitts and Nevis Islands  SC  KN  KNA  KN  KNA 

Saint Lucia  ST  LC  LCA  LC  LCA 

Saint Martin  RN  ‐‐  MAF  MF  MAF 

Saint Vincent and the Grenadines  VC  VC  VCT  VC  VCT 

Sint Maarten  NN  ‐‐  SXM  SX  SXM 

Suriname  NS  SR  SUR  SR  SUR 

Trinidad and Tobago  TD  TT  TTO  TT  TTO 

Turks and Caicos Islands  TK  TC  TCA  TC  TCA 

Uruguay  UY  UY  URY  UY  URY 

Venezuela  VE  VE  VEN  VE  VEN 

Virgin Islands, British  VG  VG  VGB  VG  VGB 

 * The same FIPS code, NU, is used for Nicaragua and the province of Nunavut, Canada in the PC*MILER 
database. 

 
 
Official Sources 
 
FIPS Country Codes: 
http://geonames.nga.mil/ggmagaz/geonames4.asp and  
http://www.state.gov/s/inr/rls/4250.htm 
 
ISO2 Country Codes: 
http://www.iso.org/iso/country_codes/iso_3166_code_lists/english_country_names_and_code_elements.htm and 
http://www.iso.org/iso/english_country_names_and_code_elements#s 
 
ISO 3 Country Codes: 
http://unstats.un.org/unsd/methods/m49/m49alpha.htm 
 
GENC2 and GENC3 Country Codes (Geopolitical Entities, Names and Codes): 
Issued by the National Geospatial-Intelligence Agency 
https://www1.nga.mil/Pages/default.aspx  
 



  
   

Appendix D:  
Valid Entries for Street Addresses 

 
 
 

For PC*MILER|Streets users, valid directional and street type abbreviations for street address 
entry in North America are listed below.  Spelling out the whole word is also acceptable.  
Capitalization is not necessary. 
 

Directional Synonyms for Address Entry – Prefix or Suffix 

Full Spelling Valid in PC*MILER 
EAST E 
EAST E. 
NORTH N 
NORTH N. 
NORTH NO 
NORTH NO. 
NORTHEAST N-E 
NORTHEAST N.E 
NORTHEAST N.E. 
NORTHEAST NE 
NORTHEAST NE. 
NORTHEAST NORTH-EAST 
NORTHWEST N-W 
NORTHWEST N.W 
NORTHWEST. N.W. 
NORTHWEST NORTH-WEST 
NORTHWEST NW 
NORTHWEST NW. 
SOUTH S 
SOUTH S. 
SOUTH SO 
SOUTH SO. 
SOUTHEAST S-E 
SOUTHEAST S.E 
SOUTHEAST S.E. 
SOUTHEAST SE 
SOUTHEAST SE. 
SOUTHEAST SOUTH-EAST 
SOUTHWEST S-W 
SOUTHWEST S.W 
SOUTHWEST S.W. 
SOUTHWEST SOUTH-WEST 
SOUTHWEST SW 
SOUTHWEST SW. 
WEST W 
WEST W. 
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Synonyms for Street Types 
 
 Valid in 
Full Spelling PC*MILER 
 
ALLEY AL 
ALLEY AL. 
ALLEY                    ALL 
ALLEY                    ALL. 
ALLEY                    ALY 
ALLEY                    ALY. 
ARCADE                   ARC 
ARCADE                   ARC. 
AVENUE                   AV 
AVENUE                   AV. 
AVENUE                  AVDA 
AVENUE                   AVDA. 
AVENUE                  AVE 
AVENUE                  AVE. 
AVENUE                   AVEN 
AVENUE                   AVEN. 
AVENUE                   AVENIDA 
AVENUE                   AVENIDA. 
AVENUE DES             AV DES 
AVENUE DES               AV DES. 
BASSIN                   BAS 
BASSIN                   BAS. 
BASSINS                 BAS 
BASSINS                  BAS. 
BEACH                    BCH 
BEACH                    BCH. 
BEND                     BND 
BEND                     BND. 
BERGE                    BER 
BERGE                    BER. 
BLUFFS                   BLFS 
BLUFFS                   BLFS. 
BOUCLE                   BCLE 
BOUCLE                   BCLE. 
BOULEVARD                BD 
BOULEVARD                BD. 
BOULEVARD                BL 
BOULEVARD                BL. 
BOULEVARD                BLVD 
BOULEVARD               BLVD. 
BOULEVARD                BOUL 
BOULEVARD                BOUL. 
BRIDGE                   BRDG 
BRIDGE                   BRDG. 
BRIDGE                   BRG 
BRIDGE                   BRG. 
BROOK                    BRK 

BROOK                    BRK. 
BROOKS                   BRKS 
BROOKS                   BRKS. 
BUTTE                    BUT 
BUTTE                    BUT. 
BYPASS                  BYP 
BYPASS                   BYP. 
CALE                     CAL 
CALE                     CAL. 
CAPE                     CPE 
CAPE                     CPE. 
CARREFOUR                CAR 
CARREFOUR                CAR. 
CARRIERE                 CARE 
CARRIERE                 CARE. 
CAUSEWAY                 CAUSE 
CAUSEWAY                 CAUSE. 
CAUSEWAY                 CSWY 
CAUSEWAY                 CSWY. 
CAVEE                    CAV 
CAVEE                    CAV. 
CENTER                   CNTR 
CENTER                   CNTR. 
CENTER                   CTR 
CENTER                   CTR. 
CHATEAU                  CHA 
CHATEAU                  CHA. 
CHEMIN                   CH 
CHEMIN                   CH. 
CHEMIN                   CHE 
CHEMIN                   CHE. 
CHEMINEMENT             CHEM 
CHEMINEMENT             CHEM. 
CIRCLE                   CIR 
CIRCLE                   CIR. 
CIRCLE                   CIRC 
CIRCLE                   CIRC. 
CIRCLES                  CIRS 
CIRCLES                  CIRS. 
CLIFFS                   CLFS 
CLIFFS                   CLFS. 
CITE                     CIT 
CITE                     CIT. 
CLOS                     CL 
CLOS                     CL. 
COLONEL                  COL 
COLONEL                  COL. 
COMMON                   CMN 
COMMON                   CMN. 
COMMONS                  CMN 
COMMONS                  CMN. 
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COMMONS                  CMNS 
COMMONS                  CMNS. 
CORNER                   COR 
CORNER                   COR. 
CORNERS                  CORS 
CORNERS                  CORS. 
CONTOUR                  CTR 
CORNICHE                 CORN 
COTE                     COT 
COUR                     C 
COUR                     CR 
COURS                    CRS 
COURT                    CRT 
COURT                    CRT. 
COURT                    CT 
COURT                    CT. 
COURTS                   CTS 
COURTS                   CTS. 
COVE                     CV 
COVE                     CV. 
COVES                    CVS 
COVES                    CVS. 
CREEK                    CRK 
CREEK                    CRK. 
CRESCENT                 CRES 
CRESCENT                 CRES. 
CRESCENT                 CRESC 
CRESCENT                 CRESC. 
CRESCENT                 CRESNT 
CREST                    CRST 
CREST                    CRST. 
CROSSING                 CRSG 
CROSSING                 CRSG. 
CROSSING                 XING 
CROSSING                 XING. 
CROSSROADS               XRDS 
CROSSROADS               XRDS. 
DESCENTE                 DESC 
DRIVE                    DR 
DRIVE                    DR. 
DRIVE                    DRV 
DRIVE                   DRV. 
DRIVES                   DRS 
DRIVES                   DRS. 
ENCLAVE                  ENC 
ENCLOS                   ENC 
ESPACE                   ESP 
ESPLANADE                ESP 
ESTATE                   EST 
ESTATE                   EST. 
ESTATES                  ESTS 
ESTATES                  ESTS. 

EXPRESSWAY               EXPR 
EXPRESSWAY               EXPR. 
EXPRESSWAY               EXPY 
EXPRESSWAY               EXPY. 
EXPRESSWAY               EXWY 
EXPRESSWAY               EXWY. 
EXTENSION                EXT 
EXTENSION                EXT. 
EXTENSIONS               EXTS 
EXTENSIONS               EXTS. 
FALLS                    FLS 
FALLS                    FLS. 
FARM-TO-MARKET    F-M 
FARM-TO-MARKET     FM 
FARM-TO-MARKET      FM. 
FAUBOURG                 FAUB 
FAUBOURG                 FAUB. 
FIELD                    FLD 
FIELD                    FLD. 
FIELDS                   FLDS 
FIELDS                   FLDS. 
FLATS                    FLTS 
FLATS                    FLTS. 
FORKS                    FRKS 
FORKS                    FRKS. 
FORUM                    FORM 
FREEWAY                  FRWY 
FREEWAY                 FRWY. 
FREEWAY                  FWY 
FREEWAY                  FWY. 
GLEN                     GLN 
GLEN                     GLN. 
GRAND BOULEVARD GBD 
GRAND BOULEVARD GBLVD 
GREEN                    GRN 
GREEN                    GRN. 
GREENS                   GRNS 
GREENS                   GRNS. 
GROVE                    GRV 
GROVE                    GRV. 
GROVES                   GRVS 
GROVES                   GRVS. 
GRANDE RUE               GR 
GRIMPETTE                GRP 
GRIMPETTE                GRP. 
HARBOR                   HBR 
HAVEN                    HVN 
HAVEN                    HVN. 
HEIGHTS                  HTS 
HIGHWAY                  HWY 
HIGHWAY                  HWY. 
HIGHWAY                  HY 
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HIGHWAY                  HY. 
HIGHWAY                  HIWAY 
HIGHWAY                  HIWAY. 
HILL                     HL 
HILLS                    HLS 
HILLS                    HLS. 
HOLLOW                   HOLW 
HOLLOW                   HOLW. 
IMMEUBLE                 IMM 
IMMEUBLE                 IMM. 
IMPASSE                  IMP 
IMPASSE                  IMP. 
ISLAND                   IS 
ISLAND                   IS. 
JARDIN                   J 
KEY                      KY 
KEY                      KY. 
KEYS                     KYS 
KEYS                     KYS. 
KNOLL                    KNL 
KNOLL                    KNL. 
KNOLLS                   KNLS 
KNOLLS                   KNLS. 
LAKES                    LKS 
LAKES                    LKS. 
LAND                     LAND 
LAND                     LAND. 
LANDING                  LNDG 
LANDING                  LNDG. 
LANE                     LA 
LANE                     LA. 
LANE                     LN 
LANE                     LN. 
LEVEE                    LEV 
LIEU DIT                 L-D 
LIEU DIT                 LD 
LIEU DIT                LIEU 
LIEU-DIT                 L-D 
LIEU-DIT                 LD 
LIEU-DIT                 LIEU 
LIGHTS                   LGTS 
LIGHTS                   LGTS. 
LOCKS                    LCKS 
LOCKS                    LCKS. 
LOOP                     LP 
LOOP                     LP. 
LOTISSEMENT              LOT 
LOTISSEMENT              LOT. 
MALL                     ML 
MALL                     ML. 
MANOR                    MNR 
MANOR                    MNR. 

MANORS                   MNRS 
MANORS                   MNRS. 
MEADOW                   MDW 
MEADOW                   MDW. 
MEADOWS                  MDWS 
MEADOWS                  MDWS. 
MILLS                    MLS 
MILLS                    MLS. 
MOTORWAY                 MRWY 
MOTORWAY                 MRWY. 
MOTORWAY                 MTRWY 
MOTORWAY                 MTRWY. 
MOTORWAY                 MTWY 
MOTORWAY                 MTWY. 
MOUNT                    MT 
MOUNT                    MT. 
OVERPASS                 OPAS 
OVERPASS                 OPAS. 
OVERPASS                 OVER 
OVERPASS                 OVER. 
OVERPASS                 OVPS 
OVERPASS                 OVPS. 
OVERPASS                 OVRPS 
OVERPASS                 OVRPS. 
PARK                     PK 
PARK                     PK. 
PARK                     PRK 
PARK                     PRK. 
PARKWAY                  PKY 
PARKWAY                  PKY. 
PARKWAY                  PKW 
PARKWAY                  PKW. 
PARKWAY                  PKWY 
PARKWAY                  PKWY. 
PARKWAY                  PKWAY 
PARKWAY                  PKWAY. 
PARKWAY                  PRKWY 
PARKWAY                  PRKWY. 
PARVIS                   PAR 
PASEO                    PSO 
PASS                     PS 
PASS                     PS. 
PASSAGE                  PASS 
PATH                     PTH 
PATH                     PTH. 
PETITE AVENUE           PTA 
PETITE IMPASSE           PTI 
PETITE ROUTE             PRT 
PETITE RUE               PTR 
PIKE                     PKE 
PIKE                     PKE. 
PINE                     PNE 
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PINE                     PNE. 
PINES                    PNES 
PINES                    PNES. 
PLACE                    PL 
PLACE                    PL. 
PLACE                    PLA 
PLACE                    PLA. 
PLACE                    PLAC 
PLACE                    PLAC. 
PLACE                    PLC 
PLACE                    PLC. 
PLAINS                   PLNS 
PLAINS                   PLNS. 
PLAZA                    PLZ 
PLAZA                    PLZ. 
POINT                    PNT 
POINT                    PNT. 
POINT                    PT 
POINT                    PT. 
POINTS                   PTS 
POINTS                   PTS. 
PORTE                    PTE 
POURTOUR                 POUR 
POURTOUR                 POUR. 
PRAIRIE                  PR 
PRAIRIE                  PR. 
PROMENADE                PROM 
QUAI                     Q 
QUAI                     Q. 
QUARTIER                 QUA 
RACCOURCI                RAC 
RACCOURCI                RAC. 
RAMP                     RMP 
RAMP                     RMP. 
RAMPE                    RPE 
RAPIDS                   RPDS 
RAPIDS                   RPDS. 
REMPART                 REM 
RESIDENCE                RES 
RESIDENCE                RES. 
RIDGE                    RDG 
RIDGE                    RDG. 
RIDGES                   RDGS 
RIDGES                   RDGS. 
ROAD                     RD 
ROAD                     RD. 
ROADS                    RDS 
ROADS                    RDS. 
ROCADE                   ROC 
ROCADE                   ROC. 
ROND POINT               ROND 
ROND POINT               RP 

ROND POINT               RP. 
ROND-POINT               ROND 
ROND-POINT               RP 
ROND-POINT               RP. 
ROTONDE                  ROT 
ROTONDE                  RTD 
ROUTE                    RTE 
RUE                      R 
RUE                      R. 
RUE DE                   RUE 
SENTIER                  SENT 
SENTIER                  SENT. 
SHOALS                   SHLS 
SHOALS                   SHLS. 
SHORES                   SHRS 
SHORES                   SHRS. 
SKYWAY                   SKWY 
SKYWAY                   SKWY. 
SPRINGS                 SPGS 
SPRINGS                 SPGS. 
SQUARE                   SQ 
SQUARE                   SQ. 
SQUARE                   SQR 
SQUARE                   SQR. 
SQUARES                  SQS 
SQUARES                  SQS. 
STRASSE                  STR 
STRASSE                  STR. 
STREET                   ST 
STREET                   ST. 
STREET                   STR 
STREET                   STR. 
STREETS                  STS 
STREETS                  STS. 
TERRACE                  TER 
TERRACE                  TER. 
TERRACE                  TERR 
TERRACE                  TERR. 
TERRACE                  TRC 
TERRACE                  TRC. 
TERRASSE                 TER 
TERTRE                   TRT 
THROUGHWAY             THRUWAY 
THROUGHWAY             THWY 
THROUGHWAY             THWY. 
TOUR                     TR 
TOUR                     TR. 
TRACK                    TRAK 
TRACK                    TRAK. 
TRAFFICWAY               TFCWY 
TRAFFICWAY               TFCWY. 
TRAFFICWAY               TFWY 
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TRAFFICWAY               TFWY. 
TRAFFICWAY               TRFY 
TRAFFICWAY               TRFY. 
TRAFFICWAY              TRWY 
TRAFFICWAY               TRWY. 
TRAIL                    TRL 
TRAIL                    TRL. 
TRAILER                  TRLR 
TRAILER                  TRLR. 
TRAVERSE                 TRA 
TUNNEL                   TUN 
TUNNEL                   TUN. 
TUNNEL                   TUNL 
TUNNEL                   TUNL. 
TUNNEL                   TUNN 
TUNNEL                   TUNN. 
TURNPIKE                 TPK 
TURNPIKE                 TPK. 
TURNPIKE                 TPKE 
TURNPIKE                 TPKE. 
UNDERPASS                UNP 
UNDERPASS                UNP. 
UNDERPASS                UNPS 
UNDERPASS               UNPS. 
UNDERPASS                UNRPS 
UNDERPASS                UNRPS. 
UNDERPASS                UPAS 
UNDERPASS                UPAS. 

VENELLE                  VEN 
VIEILLE ROUTE            VRTE 
VIEUX CHEMIN             VCHE 
VIEW                     VW 
VIEW                     VW. 
VIEWS                    VWS 
VIEWS                    VWS. 
VILLAGE                  VGE 
VILLAGE                  VLG 
VILLAGE                  VLG. 
VILLAGES                 VLGS 
VILLAGES                 VLGS. 
VOIE                     V 
WAY                      WY 
WAY                      WY. 
WAYS                     WAYS 
WAYS                     WAYS. 
WELLS                    WLS 
WELLS                    WLS. 
ZONE ARTISANALE    ZA 
ZONE D'ACTIVITE      Z.A. 
ZONE D'ACTIVITE      ZA. 
ZONE INDUSTRIELLE Z.I 
ZONE INDUSTRIELLE Z.I. 
ZONE INDUSTRIELLE ZI 
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Appendix E:  

Default Road Speeds by Jurisdiction 
 

 
The table below lists PC*MILER default road speeds worldwide by jurisdiction and PC*MILER road category.  Speeds are in miles per 
hour.  To see default speeds for any world region, you can also open the Route Options dialog, select a world region, then click the Road 
Speeds tab and select a country from the pick list.   
 

Region State FIPS 
Interstate 
Highway 

Divided 
Highway 

Primary 
Highway 

Secondary 
Highway Local Ferries 

Rural Urban Rural Urban Rural Urban Rural Urban Rural Urban Rural Urban 

Africa Algeria AG 62 56 56 43 50 31 37 25 25 18 26 26 
Africa Angola AO 50 45 40 35 35 30 30 25 20 15 18 18 
Africa Botswana BC 50 45 40 35 35 30 30 25 20 15 21 21 
Africa Benin BN 50 45 40 35 35 30 30 25 20 15 18 18 
Africa Burundi BY 50 45 40 35 35 30 30 25 20 15 18 18 
Africa Chad CD 50 45 40 35 35 30 30 25 20 15 21 21 
Africa Congo CF 50 45 40 35 35 30 30 25 20 15 18 18 
Africa Republic of Congo CG 50 45 40 35 35 30 30 25 20 15 23 23 
Africa Cameroon CM 50 45 40 35 35 30 30 25 20 15 21 21 
Africa Comoros CN 50 45 40 35 35 30 30 25 20 15 15 15 

Africa 
Central African 
Republic CT 50 45 40 35 35 30 30 25 20 15 18 18 

Africa Cape Verde CV 50 45 40 35 35 30 30 25 20 15 23 23 
Africa Djibouti DJ 50 45 40 35 35 30 30 25 20 15 21 21 
Africa Egypt EG 62 56 56 43 37 31 25 25 18 12 27 27 
Africa Equatorial Guinea EK 50 45 40 35 35 30 30 25 20 15 21 21 
Africa Eritrea ER 50 45 40 35 35 30 30 25 20 15 21 21 
Africa Ethiopia ET 62 56 56 43 50 31 37 25 25 18 18 18 

E A
pp

en
di

x 
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Region State FIPS 
Interstate 
Highway 

Divided 
Highway 

Primary 
Highway 

Secondary 
Highway Local Ferries 

Rural Urban Rural Urban Rural Urban Rural Urban Rural Urban Rural Urban 
Africa Gambia GA 50 45 40 35 35 30 30 25 20 15 21 21 
Africa Gabon GB 50 45 40 35 35 30 30 25 20 15 18 18 
Africa Ghana GH 62 56 56 43 50 31 37 25 25 18 21 21 
Africa Guinea GV 50 45 40 35 35 30 30 25 20 15 18 18 
Africa Ivory Coast IV 50 45 40 35 35 30 30 25 20 15 18 18 
Africa Kenya KE 62 56 56 43 50 31 37 25 25 18 21 21 
Africa Liberia LI 50 45 40 35 35 30 30 25 20 15 18 18 
Africa Lesotho LT 50 45 40 35 35 30 30 25 20 15 23 23 
Africa Libya LY 50 45 40 35 35 30 30 25 20 15 26 26 
Africa Madagascar MA 50 45 40 35 35 30 30 25 20 15 15 15 
Africa Mayotte MF 50 45 40 35 35 30 30 25 20 15 18 18 
Africa Malawi MI 62 56 56 43 50 31 37 25 25 18 21 21 
Africa Mali ML 50 45 40 35 35 30 30 25 20 15 18 18 
Africa Morocco MO 62 56 56 43 50 31 37 25 25 18 26 26 
Africa Mauritius MP 50 45 40 35 35 30 30 25 20 15 18 18 
Africa Mauritania MR 50 45 40 35 35 30 30 25 20 15 18 18 
Africa Mozambique MZ 50 45 40 35 35 30 30 25 20 15 21 21 
Africa Niger NG 50 45 40 35 35 30 30 25 20 15 21 21 
Africa Nigeria NI 62 56 56 43 50 31 37 25 25 18 21 21 
Africa South  Sudan OD 50 45 40 35 35 30 30 25 20 15 18 18 
Africa Guinea-Bissau PU 50 45 40 35 35 30 30 25 20 15 18 18 
Africa Reunion RE 50 45 40 35 35 30 30 25 20 15 18 18 
Africa Rwanda RW 50 45 40 35 35 30 30 25 20 15 18 18 
Africa Seychelles SE 50 45 40 35 35 30 30 25 20 15 18 18 
Africa South Africa SF 68 62 56 43 50 31 37 25 25 18 24 24 
Africa Senegal SG 50 45 40 35 35 30 30 25 20 15 21 21 
Africa Saint Helena SH 50 45 40 35 35 30 30 25 20 15 18 18 
Africa Sierra Leone SL 50 45 40 35 35 30 30 25 20 15 18 18 
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Region State FIPS 
Interstate 
Highway 

Divided 
Highway 

Primary 
Highway 

Secondary 
Highway Local Ferries 

Rural Urban Rural Urban Rural Urban Rural Urban Rural Urban Rural Urban 
Africa Somalia SO 50 45 40 35 35 30 30 25 20 15 21 21 
Africa Sudan SU 50 45 40 35 35 30 30 25 20 15 18 18 
Africa Togo TO 50 45 40 35 35 30 30 25 20 15 18 18 
Africa Sao Tome and Principe TP 50 45 40 35 35 30 30 25 20 15 21 21 
Africa Tunisia TS 62 56 56 43 50 31 37 25 25 18 26 26 
Africa Tanzania TZ 62 56 56 43 50 31 37 25 25 18 23 23 
Africa Uganda UG 62 56 56 43 50 31 37 25 25 18 23 23 
Africa Burkina Faso UV 50 45 40 35 35 30 30 25 20 15 18 18 
Africa Namibia WA 50 45 40 35 35 30 30 25 20 15 21 21 
Africa Western Sahara WI 50 45 40 35 35 30 30 25 20 15 18 18 
Africa Swaziland WZ 50 45 40 35 35 30 30 25 20 15 18 18 
Africa Zambia ZA 50 45 40 35 35 30 30 25 20 15 21 21 
Africa Zimbabwe ZI 62 56 50 43 43 31 37 25 25 18 23 23 
Asia Bangladesh BG 50 50 50 43 43 31 31 18 25 12 21 21 
Asia Burma (Myanmar) BM 50 50 50 43 43 31 31 18 25 12 21 21 
Asia Bhutan BT 50 50 50 43 43 31 31 18 25 12 16 16 
Asia British Indian Ocean 

Territory 
IO 50 43 43 37 37 31 31 25 25 18 18 18 

Asia Brunei Darussalam BX 50 50 50 43 43 31 31 18 25 12 18 18 
Asia Cambodia CB 56 56 56 50 43 31 31 25 25 18 18 18 
Asia Sri Lanka CE 50 50 50 43 43 31 31 18 25 12 22 22 
Asia China CH 68 62 56 50 50 31 37 18 25 12 27 27 
Asia Guam GQ 45 45 45 35 35 35 35 25 25 18 18 18 
Asia Hong Kong HK 31 31 31 31 25 25 18 18 12 12 27 27 
Asia Indonesia ID 50 50 50 43 43 31 31 18 25 12 27 27 
Asia India IN 62 49 49 37 43 31 31 18 25 12 22 22 
Asia Japan JA 62 56 50 43 37 31 31 18 25 12 26 26 
Asia Korea, North KN 56 56 56 50 43 31 31 25 25 18 21 21 
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Region State FIPS 
Interstate 
Highway 

Divided 
Highway 

Primary 
Highway 

Secondary 
Highway Local Ferries 

Rural Urban Rural Urban Rural Urban Rural Urban Rural Urban Rural Urban 
Asia Korea, South KS 56 56 56 50 43 31 31 25 25 18 21 21 
Asia Lao People's 

Democratic Republic 
LA 56 56 56 50 43 31 31 25 25 18 16 16 

Asia Macao MC 50 50 50 43 43 31 31 18 25 12 27 27 
Asia Mongolia MG 56 56 56 50 43 31 31 25 25 18 16 16 
Asia Maldives MV 56 56 56 50 43 31 31 25 25 18 22 22 
Asia Malaysia MY 50 50 50 43 43 31 31 18 25 12 27 27 
Asia Nepal NP 50 50 50 43 43 31 31 18 25 12 16 16 
Asia Northern Mariana 

Islands 
CQ 50 43 43 37 37 31 31 25 25 18 15 15 

Asia Pakistan PK 56 56 56 50 43 31 31 25 25 18 21 21 
Asia Palau PS 50 43 43 37 37 31 31 25 25 18 15 15 
Asia Papua New Guinea PP 50 50 50 43 43 31 31 18 25 12 18 18 
Asia Philippines RP 50 50 50 43 43 31 31 18 25 12 25 25 
Asia Singapore SN 56 56 56 50 43 31 31 25 25 18 27 27 
Asia Solomon Islands BP 50 43 43 37 37 31 31 25 25 18 18 18 
Asia Thailand TH 50 50 50 43 43 31 31 18 25 12 21 21 
Asia East Timor TT 50 50 50 43 43 31 31 18 25 12 18 18 
Asia Taiwan TW 50 50 50 43 43 31 31 18 25 12 25 25 
Asia Vietnam VM 50 50 50 43 43 31 31 18 25 12 21 21 

Europe Albania AL 50 43 40 31 31 25 25 16 18 12 16 16 
Europe Andorra AN 50 43 40 31 31 25 25 16 18 12 16 16 
Europe Armenia AM 56 56 56 50 43 31 31 25 25 18 16 16 
Europe Austria AU 50 50 34 31 34 25 25 16 18 12 16 16 
Europe Azerbaijan AJ 56 56 56 50 43 31 31 25 25 18 20 20 
Europe Belgium BE 56 56 45 31 30 25 25 16 18 12 16 16 
Europe Bosnia and 

Herzegovina 
BK 62 43 50 31 39 25 25 16 18 12 16 16 

Europe Belarus BO 62 56 40 31 39 25 25 16 18 12 16 16 
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Region State FIPS 
Interstate 
Highway 

Divided 
Highway 

Primary 
Highway 

Secondary 
Highway Local Ferries 

Rural Urban Rural Urban Rural Urban Rural Urban Rural Urban Rural Urban 
Europe Bulgaria BU 62 62 34 31 34 25 25 16 18 12 16 16 
Europe Cyprus CY 56 56 56 50 43 31 31 25 25 18 25 25 
Europe Denmark DA 50 50 34 31 34 25 25 16 18 12 16 16 
Europe Ireland EI 50 50 40 31 39 25 25 16 18 12 16 16 
Europe Estonia EN 56 43 45 31 45 25 25 16 18 12 16 16 
Europe Czech Republic EZ 50 50 40 31 39 25 25 16 18 12 16 16 
Europe Finland FI 50 50 40 31 39 25 25 16 18 12 16 16 
Europe Faroe Islands FO 50 43 40 31 31 25 25 16 18 12 16 16 
Europe France FR 56 43 40 31 31 25 25 16 18 12 16 16 
Europe Georgia GG 56 56 56 50 43 31 31 25 25 18 20 20 
Europe Gibraltar GI 50 43 40 31 31 25 25 16 18 12 16 16 
Europe Germany GM 50 43 35 31 30 25 25 16 18 12 16 16 
Europe Greece GR 43 43 34 31 34 25 25 16 18 12 16 16 
Europe Croatia HR 50 50 34 31 34 25 25 16 18 12 16 16 
Europe Cyprus CY 56 56 56 50 43 31 31 25 25 18 25 25 
Europe Hungary HU 50 43 40 31 31 25 25 16 18 12 16 16 
Europe Iceland IC 50 43 40 31 31 25 25 16 18 12 16 16 
Europe Isle of Man IM 50 43 40 31 31 25 25 16 18 12 16 16 
Europe Italy IT 50 43 35 31 34 25 25 16 18 12 16 16 
Europe Kosovo KV 50 50 34 31 34 30 25 16 18 12 16 16 
Europe Kazakhstan KZ 50 43 40 31 31 25 25 16 18 12 16 16 
Europe Kyrgyzstan KG 56 56 56 50 43 31 31 25 25 18 16 16 
Europe Latvia LG 50 50 40 31 39 25 25 16 18 12 16 16 
Europe Lithuania LH 50 43 40 31 31 25 25 16 18 12 16 16 
Europe Slovakia LO 50 50 40 37 39 30 25 16 18 12 16 16 
Europe Liechtenstein LS 50 43 40 31 31 25 25 16 18 12 16 16 
Europe Luxembourg LU 56 56 38 31 38 25 25 16 18 12 16 16 
Europe Moldavia MD 50 43 40 31 31 25 25 16 18 12 16 16 
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Region State FIPS 
Interstate 
Highway 

Divided 
Highway 

Primary 
Highway 

Secondary 
Highway Local Ferries 

Rural Urban Rural Urban Rural Urban Rural Urban Rural Urban Rural Urban 
Europe Montenegro MJ 50 43 40 31 31 25 25 16 18 12 16 16 
Europe Macedonia MK 43 43 34 31 34 25 25 16 18 12 16 16 
Europe Monaco MN 50 43 40 31 31 25 25 16 18 12 16 16 
Europe Malta MT 50 43 40 31 31 25 25 16 18 12 16 16 
Europe Netherlands NL 50 50 40 31 39 25 25 16 18 12 16 16 
Europe Norway NO 50 50 40 31 39 25 25 16 18 12 16 16 
Europe Poland PL 50 50 40 31 34 25 25 16 18 12 16 16 
Europe Portugal PO 50 50 34 25 34 20 25 16 18 12 16 16 
Europe Serbia RI 50 50 34 31 34 30 25 16 18 12 16 16 
Europe Romania RO 56 56 40 31 34 25 25 16 18 12 16 16 
Europe Russian Federation RS 62 56 40 31 39 25 25 16 18 12 16 16 
Europe Slovenia SI 50 50 34 31 34 25 25 16 18 12 16 16 
Europe San Marino SM 50 43 40 31 31 25 25 16 18 12 16 16 
Europe Spain SP 56 43 40 31 34 25 25 16 18 12 16 16 
Europe Svalbard and Jan 

Mayen Islands 
SV 50 43 40 31 31 25 25 16 18 12 16 16 

Europe Sweden SW 50 50 40 31 39 25 25 16 18 12 16 16 
Europe Switzerland SZ 50 50 40 31 39 25 25 16 18 12 16 16 
Europe Tajikistan TI 50 43 40 31 31 25 25 16 18 12 16 16 
Europe Turkey TU 62 56 40 31 39 25 25 16 18 12 16 16 
Europe Turkmenistan TX 56 56 56 50 43 31 31 25 25 18 20 20 
Europe United Kingdom UK 60 40 46 30 32 24 25 16 18 12 16 16 
Europe Ukraine UP 62 56 40 31 39 25 25 16 18 12 16 16 
Europe Uzbekistan UZ 50 43 40 31 31 25 25 16 18 12 16 16 
Europe Vatican City VT 50 43 40 31 31 25 25 16 18 12 16 16 

Middle East Afghanistan AF 56 56 56 50 43 31 31 25 25 18 16 16 
Middle East Bahrain BA 56 56 56 50 43 31 31 25 25 18 25 25 
Middle East Gaza Strip GZ 56 56 56 50 43 31 31 25 25 18 25 25 
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Region State FIPS 
Interstate 
Highway 

Divided 
Highway 

Primary 
Highway 

Secondary 
Highway Local Ferries 

Rural Urban Rural Urban Rural Urban Rural Urban Rural Urban Rural Urban 
Middle East Iran (Islamic Republic 

of) 
IR 56 56 56 50 43 31 31 25 25 18 25 25 

Middle East Iraq IZ 56 56 56 50 43 31 31 25 25 18 21 21 
Middle East Israel IS 56 56 56 50 43 31 31 25 25 18 25 25 
Middle East Jordan JO 56 56 56 50 43 31 31 25 25 18 16 16 
Middle East Kuwait KU 56 56 56 50 43 31 31 25 25 18 20 20 
Middle East Lebanon LE 56 56 56 50 43 31 31 25 25 18 25 25 
Middle East Oman MU 56 56 56 50 43 31 31 25 25 18 21 21 
Middle East Palestinian Territory -- 56 56 56 50 43 31 31 25 25 18 25 25 
Middle East Qatar QA 56 56 56 50 43 31 31 25 25 18 25 25 
Middle East Saudi Arabia SA 62 56 56 43 37 31 31 18 25 12 25 25 
Middle East Syrian Arab Republic SY 56 56 56 50 43 31 31 25 25 18 16 16 
Middle East United Arab Emirates AE 68 62 62 56 50 37 37 25 25 18 27 27 
Middle East West Bank WE 56 56 56 50 43 31 31 25 25 18 25 25 
Middle East Yemen YM 56 56 56 50 43 31 31 25 25 18 21 21 
N. America Alberta AB 62 62 62 43 56 37 43 37 31 25 21 21 
N. America Aguascalientes AG 68 62 56 43 49 37 43 31 31 25 23 23 
N. America Alaska AK 65 55 55 40 45 35 45 35 30 25 17 17 
N. America Alabama AL 68 60 55 40 45 35 45 35 30 25 15 15 
N. America Arkansas AR 65 55 55 40 45 35 45 35 35 25 15 15 
N. America Arizona AZ 68 60 60 40 50 35 45 35 35 25 15 15 
N. America British Columbia BC 68 62 62 37 56 37 43 37 31 25 21 21 
N. America Baja California BJ 68 62 56 43 49 37 43 31 31 25 23 23 
N. America Baja California Sur BS 68 62 56 43 49 37 43 31 31 25 23 23 
N. America California CA 55 55 55 40 45 30 40 30 30 25 16 16 
N. America Chiapas CH 68 62 56 43 49 37 43 31 31 25 23 23 
N. America Chihuahua CI 68 62 56 43 49 37 43 31 31 25 23 23 
N. America Colima CL 68 62 56 43 49 37 43 31 31 25 23 23 
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Region State FIPS 
Interstate 
Highway 

Divided 
Highway 

Primary 
Highway 

Secondary 
Highway Local Ferries 

Rural Urban Rural Urban Rural Urban Rural Urban Rural Urban Rural Urban 
N. America Colorado CO 68 60 60 40 50 35 45 35 35 25 15 15 
N. America Campeche CP 68 62 56 43 49 37 43 31 31 25 23 23 
N. America Connecticut CT 65 55 55 40 45 30 35 30 25 25 13 13 
N. America Coahuila de Zaragoza CU 68 62 56 43 49 37 43 31 31 25 23 23 
N. America Dist. of Columbia DC 55 50 45 40 40 35 35 30 25 25 13 13 
N. America Delaware DE 65 55 55 40 45 30 35 30 25 25 13 13 
N. America Distrito Federal DF 62 62 43 43 37 37 31 31 25 25 23 23 
N. America Durango DG 68 62 56 43 49 37 43 31 31 25 23 23 
N. America Mexico (Estado) EM 68 62 56 43 49 37 43 31 31 25 23 23 
N. America Florida FL 68 60 55 40 45 35 45 35 30 25 13 13 
N. America Georgia GA 68 60 55 40 45 35 40 30 30 25 13 13 
N. America Guanajuato GJ 68 62 56 43 49 37 43 31 31 25 23 23 
N. America Greenland GL 45 45 45 35 35 35 35 25 25 20 13 13 
N. America Guerrero GR 68 62 56 43 49 37 43 31 31 25 23 23 
N. America Hidalgo HG 68 62 56 43 49 37 43 31 31 25 23 23 
N. America Hawaii HI 60 50 45 35 35 35 25 25 25 25 13 13 
N. America Iowa IA 68 55 60 40 45 35 45 35 35 25 15 15 
N. America Idaho ID 65 60 60 40 50 35 45 35 35 25 15 15 
N. America Illinois IL 65 55 55 40 45 35 45 35 35 25 15 15 
N. America Indiana  IN 65 55 55 40 45 35 40 30 30 25 15 15 
N. America Jalisco JA 68 62 56 43 49 37 43 31 31 25 23 23 
N. America Kansas KS 68 60 60 40 50 35 45 35 35 25 15 15 
N. America Kentucky KY 65 60 55 40 45 35 40 30 30 25 15 15 
N. America Louisiana LA 68 60 55 40 45 35 45 35 35 25 15 15 
N. America Massachusetts MA 65 60 55 40 45 30 35 30 25 25 13 13 
N. America Manitoba MB 68 62 62 43 56 37 43 37 31 25 21 21 
N. America Maryland MD 65 60 55 40 45 30 35 30 25 25 13 13 
N. America Maine ME 65 60 60 40 45 35 45 35 30 25 13 13 
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Region State FIPS 
Interstate 
Highway 

Divided 
Highway 

Primary 
Highway 

Secondary 
Highway Local Ferries 

Rural Urban Rural Urban Rural Urban Rural Urban Rural Urban Rural Urban 
N. America Michoacan de Ocampo MH 68 62 56 43 49 37 43 31 31 25 23 23 
N. America Michigan MI 60 55 55 40 45 35 40 30 30 25 18 18 
N. America Minnesota MN 68 60 60 40 45 35 45 35 35 25 15 15 
N. America Missouri MO 68 60 60 40 45 35 45 35 35 25 15 15 
N. America Morelos MR 68 62 56 43 49 37 43 31 31 25 23 23 
N. America Mississippi MS 68 60 55 40 45 35 45 35 30 25 15 15 
N. America Montana MT 65 60 60 40 50 35 45 35 35 25 15 15 
N. America Nayarit NA 68 62 56 43 49 37 43 31 31 25 23 23 
N. America New Brunswick NB 62 62 56 43 56 37 43 31 31 25 21 21 
N. America North Carolina NC 68 60 55 40 45 35 40 30 30 25 13 13 
N. America North Dakota ND 68 60 60 40 50 35 45 35 35 25 15 15 
N. America Nebraska NE 68 60 60 40 50 35 45 35 35 25 15 15 
N. America New Hampshire NH 65 60 55 40 45 35 45 35 30 25 13 13 
N. America New Jersey NJ 65 55 55 40 45 30 35 30 25 25 13 13 
N. America Newfoundland and 

Labrador 
NL 62 62 62 43 56 37 43 31 31 25 21 21 

N. America New Mexico NM 68 60 60 40 50 35 45 35 35 25 15 15 
N. America Nova Scotia NS 62 62 62 43 56 37 43 31 31 25 21 21 
N. America Northwest Territory NT 56 56 56 43 56 37 43 31 31 25 21 21 
N. America Nunavut NU 59 50 41 27 27 18 23 14 16 9 5 5 
N. America Nevada NV 68 60 60 40 50 35 45 35 35 25 21 21 
N. America Nuevo Leon NX 68 62 56 43 49 37 43 31 31 25 23 23 
N. America New York NY 65 60 55 40 45 30 35 30 25 25 13 13 
N. America Oaxaca OA 68 62 56 43 49 37 43 31 31 25 23 23 
N. America Ohio OH 65 60 55 40 45 35 40 30 30 25 15 15 
N. America Oklahoma OK 68 60 60 40 50 35 45 35 35 25 15 15 
N. America Ontario ON 62 62 62 43 49 37 43 31 31 25 21 21 
N. America Oregon OR 55 55 50 40 45 35 40 30 30 25 16 16 
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Region State FIPS 
Interstate 
Highway 

Divided 
Highway 

Primary 
Highway 

Secondary 
Highway Local Ferries 

Rural Urban Rural Urban Rural Urban Rural Urban Rural Urban Rural Urban 
N. America Pennsylvania PA 65 55 55 40 45 30 35 30 25 25 13 13 
N. America Prince Edward Island PE 62 62 56 43 56 37 49 37 31 25 21 21 
N. America Puerto Rico PR 65 55 45 40 45 30 30 30 30 25 15 15 
N. America Puebla PU 68 62 56 43 49 37 43 31 31 25 23 23 
N. America Queretaro Arteaga QA 68 62 56 43 49 37 43 31 31 25 23 23 
N. America Quebec QC 62 62 56 37 56 37 49 37 31 25 21 21 
N. America Quintana Roo QR 68 62 56 43 49 37 43 31 31 25 23 23 
N. America Rhode Island  RI 65 55 55 40 45 30 35 30 25 25 13 13 
N. America South Carolina SC 68 60 55 40 45 35 40 30 30 25 13 13 
N. America South Dakota SD 68 60 60 40 50 35 45 35 35 25 15 15 
N. America Sinaloa SI 68 62 56 43 49 37 43 31 31 25 23 23 
N. America Saskatchewan SK 62 62 62 43 56 37 43 37 31 25 21 21 
N. America San Luis Potosi SL 68 62 56 43 49 37 43 31 31 25 23 23 
N. America Sonora SO 68 62 56 43 49 37 43 31 31 25 23 23 
N. America Tabasco TA 68 62 56 43 49 37 43 31 31 25 23 23 
N. America Tlaxcala TL 68 62 56 43 49 37 43 31 31 25 23 23 
N. America Tamaulipas TM 68 62 56 43 49 37 43 31 31 25 23 23 
N. America Tennessee TN 68 60 55 40 45 35 40 30 30 25 15 15 
N. America Texas TX 68 60 60 40 50 35 45 35 35 25 15 15 
N. America Utah UT 68 60 60 40 50 35 45 35 35 25 15 15 
N. America Virginia VA 65 60 55 40 45 30 40 30 30 25 13 13 
N. America Vermont VT 65 55 55 40 45 35 45 35 30 25 15 15 
N. America Veracruz VZ 68 62 56 43 49 37 43 31 31 25 23 23 
N. America Virgin Islands, U.S. VI 56 43 43 37 37 31 31 25 18 18 24 24 
N. America Washington WA 60 60 55 40 45 30 35 30 30 25 16 16 
N. America Wisconsin WI 65 60 60 40 45 35 45 35 35 25 18 18 
N. America West Virginia WV 68 55 55 40 45 35 35 30 30 25 15 15 
N. America Wyoming WY 68 60 60 40 50 35 45 35 35 25 15 15 
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Region State FIPS 
Interstate 
Highway 

Divided 
Highway 

Primary 
Highway 

Secondary 
Highway Local Ferries 

Rural Urban Rural Urban Rural Urban Rural Urban Rural Urban Rural Urban 
N. America Yucatan YC 68 62 56 43 49 37 43 31 31 25 23 23 
N. America Yukon Territory YT 56 56 56 43 56 37 49 37 31 25 21 21 
N. America Zacatecas ZT 68 62 56 43 49 37 43 31 31 25 23 23 

Oceania American Samoa AQ 50 43 43 37 37 31 31 25 25 18 18 18 
Oceania Australia AS 68 56 56 43 50 37 37 25 25 18 22 22 
Oceania Cook Islands CW 50 43 43 37 37 31 31 25 25 18 18 18 
Oceania Fiji FJ 50 43 43 37 37 31 31 25 25 18 18 18 
Oceania Micronesia, Federated 

States of 
FM 50 43 43 37 37 31 31 25 25 18 18 18 

Oceania French Polynesia FP 50 43 43 37 37 31 31 25 25 18 20 20 

Oceania 
French Southern and 
Antarctic Islands FS 50 43 43 37 37 31 31 25 25 18 15 15 

Oceania Kiribati KR 50 43 43 37 37 31 31 25 25 18 15 15 
Oceania Midway Island MQ 50 43 43 37 37 31 31 25 25 18 18 18 
Oceania New Caledonia NC 50 43 43 37 37 31 31 25 25 18 22 22 
Oceania Niue NE 50 43 43 37 37 31 31 25 25 18 15 15 
Oceania Norfolk Island NF 50 43 43 37 37 31 31 25 25 18 18 18 
Oceania Vanuatu NH 50 43 43 37 37 31 31 25 25 18 15 15 
Oceania Nauru NR 50 43 43 37 37 31 31 25 25 18 15 15 
Oceania New Zealand NZ 62 56 56 43 43 31 37 25 25 18 23 23 
Oceania Pitcairn PC 50 43 43 37 37 31 31 25 25 18 15 15 
Oceania Marshall Islands RM 50 43 43 37 37 31 31 25 25 18 18 18 
Oceania Tokelau TL 50 43 43 37 37 31 31 25 25 18 15 15 
Oceania Tonga TN 50 43 43 37 37 31 31 25 25 18 15 15 
Oceania Tuvalu TV 50 43 43 37 37 31 31 25 25 18 15 15 
Oceania Wallis & Futuna Islands WF 50 43 43 37 37 31 31 25 25 18 15 15 
Oceania Wake Island WQ 50 43 43 37 37 31 31 25 25 18 18 18 
Oceania Western Samoa WS 50 43 43 37 37 31 31 25 25 18 18 18 

S. America Aruba AA 56 43 43 37 37 31 31 25 18 18 24 24 
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Region State FIPS 
Interstate 
Highway 

Divided 
Highway 

Primary 
Highway 

Secondary 
Highway Local Ferries 

Rural Urban Rural Urban Rural Urban Rural Urban Rural Urban Rural Urban 
S. America Antigua and Barbuda AC 56 43 43 37 37 31 31 25 18 18 16 16 
S. America Argentina AR 68 50 50 37 37 31 31 25 18 12 21 21 
S. America Anguilla AV 56 43 43 37 37 31 31 25 18 18 20 20 
S. America Barbados BB 56 43 43 37 37 31 31 25 18 18 16 16 
S. America Belize BH 62 56 56 43 49 37 37 31 31 25 21 21 
S. America Bermuda BD 56 49 49 43 43 37 31 31 25 25 21 21 
S. America Bahamas BF 56 43 43 37 37 31 31 25 18 18 26 26 
S. America Bolivia BL 62 50 50 37 37 31 31 25 18 12 21 21 
S. America Brazil BR 68 43 50 37 37 25 31 18 18 12 21 21 
S. America Chile CI 62 50 43 37 31 31 25 25 18 12 21 21 
S. America Cayman Islands CJ 56 43 43 37 37 31 31 25 18 18 20 20 
S. America Colombia CO 62 50 43 37 31 31 25 25 18 12 21 21 
S. America Costa Rica CS 56 49 49 43 43 37 31 31 25 25 21 21 
S. America Cuba CU 56 43 43 37 37 31 31 25 18 18 23 23 
S. America Curacao UC 56 43 43 37 37 31 31 25 18 18 16 16 
S. America Dominica DO 56 43 43 37 37 31 31 25 18 18 20 20 
S. America Dominican Republic DR 56 43 43 37 37 31 31 25 18 18 16 16 
S. America Ecuador EC 62 50 43 37 31 31 25 25 18 12 21 21 
S. America El Salvador ES 62 56 56 43 49 37 37 31 31 25 21 21 
S. America French Guiana FG 62 50 50 37 37 31 31 25 18 12 21 21 

S. America 
Falkland Islands 
(Malvinas) FK 56 43 43 37 37 31 31 25 18 18 12 12 

S. America Grenada GJ 56 43 43 37 37 31 31 25 18 18 20 20 
S. America Guadeloupe GP 56 43 43 37 37 31 31 25 18 18 20 20 
S. America Guantanamo Bay -- 56 43 43 37 37 31 31 25 18 18 23 23 
S. America Guatemala GT 62 56 56 43 49 37 37 31 31 25 21 21 
S. America Guyana GY 62 50 50 37 37 31 31 25 18 12 21 21 
S. America Haiti HA 56 43 43 37 37 31 31 25 18 18 20 20 
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Region State FIPS 
Interstate 
Highway 

Divided 
Highway 

Primary 
Highway 

Secondary 
Highway Local Ferries 

Rural Urban Rural Urban Rural Urban Rural Urban Rural Urban Rural Urban 
S. America Honduras HO 62 56 56 43 49 37 37 31 31 25 21 21 
S. America Jamaica JM 56 43 43 37 37 31 31 25 18 18 23 23 
S. America Martinique MB 56 43 43 37 37 31 31 25 18 18 20 20 
S. America Montserrat MH 56 43 43 37 37 31 31 25 18 18 16 16 
S. America Netherlands Antilles NT 56 43 43 37 37 31 31 25 18 18 16 16 
S. America Nicaragua NU 59 50 41 27 27 18 23 14 16 9 5 5 
S. America Panama PM 62 56 56 43 49 37 37 31 31 25 21 21 
S. America Paraguay PA 62 50 50 37 37 31 31 25 18 12 21 21 
S. America Peru PE 62 50 43 37 31 31 25 25 18 12 21 21 
S. America Saint Barthelemy TB 56 43 43 37 37 31 31 25 18 18 16 16 
S. America Saint Martin RN 56 43 43 37 37 31 31 25 18 18 16 16 
S. America Saint Kitts and Nevis 

Islands 
SC 56 43 43 37 37 31 31 25 18 18 16 16 

S. America Saint Lucia ST 56 43 43 37 37 31 31 25 18 18 20 20 
S. America Saint Vincent and the 

Grenadines 
VC 56 43 43 37 37 31 31 25 18 18 20 20 

S. America Sint Maarten NN 56 43 43 37 37 31 31 25 18 18 16 16 
S. America Suriname NS 62 50 50 37 37 31 31 25 18 12 21 21 
S. America Trinidad and Tobago TD 62 50 43 37 31 31 25 25 18 12 25 25 
S. America Turks and Caicos Isl. TK 56 43 43 37 37 31 31 25 18 18 16 16 
S. America Uruguay UY 62 50 50 37 37 31 31 25 18 12 21 21 
S. America Venezuela VE 62 50 43 37 31 31 25 25 18 12 21 21 
S. America Virgin Islands, British VG 56 43 43 37 37 31 31 25 18 18 24 24 
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Appendix F:  
Toll Plaza Names in Reports 

 
 
The chart below identifies the toll authorities that have assigned multiple names to the same toll plaza location.  When generating a route 
using PC*MILER|Tolls, only one name for each toll plaza location is provided in the Detailed Route Report.  Because a vehicle can travel 
through any of the sub-plazas at one of these locations, this chart may help you match up agency names to the names that appear along a 
route in the Detailed Route Report. 
 
Currently there is only one toll plaza location in the database that has multiple names assigned to it: 
 
 
Agency Toll Road Toll Plaza Name in 

PC*MILER|Connect 
Toll Plaza 
Abbreviation in 
Detailed Route 
Report 

Other Plaza 
Abbreviations Used 
By Agency at the 
Same Location 

Other Plaza Names 
Used by Agency at 
the Same Location 

VDOT Chesapeake Expressway Chesapeake Expressway 16, 17 18*  
 
* 18 is the abbreviation used for Discount Program Members. 
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Appendix G:  
Toll Roads Requiring Electronic Payment 

 
 
Table 1 below lists roads that only accept toll discount programs.  No cash or other payment option is offered, and driving on one of 
these roads without a transponder and discount program membership will cause an invoice to be sent with a surcharge added to the toll 
rate. 
 
Table 2 lists all electronic toll roads (Open Road Tolling).  Like the roads in Table 1, drivers without a transponder on these roads will 
receive an invoice with a video toll rate amount. 
 
What differentiates these two types of roads is the amount of the surcharge on the roads in Table 1: these roads carry a relatively 
expensive surcharge, and the transportation authorities strongly advise against driving on these roads without a transponder. 

 
 
TABLE 1.  Roads Accepting Only Toll Discount Programs – Additional Surcharge on Violations 
 

State Toll Road/Exits Discount Program Video Toll/Cash Comments 

Florida Florida Turnpike SunPass None For the Florida Turnpike, the five 
exits listed are SunPass Only. 
Drivers without SunPass are 
required to exit before or after 
these exits.  If used by mistake 
then an invoice is sent home with a 
surcharge. 

Becker Road SunPass None  
Jog Road exit 98 SunPass None  
SR 710 exit 107 SunPass None  
Consulate Drive exit 255 SunPass None  
Kissimmee Park Rd exit 240 SunPass None  
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Florida Polk Parkway - 
Pace Road exit 23 

SunPass None This exit on the Polk Parkway is 
SunPass only.  If used by mistake 
an invoice is sent to the user with 
a surcharge. 

Pennsylvania Pennsylvania Turnpike E-ZPass None For the four exits listed here a 
video toll plus a surcharge is sent 
in an invoice to the user. 

Virginia Drive exit 340 E-ZPass None  
Street Road exit 352    
SR 29 exit 320 E-ZPass None  

 SR 903 exit 87 E-ZPass None  
Texas Camino Colombia Toll Road EZ Tag, TxTag, TollTag None You must have a TxTag account or 

other accepted prepaid account to 
pay tolls on Camino Colombia. 
Under Texas law, non-payment of 
tolls is a misdemeanor offense, 
and you may be subject to 
Administrative fees and fines of up 
to $350 per violation. 

Texas Fort Bend Westpark Tollway EZ Tag, TxTag None A fee is added to the toll rate and 
an invoice is sent to drivers 
without EZ Tag.  

Texas Fort Bend Parkway Toll Road 
(Fort Bend Section) 

EZ Tag, TxTag, TollTag None A fee is added to the toll rate and 
an invoice it sent to drivers 
without EZ Tag. 

Texas Westpark Tollway EZ Tag, TxTag, TollTag  None Driving without an EZ TAG results 
in a violation event. A toll violation  
invoice is sent to registered 
owner/renter for the past-due toll 
amount plus fess od $33. 
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Texas Grand Parkway (Fort Bend 
section) 

EZ Tag, TxTag, TollTag None A fee is added to the toll rate and 
an invoice it sent to drivers 
without EZ Tag. 

Texas Sam Houston Tollway EZ Tag, TxTag, TollTag    Video Toll There are nineteen plazas that 
require an EZ TAG. For the first 
two violations drivers can go to 
store or call and pay the toll; for 
the third violation an invoice with 
a surcharge of $33 is generated. 

 North Gessner EZ Tag, TxTag, TollTag    Video Toll  
 West Road Entrance Ramp EZ Tag, TxTag, TollTag    Video Toll  
 Hammerly Blvd Entrance 

Ramp 
EZ Tag, TxTag, TollTag    Video Toll  

 Bellaire Blvd Entrance Ramp EZ Tag, TxTag, TollTag    Video Toll  
 Tidwell Road EZ Tag, TxTag, TollTag    Video Toll  
 Garrett Road EZ Tag, TxTag, TollTag    Video Toll  
 Generation Parkway EZ Tag, TxTag, TollTag    Video Toll  
 Northeast Mainline Toll 

Plaza 
EZ Tag, TxTag, TollTag    Video Toll  

 W Lake Houston Parkway EZ Tag, TxTag, TollTag    Video Toll  
 John Ralston Road EZ Tag, TxTag, TollTag    Video Toll  
 Wilson Road EZ Tag, TxTag, TollTag    Video Toll  
 Tanner Road Exit Ramp EZ Tag, TxTag, TollTag    Video Toll  
 Clay Road Exit Ramp EZ Tag, TxTag, TollTag    Video Toll  
 South Main Entrance Ramp EZ Tag, TxTag, TollTag    Video Toll  
 Almeda Road Entrance 

Ramp 
EZ Tag, TxTag, TollTag    Video Toll  

 Cullen Exit Ramp EZ TAG, TxTag, TollTag Video Toll  
 Wayside Entrance Ramp EZ TAG, TxTag, TollTag Video Toll  
 Red Bluff/ San Augustine EZ TAG, TxTag, TollTag Video Toll  
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Entrance Ramp 
 Monroe Exit Ramp EZ TAG, TxTag, TollTag Video Toll  
Texas Hardy Toll Road EZ Tag, TxTag, TollTag    Video Toll There are two plazas that require 

an EZ Tag.  For the first two 
violations drivers can go to a store 
or call and pay the toll, for the 
third violation an invoice with a  
surcharge of $33 is generated. 

Rankin Road Entrance Ramp EZ Tag, TxTag, TollTag    Video Toll  
 Central Greens Blvd EZ Tag, TxTag, TollTag    Video Toll  

 
 
 
TABLE 2.  Electronic Toll Roads (Open Road Tolling) 

 

State Toll Road/Exits Discount Program Video 
Toll/Cash Comments 

British 
Columbia 

Golden Ears Bridge Quickpass Pay As You Go If the driver is not a registered 
customer, the license plate information 
is forwarded electronically to ICBC 
when the bridge is crossed. TransLink 
uses the information received from 
ICBC to send a bill for the toll amount to 
the registered owner of the vehicle. 

Port Mann Bridge TReO Pay By Mail  
California Golden Gate Bridge FasTrak Pay-by-Plate  

Foothills-Eastern Toll Road FasTrak ExpressAccount 
Invoice 

 

San Joaquin Hills Corridor FasTrak ExpressAccount 
Invoice 

 

Colorado E-470 EXpressToll, GO- License Plate  
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PASS Toll 
 Northwest Parkway EXpressToll, GO-

PASS 
License Plate 
Toll 

 

Florida Snapper Creek Expressway SR 
878 

SunPass Toll-By-Plate  

Don Shula Expressway SR 874 SunPass Toll-By-Plate  
Gratigny Parkway SR 924 SunPass Toll-By-Plate  
Homestead Extension Of Florida's 
Turnpike - Exit 1 to Exit 47 
including Miramar Plaza 

SunPass Toll-By-Plate  

Sawgrass Expressway SunPass Toll-By-Plate  
Veterans Expressway SunPass Toll-By-Plate  
Airport Expressway SunPass Toll-By-Plate  
Broad Causeway SunPass Toll-By-Plate  
Selmon Expressway SunPass We Bill You  
New interchange I-4/Selmon 
Expressway Interchange 
(Connector) 

SunPass Toll-By-Plate  

Dolphin Expressway SR 836 SunPass Toll-By-Plate  
Mid-Bay Bridge Connector SunPass Toll-By-Plate  
Florida’s Turnpike – County Line 
Road & NW 27th  Avenue 

SunPass Toll-By-Plate  

Golden Glades Toll Plaza SunPass Toll-By-Plate  
Illinois  Tri-State Tollway I-Pass, E-ZPass Video Toll Rate For the highlighted exit which is an all 

electronic tolling ramps, no cash 
accepted. Cash customers will incur an 
unpaid toll and are responsible for 
paying the cash fare indicated within 7 
days of the event. 

147th Street I-57/1294 I-Pass, E-ZPass Video Toll Rate  
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Balmoral Northbound I-Pass, E-ZPass Video Toll Rate  
Ronald Reagan Tollway I-Pass, E-ZPass Video Toll Rate For the highlighted exit which is an all 

electronic tolling ramps, no cash 
accepted. Cash customers will incur an 
unpaid toll and are responsible for 
paying the cash fare indicated within 7 
days of the event. 

Eola Road I-Pass, E-ZPass Video Toll Rate  
Jane Addams Tollway I-Pass, E-ZPass Video Toll Rate  
IL 47 EB ent WB exit I-Pass, E-ZPass Video Toll Rate  
IL 47 EB ent WB exit I-Pass, E-ZPass Video Toll Rate  

Maryland Intercounty Connector MD 200 E-ZPass Video Toll Rate Toll facility customers who do not have 
an E-ZPass and travel the ICC will be 
sent a bill in the mail and charged the 
Video Toll Rate (VRT).  VRTs at all 
Maryland toll facilities are 150% of the 
base toll rates with a minimum of $1 
and a maximum of $15 above the base 
toll rate.      

New York Henry Hudson Bridge E-ZPass Bill by Mail A photograph is taken of the license 
plate and the registered owner of the 
vehicle will receive a bill in the mail. 

North 
Carolina 

Triangle Expressway NC Quick Pass Bill By Mail  

Ontario 407 ETR 407 ETR 
Transponder 

Video Toll 
Charge 

 

Quebec A 25 Bridge A25 Transponder Video Toll 
Charge 

 

Texas 183A EZ Tag, TxTag, 
TollTag 

Pay By Mail  

Central Texas Tollways Loop 1 EZ Tag, TxTag, Pay By Mail  
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TollTag 
Central Texas Tollways SH 130 EZ Tag, TxTag, 

TollTag 
Pay By Mail  

Central Texas Tollways SH 45 EZ Tag, TxTag, 
TollTag 

Pay By Mail  

Loop 49 TxTag, TollTag, EZ 
TAG 

Pay By Mail  

Manor Expressway EZ Tag, TxTag, 
TollTag 

Pay By Mail  

Addison Airport Tunnel TollTag, TxTag ZipCash  
Dallas North Tollway TollTag, TxTag ZipCash  
Lewisville Lake Toll Bridge TollTag, TxTag ZipCash  
Mountain Creek Lake Toll Bridge TollTag, TxTag ZipCash  
Sam Rayburn Tollway TollTag, TxTag ZipCash  
President George Bush Turnpike TollTag, TxTag ZipCash  
PGBT Western Extension SH 161 TollTag, TxTag ZipCash  
Chisholm Trail Parkway TollTag, TxTag ZipCash  
Tomball Tollway EZ Tag, TxTag, 

TollTag 
Video Toll A photo of the license plate is taken and the 

registered owner of the vehicle receives a 
violation notice with a $11.00 fee added to 
the amount of the toll rate.  This is a new 
toll road that opened on April 12, 2015. 

Texas SH 550 EZ Tag, TxTag, 
TollTag 

Pay By Mail 
Rate 

 

Texas State Highway 99 EZ Tag, TxTag, 
TollTag 

Notice By Mail  

Virginia Pocahontas Parkway E-ZPass  E-ZPass, Visa or 
Mastercard 

The two listed exits are no cash exits, 
The Mainline Plaza is also cashless 
overnight from 11 p.m to 5 a.m. 
Payment options are Visa/Mastercard 
Debit/Credit cards 
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Laburnum Avenue E-ZPass E-ZPass, Visa or 
Mastercard 

 

Airport Connector E-ZPass E-ZPass, Visa or 
Mastercard 

 

South Norfolk Jordan Bridge E-ZPass Pay by Plate  
Midtown Tunnel E-ZPass Pay by Plate  
Downtown Tunnel E-ZPass Pay by Plate  

Washington SR 520 Bridge Good To Go Pay By Mail  
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Appendix H:   

Worldwide Postal Code Formats 
 
 

 

Legend: A = alphabetic (A,B,C,…Z) 
N = numeric (0,1,2,...9) 

 

NOTE:  The version of PC*MILER in which postal code coverage was started is 
noted for each country listed below.  This refers to postal code coverage only, the 
country may have been available for routing without postal code access in 
previous versions. 

North America 
Canada  
ANA NAN or ANANAN 

Mexico, starting in Version 25.1 
NNNNN 

Puerto Rico, starting in Version 27.1 
NNNNN 

United States 
NNNNN 

South America 
Brazil, starting in Version 24.1 
NNNNN 

Europe 
United Kingdom 
AANA N or AAN N or AANN N 
or, starting in PCM24, AANAN or AANN or AANNN 
or, starting in Version 25.1, AANA NAA or AANANAA or AAN NAA or 
AANNAA or AANN NAA or AANNNAA 

France, Germany, Italy, Vatican City, Spain, and Finland 
NNNNN 

Russian Federation, starting in Version 22.1 
NNNNNN 

Romania, starting in Version 23.1 
NNNNNN 
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Estonia and Croatia, starting in Version 22.1 
NNNNN 

Lithuania, starting in Version 23.1 
NNNNN 
 
Andorra, starting in Version 26.1 
AANNN 
 
Monaco, starting in Version 26.1 
NNNNN 

Ukraine and Turkey, starting in Version 24.1 
NNNNN 

Netherlands, Belgium, Luxemburg, Austria, Switzerland, Liechtenstein, 
Denmark, Norway and Hungary 
NNNN 

Latvia and Slovenia, starting in Version 22.1 
NNNN 

Bulgaria, starting in Version 23.1 
NNNN 

Iceland 
NNN 

Ireland (Dublin only) 
NN (single digit postcodes N are not supported for input in PC*MILER) 

Poland 
NN-NNN 
or, starting in Version 24.1: NNNNN 

Portugal 
NNNN 
or, starting in Version 24.1: NNNN-NNN or NNNNNNN 
 
San Marino, starting in Version 26.1 
NNNNN 

Sweden 
NNN 
or, starting in Version 22.1: NNN NN or NNNNN 

Czech Republic and Slovakia 
NNN NN or NNNNN 
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Greece, starting in Version 22.1 
NNN NN or NNNNN 

Africa 
Lesotho, starting in Version 27.1 
NNNN 
 
South Africa, starting in Version 24.1 
NNNN 
 
Swaziland, starting in Version 27.1 
ANNN 

Asia 
Japan, starting in Version 24.1 
NNN-NNNN or NNNNNNN  

India, starting in Version 24.1 
NNNNNN 
 
Indonesia, starting in Version 27.1 
NNNNN 
 
Malaysia, starting in Version 27.1 
NNNNN 
 
Taiwan, starting in Version 27.1 
NNN 
 
Thailand, starting in Version 27.1 
NNNNN 

Oceania 
Australia, starting in Version 24.1 
NNNN 
 
New Zealand, starting in Version 27.1 
NNNN 
 
Federated States of Micronesia, Guam, Marshall Islands, Northern Mariana 
Islands, and Palau, starting in Version 27.1 
NNNNN 
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Appendix I:  Worldwide Data Coverage & 

Postal Code Access 
 
 
PC*MILER Version 29 data highlights include extensive updates in over 125 countries and 
territories, and over 25 countries and territories upgraded to High and Comprehensive coverage 
since the previous version. 
 
Highway and Street-Level Data Coverage by Region 
 

Region Number of 
Countries 

Highway 
Distance 
 (Miles) 

Streets  
 Distance1  

(Miles) 
Number of 

Cities 
Number of 

Postal Codes 

Africa  58 424,439 3,201,635 135,732 5,841 
Asia  32 1,007,522 4,821,424 941,755 998,276 
Europe  58 1,875,662 10,071,351 739,096 1,017,853 
Middle East 16 200,699 432,016 142,645 24,300 
North 
America  7 948,439 7,540,110 268,172 1,047,0352 
Oceania 21 157,827 824,619 21,926 31,883 
South 
America  48 505,152 1,985,903 116,027 91,974 
TOTAL 240 5,119,740 28,877,058 2,365,353 3,217,162 
1 Available with purchase of the PC*MILER|Streets add-on.  Street-level coverage for each region is available only 

for select countries with coverage level Comprehensive and High.  Street-level mileage includes highway miles. 
2  Includes Canadian Postal Codes available with purchase of data add-on 
 
 

Countries Where Significant Street-Level Coverage* 
 Is Available (By Region) – Version 29 

 
Region Countries 
Africa Botswana, Egypt, Kenya, Lesotho, Morocco, Mozambique, Namibia, 

Reunion, South Africa, Swaziland, Tunisia, Western Sahara, Zimbabwe 
Asia  Brunei, Hong Kong, India, Indonesia, Macau, Malaysia, Philippines, 

Singapore, Taiwan, Thailand, Vietnam 
Europe  All countries except Armenia, Azerbaijan, Cyprus, Faroe Islands, Georgia, 

Kyrgyzstan, Svalbard, Tajikistan, Turkmenistan, and Uzbekistan 
Middle East Bahrain, Jordan, Kuwait, Lebanon, Oman, Qatar, Saudi Arabia, UAE 
North America Canada, Puerto Rico, United States 
Oceania Australia, New Zealand 

South America  
Argentina, Bahamas, Brazil, Cayman Islands, Chile, Colombia, Costa Rica, 
Falkland Islands, French Guiana, Guadeloupe, Martinique, Panama, 
Paraguay, Peru, Saint Barthelemy, Uruguay, Venezuela 

* Includes High and Comprehensive coverage (see next page), data for some countries does not include truck attributes. 
NOTE:  When calculating routes using Streets data sets in regions outside North America, note that routes cannot be 
run within or across countries not included in the selected data set.  The Worldwide Highway data set must be used to 
run routes to/from countries that are not covered in the Streets data set. 

A
pp

en
di

x I 

 
 PC*MILER User’s Guide  282 



  

PC*MILER|Worldwide 29 Data Coverage - Overview 
 
The map and table below shows a high level overview of the map data coverage offered in 
PC*MILER|Worldwide 29.  Please note that the coverage classifications have changed slightly 
from Version 28.  For more information, please contact ALK at pcmsupport@alk.com.   
 

 

 
 
 

Coverage Level* Road Coverage Locations Truck-Specific 
Attributes 

Comprehensive Comprehensive Street Level 
Network Cities, postal codes, addresses  Yes 

High Comprehensive Street Level 
Network Cities, postal codes, addresses  No 

Intermediate  Complete Highway + Street Level 
Network 

Cities, some postal codes,                        
some addresses  No 

Entry Basic Highway + Some Street 
Level Network Cities, some postal codes  No 

Basic City to City Road Network Cities No 

*  Coverage levels are assigned based on road coverage.  Postal code attributes generally correspond to 
the level of road coverage, with some exceptions. 

 

PC*MILER|Worldwide 29 Map Data Coverage 
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Index 
 
 
53 Foot access policies, 233 
53-Foot Trailer or Twins routing, 14 
 
A 
abbreviations in addresses, 54, 251 
abbreviations list, 241 
accented letters, 53 
access routes and policies, 13, 233 
Add Comments box, 171 
adding new PC*MILER products, 38 
address entry, 54, 145, 251 

abbreviations in, 54 
synonyms for street type, 54, 251 

ALK Cloud Services, 208 
ALK Technologies, 226 
Application Settings dialog, 47 
AS400 installation, 35 
automobile routing, 153, 155, 181 
avoid route segments, 170 
avoid whole roads, 178 
avoid whole states, 178 
axles, 128, 130 
 
B 
backing up custom files, 194 
border crossings, 61 
borders open/closed, 143 
 
C 
Canadian counties, 238 
Canadian place names, 53 
Canadian postal codes, 53, 59 
Canadian province abbreviations, 241 
CAT Scale weigh stations, 67 
CICS installation, 35 
Citrix and Terminal Services installs, 34 
city names, entering, 51 
clean up distance, 145 
closures, 163 
cloud account, 208 
column adjustments, 91 

comments, 171 
Comparison report, 138 
confidence level, custom place importing, 

104 
Copy Latitude/Longitude command, 168 
copying a map, 169 
copying a stop, 72 
cost and time estimates, 83, 108, 113, 116, 

117, 147 
country code formats, 56, 244 
Custom Place Manager, 96 
custom places 

adding, 94 
as lat/longs, 97 
converting to Version 29, 107 
exporting, 97 
importing, 98 
managing, 96 
search along a route, 79 
search within a radius, 76 
sharing, 208, 213 

custom road file conversion, 180 
Custom Roads report, 177 
custom route profiles, 183 
custom routing, 170 

adjust for hazmat permits, 201 
avoid/favor route segments, 170 
avoid/favor whole roads, 178 
avoid/favor whole states, 178 
drag route, 186 
geofences, 187 
hazmat permits, 201 
override restrictions, 173 
sets of road preferences, 175 
Use Custom Roads option, 143 
via points, 184 

custom vehicle profiles, 181 
 
D 
data errors, reporting, 225 
data matching, 98 
data set, changing, 56 
database for PC*MILER, 9, 225 
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deactivating a PC*MILER license, 39 
default city match, 57 
default route options, 158 
designated truck routes, 163 
destination, entering, 50 
Detailed Route report, 134 
distance calculation, 10 
distance units, 146 
dock window pane, 46 
Drag Map mode, 162 
Drag Routing option, 186 
dragging a stop, 72 
Driver’s Report, 137 
driving directions, 137 
duplicate city names, 70 
duplicate route, 93 
 
E 
editing stops, 71 
elevation discouraged, 145 
Email Technical Support option, 221 
Energy dataset, 205 
energy roads data, 204 
Enterprise Solutions, 227 
error messages, 69 
estado abbreviations, 241 
ETA/ETD, 112, 149 
Export All button, 177 
exporting custom places, 97 
 
F 
Fastest routing, 12 
favor route segments, 170 
Feature Reference Guide, 41 
ferry discouraged, 145 
File application menu, 43, 47 
file conversion from earlier versions, 36 
FIPS codes, 56 
float window pane, 46 
frame options, 160 
frame stop, 73 
framing routes, 92 
fuel costs, 147 
fuel price search, 81 
fuel stops search, 81 
fuel tax reporting, 11 
full-size van, 153, 154, 181 

G 
gallons/liters conversion, 146 
GENC codes, 56 
geofences, 187 

conversion utility, 194 
creating, 188 
customizing, 190 
report, 192 

greenhouse gases emission, 148 
 
H 
hazardous material routing, 196 
hazmat routing 

adjust for permits, 201 
hide window pane, 46 
highway exits, 66 
highway junctions, 62 
Highway Only routing, 144 
Hours of Service, 83 
Hub distances, 145 
 
I 
importing custom places, 98 
importing saved settings, 36 
installation, 23 
installing to a mapped drive, 31 
ISO codes, 56 
 
K 
kilometers, 146 
 
L 
labor costs, 148 
latitude/longitude points 

as custom points, 97 
using with addresses, 64 

Least Cost routing, 17, 108 
legends, 163 
local mileage, 144 
location radius, 75 
 
M 
map data set, changing, 56 
Map Features dialog, 165 
map panning, 162 
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map window. See Map window 
Map window, 43, 159 

copying, 169 
frame options, 160 
hiding/displaying features in, 165 
lat/long tracking in, 63 
legends, 163 
map styles in, 166 
picking stops from, 69, 168 
points of interest, 168 
printing, 169 
right mouse menu, 167 
route distance tooltip, 167 
satellite image layer, 166 
scroll bars, 162 
zoom options, 161 

Mexican postal codes, 53 
Mileage report, 92, 133 
miles/kilometers conversion, 146 
multiple routes, 92 
multiple trailer, 153 
 
N 
National Network access policies, 233 
National Network designation, 163 
National Network routing, 13 
new PC*MILER features, 5 
new route, 49 
NL abbreviation setting, 53 
 
O 
open a saved trip, 93 
optimizing routes, 74 
Options. See Route Options 
origin, entering, 50 
override hazmat restrictions, 201 
override restrictions option, 143 
override truck restrictions, 173 
Oversized Access designation, 163 
oversized vehicle access policies, 233 
 
P 
Pan map view, 162 
PC*MILER Sales, 221 
PC*MILER|Energy, 204 
PC*MILER|Energy installation, 29 

PC*MILER|Worldwide installation, 29 
pick list for stop entry, 52, 54, 57 
pick list on/off, 54, 57 
picking stops from the map, 69, 168 
POI search 

along a route, 79 
fuel prices, 81 
fuel stops, 81 
radial around a location, 76 

points of interest icons, 168 
postal code formats worldwide, 279 
postal code help, 58 
postal codes, entering, 58 
Practical route, 11 
printing a map, 169 
printing reports, 139 
Provide Pick List option, 52, 57 
province abbreviations, 241 
proxy setup, 28, 36 
 
Q 
Quick Access Toolbar, 44 
 
R 
ramp speed, 156 
ReadMe file location, 41 
region 

changing, 55, 142 
default, 142 

region-to-region routing, 55 
report location, 133 
reporting data errors, 225 
reports 

Comparison, 138 
copying, 140 
Detailed Route, 134 
Driver’s Report, 137 
Geofence, 192 
Least Cost comparison, 110 
memo field in, 146 
Mileage, 92, 133 
Road Type, 138 
saving, 140 
State/Country Report, 136 

requirements, 18 
resizing a route window, 90 
restricted roads, 163, 173, 201 
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restrictions - special time-based, 118 
reversing the stop order, 74 
Ribbon toolbars, 43 
right mouse map menu, 167 
road classifications, 157 
road closure, 163 
road speed defaults, 257 
road speeds, 156 
Road Type Report, 138 
route 

53-Foot Trailer or Twins, 14 
cost and time estimates, 89, 113, 116, 117 
Fastest, 12 
Least Cost, 17 
National Network, 13 
new, 49 
optimization, 74 
Practical, 11 
running, 89 
Shortest, 12 
Toll Discouraged, 15 
type descriptions, 11 
type, changing, 143 

route distance tooltip, 167 
route framing, 92 
route name, 142 
Route Options, 141 

borders open/closed, 143 
cost and time estimates, 147 
elevation discouraged, 145 
ETA/ETD, 149 
ferry discouraged, 145 
fuel costs, 147 
gallons/liters, 146 
greenhouse gases emission, 148 
hazmat routing, 196 
hub routing, 143, 145 
labor costs, 148 
miles/kilometers, 146 
miscellaneous costs, 148 
override restrictions, 143 
report memo, 146 
road speeds, 156 
route name, 142 
route type, 143 
state/country report order, 146 
Streets mode, 144 
Use Custom Roads, 143 

use ferry distance, 145 
Use Highway Only, 144 
vehicle dimensions, 149, 154, 181 
vehicle profile, 142 

route options display, 49 
route window features, 49, 89 
route window resizing, 90 
Routes window, 43 
RouteSync, 214 

adding drivers, 216 
managing vehicles, 219 
sending routes to CoPilot, 217 
vehicle display on map, 220 

routing types, 11 
running a route, 89 
 
S 
satellite image map layer, 166 
save routes as text files, 94 
saved custom places - importing, 107 
saved custom roads - importing, 180 
saving trips, 93 
seasonal routing, 175 
sets of road preferences, 175 
Settings Importer, 36 
shortcut keys, 46 
Shortest Route, 12 
special restrictions warnings, 118 
spelling help, 57 
SPLC 

as stops, 60 
SPLC help, 60 
State Oversized designation, 163 
state weigh stations, 68 
state/country abbreviations list, 241 
State/Country Report, 136 
state/country report order, 137, 146 
stop duration, 85 
stop entry, 50 

accented letters, 53 
HOS rest stops, 83 
lat/long formats, 63 
picking stops from the map, 69 
Zoom to Stop feature, 161 

stop list 
copy a stop, 72 
deleting stops, 71 
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drag a stop, 72 
editing stops, 71 
moving stops, 71 
optimization, 71 
reversing the stop order, 71 

stop times, 83, 113 
Streets mode default, 144 
sync data, 213 
system requirements, 18 
 
T 
technical support, 221 
time format setting, 115 
time zone display, 113 
time-based restrictions warnings, 118 
time-based routing, 112 
time-based toll cost reporting, 119 
toll barriers omission, 135 
toll costs 

by state, 132 
by trip leg, 90 
by weight and axle, 128 
calculation, 124 
cashless toll plazas, 126, 271 
currency for, 127 
discount information in reports, 132 
in reports, 130 
number of axles for, 152 
plaza names, 130 
totals for trip, 131, 132 
vehicle weight for, 128 

Toll Discouraged routing, 15 
toll plaza names in reports, 270 
toll plazas, electronic only, 271 
traffic data 

map display, 120 
use by default, 117 
with ETA/ETD calculation, 115 

Traffic subscription upgrade, 28 
travel time, 112, 156 
truck stops, 65 

picking from the map, 69 
truck-discouraged roads, 173 
truck-inaccessible roads, 173 
truck-restricted roads, 163, 173 
 

 

U 
uninstalling PC*MILER, 39 
units of distance, 146 
updates, 222 
use ferry distances in reports, 145 
Use Highway Only option, 10, 144 
Use Traffic Data option, 115 
 
V 
valid entries for addresses, 251 
vehicle dimension options, 149 
vehicle profile drop-down, 142 
via points, 184 
 
W 
warning - Highway Only, 54 
warnings in the Detailed Route report, 135 
waypoints, 184 
weigh stations, 68 
window options, 45 
 
Z 
ZIP Code help, 58 
ZIP codes, entering, 58 
zoom options, 161 
zoom to stop, 71, 73 
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